
  

 

NOTE: If magnetic materials are placed close to the 
underside of the Series 3c they may be affected by the 
speaker magnet. For this reason it is best not to keep your 
Series 3c in the same pocket as credit cards and/or travel 
passes with magnetic strips. 
There are no known problems with passing this product 
through airport X-ray machines or metal detectors. 

User Guide           
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FCC Information for the USA 

Radio and Television Interference 
This equipment radiates radio frequency energy and if not used properly - that is, in 
strict accordance with the instructions in this manual - may cause interference to Radio 
and Television reception. 
It has been tested and found to comply with the limits for a Class B computing device 
pursuant to part 15 of the FCC Rules. These are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures: 

•  Reorient or relocate the receiving antenna. 

•  Increase the separation distance between the equipment and the receiver. 

•  If you are using the Series 3c computer with a mains adapter, plug it into an outlet 
which is on a different circuit from that to which the receiver is connected. 

•  Consult an authorised PSION dealer or an experienced radio/TV technician for 
help. 

Important 
This equipment was tested for FCC compliance under conditions that included the use 
of shielded cables and connectors between it and the peripherals. It is important that 
you use shielded cable and connectors to reduce the possibility of causing Radio and 
Television interference. Shielded cables, suitable for the Series 3c, can be obtained from 
an authorised Psion dealer. 
If the user modifies the Series 3c or its Expansion Modules in any way, and these 
modifications are not approved by Psion, the FCC may withdraw the user’s right to 
operate the equipment. 

In the USA 
For customers in the USA, the following booklet prepared by the Federal 
Communications Commission may be of help: “How to Identify and Resolve Radio-TV 
Interference Problems”. This booklet is available from the US Government Printing 
Office, Washington, DC 20402  
Stock No 004-000-00345-4. 



 4

Emissions information for Canada 

This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations. 
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le 
matériel brouilleur du Canada. 



 5

Table of Contents 

1 Getting started......................................................................... 1 
What is the Series 3c? 2 
How to use this manual 3 
Fitting the batteries 4 
Where things are 6 
Turning on & off 7 
The System screen 8 
Getting Help 10 
Setting the time & date 11 
Displaying a Status window 12 
Moving to applications 14 
How the applications work 15 
Starting to enter information 19 
How is my information stored? 21 
How safe is my information? 21 
Care of the Series 3c 22 
Using the keyboard 23 
Changing the batteries 25 

2 Agenda.................................................................................. 29 
Introduction 30 
Inserting an appointment in the Day view 31 
Viewing entries by Day, Week, Year etc. 33 
Birthday and anniversaries 35 
Lists and things to do 38 
Repeating entries 43 
Changing & copying entries 46 
Looking at your Agenda 48 
Finding a particular entry 53 
Working with free/busy time 54 
Alarms and reminders 56 
Adding notes to entries - ‘Memos’ 58 
Grouping entries together 60 



 6

Managing your Agenda 65 
Example setups 70 

3 Data....................................................................................... 73 
What is a database? 74 
Typing in entries 74 
Viewing & finding entries 76 
Changing & deleting entries 81 
Copying entries 82 
Sorting entries 84 
Changing how Data looks 85 
Data files 88 
Dialling 90 
Example setups 96 

4 Jotter ..................................................................................... 97 
Introduction 98 
Adding notes 98 
Finding notes 99 
Reading & changing notes 101 
Deleting notes 101 
Copying notes 101 
Working with Jotter files 102 

5 Time .................................................................................... 103 
Time screen 104 
Alarms 107 

6 Calc ..................................................................................... 111 
Introduction 112 
Calculations in the Desk view 112 
Calculations in the Advanced view 114 
Calculator memories 117 
Entering percentage calculations 119 
Decimal places and number formats 120 
Functions 122 



 7

7 World................................................................................... 125 
The World Screen 126 
Selecting a city or country 127 
Summer times 128 
Adding and changing information 129 

8 Word ................................................................................... 133 
Entering text 134 
Editing text 136 
Finding & replacing text 140 
Changing the appearance of text 142 
Quick formatting with emphases & styles 148 
Managing styles and emphases 154 
Using templates for documents 156 
Using the Outline view 159 
Working with Word documents 161 
Printing 164 
Other file formats 164 
Example setups 167 

9 Spell .................................................................................... 169 
Introduction 170 
Running Spell 170 
Spell-checking in Word 177 
The Thesaurus in Word 179 
Adding your own words 179 

10 Patience ............................................................................ 181 
Running Patience 182 
How to play - one-player game 183 
How to play - two-player game 184 

11 Soundmaster ..................................................................... 185 
Running Soundmaster 186 
Recording sounds 186 
Playing sounds 188 
Modifying sound files 189 
Saving part of a sound to a new file 194 



 8

Using sounds as alarms 194 

12 Sheet................................................................................. 195 
Introduction 196 
Creating spreadsheets 197 
Sorting information 211 
Searching for text, numbers & formulae 212 
Changing the display 213 
Working with spreadsheet files 216 
Graphs 219 
Using Databases 227 
Using Tables 233 
Function reference 235 
Differences between Sheet and Lotus 1-2-3 250 

13 The System screen............................................................ 251 
Introduction 252 
Displaying the System screen 252 
General settings 253 
Applications, icons and file lists 259 
Managing disks and memory 269 
Understanding files and directories 274 

14 Files application................................................................. 283 
Introduction 284 
Running the Files application 284 
Working with files and directories 289 
Organising disks and directories 293 
Running utilities from the Files application 294 

15 The Program editor............................................................ 295 
Creating your first program 297 
Managing programs 300 
Finding out more about OPL 301 
Summary for experienced OPL users 301 

16 Comms & Script................................................................. 307 
Using the Comms application 308 
Installing the Comms application 309 



 9

What are scripts? 310 

17 Security & backups............................................................ 311 
How secure is my Series 3c? 312 
Using passwords 313 
Backing up & restoring files 316 

18 Printing .............................................................................. 321 
Printing from your Series 3c 322 
Printing from Word 329 
Printing from the Agenda 332 
Printing from Data 335 
Printing from Sheet 336 
Print preview 339 
Other printing information 340 

19 Infrared.............................................................................. 341 
Transferring information using Infrared 342 
About transferred information 344 

20 Troubleshooting................................................................. 347 
General problems 348 
Memory problems 351 
Problems with files 354 
The built-in applications 355 
Resetting the Series 3c 358 

Glossary ................................................................................. 361 
Appendix ................................................................................ 369 

Character set (IBM Code Page 850) 370 
Specification 373 

Index 
 





 1

 

Getting started 

You should read this chapter first. It introduces you to your 
Series 3c and tells you how to: 

••••  fit the batteries. 

••••  start using your Series 3c. 

••••  display help. 

••••  set the time and date. 

••••  start entering information. 

••••  look after your Series 3c. 

••••  change the batteries. 
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What is the Series 3c? 
The Series 3c is the perfect way to manage your information. Whether you use your 
Series 3c to organise your work or your personal life (or both), you can keep everything 
in one place and view it in an instant. 

All your information on hand 
The Series 3c’s Agenda will look after your diary, tell you when you’re available and 
stop you missing appointments and meetings. You’ll be able to impress your friends and 
family by remembering birthdays and anniversaries (no more “Sorry I forgot”). 
Use Jotter to make quick notes, and the Word processor to type in longer and more 
complex documents. You can print them later, to an Infrared printer using the built-in 
Infrared function, or to an ordinary printer using an optional Parallel Printer Link. 
With the Series 3c’s Data application, you’ll always have phone numbers and addresses 
to hand. You can keep your work contacts separate from your private address book, and 
even keep records of your hobbies or collections. 
You can set alarms, to wake you on workday mornings or to remind you of important 
things to do. 
The Series 3c has “Infrared” communication capabilities built-in, allowing you to copy 
information (documents, diary entries, names & addresses etc.) between your Series 3c 
and another Series 3c or Siena. (See the ‘Infrared’ chapter for more details.) 
These are just some of the things you can do with your Series 3c; they and many others 
are covered in detail in this manual.  

An office in your pocket 
Using the Series 3c’s sophisticated word processor and spreadsheet, you can work on 
important assignments wherever you are. In addition, Psion has a range of optional 
communications accessories, allowing you to link your Series 3c to a PC, printer, fax 
modem, mobile phone or email system. 
For example, using PsiWin, you can transfer files to and from a PC, and synchronise 
your Series 3c Agenda with PC time managers such as Microsoft Schedule+ and Lotus 
Organizer, enabling you to keep all your schedules up-to-date. PsiWin is available from 
your Psion distributor. 
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How to use this manual 
•  Before you can use the Series 3c, you have to fit the batteries (as described next in 

‘Fitting the batteries’). You should then read the rest of this chapter: it tells you all 
you need to know to start using the Series 3c.  

•  After that, read as much, or as little of the other chapters as you need. Each 
“application” - Agenda, Data, Word etc. - has its own chapter, where it is 
explained in detail. Some chapters have an ‘Example setups’ section at the end, 
which may give you some ideas on the different ways you can use your Series 3c. 
More general topics - Printing, Infrared etc. - are covered later in the manual. 

•  After you have entered some information on the Series 3c, you would be well 
advised to read the ‘Security & backups’ chapter - it tells you how to safeguard 
your information against loss, damage and prying eyes. 

•  If you don’t understand a technical or jargon term that is used in the text, you can 
look it up in the ‘Glossary’. 

•  For help about a specific subject, look for an appropriate chapter in the ‘Contents’ 
list at the start, or a suitable entry in the ‘Index’ at the end.  

•  If you have any problems, look up the subject in the ‘Index’ or refer to the 
‘Troubleshooting’ chapter. 

Symbols 
Throughout this manual, you will see the following symbols used to indicate different 
types of information: 

 A note, for any additional information or details. 

 A tip, for useful information or advice. 

 A warning, for advice on avoiding problems or things to watch out for. 

 A troubleshooting tip, for ways to solve problems you might encounter. 

Keys 
Whenever you need to press a certain key on the keyboard, you will see a picture of that 
key. For example, 

 is the key marked Enter, which is used to confirm actions.  

 is the key marked Menu, which is used to display “menus” and “options”. 

 is the key marked with the letter Y. 

 is the Spacebar - the key without writing on it, at the bottom of the keyboard. 
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Fitting the batteries 
The Series 3c is powered by: 

•  two AA batteries for the main batteries (not supplied) - alkaline batteries are 
recommended, and they should give approximately 80 hours continuous use (2-4 
months typical usage). 

•  a Lithium backup battery (supplied with your Series 3c). This preserves your 
information when you replace the main batteries. 

A mains adapter for the Series 3c is also available. 

 For continued protection against the risk of fire, use ONLY Psion approved mains 
adapters. The following approved models are available from your Psion stockists: 
1602-0001-02 (UK) 
1602-0002-02 (Europe) 
1602-0014-01 (US) 

You can leave the Series 3c connected to the mains for as long as you wish, whether the 
Series 3c is turned on or off. 

Fitting the main batteries 

1. Turn the closed Series 3c over and unclip the main battery cover by pulling gently 
in the direction shown by the arrows on the cover. 

2. Insert the batteries as shown in the diagram below. Make sure you insert them 
the right way round, as shown by the pictures in the battery compartment. 
(Note: one battery has its positive end on a “pushable” contact.) 

 

3. Replace the main battery cover. 

main batteries 

main battery cover 
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Fitting the backup battery 

1. On the underside of the Series 3c, there are two doors which swing open; the 
backup battery fits under the door marked ‘B’ (on the left). Open this door. 

2. The backup battery slides in from left to right. Insert it with the flat side, usually 
marked with a + symbol, facing upwards. 

 

3. Close the door again, and turn the Series 3c over. 

Using rechargeable batteries 

You can use AA-sized rechargeable Nickel Cadmium batteries (sometimes called NiCd 
or Nicad batteries) to power your Series 3c, but some care is required. 
If you use rechargeable batteries: 

•  You are advised to keep two sets of rechargeable batteries; when the pair in the 
Series 3c needs recharging, swap them over. If you have just one pair, you will run 
down the backup battery while you are recharging them. 

•  You should replace them with fresh, non-rechargeable (preferably alkaline) 
batteries, if you are not going to use the Series 3c for a while (for example, if you 
go on holiday for a couple of weeks and don’t take the Series 3c with you). 
Important: If your rechargeable batteries go flat while you are away, your backup 
battery will not preserve your information indefinitely, and you may lose all your 
information. 

 When rechargeable batteries go flat they do so very suddenly; this is difficult for 
the Series 3c to detect and you may get very little (if any) advance warning. The 
backup battery will preserve your information when they do go flat however, so 
you should not lose any information. 

backup battery 

open the door marked ‘B’ 
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Where things are 

 

 

 
 

Keyboard markings 
The yellow markings above certain keys are:  

•  extra characters the key can produce, or  

•  special functions the key can perform. 

To get one of these characters or functions, hold down the  key (the “Psion” key) 
while pressing the other key. See also ‘Using the keyboard’ later in this chapter. 

 The  key is called the Psion key, and it is used in conjunction with other keys 
for extra characters and special functions. 

The Buttonbar 
The touchpad of nine large buttons between the keyboard and the screen is known as 
the “Buttonbar”. You can press a Buttonbar button to move between the main 
“applications” on the Series 3c. 

  
ON/ESC 
key 

 
OFF key 

  
Psion key 

 Diamond key 

 
Spacebar

 
Tab key 

 Menu key   
Help key 

  
Delete key 

  
Enter key 

Arrow keys 

Buttonbar
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Turning on & off 

To switch on, either... 
•  press the key marked  (with ON marked in yellow just above it), in the top 

left of the keyboard. This key is sometimes referred to as the ON/Esc key. 
Although the ON key is also marked in yellow for consistency, you don’t actually 
need to use the  key when turning on the Series 3c. 

or... 
•  press one of the keys on the Buttonbar. Switching on this way allows you to move 

straight to a particular “application”, e.g. Word or Jotter. If you are switching on 
for the first time, use the button labelled “System” to take you to the “System 
screen”. 

 The first time you switch the Series 3c on, you will see a copyright screen 
displayed briefly and then, after a few seconds, the “System screen”. 

To switch off: hold down the key marked  (at the bottom left of the keyboard) 
and at the same time press the  key (with OFF marked in yellow just above it). 

Setting the screen contrast 

If the screen appears too light or too dark, you can adjust the contrast: 

•  Hold down the  key and either the  key (Contrast +) or the  key 
(Contrast -), until you’re happy with the screen contrast. 

If you ever need to clean the screen, use a dry cloth. 

Changing the size of screen text 

You can adjust the size of text on the screen in most applications. To do so: 

•  Use the ‘Zoom in’ option (to increase text size) or ‘Zoom out’ option (to reduce 
text size) on the ‘Special’ menu. 

 Some applications have an option for turning text wrapping on and off. (You 
should turn wrapping on to see the ends of lines of text that are too long to fit the 
size of the screen.) 
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The Tips screen 

The next time you turn the Series 3c on, you will see the “Tips” screen. Tips appear 
when you turn the Series 3c on each day; they give you ideas about some of the things 
you can do on the Series 3c. The Tips screen looks like this: 

 

The three buttons at the bottom of the screen tell you the keys you can press: 

 to continue. This removes the Tips screen and displays the System screen. 

 to view the previous or next tip. 

 to disable tips. If at some point you’ve seen all of the tips, or have decided 
you no longer want to see tips, press . A dialog will appear asking 
for confirmation that you really do want to stop tips appearing. 

Press . The Tip will disappear, and be replaced by the System screen. 

 If you do disable tips, you can always re-enable them later. See ‘Controlling when 
Tips appear’ in ‘The System screen’ chapter later in this manual. 

The System screen 
The System screen is what you see the first time you use the Series 3c. It is the desktop 
or control panel and it displays “icons” (pictures) for all the “applications” (programs) 
on the Series 3c. Each application is used for a particular type of information or task, 
such as word processing or looking after your diary. 

 

•  The small arrow on the right of the System screen indicates that there are more 
icons than can be shown on the screen at one time. Use the  and  keys to see 
the others not currently shown and to move between them. 
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The System screen displays the following application icons: 

 

Agenda - a diary for 
appointments, birthdays and 
lists of things to   

Data for names and addresses, 
phone numbers and other lists 

Time for alarms 

 

Calc for simple and scientific 
calculations 

 

World for a map of the world, 
world times and dialling codes 

 

Word for writing letters and 
other documents 

 

Sheet for tables, spreadsheets 
and graphs 

 

Jotter for quick notes 

 

Spell for checking your 
spelling, finding synonyms 
and even solving crosswords  

Patience card game, for one or 
two players 

 

Files for managing your 
“files”, where your 
information is stored. 

Sound for recording, editing, 
playing back and adding 
effects to digital sound 

 

Program editor for writing 
your own programs in OPL, 
the Series 3c’s built-in 
programming language 

  

•  To return to the System screen at any time, press the  button on the 
Buttonbar. This is known as the System button. 

 Each time you switch on the Series 3c, you won’t necessarily see the System 
screen - the Series 3c always remembers the last thing you were doing when you 
turned it off. If you want to go to the System screen, press the System button. 
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Getting Help 
Whatever you’re doing on your Series 3c, you can always display Help information. 
Each application (and the System screen) has its own set of help topics that you can 
refer to for guidance whenever you need it. 

 

To display help 
•  Press the  key. You will see an index of Help topics. 

•  Use the  keys to scroll through the topics.  

•  When you have spotted an appropriate topic, move the “highlight” onto it and 
press  to view the help on that subject. 
(Note: highlighted text appears in white on black.) 

 The small arrow in the bottom right corner of the Help screen shows that you need 
to use the  to see the rest of the index or information. 

  displays an index of help topics. 

To remove help from the screen 
•  Press  to remove a help topic from the screen. Press  again to remove 

the help index. 

•   leaves Help immediately. 
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Setting the time & date 
There are two things you MUST set before you enter any information: your home city, 
and the current time and date. You have to set these before you can make effective use 
of the Agenda, alarms, world dialling etc. 

Setting your Home city 

You should first set your ‘Home city’. The Home city affects the current time displayed 
by the Series 3c clock, because the Series 3c is aware of time zones around the world. 

1. Press the Time button (marked  ) on the “Buttonbar” to move to the Time 
application. 

2. Press the  key (on the lower row of keys). This displays the menus of options 
for the things that you can do in the Time application. 

3. Press the  key until the highlight is over the ‘Home city’ “option” on the 
‘Settings’ menu. 

4. Press . The ‘Set home city’ “dialog” will appear. 

 

5. If the ‘City’ line is not already set to your home city, first make sure that the 
‘Country’ line is set to your home country: use the  key to move the cursor to 
the ‘Country’ line, then use the  keys, or type the first few letters of the 
country’s name, until you find your home country. Then use the  key to move 
to the ‘Home city’ line and set it to the correct city in the same way. 

 If the Series 3c beeps, then it doesn’t know about this city. Press , then select 
the name of a nearby large town or city. (When you are used to using the Series 3c, 
you can add your own town or city in the World application and then set it as your 
‘Home city’.) 

6. Press . The ‘Set home city’ dialog will disappear from the screen and your 
Home city setting will be saved. 
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Setting the time & date 

1. Press the  key.  

2. This time use  to move the highlight over the ‘Time and date’ option on the 
‘Settings’ menu and press . You’ll see the ‘Set time and date’ dialog. 

3. Type the current time on the ‘Time’ line.  
To move between the numbers: press . 
If you make a mistake: you can press the  key to delete from the cursor 
backwards. 

 The Series 3c initially uses a 12-hour clock, so midnight is 12:00:00 am. 

4. Press  to move the highlight to the ‘Date’ line. Then type the current date on 
the ‘Date’ line. 

5. When you have finished, press  to save the time and date. 

For information about setting the Series 3c to use a 24-hour clock and to take account 
of summer times, see the ‘Time’ chapter. 

Displaying a Status window 
You can display a “Status window” in the System screen and most applications, which 
shows information such as the current time and date, and the name of the file or 
application. 

 

To turn the Status window on: 

•  Press . 

To shrink it to half its size (to show more information in the main screen): 

•  Press  again. 

 It is always a good idea to display a Status window in the System screen, as it can 
tell you very useful information about your Series 3c, and always shows you the 
current time and date.  
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Understanding the Status window 
The Status window always shows: 
•  the current time and date. 

•  the name of the current application or file. 

•  the names of the different views available on pressing the  key. 
The Status window may also show: 

 a “Caps Lock” indicator, if the “Caps Lock” key is on. 

 a “Low battery” indicator, when the batteries are getting low.  

 an SSD indicator, if there is a “Solid State Disk” (where additional 
applications or files can be stored) in drive A or B. 

 a “Link” indicator, if you are using a PC Link cable. 

 The Status window setting is remembered separately in each application. For 
example, you can use a large Status window in the System screen and Data, a 
smaller one in Agenda, and even switch it off altogether in other applications. 

 You can’t turn on a Status window within the World and Time applications (they 
show you the current time and date anyway).  
In other applications, when most of the screen is needed to display information, 
you may occasionally be able to turn on only a half-sized Status window. 

To turn the Status window off: 

•  Press  once more. 

To display a Status window temporarily, e.g. to check the time: 

•  Press . 

 You can control what type of clock appears in the System screen (i.e. an analog or 
digital). Select the ‘Status window’ option on the ‘Control’ menu and set the 
‘Clock type’ line to ‘Analog’ (for a clock with hands) or ‘Digital’.. 

 You can also use the ‘Status window’ option to change which indicators appear in 
the Status window, although it is not usually necessary to change these. It is best 
to leave the other lines in this dialog set to ‘Yes’. 
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Moving to applications 

 

Before you can add or find information in an application, you need to move to that 
application.To do so: 

•  press the button for the application on the Buttonbar, or 

•  press the System button to move to the System screen, then use the  or  key 
to move the “highlight” to the word below its icon. Press  (on the right-hand 
side of the keyboard). 

•  You can move straight from one application to another, simply by pressing its icon 
on the Buttonbar. For example, you might press the Word button to move to the 
Word processor, type some text, then decide you want to use the Calculator. Just 
press the Calc button on the Buttonbar to move straight to it, and when you have 
finished, press the Word button again, to return to your original document. 

 When an application name is shown in bold on the System screen, it is “open”. 
When an application is not “open”, pressing its button on the Buttonbar moves the 
highlight to the word below the icon. You then need to press  to open the 
application. 

•  If your Series 3c is switched off, you can press an application’s button on the 
Buttonbar to switch on and move straight to that application, if it is “open”. 
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How the applications work 

Menus & options 

Each application has its own set of “menus” and menu “options” which you use to carry 
out the actions you want.  

Displaying the menus of options 
•  Press . You will see the options on the first menu in the application, and the 

names of all the other menus on the “Menubar” at the top of the screen. 

 

•  Use the  keys to display the options on menus not currently shown. 

Selecting a menu option 
•  Use the  keys to move the highlight over the option and then press 

.  

•  Or, press the “hot-key” for the menu option; it is shown beside the option name on 
the menu. For example, for the ‘Time and date’ option (shown above), hold down 

 and at the same time press . 

•  Alternatively, you can display the menus and then press a hot-key letter without 
holding down the  key. The highlight will jump straight to the menu option 
that goes with the key. 

 Menu options with “...” at the end of the name, e.g. the ‘Style housekeeping...’ 
menu option in the Word application, display a further menu of options when you 
select them. 
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Dialogs 

If the menu option needs more information before the action can be carried out, a 
“dialog” will appear. Some lines in a dialog require you to type in the information, 
others offer you a list of alternatives to choose from.  

Entering information in dialogs 
•  Use the  keys to move between dialog lines; a cursor (highlight) shows your 

current position. 

 

•  On some dialog lines you type text or numbers. 

•  On dialog lines with “...” at the end, press  to display a further dialog where 
you enter information. 

•  In dialogs with buttons (like the Tips screen), the letters on the buttons tell you the 
keys that you need to press for certain actions. 

Using dialog lines with arrowheads 
•  When a dialog line has small arrowheads around the setting, use  to select a 

setting from a list of alternatives. 

•  Or, press  to list all the items and select one from the list (by using  or 
to move the highlight over the item you want and pressing ). 

 

•  Or, type the first letter of the item you want and press  until you find your 
choice. 

When you’ve finished entering information in a dialog: 

•  press  to save it, or 

•  press  to remove the dialog without your changes taking effect. 
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Entering dates in dialogs 
In a dialog, you can either type in the date in the usual way, or 

•  press  to display a one month calendar.  

 

Then press  to select the current date (indicated by a flashing cursor), or move to 
the date you want using the  keys and press . 

•   or  twice to display a three month calendar. 

•   or  three times to display a 12 month calendar. 

•   removes the calendar without selecting a date. 

Entering numbers in dialogs 
You can type numbers directly into dialog lines, or use: 

•   and  to increase or decrease the current number. 

•   or  to increase or decrease the number by 10 at a time. 

 These keypresses also work when typing each part of a date or time. 

Unavailable dialog lines 
•  Dialog lines usually begin with a small square bullet. 

•  Dialog lines without bullets are unavailable; if you try to set or change such a line 
a message will remind you that it is unavailable.  

 

A dialog line is usually unavailable because of the setting on another line in the dialog. 
For example, select ‘Sound’ on the ‘Control’ menu in the System screen. If you set the 
‘All sound’ line to ‘Off’, the bullets will disappear from the start of the other dialog 
lines and you cannot change their settings.  
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Entering & saving information 

Unlike many computers, you don’t need to use a separate “save” option on the 
Series 3c.  
With most applications, your information is automatically saved when you move from 
one application to another, exit an application, or switch the Series 3c off.  

Files and filenames 
•  Each separate collection of information, for example a Word processor document 

or a Spreadsheet, is saved in a different “file”, each of which has a “filename” to 
identify it.  

•  Initially, there is one separate file for each application; you will probably create 
quite a few Word or Sheet files later, and you may also have more than one Data or 
Agenda file. 

•  Εach application creates a file whose name is the same as its application name, for 
example, the Agenda application creates a file called ‘Agenda’. When you are 
more confident using the Series 3c, you can rename this file if you wish. Each time 
you create a new file, you will be prompted to enter a new name for that file. 

•  You can see the names of all your files beneath their respective icons on the 
System screen. These lists are known as “file lists”.  

See the ‘System screen’ chapter for more information about files.  

Cancelling 

You can remove menus and dialogs - or stop anything else you have started to do - by 
pressing the  (Escape) key. 

Setting your “preferences” 

Your Series 3c is very adaptable: you can set “preferences” to change the way each 
application looks and works to suit the way you want to use it. For example,  

•  in the Agenda, the Series 3c’s diary, you can change the number of time slots 
shown on the page for each day. 

•  using Data, you can keep separate databases of customers, suppliers and business 
contacts, as well as private phone numbers. 

•  in Word, you can set up templates for documents you create regularly 
Most of the changes that you can make to an application can be done using the ‘Set 
preferences’ option on its ‘Special’ menu.  
Some chapters in this manual contain an ‘Example setups’ section, where you will find 
more suggestions of ways to customise the Series 3c. 
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Starting to enter information 
This section covers the first things you are likely to want to do with your Series 3c, such 
as transferring your diary entries to the Agenda application; adding the contents of your 
address book to the Data application; and setting an alarm to wake you in the morning. 

Entering appointments, reminders and things to do 

Press the Agenda button on the Buttonbar to move to the Agenda, then add your 
appointments, etc. from your old diary. 

 

Adding entries to the Agenda: to move between dates and time slots: use the 
 keys. 

To add an appointment: move to the right day and time, then type in the text. When 
you’ve finished, press . Fill in the appropriate details in the dialog that appears, 
and press  again to confirm. 

See the ‘Agenda’ chapter later for more information. 

Entering names & addresses 

Press the Data button on the Buttonbar to move to Data, then add your names and 
addresses from your old address book.  

 

Adding entries to Data: Type the name and address on the appropriate lines. 

To move to the next labelled line: press . 
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To add another line next to a label: press  and  at the same time. 

To save the name and address: press . You can then add the next entry. 

See the ‘Data’ chapter later for more information. 

 If you have a personal computer and a copy of PsiWin, you might prefer to use 
PsiData (the PC version of the Data application) supplied with PsiWin to enter all 
your names & addresses in a file on the PC, then transfer that file to the Series 3c. 
Contact your Psion distributor for more information about PsiWin. 

Setting a morning alarm 

Press the Time button on the Buttonbar to move to the Time application, press  
and then enter the time for the alarm in the dialog that appears. 
See the ‘Time’ chapter later for more information. 

Entering notes 

Press the Jotter button on the Buttonbar to move to the Jotter application, then simply 
write your notes in the “Notebook”: 

 

Jotter is very useful if you need to note something down quickly, as you can simply 
press a single keypress and start typing your information. You can leave your notes in 
Jotter, or move them to another application. See the ‘Jotter’ chapter for more details. 

Entering other information 

Just press the button for the appropriate application on the Buttonbar to move to it, then 
enter your information. For more details, turn to the chapter for the application you’ve 
chosen to use. 
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How is my information stored? 
Your information is initially stored on the “Internal disk” of the Series 3c. Later you 
may store some of your information on “Solid State disks” (SSDs), or even transfer it to 
another computer.  

The Internal disk 
•  Your information is stored as files on the Internal disk. This is the built-in memory 

inside the Series 3c. 

•  When you delete information, the space which it occupied on the Internal disk can 
be re-used. 

•  The Internal disk is a part of the overall internal memory of the Series 3c. Other 
things need to use internal memory too - for example, each application needs some 
in order to get started. 

You should refer to the ‘System screen’ chapter for more detailed information on the 
Internal disk. 

Solid State disks 
•  You can also use SSDs to store any of the information normally kept on the 

Internal disk. You can use them to give you more room for storing information, or 
to backup your important files. 

•  SSDs are plugged into the “SSD drives”, located on either side of the Series 3c, 
behind the doors marked A and B. 

Solid State disks are covered in detail in the ‘System screen’ chapter; making backups is 
covered in the ‘Security & backups’ chapter. 

How safe is my information? 
•  When you select a ‘Delete’ menu option or hot-key, or press the  key, the 

Series 3c usually asks you to confirm that you really want to delete the 
information, before going any further. 
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•  In some circumstances (such as when deleting text in the Word processing 
application) it doesn’t ask for confirmation. The deleted information will be stored 
on a “clipboard” and there will be an ‘Insert’ option to put it back again.  
(Note: The clipboard only holds the last thing you deleted.)  

•  You should make “backup” copies of your information. If you lose your 
Series 3c, or if you need to recover any information you have lost, you can use 
your backups to restore your information. See the ‘Security & backups’ chapter for 
more details. 

•  You can set a “system password” to stop others using your Series 3c. You can also 
“password-protect” individual Word and Sheet files, and memos attached to 
Agenda entries. See the ‘Security & backups’ chapter for more details. 

•  You can enter “owner information” to identify the Series 3c as your own. It can 
then be returned if you lose it. See the ‘Security & backups’ chapter for more 
details. 

Care of the Series 3c 
When used in accordance with the instructions in this manual, you should find the 
Series 3c reliable and hard-wearing. Please take careful note of the following list of dos 
and don’ts:  
DO: 
•  keep the Series 3c at a room temperature of 0°C to +50°C (+32° to +122°) and 

avoid sudden extremes in temperature, exposure to direct sunlight, heat sources 
(e.g. electric heaters) and rain. 

•  switch the Series 3c off and use a soft, clean, dry cloth to gently wipe the keyboard 
and screen, should you ever need to clean it. Under no circumstances use water, 
or chemical solvents that may have a corrosive effect. 

•  store the Series 3c in a place that is free from damp, dust, or extremes of heat and 
cold when you are not using it. Note: If you normally use rechargeable batteries, it 
is wise to replace them with ordinary alkaline batteries if you are not using it for a 
while; see ‘Fitting the batteries’ earlier in this chapter for more information about 
rechargeable batteries. 

DO NOT: 
•  drop the Series 3c, bend it, or press the keys with extreme force. 

•  immerse the Series 3c in water, or any other liquid, or spill liquids onto it. 

•  use pens or other objects to operate the Series 3c. Use only your fingers. 

•  carry it in your back pocket where it is in danger of being sat upon. 
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Battery safety 

•  Do not dispose of batteries in a fire - there is a danger of explosion. 

•  Always observe the polarity of the cells and insert them correctly. 

•  Do not crush, puncture, open, dismantle or otherwise mechanically interfere with 
the batteries. 

•  Do not store batteries at temperatures in excess of +60°C; the optimum storage 
temperature for maximum battery life is +10° to +35°. 

•  If a battery has been accidentally swallowed, it is ESSENTIAL that medical advice 
is sought IMMEDIATELY. If the small backup battery has been swallowed, advise 
the medical person that a LITHIUM battery is involved. 

•  If a battery is found to be leaking, do not allow the residue to touch either your 
skin or your eyes. If it does, wash immediately with plenty of water and seek 
medical advice. 

Using the keyboard 
The keypresses and features listed below are all useful ways to navigate around the 
Series 3c. You will gradually learn the keypresses that are most useful to you, and 
you’ll find they provide helpful shortcuts when editing text and moving around in 
applications. Don’t try to learn this section yet! You can refer back to it when you get 
used to using your Series 3c. 

Summary of action keys 
 Displays the menus of options in an application. Actually, 

the  key itself cycles through the menus, one by one. 
You can also press  and then  for the leftmost 
menu,  for the next one, and so on. 

 Moves the highlight or cursor around. 

 Confirms an action, e.g. selects a menu option that you have 
highlighted, or saves changes you have made in a dialog. 

 Moves between the “views” in an application.  

 Cancels an action, e.g. removes a dialog without saving any 
changes you made to its contents. 

 Deletes characters to the left of the cursor; to delete to the 
right of the cursor, press . 

 Displays Help. 

 Displays the Infrared transfer screen. 
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Movement & text editing keys 
 To get uppercase (capital) letters - A instead of a - hold 

down the  key and press the letter key. Similarly, to get 
the symbols above the numbers on the number keys, press 

 and the number key. 

 Moves the cursor around the text. 

 Starts a new paragraph. 

 Starts a new line without starting a new paragraph. 

 Deletes characters to the left of the cursor. 

 Deletes to the right of the cursor. 

 Selects text. Hold down  and press an arrow key to 
highlight (select) text. You can then press other keys, e.g. 

 to delete the text, or select a menu option for an 
action, e.g. the ‘Copy text’ option to copy the text. 

 Highlights whole lines of text. 

 Press it at the same time as one of the arrow keys to increase 
the amount you move, e.g. from a single character to a word. 

 Press it at the same time as one of the arrow keys to increase 
the amount you move, e.g. from a single character to a line. 

 Turns Caps Lock on (press  again to turn it off).  

 ‘Home’ and ‘End’. Moves the cursor to the start and end of 
the line respectively. 

 ‘Pg Up’ and ‘Pg Dn’. Moves the cursor up and down a 
screenful at a time.  

 Deletes to the beginning of the line. 

 Deletes to the end of the line. 

 Highlights the current word. 

 Highlights the current paragraph. 
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Changing the batteries 
The life of your batteries will depend on the way you use your Series 3c. If you play 
sounds frequently, use the Link cable a lot, or often write information to Flash SSDs, 
you will find the battery life is reduced. 

When to change the main batteries 

The Series 3c will warn you when the main batteries need changing, by displaying a low 
battery symbol (an empty-looking battery) in the Status window. 

 Do not be alarmed by this symbol! It appears when you have used approximately 
80% of the batteries’ power. The Series 3c will continue to work for some time, 
unless you try to do something which requires lots of battery power. 

When the battery power is approaching the absolute minimum, the low battery symbol 
will start to flash, and you will see this message whenever you turn the Series 3c on: 
Replace main batteries

If you don't replace the main batteries, they will eventually run down completely. When 
this happens, you will not be able to switch the Series 3c on. Your information will still 
be safe though, as long as the backup battery has not run down completely. 

When to change rechargeable batteries 
•  Have two sets of batteries, one pair in the Series 3c and the other pair freshly 

charged. (Then you can swap them over straight away, without running down the 
backup battery.) 

•  Rechargeable batteries may cause the low battery symbol to appear after a 
comparatively short space of time (they have a lower voltage than alkaline batteries 
to start with). 

•  Rechargeable batteries fade very rapidly, which means the warning messages will 
only be shown a few times before the batteries fail completely. 

 Use the ‘Usage monitor’ (see ‘Understanding battery levels and power usage’ later 
in this chapter), and compare the estimated ‘Total battery used’ setting with that of 
your previous set of rechargeables - this will give you advance warning of when 
your batteries are likely to fail. 

When to change the backup battery 

•  The backup battery should not need replacing very frequently. It should last for 
about a year, as long as you only remove the main batteries for short periods of 
time when you change them. 
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•  When the backup battery becomes low, or if it is fitted incorrectly, you will see a 
message like this: 

Replace backup battery

•  You should change the backup battery within a week or two of it becoming low. 

Changing the batteries 

Changing the main batteries 
1. Press  to turn off the Series 3c. 

2. Clip off the main battery cover, remove the old batteries and replace them with the 
new ones. 

You don’t have to rush when changing the main batteries - the backup battery alone can 
preserve your information for many hours (providing you have not seen the Replace
backup battery message). 

 If you see the Replace main batteries message after you have just 
inserted new batteries, don’t worry, it will soon go away. 

Changing the backup battery 
Have your replacement battery ready before you start. 

1. Press  to turn off the Series 3c. 

2. Turn the Series 3c over, open the door marked B. Lever out the old battery, with a 
fingernail or a blunt non-metallic instrument, and insert the new one. 

 Make sure that the flat side of the backup battery, usually marked with a + symbol, 
faces upwards. 

You don’t have to rush when changing the backup battery - the main batteries are 
preserving your information. 

Changing both sets of batteries 

 Never remove the main batteries and the backup battery at the same time. If 
you do, you will lose all of your information. 

•  If both the main batteries and the backup battery are low, replace the backup 
battery first. 

•  If the main batteries are so low that you cannot turn on the Series 3c, connect the 
Series 3c to mains power with a mains adaptor before changing the backup 
battery.  
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Understanding battery levels and power usage 

Low battery warning 
The System screen’s Status window (press  to display this if it’s not 
already shown) shows a flashing battery symbol if your batteries are getting low. 

Checking the battery status 
•  You can check the condition of your batteries at any time by selecting ‘Battery 

info’ on the ‘Info’ menu in the System screen. 

 

•  When the low battery symbol appears, the ‘Battery info’ dialog will have changed 
from ‘Good’ to ‘Low’ for the main batteries. 

•  When the battery power is approaching the absolute minimum, the ‘Battery info’ 
dialog will show ‘Replace!’ for the main batteries. 

•  Similarly, when the backup battery needs replacing, its ‘Battery info’ will at first 
waver between ‘Good’ and ‘Replace!’ (as its voltage can change under load), 
eventually though it will read just ‘Replace!’. 

 When you are using alkaline batteries under high load (e.g. playing sounds, or 
writing to Flash SSDs), they may lose voltage, but recover voltage when the load is 
reduced. The battery levels shown in the ‘Battery info’ dialog take this into 
account. When the batteries really are ‘Low’, the setting is locked (even if the 
batteries were to recover voltage slightly). The same is true for the ‘Replace!’ 
reading. 

•  The Series 3c will turn off when the battery voltage becomes to low to power it. 

 Alarms will not go off until you have replaced the batteries (or inserted a mains 
lead) and turned the Series 3c back on. 

•  You may also see error messages, e.g. Batteries too low for digital
audio or Batteries too low to write to Flash. 
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Checking power usage 
Select ‘Usage monitor’ on the ‘Info’ menu in the System screen. The usage monitor 
gives information on your pattern of battery use, including: 

 

•  the time the Series 3c has been used on battery power; 

•  the estimated total amount of battery power used (in milliAmp hours); 

•  the average battery current (in milliAmps). 

If you press  in this dialog, you can see the final readings for your previous set of 
batteries. 

 The Series 3c can only estimate (not measure) the amount of power it is using for 
different activities. 
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Agenda 

The Agenda is the Series 3c’s diary application. You can use it to 
record all your appointments, birthdays and anniversaries, and 
lists of things to do.  

The Agenda is very flexible; you can customise it to look and work 
in the way that best suits you, whether you like to use your diary as 
a notebook, or powerful personal organiser. You can: 

••••  write an entry just like in a paper diary, or give it a duration so 
that the Agenda can show your free and busy time. 

••••  set individual entries to repeat, e.g. for a weekly meeting. 

••••  keep track of lists of things to do, and even remember when 
you completed each task. 

••••  set alarms for entries to remind you of things to do. 

••••  attach notes or documents to entries. 
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Introduction 
The Agenda is designed to be flexible. If you want to, you can use it like a paper diary 
and just enter notes. Alternatively, you can set your entries with times and alarms and 
use it as a sophisticated time manager. You can even use it as a “what I did today” 
diary, if you wish, using lists of things to-do and attaching notes to entries. 
When you first move to the Agenda you will see the Day view: 
 
 

 

 If you have not yet set the correct time and date in your Series 3c, ‘today’ will not 
be set to the correct day in the Agenda. See ‘Setting the time & date’ in the 
‘Getting started’ chapter for instructions. 

The Day view is one of the Agenda views. You can also use other views, for example, 
the Week view which displays a week at a time. Press  to step though the various 
views and see ‘Viewing entries’ later for more information. 

•  A bullet or highlight marks the current position. You can move it anywhere on the 
page - and onto the other pages in the Agenda.  

Moving between days and dates 
You can use: 

 to move between dates and times. 

 (the Spacebar) to move to today. 

‘Jump to date’  on the ‘Search’ menu to jump to any date. 

 to display a calendar for the current month. Press  again for a three 
month calendar, and once more for a whole year. See ‘Using the 
Agenda’s calendars’ later for more details. 

 to move to the same time slot on the previous/next day. 

 to move to the same day in the previous/next week. 

This bullet marks the 
current position 
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Inserting an appointment in the Day view 
1. Move to the day on which the appointment is taking place. 
2. Move the cursor to the correct time slot. 
3. Type in the text, e.g. Meeting with Fred. You don’t need to enter the time in 

the text. 

4. Press . You will see the ‘Day entry details’ dialog: 

 

 Use the dialog lines to give the appointment a time or duration, if required. You 
can: 

•  display the entry with a time by setting ‘Timed entry’ to ‘Yes’. You can also 
display the duration of the entry by setting the ‘Duration’ or ‘End time’ lines: 

 

•  display the entry at the cursor position by setting ‘Timed entry’ to ‘No’. This is 
known as an ‘Untimed entry’. 

 

5. Press  to save your entry. 

 You cannot enter timed appointments that span more than one day. If you want an 
entry to go across midnight, enter it as more than one entry, or as a “repeating” 
entry (described later). 
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Inserting more appointments 

You can add as many appointments as you like in the same way - you can just type 
‘over’ the position of an existing entry if you need to put another entry in the same time 
slot: 

 

In the Day view: 

•  the duration of a “timed entry” is marked in grey in the Day view. 

•  a black “overlap bar” is displayed if the appointment takes place at the same time 
as another appointment. 

 If you have entered appointments as “timed entries” you can use the Busy view to 
keep track of your busy and free times, and manage any overlaps. See ‘Displaying 
your busy/free time’ later for details. 

 When you first run the Agenda, you will find that entries are initially suggested as 
timed, and you can change them to untimed by setting the ‘Timed entry’ line. 
However, if you find that most of your entries are untimed entries, you can change 
the way the Agenda works so that entries are initially suggested as untimed. Select 
‘Set preferences’ from the ‘Special’ menu, then ‘Day entry defaults’ from the 
‘Entry preferences’ menu. Set ‘Day entries timed by default’ to ‘Yes’ or ‘No’ as 
you wish.  

 This doesn’t stop you changing an entry from untimed to timed by changing the 
‘Timed entry’ line to ‘No’ or ‘Yes’ for each entry - it simply means that your usual 
preference for this line is already set. 
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Viewing entries by Day, Week, Year etc.  
On the right side of the Agenda screen you will see a Status window, which contains the 
“diamond list”. This lists the Agenda views that you can use to display your 
appointments and entries. A ♦  symbol is displayed next to the current view (‘Day’). 

Press  to move between all the views; if you keep pressing  you will return to the 
Day view. 

The Week view 

 

Shows a week’s appointments at a time. 

The List view 

 

Displays all your Agenda entries in a list. 
The Anniversary view 

 

Shows all the anniversaries and birthdays, 
month by month. 

The To-do view 

 

Shows your ‘things to do’ lists. 

The Busy view 

 

Shows all the timed appointments in your 
Agenda as blocks of busy time, so that you 
can see when you are free. 

The Year view 

 

Is a “year planner”, showing codes for 
selected entries over a whole year’s range. 

You can also hold down  and press a hot-key to move straight to a view. 
For example,  goes straight back to the Day view. 
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Using the Agenda’s calendar 

You may find an on-screen calendar a convenient means of looking at dates and moving 
around your Agenda. In any view, you can press  to display one: 

 

In the calendar, you can press: 

 to move the cursor about. 

  to move straight to the date highlighted in the calendar in the original 
Agenda view. 

 to remove the calendar, without changing date in the Agenda. 

Viewing a 3 month and year calendar 
When a calendar is displayed, press  again to ‘extend’ the calendar to show three 
months. At other times, you can display the three month calendar by pressing  
twice, or . 

Similarly, when a 3 month calendar is displayed, pressing  again will ‘extend’ it to 
shown a whole year. At other times, you can display a one year calendar by pressing  

 three times, or . 

You can also display a calendar in this way when entering a date in a dialog − for 
example, in the ‘Jump to date’ option, or by using the ‘Calendar’ option on the ‘Search’ 
menu. 
You can use the keys listed earlier to move around in the 3 month and one year 
calendars. You can also press: 

 to move a day at a time. 

 to move a week at a time. 



 35

Moving to “today” and other days 

There are many keypresses you can use to help you move around your Agenda quickly.  
In any view, you can press: 

 to move to today in the Day view - whichever view you’re in. 

 to move to today in the current view. Pressing it again returns to the 
day you were on. 

 to switch between the current and last view. 

You can also press  with the first letter of a day’s name to go straight to the next 
occurrence of that day. Press again if two days share the same first letter. Pressing 

 with the first letter of a day’s name goes to the previous occurrence. 

Birthday and anniversaries 
You could add a birthday or anniversary in the same way as an appointment, but it 
would not repeat each year. Instead: 

•  enter birthdays and anniversaries from the Anniversary view. They will 
automatically appear on the right day every year in the other Agenda views. 

 As well as birthdays and anniversaries, you can set any other entries to repeat 
daily, weekly, monthly or yearly, and as many times as you want. For example, a 
meeting on the first Tuesday of each month, or a reminder to pay rent on the first 
day of every month. See ‘Repeating entries’ later. 

To add a birthday or anniversary 

Press  to move to the Anniversary view, or select ‘Anniversary view’ from the ‘♦ ’ 
menu. Then: 
1. Move to the correct month. 
2. Type the text for the birthday, e.g. Catherine’s birthday. 

3. Press . The ‘Anniversary details’ dialog will appear: 
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If you give the entry a “start year”, the Agenda can show you how old the person is and 
when they were born: 

•  If you don’t want to display anything about an anniversary’s start year, you can set 
the ‘Specify start year’ line to ‘No’. 

•  If you want to do this, set ‘Specify start year’ to ‘Yes’ and give the anniversary a 
‘Start year’ (i.e. the year the person was born). Set ‘Display year as’ to display the 
‘Number of years’ or ‘Start year’ (or both) with the anniversary entry.  

 Although the Agenda only shows anniversaries from 1980 onwards, you can set an 
anniversary’s start date to be before this. You can even enter BC dates, by setting 
the start year with a minus sign. 

4. Press  to save your Anniversary entry. 

You can set up anniversaries for special days, or public holidays which repeat on 
the same day each year, e.g. Christmas Day or New Year’s Eve. Simply enter them 
in the same way as any other anniversary and they will appear in your Agenda each 
year.  

Press  until the Day view is displayed. You will see the anniversary entry has a 
candle symbol in front of it, (to indicate that it’s an Anniversary entry), and a >> 
symbol after it (to indicate that it repeats every year).  

Press  again to move to the Year view. The cursor is placed on the date of the 
anniversary, and the entry code A will be displayed for your anniversary. The text of the 
entry will be shown on the top line of the screen. See ‘Grouping entries together’ later 
for more about entry codes. 

 You can enter anniversaries from within the Day, Week, Year and List views, with 
the ‘New entry’ option on the ‘Edit’ menu. 

You can look at all of your birthdays and anniversaries in the Anniversary view: 

 

 You can choose how many months are shown on screen at once. Select ‘Set 
preferences’ and then ‘Anniversary view’ from the ‘View preferences’ menu. 
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In the Anniversary view, you can press: 

 to move to the next/previous entry (or month) 

 to move to the next/previous month. 

 to move to the first/last entry in the current month. 

 to move by a screenful at a time. 

 to move by three months at a time. 

 to move by a year at a time. 

 to move to the same month five years before or ahead. 

 to display the current month in the current year, and move to the 
first entry which is on or after today’s date. 

Adding anniversaries which repeat on a certain day 
By default, the entries you put in the Anniversary view will repeat each year on that 
date, just like a birthday. You can also set up an entry which repeats on a certain day 
each year, rather than a certain date, for example, the first Monday in January, or the 
last Friday in August. To do this: 
1. Type the anniversary entry as usual, and make sure it is set to occur on the correct 

day for the year you enter. 
2. Highlight the entry, and select ‘Repeat entry’ from the ‘Entry’ menu. 
3. Set ‘Type’ to ‘Yearly by day of week’. 

4. Press  on the bottom line of the dialog, and set the day for the repeat. 

You can also set the ‘Type’ line to ‘No repeat’, should you so wish. This allows you to 
make a non-repeating anniversary entry appear in the Anniversary view. 

How anniversaries appear in other views 
When you first use your Agenda, you will find that your anniversaries and birthdays 
appear in the Day view at 06:00, so they usually appear before your other timed entries 
in the List view and Week views. 

•  If you don’t want birthdays and anniversaries to appear in other views, use the 
Day view (or the Week view or List view) options of ‘Set preferences’, and set the 
‘Allowed types’ to exclude anniversaries. 

•  If you want your anniversary entries to appear in a different time slot, select ‘Set 
preferences’ on the ‘Special’ menu, then the ‘Anniversary defaults’ option. Set the 
‘Default position for anniversaries’ line to your preferred time slot. 

•  To change the position of any individual anniversary in the Day view: press 
 to delete it, then move the cursor to the desired position and use the 

‘Insert entry’ option. 

•  Anniversary entries are set up so that the entry code ‘A’ identifies them in the Year 
view. See ‘Grouping entries together’ later for more about entry codes. 
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Lists and things to do 
You can use the To-do view to enter things to do and other lists, for example: 

•  your tasks for work. 

•  personal reminders, e.g. ‘Pay gas bill’, ‘Buy birthday card’. You can set a “due 
date” for a to-do entry, if you want the Agenda to display a warning, which can be 
as far in advance as you choose. 

•  shopping to buy. 

•  ideas for Christmas or birthday presents. 

 You might use dated to-dos to complement anniversary entries − for example, you 
might enter ‘Buy card for Joe’ as a dated to-do, with Joe’s birthday as its due date, 
and a warning date of two or three days. 

You can keep a record of the to-dos that you’ve completed (and when) by crossing them 
out on the list, rather than deleting them when you’ve finished. See ‘Crossing out an 
entry’ later for more details. 

To enter a to-do  

Press  until the To-do view is displayed, or select ‘To-do view’ from the ‘♦ ’ menu 
to move straight there. It initially looks like this: 

 

The To-do view initially has just one list, called ‘To-do list’. The name is displayed at 
the top of the screen. The cursor is a bullet in the list. 

1. Type the text for the item, and press . The ‘To-do details’ dialog will be 
displayed: 
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2. Each to-do item has a ‘Priority’ which controls where it appears in the to-do list 
and whether or not it is displayed in other Agenda views. If you want this to-do 
item to appear in the Day, Week and List views too, leave the ‘Priority’ line set to 
‘1’; if you don’t, set it to a different ‘Priority’. 

 You can set up your Agenda to control which priority entries are displayed in the 
other Agenda views. See ‘To-do entries in other views’ later for details. 

3. Many to-dos do not need to have dates, e.g. for a shopping list item, just leave the 
‘Dated’ line set to ‘No’, and just press . 

  You can enter to-dos from within the Day, Week, Year and List views, with the 
‘New entry’ option on the ‘Edit’ menu - you do not need to be in the To-do view. 

To-dos with due dates and warnings 
You can enter a to-do so that: 

•  A ‘Due date’ is set to when you need to start, or complete the task, which can 
appear in your Day or Week view to remind you. 

•  You are reminded the day before a to-do is due, on the day it is due, and on the day 
after. 

•  An additional warning date (or “start date” or “valid date” − however you think of 
it) can be displayed beforehand, as an actual date or as a number of days to go. 

This type of entry is called a “dated to-do”.  
To enter a dated to-do: 

1. Type in a new to-do entry or move to an existing entry and press , i.e. to 
display the ‘To-do details’ dialog. 

2. Set the ‘Dated’ line to ‘Yes’ and set the ‘Due date’ line as required.  
 If you leave the other settings in the dialog as they are, you will be reminded of the 

due date in the To-do view, and the to-do entry will appear in the other views on 
the due date, as well as the day before and the day after the due date. 

You can also set up an additional warning which will be displayed in other views: 

3. Press  on the ‘Date details’ line to display the ‘To-do date details’ dialog: 

4. Set the ‘Warning from’ line as appropriate, or enter a number of days on the ‘Days 
warning’ line. 

5. You can change the ‘Show due date as’ line to change the way warnings will 
appear - if you want it: 

•  to appear in words, e.g. “Tomorrow”, “next Mon”: use ‘Auto’. 

•  to appear as the number of days to go: use ‘Days’. 

•  to appear as the date due: use ‘Date’. 

•  to appear just as the to-do text (i.e. without mentioning the due date): use 
‘None’. 

6. Press . 
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Creating a new to-do list 

You can create up to 99 to-do lists in your Agenda. 
To create a new list: 
1. Select the ‘New to-do list’ option on the ‘To-do lists’ menu. 

2. Type the name for the new list, e.g. Shopping, and press . 

The top line of the To-do view will now display an arrowhead in the top corner to 
indicate that there is another list. 

Managing to-do lists 

You can use: 

•   and Pg Up and Pg Dn ( and ) to move between the 
entries in a list. 

•   to move from list to list.  

•   to move to the list that is furthest to the left/right. 

•  ‘Jump to list’ on the ‘Search’ menu to move straight to a particular to-do list.  
To change the order of your to-do lists: use the ‘To-do list settings’ option, and set 
‘Position among to-do lists’ for each list you want to move. The first/leftmost to-do list 
has position 1, as to-do lists are numbered from right to left. 
The ‘To-do lists’ menu has options for renaming and deleting to-do lists. For example, 
you might wish to rename or delete the initial list in the Agenda (called “To-do list”). 

Showing more than one list at once 
1. Select the ‘Set preferences’ option on the ‘Special’ menu. 
2. Select the ‘To-do view’ option on the ‘View preferences’ menu. 
3. Type the number of To-do lists to display at once. You can display up to four (if 

you have created four lists). Press .  
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How to-do lists look and work 
You can change the settings for each to-do list independently. Note that many related 
settings are available from the ‘To-do list settings’ option, including the default position 
in the Day view for entries from each list. 
Set the top line of the ‘To-do list settings’ dialog to the to-do list you want to change. 
(Having made changes, you can then change the top line to a different to-do list, and 
change the settings for this list.) 
In each list you can choose: 

•  a simple numbering system: set the ‘Bullet entries with’ line to ‘Numbers’. This 
is helpful if you need to know how many entries there are in a list. 

•  to control the order of the entries yourself: set the ‘Sort order’ line to ‘Manual’. 
The entries appear in the order you enter them, or you can move them using the 
‘Position to-do entry’ option on the ‘To-do lists’ menu, or by deleting the entry, 
moving to the desired position on the list, and using the ‘Insert entry’ option. 

•  to order the entries by priority: set the ‘Sort order (in To-do view)’ line to 
‘Priority first (then date)’. This sorts dated and undated entries together, by 
priority. Within each priority the dated entries come before the undated ones. 

•  to order the entries by due date: set the ‘Sort order (in To-do view)’ line to ‘Date 
first, (then priority)’. The list is then ordered according to the importance of the 
entries. Dated to-dos which are “valid”, i.e. within their warning period, come first. 
Then come undated to-dos, sorted by priority; last come dated to-dos which have 
not yet reached their warning date. 

 You can then enter long-term to-dos with a high priority and a warning date a few 
days before they are due. They will then stay at the bottom of the to-do list until 
their warning date is passed, at which time they will move to the top. 

To-do entries in other views 
If the dated to-do has a high enough priority to be displayed in other views, it will 
be shown on its warning/start date. Once the real date has passed this warning/start 
date, the entry will be carried forward, always appearing on the screen for today, until 
you delete it or cross it out. 
To control how the to-do entries appear in other views: 
1. Select the ‘To-do list settings’ option on the ‘To-do lists’ menu, and select the 

name of the to-do list. 
2. Move to the ‘Display entries in general views’ line and set this to ‘Yes’. 
3. If you want only entries with priorities from 1 to 3 (for example) to appear in the 

Day/Week/List views, enter ‘3’ on the ‘From priority 1 to’ line. (If you don’t have 
too many to-dos, you may wish to enter ‘9’ here, so that all to-dos on this list are 
included.) 

4. Set ‘Default position in Day view’ to the time at which to-dos from this list should 
be positioned in the Day view. (They will have the same position, relative to day 
entries, in the Week and List views.) 
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5. Set the bottom line to say whether crossed out to-do entries are allowed to appear 
in the other views.. (There is more about crossing out entries later.) 

 If you wish you can display to-dos in some, but not all other views. (You might, 
for example, want to see them on the Day view, but not on the Week view, as they 
would fill up the slot for the current day.) Use ‘To-do list settings’ to set each list 
to display to-dos in other views. Then to set to-dos not to appear in the Week view, 
for example, select the ‘Week view’ option, press  on the ‘Allowed types’ 
dialog, and set ‘To-dos’ to ‘No’. 

You can position individual to-dos when in the other views, by using the  key 
to remove them, then positioning the cursor where you want them and selecting the 
‘Insert entry’ option to insert them at a different position. 

Displaying crossed out to-do entries 

 You can set up your Agenda so that a completed (i.e. crossed-out) to-do appears as 
“anchored” to the day it was completed, and is removed from the list itself. Your 
to-do lists are then not cluttered with crossed out entries, and you can review when 
you completed each to-do. If you don’t wish to do this, you should “tidy” your 
agenda, as explained later. 

To display crossed-out to do entries: 
1. For the to-do list, use the ‘To-do list settings’ option, and set ‘Display crossed out 

entries’ to ‘No’ for the list. Crossed-out entries will not be shown in the list itself.  
2. Now set ‘Display entries in general views’ to ‘Yes’, and the bottom line of the 

dialog to ‘Yes’ as well. Crossed out entries with a suitable priority will still be 
displayed in other views. 

See ‘Example setups’ later for an example Agenda which makes use of this feature. 

 Features like due dates and crossing out entries are there to be used as you want to 
use them. You might cross out a forthcoming appointment because it has been 
cancelled, not because it has been completed; a due date might be the date to start 
taking action on a to-do entry, or the deadline on a project. 

 If you remove crossing-out from a to-do entry which is shown in the past in other 
views, it becomes “valid” and will then be displayed today. If, for example, you 
are currently on a different day in the Day view, the entry vanishes from the screen; 
however, the message “Entry crossed out” is shown. 

Combining to-do lists 
If you want to combine one to-do list into another, “tidy” the list to a file, open the file 
and rename this to-do list to have exactly the same name as the list where you wanted 
the entries. Then open your main Agenda file again, and Merge in the tidied file. See 
‘Managing your Agenda’ later in this chapter for more about tidying entries and 
merging files. 
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Repeating entries 
You can repeat any entry on a daily, weekly, monthly by date, monthly by day or yearly 
basis. Any alarm or memo attached to the entry is also repeated. See later for more 
about alarms and memos. 

•  Repeating entries have their repeat information stored as part of the entry. They do 
not use up space on disk for each occurrence of the repeat. 

•  Dated to-do entries can repeat just like Day entries. You can set up a to-do such as 
‘Pay rent’ which repeats on the same day each month, and gives you the to-do 
warning as well. 

1. Add the first occurrence of the appointment in the usual way. 
2. With the cursor on the appointment, select the ‘Repeat entry’ option on the ‘Entry’ 

menu. 
3. Change the dialog line settings to create the kind of repeat you want: 

 

•  Every week. Set the ‘Type’ line to ‘Weekly’ to repeat an entry every week. You 
can choose more than one day for the repeat, or just one - press  on the ‘Days 
in week’ line to set which days you want. 

•  Every other week (or a different weekly interval). Use the ‘Weekly’ repeat and 
set the ‘Interval’ line to 2 (or more).  

•  Every month, on the same date(s). Use ‘Monthly by date’ to enter an entry which 
appears on the same day each month − for example, the 12th of June, 12th of July 
and so on. (Note that an entry on the 29th, 30th or 31st of a month can be given a 
‘Monthly by date’ repeat; in months which do not have this day, the entry appears 
on the last day of the month.) 

Press  on the ‘Dates in month’ line to select which dates you want - you can specify 
more than one if you want, e.g. an entry which repeats on the 1st and 15th of each 
month. 

•  Every month, on the same day(s). Use ‘Monthly by days’ to use the day of the 
week to control the repeat date − the first Tuesday of each month, the second 
Saturday, the last Thursday, and so on. Press  on the ‘Days in month’ line to 
see a vertical list. 

•  Every year. Use the ‘Yearly’ option, with an ‘Interval’ of 1. 
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You can set monthly or yearly repeats to occur every second or third month or year by 
setting the ‘Interval’ to 2, or 3, and so on. 
4. If you need to change the ‘From’ line, type the date on which you want the 

repeating entry to start (usually it starts from the date of the entry you enter). 
5. If you want the entry to be repeated forever, leave the ‘Repeat forever’ line set to 

‘Yes’. If you choose ‘No’, either type the date that you want the repeating entry to 
finish, on the ‘Until’ line, or type the number of times you want the entry to repeat 
on the ‘Occurrences’ line. 

6. Use the ‘Show’ line to set whether just the next occurrence of the entry is to be 
shown, or every occurrence. 

7. Press  to complete the ‘Repeat entry’ dialog. 

 You cannot enter more than one day for each yearly repeating entry. If you want an 
entry which repeats once every six months, for example, enter two entries (you can 
use the same text if you want to) six months apart which repeat yearly. 

To make an entry repeat on workdays, give it a weekly repeat, then select the days in the 
week on which you want the entry to appear. (If your workdays were to change you 
would have to edit any workday repeat entries.) 
When you have set up your repeating entry, you will see a >> symbol next to the 
appointment text to indicate that it is repeated. 

 If an overdue repeated to-do is not crossed out or deleted by the time the next 
occurrence is set to display, it is superseded by the occurrence which is now due.  

To view all the repeat entries 
•  Select the ‘View all repeats’ option on the ‘Search’ menu.  
The Agenda will display a list of your repeat entries; you can use the  keys to 
scroll the list. Press  when you’ve finished to remove it from the screen. 

 The entries are sorted by the date which you set as the ‘From’ date. (This is not 
necessarily the same date on which the entry first appears in the Agenda views.) 

 If an anniversary entry which is also set up to repeat has a start date before 1980, it 
will be listed as 1980. 

Changing repeats 
You can edit the text, modify the entry details, change the date and delete any 
occurrence of a repeating entry as you would any other entry 
When you make a change to a repeating entry, a dialog will ask you which occurrences 
are to be affected by the change. Select ‘All’, ‘Just this one’, ‘This & all future’, or 
‘This & all previous’. (If you make a change by using the ‘Repeat entry’ dialog itself, 
some of these choices will not be appropriate; you may find that the ‘Just this one’ 
setting is not offered, or even that no dialog is shown at all.) 
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•  If you choose ‘Just this one’ the Agenda creates a new non-repeating entry with the 
changes you made, and disables (hides) the occurrence of the repeating entry. The 
new entry has no “repeat” symbol. 

•  If you choose ‘This & all future’, or ‘This & all previous’, a message informs you 
that the repeating entry has been split into two repeating entries. 

Each new entry created in the above ways inherits most of its settings from the repeating 
entry. Memos are inherited too; if the entry has a long memo, the new entry uses up that 
much more disk space. 

 You cannot set the “due date” or “warning date” for a repeating dated to-do, only 
the number of days warning. This is because the actual dates on which the entry 
will be due are controlled by the “repeat” settings. 

Examining the details of repeat entries 
An occurrence of a repeating entry is disabled (hidden) if you delete just that 
occurrence. This also happens if you make any change to just one occurrence of a 
repeat: the occurrence is disabled and a new non-repeating entry, which has the change 
you made, is inserted at the same point. 

••••  Examining repeats from within the ‘View all repeats’ option: Move the cursor 
to the repeating entry whose details you wish to examine and press . 

••••  Examining repeats from Agenda views: Move to the repeating entry you wish to 
examine and select the ‘Examine repeat’ option on the ‘Entry’ menu. 

In both cases, the ‘Examining repeat’ dialog appears: 

 

A maximum of 999 occurrences will be shown. Typically, you will see a message to this 
effect when examining a weekly or daily repeating entry which is set to repeat forever. 
You can use the ‘Date’ line to view all the dates for the repeating entry. The number of 
the occurrence is shown in the ‘Occurrence’ line. 

You can press the  and  keys to enable or disable an occurrence as enabled or 
disabled. You might, for example, re-enable an occurrence which you had deleted. Press 

 (the Spacebar) to search for the next hidden entry. 

Press  to confirm any changes you make. If you press , the entry is left 
unchanged. 
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Changing & copying entries 

 You cannot highlight more than one entry in the Agenda. In general, you can only 
make changes to the entry that the cursor is on. 

Changing an entry 

To change the text or time: 
Place the cursor on the entry, then... 
•  Press . Edit the text and press ; then change any of the details in 

the entry details dialog and press  to save them. 

 If you only want to change the entry text, you can edit the text, then press  
. This ‘skips’ the entry details dialog, and the details remain 

unchanged. 
 Alternatively, if you want to ‘skip’ the entry text, you can just select ‘ Change 

entry details’ from the ‘Edit’ menu. 

The editing menu 
While you are editing an entry, a special menu (entitled ‘Edit’) is available. This has a 
‘Copy text’ option, to copy a highlighted region; an ‘Insert text’ option, to insert text 
previously copied (or cut with the  key); and a ‘Bring text’ option, to insert a 
copy of text highlighted in a different application on the Series 3c. 
This menu also has an ‘Evaluate’ option, which lets you make calculations on figures 
while you are editing an entry: 
You can also use: 

•   to delete to the beginning of the line, and  to 
delete to the end of the line. 

•   to highlight the current word. 

•   to highlight the whole of the entry. 
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Crossing out an entry 

You can use the crossing-out facility to mark entries that are completed or cancelled. 

•  Move to the entry concerned and select the ‘Cross out entry’ option on the ‘Entry’ 
menu. The entry will be displayed with a line through it. 

If you cross out alarmed entries, the alarm is disabled. 
You can remove the crossing-out from an entry by repeating the same procedure. (The 
‘Cross out entry’ option changes to ‘Reinstate entry’.) If an alarm had been set for the 
entry, it will be re-enabled. 

Moving an entry 

To change just the entry date: 
•  Select the ‘Change entry date’ option on the ‘Edit’ menu, type the new date for the 

entry in the dialog and press  to save it. 

Cutting, copying, and inserting entries 

Place the cursor on the entry, then... 
To delete it: 

•  Press . Confirm this (to make sure you want to delete it) and the entry will 
be cut from the Agenda and placed on the “clipboard”, ready for you to insert it 
back in if you wish. 

To copy an entry: 
•  use the ‘Copy entry’ option on the ‘Edit’ menu. The message ‘Entry copied’ will 

be displayed and the entry will be copied to the clipboard, ready for you to insert 
it. 

To insert the entry which is on the clipboard: 
•  move to the time slot in which you want the entry and select the ‘Insert entry’ 

option on the ‘Edit’ menu.  
 To delete an entry without affecting the clipboard: 

•  press . 

Important: You should select the ‘Compress file’ option on the file menu every now 
and again; this reclaims the space used by deleted and changed entries. (See 
‘Reclaiming space - compressing Agenda files’ later for more details.) 
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Copying entries to/from other applications 
You can use the ‘Bring entry’ option on the ‘Edit’ menu to copy text from a different 
application on your Series 3c.  
To “bring” text from another application: 
1. Highlight the text to copy in the other application, e.g. a name and address in Data. 
2. Switch to the Agenda, and select ‘Bring entry’. 

 If the text will not fit into a single Agenda entry, you can bring it into a memo 
attached to the entry instead. See ‘Adding notes to entries - ‘Memos’’ later for 
more details. 

To “bring” an entry from the Agenda into a different application: 

1. Move the cursor onto the entry to copy. (Don’t press  to re-edit it.) You 
cannot “bring” more than one entry at a time, to or from the Agenda. 

2. Switch to the other application and use its ‘Bring’ option to copy the entry. 

Copying Agenda entries using Infrared 
You can also copy Agenda entries to or from another Series 3c or Siena. See the 
‘Infrared’ chapter for more details. 

Looking at your Agenda 
You can change the appearance of your Agenda entries and views, so that the screen 
display is tailored to the way you want to use the Agenda. 
You can customise each Agenda view in a similar way: 

•  Select ‘Set preferences’ from the ‘Special’ view and select each view from the 
‘View preferences’ menu to see how you can change each one. 

You can also change how entries look and the suggested entry “defaults”, which control 
when and how each type of entry appears. 

How entries look 

You can change the appearance of any entry with the ‘Set style for entry’ option on the 
‘Entry’ menu. This lets you set the entry’s style to bold, italics, underline, or any 
combination of the three. 

 You may want to use a system which attaches meanings to entries with a particular 
style, for example, meetings could be entered in italics until they are confirmed, 
when you change them to normal text. 
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To change the default style (the style that entries have when you insert them), select the 
‘Set preferences’ option, and choose either ‘Day entry defaults’, ‘Anniversary defaults’ 
or ‘To-do entry defaults’. Each dialog includes a ‘Default style’ line. Move onto this 
line and press , and you can set the default style for that type of entry. 

•  Use ‘Zoom in’ or ‘Zoom out’ to change the size of the text displayed in each view 
(except the Year and Busy views). The font in use in each view is remembered 
separately. You might set the Week view to use the smallest font, for example, 
while the Day view uses a larger font. 

Time slots and slot compression 
To insert a second entry in a time slot, simply type it as you did the first one. A new 
line will be created for it automatically. 
When a time slot needs more than one line to show its entry or entries, the slot expands 
to accommodate the second entry, while other time slots without entries reduce in size. 
This feature is called “slot compression”; it allows the maximum number of entries and 
empty time slots to be displayed. 
If you wish, you can turn slot compression off. See ‘Changing the appearance of the 
Day view’ later in this chapter. 

Wrapping text 
If the text for your entry extends over more than one line it will be displayed truncated. 
(The entry itself is unchanged.) You can select ‘Wrap on’ from the ‘Special menu’ so 
that the entry wraps onto the next line. You can then read the whole entry. 
Alternatively, if you have lots of appointments, you might find that it is easier to leave 
the text wrapping off, so that you can see your appointments more easily in the Day 
view or Week view as each one is on a single line. You can always see the full text for 
an entry by selecting it and pressing .  

The “wrap” setting is remembered separately for each view. You might set just the 
Week view to have wrapping off. 

 You can use soft hyphens, hard hyphens and non-break spaces within the text for 
more precise control of word-wrap. (See the ‘Word’ chapter for further details.) 

The time separator character 
When timed entries are displayed in a view, a dot is used to separate the hours and 
minutes. You can change this if you wish: 
1. Select the ‘Set preferences’ option on the ‘Special’ menu, and in the ‘Entry 

preferences’, select ‘General preferences’. 
2. On the ‘Time separator character’ line, enter the character you want to use. Press 

 to complete the dialog. 

 This does not affect the display of times in dialogs. 
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The Day view 

The Day view always displays the day in two columns. 

Changing the appearance of the Day view 
Select the ‘Set preferences’ option on the ‘Special’ menu, and then the ‘Day view’ 
option on the menu shown. You can set: 

•  the position of the title,  

•  slot compression, 

•  the display of slot times, entry duration and end times,  

•  overlap bars, 

•  and the entry types which are allowed in the Day view. You may wish to exclude 
to-do entries from the display in the Day view, to prevent today’s slot from 
becoming cluttered. 

 To change the display of slot times and lines, move to the ‘Slot definitions...’ line 
and press  to display the ‘Slot definitions’ dialog. The settings for the left and 
right of the screen are separate to allow you to have different layouts on each side. 

 For both left and right side: set the ‘From’ line to the time that you want the page 
to start on. Set the ‘Slot duration’ to the length of time that you want for each slot. 
Set the ‘To’ line to the time the last slot on the page ends. 

 Use the options on the ‘Show’ line to set whether or not slot times and lines are 
displayed, e.g. to turn off slot times and lines completely set the ‘Show’ line to 
‘Neither time or line’. 

 Even if you do not display the slot times and lines, the Agenda still knows about 
the time slots and will always place timed entries in their correct positions on the 
page. 

If you insert entries from other views 
The ‘Default position for untimed entries’ setting in the ‘Day view preferences’ dialog 
controls where untimed entries should be positioned if you enter them while not in the 
Day view.  
‘Default position for timed entries’ does the same for timed entries, if you enter them 
using  to avoid the ‘Day entry details’ dialog. 
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The Week view 

The Week view displays all the day entries, to-dos and anniversaries for a week: 

•  Press the  key until the Week view is displayed, or select ‘Week view’ from the 
‘♦ ’ menu to move to it directly. It looks like this: 

 

The slot name for today is displayed in black; other day names are white. 
You can enter any entry from here, not just Day entries. For other entry types, e.g. 
anniversaries or to-dos, type in your entry text as a Day entry, then use ‘Change entry 
type’ to set it to be a different type of entry. 

 You can change the day that appears first in this view with the ‘Start of week’ 
option in the Time application. Week numbers are always calculated from the start 
of the year, according to an international standard. 

You can press: 

 to move to the corresponding day slot on the opposite page, or to the 
same day in the previous/next week. 

 to move to the previous/next entry, or the previous/next day slot if there 
are no entries in the current slot. 

 to move to the same day in the previous/next week. 

 to move to the same day slot in the previous/next month. 

 to move to today. Pressing it again returns to the day you were on. 

 To get to the end of a day full of entries, use PgDn ( ) then . 

Changing the appearance of the Week view 
Select the ‘Set preferences’ option on the ‘Special’ menu, and then the ‘Week view’ 
option on the menu shown. You can set: 

•  the position of the title, 

•  the display of entry duration and end times,  
and the entry types which are allowed in the Week view. You may wish to exclude 
to-do entries from display in the Week view, to prevent today’s slot from becoming 
cluttered. 
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Listing all your Agenda entries 

You can list all your entries in the List view: 

•  Press  until the List view is displayed, or select ‘List view’ from the ‘♦ ’ menu 
to move to it directly. It looks like this: 

 

You can press: 

 to move up and down through the entries. 

 to move to the previous/next entry at the start of a day. 

 to move a screenful at a time. 

 to move to the first/last entry on the list. 

 to move to today, or the nearest day with an entry. Pressing it again 
returns to the day you were on. 

Changing the appearance of the List view 
Select the ‘Set preferences’ option on the ‘Special’ menu, and then the ‘List view’ 
option on the menu shown. You can set: 

•  whether entries appear with an end time, a duration, or neither. 

•  the entry types which are allowed in the List view. 

•  whether repeats are shown ‘Once only’ (i.e. only their next occurrence) or 
‘As normal’ (i.e. all the repeats). 

 The List view may be slower if you choose ‘As normal’, and you have entries 
which repeat ‘Forever’ and have every occurrence shown. 

You can enter notes, appointments, anniversaries and to-dos (with or without due 
dates); you can also delete or cross out any type of entry when it is completed. 
Other Agenda functions allow you to search for particular entries and dates, set up 
series of repeating entries, copy and insert entries, copy text from other applications on 
your Series 3c, and even perform calculations inside the Agenda. 
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Changing the ♦♦♦♦  list 

You can change the views that are included in the ♦  list so that you can move more 
easily between the views that you use most frequently. For example, if you mainly use 
the Day and Week views, you could just have these two views in the ♦  list. If you’re 
not in the Day view, pressing  will always go there, and a second press will go to the 
Week view. You can still use all the other views using the options on the ‘♦’ menu. 

Select ‘Set up ♦  list’ from the ‘♦ ’ menu. Set ‘Yes’ for the views you wish to include 
and ‘No’ for those you wish to exclude from the list. 

Finding a particular entry 
You can use the ‘Find’ option to search for text, repeating entries, crossed out entries, 
alarmed entries and particular entry types or entry codes in your Agenda. 
1. Select the ‘Find’ option on the ‘Search’ menu.  
2. If you want to search for text, type it in the ‘Text to find’ line. 
3. Set the ‘Start date’, and ‘End date’ lines, or set them with the ‘Range of entries’ 

line, to select the range of entries to search. 

 If you set a smaller date range, the search is usually faster. If you know roughly 
when an entry occurred, you’ll probably find it faster to search a smaller date 
range, e.g. ‘Last month’ or ‘This year’, especially if you have a large Agenda. 

4. Use the settings on the ‘Repeat entries’, ‘Crossed out entries’, ‘Alarms’, and 
‘All entry types’ lines to modify the set of entries that are to be searched.  

5. Press  to start the search: 

 

While a search is in progress 
•  Use  to move the highlight through the list of entries found so far. 

•  If you see the entry you are looking for and want to stop the search, move the 
cursor to it and press  to see this entry in the previous view. 

•  Press  to interrupt the search. 
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When the search is finished 
•  The top line shows the number of entries found. 

•  The following lines list the matching entries, like in the List view.  

•  If no entries were found, the message “None found” will be displayed. 

•  Press  to return to the previous view. 

While you are searching, and when search results are displayed, a ‘Special’ menu is 
available, with zoom, wrap and printing options. You can, for example, format and print 
just your search results. 

 If you are searching the whole Agenda, and you have repeating entries which are 
set to show all their occurrences, the search could take a very long time, as it keeps 
finding occurrences of repeating entries. You can press the  key to stop the 
search at any time. (If, in the ‘Find’ dialog, you set ‘Repeat entries’ to ‘Show next 
only’, you should avoid the problem.) 

 Find does not search for text within memos. 

The ‘Find again’ option 
The ‘Find again’ option works in the same way as the ‘Find’ option, but it suggests the 
same settings you selected the last time you used ‘Find’. 

Working with free/busy time 
You can use the Busy view to see at a glance when you are free, and when you are busy. 
It is especially useful for arranging meetings, or other appointments. 
To display the Busy view: 

•  Press the  key until the Busy view is displayed, or select ‘Busy view’ from the 
‘♦ ’ menu to move to it directly. It looks like this: 
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Looking at your entries in the Busy view 
All Agenda entries (except Anniversaries) will appear in the Busy view. 
In the Busy view: 

•  your Agenda appointments which have a duration are shown as filled ‘blocks of 
time’ across a four week period. 

•  entries which take no time are shown as a black line across the top of the block. 

•  overlapping entries are shaded in black; normal entries are shaded grey. 

•  the text for an entry is displayed in the top line when you highlight it with the 
cursor. If there is more than one entry in a time slot, use  and - to list each 
one. 

You can press: 

  to move to the previous/next day. 

  to move through the time slots in a day, or to the next day. 

 to move exactly a week. 

 to move exactly four weeks at a time. 

 to move by a year at a time. 

 to move to the start/end of the entries for a day. 

 to scroll the Busy view upwards/downwards by a time slot. The 
slot at the top changes. 

 to move to today. 

Adding new entries in the Busy view 
If you want to add an Agenda entry once you have checked your busy/free time in the 
Busy view, you can simply add an entry straight away - you do not need to change to 
another view an entry. 

To add an entry: move to the correct time, then simply start typing. Press  to 
display the ‘Day entry details’ dialog, and set any other entry details if you need to, then 
press . 

Changing the appearance of the Busy view 
Select the ‘Set preferences’ option on the ‘Special’ menu, and then the ‘Busy view’ 
option on the menu shown. You can set: 

•  the first and last slot usually displayed in the Busy view (you can use  
 to scroll up or down by a time slot at any time). 

•  a dotted line showing the start and end of your normal work hours. Press  on 
the ‘Work hours’ line to set your work hours. 

•  whether the ‘busy’ entries appear as a 3D solid, or shading. 

•  whether overlaps and/or crossed-out entries are allowed. 
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•  whether the duration or end time of each entry is shown when it is listed. 

•  whether grid lines are displayed in the Busy view. 

Alarms and reminders 
You can set an alarm for an entry, for example: 

•  when a meeting is due, or perhaps in advance (a day, half an hour, 5 minutes) 
giving you some time to prepare or travel. 

•  to remind you a few days in advance of birthdays or anniversaries. 

•  to remind you to do something or call someone, or perhaps do something on a 
To-do list. 

Setting an alarm for an entry 

You can set an alarm for an entry while you are entering it, or at any time thereafter. 
Generally, you set each alarm from the ‘Alarm details’ dialog. To display this: 

•  For new entries: type the entry as usual and press . In the entry details 
dialog, set the ‘Alarm’ line to ‘Yes’. Press  on the ‘Alarm details’ line. 

•  For existing entries: move to the entry and select the ‘Set alarm for entry’ option 
on the ‘Entry’ menu. 

 For day entries, you can enter the time of the alarm in the main ‘Day entry details’ 
dialog. 

To set the alarm: 
1. In the dialog, set the ‘Alarm’ line to ‘Yes’. 
2. Type the time for the alarm in the ‘Alarm at’ line (remember to put in am or pm if 

your Series 3c is set to use a 12 hour clock). 
3. Enter the number of days prior to the entry date that you want the alarm to ring in 

the ‘Days previous’ line. 
4. Select the alarm sound that you want to use in the ‘Sound’ line. You can test each 

sound by pressing the  key.  

 If you want to, you can create your own sounds to use as alarms in the 
Soundmaster application, and select them here just like the built-in alarms for the 
Series 3c. See the ‘Soundmaster’ chapter for more details. 
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 Each entry type has a different default alarm sound: ‘Rings’ for timed day entries, 
‘Fanfare’ for untimed day entries, ‘Soft bells’ for anniversary entries, and ‘Chimes’ 
for to-dos. You can change these in the preferences for each type of entry, e.g. 
select ‘Anniversary defaults’ and press  on the ‘Alarm defaults’ line.  

5. Press  to complete the dialog.  

The entry will now display a bell symbol after the text to indicate that it is set to 
produce an alarm. 

 To set workday alarms for a day entry or a to-do, you must make the entry repeat 
on your workdays. (In the ‘Repeat entry’ dialog, set ‘Type’ to ‘Weekly’, and ‘Days 
in week’ to include all your workdays.) Then set this repeating entry to have an 
alarm. 

When an alarm rings 
When an alarm rings, a dialog appears taking over the whole of the screen, no matter 
what you are doing on your Series 3c. (The Series 3c will turn itself on if necessary.) 
The dialog shows the text and time of the entry for which it is set. The alarm starts 
quietly, and becomes louder. You cannot use your Series 3c until you have 
acknowledged the alarm. 
Use: 

 to turn off the alarm. 

 to silence the alarm. The dialog will remain on screen so that you can read it. 

 to snooze the alarm. The alarm will turn off for five minutes and then resume 
ringing. If you press  again, a further five minutes is added to the snooze 
time. You can do this to a total of 60 minutes. 

Cancelling an alarm 
If you decide that you don’t want an alarm you have set to ring: 
1. Move to the entry and select the ‘Set alarm for entry’ option on the ‘Entry’ menu. 

2. Set the ‘Alarm’ line to ‘No’, and press . 

You can also silence alarms by switching the sound on your Series 3c to ‘Off’ 
temporarily. You might want to do this if you do not want any alarms to ring while you 
are busy, or the alarm may disturb others. See the ‘Time’ chapter for details. 

Alarms and exiting files 
Open Agenda files always inform the Time application about their next alarm only. (It 
is the Time application which actually rings the alarm.) When an Agenda alarm rings, 
the open Agenda file then informs Time of the next alarm it contains, and so on. 
However, when you “exit” an Agenda file, the Time application still knows about the 
Agenda’s next alarm. It will still ring it, but will not be able to ring any others from that 
file, until you open it again. 
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•  If you did not want the alarm to ring, use the ‘View next alarms’ option on the 
‘Alarm’ menu in the ‘Time’ application.  When you get to the alarm in question, 
the Time application knows that the Agenda file is no longer open, and offers you 
the chance to remove the alarm. 

•  If you did want this and other alarms in the file to ring, you must re-open the file. 

 You can always “exit” an open application by selecting the ‘Exit’ option in the 
application, or by highlighting the bold filename and pressing  in the 
System screen. Exiting applications may save memory. However, if you set lots of 
alarms in your Agenda, it is a good idea to leave the Agenda file “open” all the 
time if possible (even when you switch the Series 3c off), so that you do not “miss” 
any alarms. 

Adding notes to entries - ‘Memos’ 
You can attach notes to any Agenda entry with the Memo editor. For example, you can 
use this for: 

•  keeping notes and actions from meetings. 

•  keeping ideas for presents for your anniversary entries, or directions or additional 
travel arrangements for appointments. 

•  turning your Agenda into a “what I did today” type diary. Memos can have 
passwords, so nobody else can read them without the correct passwords. 

Attaching a memo to an entry 

1. Move to the entry concerned and select the ‘Edit memo’ option on the ‘Entry’ 
menu. The Memo editor appears. 

2. Type the text for the memo: 

•  Each memo can contain over 3000 characters. 

•  If you press , you will see that many of Word’s features for manipulating and 
changing the styles of text are available to you. 

3. When you have finished, select the ‘Exit’ option on the ‘Special’ menu, to return 
to the previous view. You will see that the entry is now followed by a small symbol 
like a sheet of paper, to indicate that a memo is attached to it.  

When you’ve finished, select the ‘Exit’ option. If you’ve made changes which you do 
not want to save, select ‘Exit, lose changes’ on the ‘Special’ menu. 
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Viewing and re-editing a memo 
•  Move the cursor onto the entry, then use the ‘Edit memo’ option again if you want 

to read or re-edit a memo. When you’ve finished, select the ‘Exit’ option. 

Changing the appearance of text within memos 
The Memo editor is essentially a specialised version of Word. It contains the same 
functions for manipulating and changing the appearance of text. 
The set of styles which can be used within memos is common to all memos in the 
Agenda file. So if you make any change to a style, that change will affect any memo 
that uses that style. Initially, the same four styles are available as in new Word 
documents. 

•  Use the options on the ‘Paragraphs’ menu to change the fonts, indents, tabs, 
alignment and spacing of paragraphs within a memo. (Each change you make 
creates a new “style”, and that style is then applied to the paragraph.) 

•  Use the same emphases for bold, underlined text etc. For example, hold down the 
 key and press  twice for bold text. 

•  You can use the ‘Insert’, ‘Copy’, ‘Bring’ and ‘Evaluate’ options (on the ‘Edit’ 
menu) for text within memos in the same way as you can use them within other 
Agenda views. If you want to bring some text to the Agenda which will not fit into 
a single Agenda entry, bring it straight into a memo.  

•  Use ‘Find’ to search for text. ‘Find again’ searches for further occurrences of text 
searched for by ‘Find’. 

•  Use ‘Replace’ to search for a particular piece of text and replace it with other text. 
The ‘Word’ chapter has more details of these and other options. 

Password protecting a memo 
You can set each memo to have a password of up to eight characters. In the Agenda 
views you cannot tell that a memo has a password, but when you try to view or edit the 
memo, you will be asked to enter the password. 
1. While editing the memo, select the ‘Password’ option on the ‘Memo’ menu. 
2. Type the password in the ‘Enter password’ line. The characters are not displayed as 

you type them; padlock symbols are shown instead. Type the password again in the 
‘Confirmation’ line and press . 

3. Select the ‘Exit’ option on the ‘Special’ menu to return to the previous view. 
You must now type in this password when you next try to edit this memo. 
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Changing or deleting a password 
1. Edit the memo, and select the ‘Password’ option on the ‘Memo’ menu. 
2. You are asked for the password again; enter it, and the ‘Change password’ dialog 

is shown. 
3. To change the password, type the new password in the ‘Enter password’ and the 

‘Confirmation’ line. 
To delete the password, press  twice to complete the dialog without 
entering a new password. 

Deleting a memo 
You can delete any memo which you no longer wish to keep, by deleting all the text 
that it contains: 
1. Edit the memo, then select the ‘Highlight all text’ option on the ‘Edit’ menu, to 

highlight all of the text. Press  to delete all of the text. 

2. Exit the memo as usual to return to the previous view. The memo symbol will have 
disappeared to show that the entry no longer has a memo attached. 

Long memos 
Large memos can take up to 3-4 K of space on a disk. If you change an entry which has 
a memo attached, you will use up that amount of disk space again, as the entry is re-
written to disk. You should therefore try to avoid making unnecessary changes to 
entries with long memos. 

 You can use the ‘Compress file’ option (or ‘Save as’ for files stored on Flash 
SSDs) to reclaim the space taken by deleted or changed memos. This is described 
later in this chapter. 

Grouping entries together 
If you want to, you can group entries which are related together using “entry codes”: 

•  An entry code is a single letter which can be used to group entries which are 
similar. The letters can appear in any Agenda view, but are especially useful in the 
Year view, so that you can see at a glance which entries are linked. 

•  You can use one of the entry codes in the list supplied, or define your own codes 
and descriptions. 

•  You can use entry codes when viewing or sorting entries. For example, if you set 
up different codes for each client you work with, your entry code system could be 
based on each client. You can search for all your meetings, appointments and other 
Agenda entries with a client by entry code. 
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•  If you transfer your Agenda to Microsoft Schedule+ on a PC using PsiWin, your 
entry code details are converted to the equivalent entry categorization in 
Schedule+. 

Displaying entry codes in Agenda views 
To display the entry codes for entries in: 

•  The Year view only. 
 Use the ‘Set entry code’ option on the ‘Entry’ menu to select an entry code, and 

make sure that the ‘Show in Year view’ line is set to ‘Yes’. 
 When the Year view is displayed, you can change which entry codes are visible by 

selecting ‘Which symbols’ from the ‘Special’ menu and choosing which entry 
codes you want to see. See ‘Using entry codes in the Year view’ for more details. 

•  Other Agenda views too (e.g. Day, Week, List). 
 Select ‘Set preferences’ on the ‘Special’ menu, then ‘General preferences’ on the 

‘Entry preferences’ menu. Make sure that ‘Show entry codes’ is set to ‘Yes’. 

 Entry codes are displayed after the entry text. If your entry text is long and you 
have set ‘Wrap off’, you may need to set ‘Wrap on’ to make sure that the entry 
code is displayed. 

Giving an entry an entry code 
To give an Agenda entry an entry code: 
1. Enter your entry as usual, and select it in an Agenda view. 
2. Select ‘Set entry code’ from the ‘Entry’ menu. 

3. Press  on the ‘Entry code’ line to see the entry codes which are available. The 
entry codes which are initially provided are: 

B
C
H
L
M
P 
T 

Birthday 
Phone call 
Holiday 
Leisure 
Meeting 
Public Holiday 
Travel 

•  To select a built-in entry code: use  to select the description, and press 
. 

•  To enter your own entry code: press  to remove the built-in codes, and 
simply type in a letter or character to use as a code. 

 This is the character that appears with the entry and is displayed in the Year view. 
You can use any upper or lower case letter, as well as some punctuation characters 
- if you’re not sure whether a character is acceptable, simply type it in to see! 
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 You can use any character as a symbol for an entry in the Year view. However, it is 
worth remembering that some characters, such as #, cannot be shown very clearly 
in the Year view display. You may wish to stick to letters of the alphabet. 

4. Set the ‘Show in year view’ line to ‘Yes’ if you want this entry code to appear in 
the Year view. 

 Entering new entries with entry codes 

 You can set up your Agenda so that there is a line for the ‘Entry code’ in the dialog 
when you enter your original entry, e.g. the ‘Day entry details’ dialog or the 
‘Anniversary details’ dialog. If you use entry codes a lot, you’ll probably find it 
easier to set the entry code this way. 

 To do this: select ‘Set preferences’ from the ‘Special’ menu, then select ‘General 
preferences’ and set the ‘Show entry codes’ to ‘Yes’.  

Entry types and entry codes 

•  When you first run the Agenda, anniversary entries are shown in the Year view 
with the entry code A. You’ll find that for anniversary entries, the ‘Show in Year 
view’ line is set to ‘Yes’ already. They automatically appear in the Year view. 

•  However, for other types of entry, e.g. to-dos or day entries, ‘Show in Year view’ 
is set to ‘No’. Entries will not appear in the Year view unless you set this line to 
‘Yes’ for each entry. 

Alternatively, you can change the suggested setting for ‘Show in Year view’ for each 
type of entry. Select the ‘Set preferences’ option on the ‘Special’ menu, select the 
appropriate ‘Entry preferences’ option (e.g. ‘To-do entry defaults’ for to-do entries) and 
move to the ‘Entry code defaults’ line. Press , and set the ‘Default display in Year 
view’ line as required. 

Adding your own entry codes and descriptions 
You can use any letter or character as an entry code simply by typing it on the ‘Entry 
code’ line. You do not need to use one of the codes with a description, or set up a 
description for each entry code you use. 
However, if you have a number of entry codes, you may find it easier to add a 
description which you can use to help you keep track of the entry codes that you use. If 
you do this, you can pick the description from a list when you assign an entry code to an 
entry.  
To assign an entry code a description: 
1. Select ‘Set preferences’ from the ‘Special’ menu, then ‘Entry code settings’ from 

the ‘Entry preferences’ menu. 
2. Type the letter or character for the entry code onto the ‘Current code’ line. See 

‘Giving an entry an entry code’ earlier for more information about which letters or 
characters to use. 

3. Type in a description for this entry code on the ‘Description’ line. 
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Removing entry codes 
To remove an entry code from an entry: 
1. Highlight the entry in a different Agenda view (don’t use the Year view as the 

entry will disappear from view when you remove the entry code!). 
2. Select ‘Set entry code’ from the ‘Entry’ menu. 

3. Press  to set the ‘Entry code’ line to ‘None’. 

To remove an entry code description: 
1. Select ‘Set preferences’ from the ‘Special’ menu, then select ‘Entry code settings’ 

from the ‘Entry preferences’ menu. 

2. Type the code that you want to delete on the ‘Current code’ line, or press  and 
select the description from the list. 

3. Move to the ‘Description’ line and use the  key to remove the text from 
this line.  

 You can delete any of the entry code descriptions which are initially set up in 
Agenda, or those you have added yourself. If you want to use them again from the 
description list, you can replace them. 

Using entry codes in the Year view 

The Year view displays entry code symbols for selected entries of any type. Each “day” 
in the Year view shows the entry codes set for the entries on that day, i.e. an ‘A’ in a 
box indicates this Anniversary entry has an entry code ‘A’. An ‘H’ might indicate this 
day is a holiday for you. 
To display the Year view: 

•  Press the  key until the Year view is displayed, or select ‘Year view’ from the 
‘♦ ’ menu to move to it directly. It looks like this: 

  

•  The current year is shown in the top left-hand corner. 

•  The cursor appears as a black box around one of the dates in the grid. 

•  The grid of days is drawn in grey for the past (with diagonal grey lines through the 
days), and with black lines for the future. 

•  The date of the current cursor position is given on the top line of the screen. 
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You can press: 

  to move to the previous/next day. 

  to move to the day above/below. If you are at the top or bottom of 
the Year view, they scroll the screen by a year. 

 to move a week at a time. 

 to move to the first or last day in the current month. 

 to move a month at a time, keeping the cursor on the same date of 
each month. 

 to move a month at a time, keeping the cursor on the same date 
and also at the same position on screen - the months will scroll up 
and down the screen. 

 to move a year at a time. 

 to move by four years at a time. 

 to scroll the Year view backwards/forwards by a month. The 
month at the top changes, but not the selected day. 

 to make the current month go to the top of the Year view. You 
can then see the next 12 months. 

You can display: 

•  Entries with a particular entry code, e.g. Holidays or Meetings. 

•  All entries with an entry code.  
Anniversaries are the only entries which initially appear in the Year view (with entry 
code A). For all other entries you must select an entry code description, or type in your 
own. 

Displaying all entries with entry codes 
You can display all the entries which have entry codes set in the Year view, even if you 
do not want them to appear in other views in your Agenda. 

•  Select ‘Which symbols’ from the ‘Special’ menu in the Year view, and set the 
‘Which symbols’ line to ‘All’: 
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Days with multiple entries 
Up to two year entry codes can be displayed for each day in the Year view, though you 
can set entry codes for as many entries as you like for each day. When there are two or 
more entries, a message such as ‘(1/2: + − for more)’ is displayed in the top right-hand 
corner of the screen. The text for the first entry for a particular date is shown on the top 
line of the screen, whenever the cursor is positioned over that date in the grid. To see 
the text for further entries use the ‘+’ and ‘−‘ keys to move between them. 

 If you use ‘Set entry code’ for a particular entry and set ‘Show in Year view’ to 
‘No’, note that that entry will not appear in the Year view anymore. Be careful not 
to ‘lose’ your entries. Other entries with this entry code will still appear though. 

Displaying entries with a particular entry code 
You can choose one of your entry codes, and display all the entries with that entry code: 

•  Select ‘Which symbols’ from the ‘Special’ menu in the Year view, and set the 
‘Which symbols’ line to ‘One’. You can then type the entry code, or press  to 
select from the descriptions. 

Changing the appearance of the Year view 
Select the ‘Set preferences’ option on the ‘Special’ menu, and then the ‘Year view’ 
option on the menu shown. The ‘Preferences in Year view’ dialog lets you set the 
month that is displayed first, and whether appointment duration or end times are shown 
with the entry text on the top line. 

Managing your Agenda 
As well as deleting entries, you can cross them out when they are completed (or if they 
are cancelled), and you can use the ‘Tidy/extract’ option to remove out-of-date entries. 
You may wish to leave selected entries in the past, whether crossed out or not, as a 
“what I did” type of diary, or as a record of appointments and so on. Alternatively, you 
may wish to remove all out-of-date entries, and then maybe reclaim the disk space they 
took up. 

 It is a good idea to clear out your Agenda occasionally, so that your Agenda does 
not get too large. 
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Tidying your Agenda 

Use the ‘Tidy/extract’ option to delete specific entries from your Agenda. 
The top line of the dialog sets what should happen to tidied entries. ‘Delete entries’ 
just deletes the entries from the Agenda; ‘Copy to file’ copies them into a new Agenda 
file, but still leaves them in the current Agenda file; ‘Copy to file and delete entries’ 
copies them to a new file and deletes them from the current file. For the last two of 
these you must enter the name for the Agenda file to be created to contain the tidied 
entries. 
Choose the ‘Start date’ and ‘End date’ of entries to be tidied; however, you can set 
these dates automatically by setting ‘Range’ to ‘Whole Agenda’, ‘From/until today’, 
‘This week/month/year’, or ‘Last week/month/year’. 
Two further settings control which entries are tidied: 

•  The ‘Entry types...’ line lets you set which types of entries can be tidied. 

•  The ‘Status filter’ line lets you tidy ‘Crossed out entries only’ (or, should you so 
wish, ‘All except crossed out’ entries). 

For example, you might set both of these lines so that only crossed out to-dos were 
tidied. 
Repeating entries appear in any file created by ‘Tidy/extract’, but with their date ranges 
clipped to the range of dates you were tidying. However, they are only deleted from the 
original file if all their occurrences lie within the range you are tidying. 
If you chose ‘Copy to file’ or ‘Copy to file and delete entries’, you can move to the 
System screen and see the name of the file beneath the Agenda icon. You can access the 
file in the same way as any other Agenda file. 

 It is not possible to use the Tidy/extract option to tidy entries into an existing 
Agenda file. Instead, open this other file, merge in the file created by 
‘Tidy/extract’, and exit the file again. 

Tidying to-do entries 
If you use ‘Tidy/extract’ when in the To-do view, the dialog does not ask for dates, but 
instead asks which to-do lists to tidy. Set ‘Which lists’ to ‘All’, ‘One’ or ‘Selection’; if 
you choose ‘Selection’, set ‘Include list’ to ‘Yes’ for each list you want to tidy, and to 
‘No’ for all the others. 
If you just want to tidy crossed out entries, set ‘Status filter’ to ‘Crossed out entries 
only’. 
Important: if you are in the Day, Week or List views when you use ‘Tidy/extract’, low 
priority to-dos which are not shown in these views will not be tidied. 
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Merging two Agenda files 

You can merge in the entries and/or preference settings from another Agenda file. You 
might wish to do this if you have two separate Agenda files, perhaps for work 
appointments and domestic entries, and have decided instead to merge them into one 
file. 
Alternatively, you might wish to merge just the preference settings from an existing 
Agenda file into a new file so that it looks the same and works in the same way as your 
original one − or if someone else has a layout you want to use for your own Agenda. 
To merge the files: 
1. If any of the files you want to merge in are open, exit them. (If you do not, you will 

see a ‘File or device in use’ message, and the merge will fail.) 
2. Open the Agenda file into which you want to merge the entries and/or preferences. 

This is the file that will be modified to include all the entries or preferences from 
the second file. 

3. Select the ‘Merge in’ option on the ‘File’ menu, and on the ‘Merge in’ line select 
whether you want to merge the entries, preferences or both. 

4. Select the name of the file whose entries you want to merge in, and press . 

If you choose to merge preferences, a confirmation dialog will appear. Press  if you 
are sure you want to overwrite them. 

Reclaiming space −−−− compressing Agenda files 

When you delete or change an entry in an Agenda file, the original version of the entry 
still takes up space in the file. You may therefore need to compress Agenda files 
periodically to reclaim this unused space. 

For Agenda files on the Internal disk or on Ram SSDs 
1. Select the ‘Compress file’ option on the ‘File’ menu.  
The size of your current Agenda file and the amount of space used by deleted entries are 
displayed (in bytes). 

2. Press  to compress the file. The message “Agenda compressed” is displayed 
when the process is completed. 
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For Flash SSDs 
You cannot compress files that are saved on Flash SSDs. 
To reclaim the space, you should: 

•  Copy all the files from the Flash SSD onto the Internal disk, or another Ram SSD, 
and compress the files there. 

•  Reformat the Flash SSD, then copy the files back. 
See ‘The System screen’ chapter for more about using Flash SSDs, and formatting 
disks. 

Making new Agenda files 

You can use the ‘New file’ option to create as many Agenda files as you like. For 
example you might create two Agenda files, one for work and one for home. You can 
create new Agenda files from the System screen, by first moving the highlight to the 
Agenda icon, or from within another Agenda file: 
1. Select the ‘New file’ option on the ‘File’ menu. 
2. Type the name for the new file on the ‘File: Name’ line (maximum 8 characters). 
3. On the ‘Disk’ line, select the disk that you want to create the file on. A message is 

displayed, confirming the creation of the new file. 
If you move to the System screen you will now see the names of two Agenda files 
beneath the Agenda icon. 
To use the same settings and preferences as an existing file: create the new file from 
inside the Agenda file, or from the System screen while the existing Agenda file is open. 
To use the default preference settings: close all other Agenda files, then create the 
new file. 

Saving copies of Agenda files 

You can save a copy of an Agenda file onto an SSD or the Internal disk. You might 
wish to do this to create a second copy of the file for back-up purposes. 
Select the ‘Save as’ option on the ‘File’ menu. Type the name for the copy of the file 
and select the disk that you want to create it on. Press  to complete the dialog and 
create the copy of the file. 

 If you set ‘Use new file’ to ‘Yes’, your old file will be exited and you will start 
using this file instead. 

 You cannot import/export plain text (ASCII) files. You can, however, use ‘Print 
setup’, set ‘Printer model’ to ‘General’ and ‘Printer device’ to ‘File’, and print all 
or part of your Agenda to a plain text file. 
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Low battery when saving an entry 
If there is a ‘Battery too low’ or ‘Batteries too low to write to Flash’ message while 
saving an entry: 

•  If possible, change the batteries (or insert a mains lead) and select ‘Retry’. The 
entry should be saved correctly. 

•  If this is not possible, select ‘Fail’ although an incorrect entry will be saved. Exit 
the file; when you next open the file, the Agenda will remove the bad entry, and 
you can then add new entries after it. 

Series 3 and Series 3a Agenda files 

For Series 3 users 
If you open a file from the Series 3, the Agenda must first convert it. A dialog asks you 
for the name to use for the new converted file. You must enter a new filename; the 
Agenda will not allow you to overwrite an existing file.  

The Series 3 is unable to open Series 3c Agenda files − you cannot transfer Agenda files 
back from the Series 3c to the Series 3. 

For Series 3a users 
The Agenda will also convert Series 3a Agenda files. The Series 3a is able to open 
Series 3c Agenda files and vice versa, although you may notice differences in the year 
symbols and entry code settings, and in the preferences for the Busy view. 
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Example setups 
The following pages give you some tips and ideas on how you could set up your 
Agenda, to tailor it to your needs. 
You may wish to make further modifications to one of the example setups outlined 
below, to suit your use of the Agenda. 
Note: apart from ‘To-do list settings’, which has its own menu option, the settings 
referred to in these examples are options of ‘Set preferences’. 

A “plain paper” agenda 

 

The Day view is used here to give a blank page with slot lines. You can simply ‘write 
on’ it anywhere. 
In this example: 

•  The ‘Day view preferences’ are set so that slot times are shown, but that times are 
only shown when you enter a timed entry. 

•  The ‘Day entry defaults’ are set so that all day entries are untimed by default, and 
untimed day entries appear in the first morning slot. 

•  Some entries for tasks have been entered as to-do entries. 

Work to-do (and completed) Agendas 

For those who have lots to do, and also need to keep track of appointments. 
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The ‘Day view’ preferences are set so that: 

•  The title appears on the left-hand side. 

•  The left hand side is set up as a single time slot, with times and slots not displayed 
so that to-do entries for the day can be listed. 

•  The right hand side is set up as a day planner, with hourly slots between  
9am and 5pm. 

Alternatively, you might prefer to include to-dos for morning and afternoon: 

 

The to-do lists are set up so that: 

•  There is a to-do list for the different times of the day: morning and afternoon. 

•  The ‘To-do list settings’ for each list are set so that entries on each list appear at an 
appropriate time of the day in the Day view. For example, morning to-do list 
entries appear at 9am and afternoon to-do entries appear at 1pm. 

•  For each list, entries of priority 3 or above are set to appear in the Day view. 

•  Entries from other to-do lists (e.g. a shopping list) are not displayed in the Agenda 
views - ‘Display in other views’ in the ‘To-do list settings’ is set to ‘No’. 

Using the Agenda this way allows you to keep track of your tasks at work as to-do 
entries, using the Day view and Week views. 
Crossed out entries can be anchored to the date they are completed. 

 

•  Set up a to-do list to enter each work task. 

•  In the ‘To-do settings’ dialog, make sure that ‘Display crossed out entries’ is set to 
‘No’ so that they do not appear in your to-do list once you have crossed them out. 

•  Then set both the ‘Display entries in General views’ line and the last line of the 
dialog to ‘Yes’. This will anchor each crossed-out to-do to the day you completed 
it. 

•  The ‘Day entry defaults’ are set so that untimed day entries appear at 8am. 
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•  The ‘To-do List settings’ are set so that to-dos are undated by default and appear at 
9am. Your untimed entries will always appear before your to-do entries. 

•  The ‘Anniversary defaults’ are set so that anniversaries appear at 6am. 

Managing small documents with to-dos 

You can use the memo feature with the To-do view to store and manage small but 
related documents, or further notes about the to-do: 

 

Although these documents could be in Word, you can: 

•  enter a document summary of up to 200 characters as the to-do entry as a title, as 
compared to an eight character filename for Word document. 

•  use the ‘Find’ option in the Agenda to search for text within the to-do entry (i.e. in 
the document summaries), making it easier to locate one document from among a 
large number of them. 

•  set due dates and alarms for important documents, which you cannot do in Word. 

 Password protection, and formatting with styles and emphases are provided for 
memos in exactly the same way as in Word. 
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Data 

Data is the application where you can store lots of information of a 
particular type, as you would in a paper-based card index, for 
example: 

••••  names and addresses, like in an address book, 

••••  client details, price lists, catalogues, the CDs in your collection 
and so on. 

You can quickly find an address etc. by searching for a small piece 
of text contained in the entry, such as Jones or doctor . 

You can define your own labels for the lines of information in each 
entry, such as name: or cost: to guide you when typing in 
entries, and finding them. 
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What is a database? 
A database is like a card index. Each entry you type into a database is like one card in 
the index box 
Unlike card indexes though, with the Series 3c Data application you can quickly find 
any entry by typing a short search clue, such as Jones, and move quickly to any entries 
which contain this text. 
When you first use Data, it is set up to be used as an address book. However, as you 
will see, you can create new databases to store other information if you wish. 

Dialling phone numbers 
Your Series 3c is capable of dialling phone numbers from your address book. When you 
use the Dial keypress ( ) the Series 3c emits the DTMF tones required to call 
the number you chose. The dialling system takes account of international codes and 
your current home country. See the ‘Dialling’ section later in this chapter for more 
details. 

Typing in entries 
When you first use Data, the Add view is shown: 

 

Data is already prepared for use as an address book, with a suitable set of labels - 
‘Name:’, ‘Address:’ etc. - down the left-hand side of the screen. 

 The database labels already shown should be fine for most address books. 

 You can change the labels for your address book, if you wish. You can also invent 
a new set of labels for other types of information or even switch them off so that 
they do not appear at all. See ‘Changing the database labels’ later in this chapter 
for details. If you do wish to change the labels, it’s best to do it before you start 
adding entries. 
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Adding entries 

To add a new entry: 

1. If you are not already in the Add view, select ‘Add’ from the ‘♦ ’ menu or press the 
 key until the Add view appears. 

2. Type the name, phone numbers, address and any notes alongside the labels.  
 If you wish to “dial” numbers from your Database, you should enter phone 

numbers alongside labels that contain a � symbol, and type them in the form 
01719998080 for numbers in your own country, and +46 31 999999 for 
numbers in other countries. See ‘Dialling’ later for more information about how to 
enter phone numbers for dialling. 

•  Use  to move between the labels. 

•  Just press  (or ) to skip to the next line and leave a label blank - for 
example, if you don’t have someone’s work phone number. 

•  Press  if you need to insert another line for one of the labels. You may 
want more than two lines for the ‘Address:’, for example.  

For more information about typing and editing in Data, see ‘Editing while you enter 
text’ later. 

3. Press  to save the entry. 

 If you need to insert a real tab character in an entry, press . If you need 
to, you can select ‘Set tabs’ from the ‘Display’ menu to specify how many 
character widths each tab should be shown as on the screen. 

Data is then ready for you to type another entry. Type in as many further entries as you 
wish, pressing  after each. 

4. When you’ve finished adding your entries, press the  key to move to the List 
view where you can see your entries. 

How many entries can I have? 
There is no limit to the number of entries a database can contain. 
Each entry can contain a maximum of 4000 characters, though there is no limit to the 
number of lines an entry can contain, or the length of each line in an entry. 
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Moving between views 

There are four different “views” in Data which you can move between by pressing the 
 key, or using the options on the ‘♦ ’ menu: 

•  To add new entries, go to the Add view. 

•  To view your database entries as an ordered list (alphabetical or chronological 
order), go to the List view. 

•  To find entries, use the List view or use the Find view to move straight to 
particular entries. You can use the List view or Find view to look for entries - 
whichever you prefer. 

•  To update or change entries, go to the Edit view; see ‘Updating an entry’ later for 
more information. 

Viewing & finding entries 
You can review all your entries, or find a particular entry, by: 

•  looking at an alphabetical list of your entries in the List view. 

•  looking at them one-by-one in the Find view. You can also find a particular entry 
(or group of entries) by typing a search clue in the Find view. 

Viewing a list of entries  

To see a list of entries, select ‘List’ from the ‘♦ ’ menu, or press  until the List view 
is displayed: 

 

•  Use  to scroll to the entry you want, and then  to see the other 
columns that are not currently shown. If the columns are too narrow for you to see 
all the details, you can increase their width - see ‘Columns in the List view’ later 
for more details. 

•  Initially, the ‘Name:’ column is “frozen”. This means that it remains visible when 
you scroll to the right, e.g. when you look at the ‘Notes:’ column. See ‘Columns in 
the List view’ later for more about freezing and unfreezing columns. 
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•  Initially, your list will be sorted into alphabetical order. You can also choose to 
sort your Database entries into chronological order, where new or updated entries 
are added to the bottom of the list; see ‘Sorting entries’ later for more details. 

 You can select ‘Hide grid’ on the ‘Display’ menu to hide the lines in the List 
view’s table. The option automatically becomes ‘Show grid’ for when you want to 
show the lines again. 

Viewing individual entries 

Select ‘Find’ from the ‘♦ ’ menu or press  until the Find view is displayed. 

 

•  If the ‘Find:’ line is blank, you can press  to move through all of your entries 
in turn. Press  to clear the ‘Find:’ line if you need to. 

•  Press  to move back through your entries in the opposite direction. 

Each entry has a number which is displayed in the bottom right-hand corner of the 
screen. The total number of entries in the database is also shown. 

Finding an entry in the List view 

•  Start typing the person’s name. Data will search for matching entries on a 
letter-by-letter basis. Pressing  goes back one letter, and  returns the 
cursor to the first letter. 

 If you want to search by a different label in the List view, you have to change the 
label by which entries are sorted. See ‘Sorting entries’ later for more information. 

•  Press  if you wish to display the highlighted entry in the Find view - if, for 
example, you cannot see the whole of the address in the List view. 
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Finding an entry in the Find view 

•  Type a search clue, e.g. the person’s name, on the ‘Find:’ line and press  to 
find a matching entry. 

A search clue can be any piece of text which is in the entry you want to find - doctor, 
jones, doct and so on. It does not matter whether you type upper or lower case 
characters as the search is not case sensitive, e.g. DI would match with both Gliding 
and Diana . 

 The text you are searching for must be on one line. For example, DI would match 
with: 
 Diana Smith 
but not with: 
 Grantham Road

Inglebrook 

Searching backwards 
•  Type your search clue in the Find view, then press  instead of . 

If a matching entry is found 
If a matching entry is found in the Find view it is displayed in the main part of the 
screen, and the text which matched is briefly highlighted, for example:  

 

•  The lines you left blank when typing the entry are not shown. You see only the 
information you entered, correctly labelled. 

•  You will see a small triangular bullet beside the line in which the match occurred. 

•  If there are too many lines to show at once, use  and  to scroll the entry. 

•  You can use  and  to scroll the entry to the left and right to see text that 
doesn’t fit on the screen. (To make the text in your entries “wrap” to the width of 
the screen, you can select the ‘Wrap on’ option on the ‘Display’ menu.)  
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 All the entries in the database are included when you type a search clue and press 
. The search starts from the first entry. 

 To start the search at the entry which is currently displayed: select ‘Start at 
current entry’ from the ‘Search’ menu, type a search clue in the normal way, and 
then press  to start searching forwards from current entry, or  to 
start searching backwards. 

If more than one entry matches 
If a matching entry is found, you can keep pressing  to search for further matching 
entries. When Data finally fails to find another matching entry, a ‘No more found’ 
message is displayed.  

If you press  again, Data begins the search again from the first entry; or, press 
 to go back to the last matching entry you’d found. 

 To speed up searches, or limit your search to a particular label in the database, you 
can search using only one label of your entries e.g. just the ‘Name:’ or the ‘Notes:’ 
label. See ‘Searching by label - speeding up searching’ later for more details. 

If no matching entries are found 
If none of the entries contain the search clue you typed, a ‘Not found’ message is 
displayed. Press  to remove this message, or just start typing a different search 
clue instead. 

Finding a different entry 
To find a different entry, type the new search clue and press . It doesn’t matter 
whether an entry was shown, or ‘Not found’ or ‘No more found’ were displayed; as 
soon as you start typing the search clue, Data shows the first entry again, and when you 
press , it searches from the first entry onwards. 

Jumping straight to an entry 

•  If you know the entry number of the entry you want to find, select ‘Jump to entry’ 
from the ‘Search’ menu, and type the entry number in the dialog.  

 Remember that entry numbers may change as you add, change or sort your 
entries. 

In the List view, the highlight will move straight to the entry; in the Find view the entry 
will be displayed. 
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Searching by label - speeding up searching 

Searching by label in the Find view 
You can request a more specific search if you know which line of the entry your search 
clue will appear on. If you have lots of entries, or want to search for some text which 
could occur in more than one label (for example, if you are looking for your friend 
‘Steve’ but also have friends with addresses in ‘Stevenage’), you will probably find this 
is a more efficient way to search. 
For example, to search just the name line of all your entries for “Brown”: 
1. In the Find view, select ‘Find by label’ option on the ‘Search’ menu. 
2. Select the label you want to search by, e.g. ‘Name’. 

3. Press the  key and Name: will replace Find: in the bottom left hand corner 
of the screen. 

4. You can now perform the search: type Brown and press . 

Data will search as usual, but only in the information next to that particular label in each 
entry, e.g. ‘Mr Brown’ will be found, not ‘Brown Street’.  
You can leave a database file set up like this is you want to. You might, for example, 
keep it set to find by name if it is a database file which contains just names, addresses 
and telephone numbers, and you wish to use names as your search clues. 
 To search all lines in the database again: select ‘Find by label’ once more, and set 
‘Label’ to ‘All’. 

Searching in the List view 
•  When you first run Data and use the List view, your search always matches against 

the text in the Name column, regardless of the ‘Find by label’ setting you have 
selected in the Find view. 

•  By default, entries in the List view are sorted alphabetically by the Name column. 
You can, however, choose to sort entries by other columns; see ‘Sorting entries’ 
later for more information.  

 Important: If you have chosen to not alphabetically sort entries in the List view, 
you cannot use letter-by-letter matching to find entries. 
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Changing & deleting entries 

Updating an entry 

You can change any entry in your database. When, for example, someone’s phone 
number changes, you simply change the entry - you don’t have to type in a new entry. 
1. Find the entry you wish to change. 

2. Select ‘Edit entry’ from the ‘Edit’ menu, or press  until the Edit view is 
displayed: 

 

3. Change the entry details as required. You will notice that all the database labels are 
shown, including the ones that you didn’t need when you created the original 
entry.  

4. Press  to save this new version of the entry. 

If, while you’re editing, you want to cancel the changes you’ve made, press . You 
will be asked to confirm that you wish to lose the changes. The original entry will not 
be changed. 

 When you have finished adding or editing an entry in the database, and when you 
press  in the Find view, the first record in the database is displayed so that 
you are ready to start a search from the start of the file. 

Editing while you enter text 

The editing keys work as described in the ‘Getting started’ chapter. 

If you type information on the wrong line, perhaps by pressing  when you meant 
to use , you can move it easily: 

•  To move a line up: move the cursor to the start of the line, and press the 
key. All of the lines below also move up. 

•  To move a line down: move the cursor to the start of the line, and press . All 
of the lines below also move down.  
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•  To split a line into two lines, move the cursor to the place where you want to split 
the lines and press . 

The following options on the ‘Edit’ menu will also help you edit entries as you type 
them in: 

•  ‘Copy text’ makes a copy of any area of text you’ve highlighted by using  
with . 

•  ‘Insert text’ inserts the area of text you most recently deleted with , or 
copied with ‘Copy text’. 

•  ‘Bring text’ inserts text that you have highlighted in other applications on the 
Series 3c. 

•  Use ‘Evaluate’ to make calculations while you’re typing. E.g. type 2+4 (without 
spaces), then without moving the cursor, select ‘Evaluate’. The calculation will be 
left highlighted, so you can delete it, if you wish by pressing . 

Deleting an entry 

1. Find the entry you wish to delete in the Find or List views. 
2. Select the ‘Delete entry’ option on the ‘Edit’ menu. A dialog will be shown, asking 

for confirmation before deleting the entry. 
Each time you delete an entry it will disappear from view but the space it takes up is not 
automatically reclaimed. To make sure that this is reclaimed you need to compress the 
file. See ‘Compressing your Data files’ later for further details. 

Copying entries 
You can copy an entry, or some lines of an entry to: 

•  another entry which already exists in the database. 

•  a new entry in the database. 

•  another application on your Series 3c, e.g. the Agenda. 

•  another Series 3c or Siena using Infrared. See the ‘Infrared’ chapter for more 
details. 
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Copying all or part of an entry 
1. Find the entry to copy in the List or Find view, then press  to move to the Find 

view if it is not already displayed. 

2. If the cursor is flashing on the ‘Find:’ line, press  to move it into the entry text 
itself - the cursor changes to a triangular bullet which you can move through the 
entry using . 

3. Highlight the lines you wish to copy using . 

 You are not editing any lines that you highlight in the Find view; only the Edit 
view and ‘Edit’ menu option re-edit an entry. 

4. Select ‘Copy text’ from the ‘Edit’ menu. The blank lines next to unused labels 
(which are not displayed in the Find view) are also copied. 

5. To copy the information to a new entry: press  to move to the Add view. The 
cursor will be on the first line of the new entry. 

 To insert the information into an existing entry: find the entry you want to copy 
the information to, and press  to move to the Edit view (or select ‘Edit’ on the 
‘♦ ’ menu). Move the cursor to the appropriate place for inserting the information. 

6. Select ‘Insert text’ from the ‘Edit’ menu, and the copied text is inserted. Each line 
should match up correctly with its label, although you can move text up and down 
quite easily - see ‘Editing while you enter text’ earlier. 

7. Press  to save the copied entry. 

Copying an entry to another application 
You can copy information from Data to another application such as Word, for example 
to insert an address from a database entry at the beginning of a letter in Word. To do so: 
1. In Data, find the entry in the Find view, or highlight it in List view. 
 If you want to copy only a few of the lines, highlight the relevant lines from the 

entry in the Find view using . 

2. Move to the other application, without exiting Data. 
3. In the other application, position the cursor where you want to insert the lines from 

the Data entry. 
4. Select ‘Bring text’ from the ‘Edit’ menu to insert the information. 

Copying an entry to another Data file 
You might wish to copy an entry to another Data file. To do so: 
1. In the first file, find the entry in the Find view, or highlight it in List view. 
 If you want to copy only a few of the lines, highlight the relevant lines from the 

entry in the Find view using . 

2. Press the System button to move to the System screen. Do not exit the Data file. 
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3. Move the highlight to the name of the file you want to copy the entry into, then 
press  to open the file, without closing the one that is already open. 

4. Position the cursor where you want to insert the lines from the Data entry. 
5. Select ‘Bring text’ from the ‘Edit’ menu to insert the information. 

Sorting entries 
Initially, your entries will be sorted into alphabetical order by ‘Name’ each time you 
open Data. (So if you haven’t closed and re-opened a Data file, any new entries will not 
appear in their correct position alphabetically.) You can also choose to: 

•  sort entries by a different label, or by multiple labels. 

 It may be useful to sort by multiple labels if you have a number of contacts at the 
same company in a business contacts database, for example - you can sort by 
‘Company:’ then ‘Name:’. See ‘Changing the database labels’ later for more 
information about how to add labels for ‘Company’ etc. 

•  turn off alphabetical sorting to display entries in chronological order. New or 
updated entries are then added to the end of the database, appear at the bottom of 
the list in the List view, and have the highest entry numbers. (Even if your entries 
have previously been sorted, Data always remembers the order in which you enter 
or change entries.) 

 If you have edited the labels in a database (see ‘Changing the database labels’ 
later), automatic sorting will not take place. You can re-sort the entries as 
described in the following section. 

Changing the way that entries are sorted 
•  To turn off alphabetical sorting (to display entries chronologically): select 

‘Sorting’ from the ‘Search’ menu and set ‘Sort file’ to ‘No’. 
 You should also select ‘Set preferences’ and set ‘Sort on opening file’ to ‘Ask’ or 

‘No’. See ‘Sorting on opening a database’ later for more details. 

•  To turn on alphabetical sorting (or “re-sort” entries manually): select ‘Sorting’ 
from the ‘Search’ menu and set ‘Sort file’ to ‘Yes’. 

•  To sort the entries by a different label: select the ‘Sorting’ option from the 
‘Search’ menu, and press  on the ‘Sort by...’ line to display the ‘Sort by label’ 
dialog. Set the ‘First label’ line to the label you want to sort by. 

 When you sort by a label, you can also search by this label in the List view. 

•  To sort by more than one label: display the ‘Sort by label’ dialog as above, and 
set the ‘Number of labels’ line, up to a maximum of 3. Set the lines in the dialog 
for the second label (and third, if required). 
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•  To change the direction of the sort (forwards to backwards etc.): set the 
‘Direction’ line for each label in the ‘Sort by label’ dialog; ‘Forwards’ sorts entries 
A-Z and ‘Backwards’ Z-A. 

 If you have a very large number of entries in your database (probably more than 
about 3000), you may find that sorting and searching can take quite a long time. 
You may find that you can speed up the search by decreasing the ‘Sort key size’. 
This determines the number of letters from each entry that are held in memory 
when searching and sorting, and the number of letters matched in the List view. 
The sort key size can be any number of letters between 3 and 16. For most 
databases, you will not need to change it. 

Sorting on opening a database 
When you create a new database file, Data will automatically sort the file into 
alphabetical order every time you open it. You will see a message saying that the file 
has been sorted - e.g. "Friends" sorted. 

If you don’t want the Series 3c to do this (because you would like entries to be 
displayed in chronological order), or you would like it to ask you whether or not to sort 
the file when you open it: 
1. Select ‘Set preferences’ from the ‘Special’ menu. 
2. Set the ‘Sort on opening file’ line to ‘No’ or ‘Ask’. 

Changing how Data looks 
There are many ways you can change the display in Data to suit the way you want to use 
it, as described below. 

Setting up the ♦♦♦♦  list 

The  key can swap between the four Data views - the Find view, the Edit view, the 
Add view and the List view. 
You can choose which views are included in the list, perhaps to only include the views 
that you use most frequently. For example, if you refer to your database a lot but do not 
change or add entries as often, you may find it preferable to  key step between the 
Find and List views only.  

1. Select ‘Set up ♦  list’ from the ‘♦ ’ menu. 

2. Set each line in the dialog to ‘Yes’ or ‘No’ as required, and press . 

You can still use the different views by selecting them from the menu (or by 
pressing their hot-keys). 
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Changing the appearance of text on the screen 

•  To increase or reduce the size of text displayed on screen: use the ‘Zoom in’ 
and ‘Zoom out’ options on the ‘Special’ menu. 

 The size of the text displayed is remembered for each individual view, and can 
affect how much of an entry is visible. You may, for example, prefer to use smaller 
text in the List view than the Find view so that more columns are visible. 

•  To increase the screen space available for your entries: use  to 
reduce the size of the Status window or remove it altogether. You can use 

 to display it again. 

•  To word-wrap text at the edge of the screen: select ‘Wrap on’ from the ‘Display’ 
menu. If you set ‘Wrap on’, you won’t have to use  to see the end of a long 
line. 

 When you select the ‘Wrap on’ option, its name changes to ‘Wrap off’. Select it 
again, and Data will no longer word-wrap each line. 

 Word-wrap does not affect the way you find entries. For example, if your search 
clue is green bay, entries containing green bay will match even if bay has 
been word-wrapped onto a different line from green. 

 You can use soft hyphens, hard hyphens and non-breaking spaces for precise 
control of word-wrap. See the ‘Word’ chapter for more details. 

Changing the database labels 

You can change the labels in your database at any time, although it is usually best to set 
up your labels before you start adding your entries. 

 If you want to add a label after you’ve typed entries into a database, it is best to 
add new labels to the bottom of the list. If you add new labels before existing ones, 
you may need to re-edit your existing entries so that they match the new labels. 
However, if you add new labels at the bottom, existing entries will not be affected. 

To change the labels: 
1. Select the ‘Edit labels’ option on the ‘Edit’ menu to edit the database labels, then: 

•  To change an existing label: simply change the text as required. 

••••  To insert a blank line between labels: press . When editing labels,  
 has the same effect as . 

•  To insert a new label: press  to insert a blank line, then type the new label. 

•  To insert a telephone symbol (����): press  with the Dial keypress  
(i.e. ). These lines will be searched for phone numbers when you 
use DTMF dialling. See ‘Dialling’ at the end of this chapter for more details. 
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2. When you’re happy with the new labels, press . You are returned to the 
original view, with the new labels in place. Alternatively, if you change your mind, 
press  and then confirm that you wish to abandon the changes. 

 Remember that editing the labels will switch off alphabetic sorting. To re-sort the 
file, select ‘Sorting’ from the ‘Search’ menu and set the ‘Sort file’ line to ‘Yes’. 

 There is a maximum screen width which the labels can occupy; if one is too long it 
will be highlighted, and a ‘Label too long’ message will be shown. Edit the labels 
again to avoid this. 

Turning labels on and off 

•  To remove the labels in each view so that the whole screen is available for your 
entries, select ‘Hide labels’ from the ‘Display’ menu. 

•  To turn them back on, select the option from the same point on the ‘Display’ menu 
which has now become ‘Show labels’. 

Columns in the List view 

Freezing & unfreezing columns 
You can “freeze” a column so that it is displayed in position even if you scroll the 
screen using . Initially, the ‘Name:’ column is frozen so that it is visible while you 
are looking at the information in the ‘Address:’ and ‘Notes:’ columns - you can then 
read across to see the ‘Name:’ for each column. 
1. Select ‘Set columns’ from the ‘Display’ menu. 
2. To freeze additional columns: change the setting on the ‘Freeze leftmost’ line. 
 To turn off column freezing: set the ‘Freeze columns’ line to ‘No’. 

To change the widths of columns 
You can press  to change the width of the leftmost column by a small 
amount at a time. Or, similarly, you can press  to change it by a 
larger amount at a time. 

 The above keypresses cannot change the width of columns that are ‘frozen’ - see 
‘Freezing & unfreezing columns’ for more details. 

Alternatively: 
1. Select the ‘Set columns’ option the ‘Special’ menu. 

2. Set the ‘Column line’ to the column you wish to change, and use  to change 
the width. 
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Data files 
Initially, all of the entries you save are kept in one file. Unless you specify otherwise, it 
is kept on the Internal disk, with Data as the filename. 

Creating a new Data file 

You can use more than one database file in Data. You might, for example, want a 
business database and a personal database. 
You can create new Data files from the System screen, or from within an existing Data 
file: 
1. If you are on the System screen, first move the highlight to one of the names below 

the Data icon.  
2. Select ‘New file’ from the ‘File’ menu. 
3. Type a name for the new file Business, for example. The name can be from one 

to eight letters long; the name can include numbers, but the first character must be 
a letter. 

4. Press , and a new blank database is made for you. The Add view is 
displayed, ready for you to type new entries. 

In the System screen, you’ll now see two names under the Data icon Data, the original 
database you were using, and the name of the new database you have created. To use 
either database, move the highlight onto the file you want in the System screen, and 
press . 

Creating labels for new files 
Each database file has its own set of labels. When you create a new file, Data 
automatically gives it the same “address book” labels you’ve seen before. 
You can change these labels, invent new ones, or hide them altogether. See ‘Changing 
the database labels’ earlier for more details about using and changing labels. 

 Do think carefully about which labels to use, and, if possible, set them up before 
you type in your entries. 

 Once you’ve started typing in entries, adding or removing labels could mean 
re-editing entries to match.  
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Merging two Data files together 

You can merge all the entries in one Data file to another. You might wish to do this, for 
example, to combine your business and personal address books into one large address 
book. 
To merge two database files: 
1. Open the Data file that you wish to contain all the entries. 
2. Select ‘Merge in’ from the ‘File’ menu. 
3. Select the Data file whose entries you wish to merge into the current one on the 

‘From: Name’ line. (If the Data file whose entries you wish to merge in is saved on 
an SSD, you will need to change the setting on the ‘Disk’ line of the dialog before 
the Data file will be listed on the ‘From: Name’ line.) 

As well as Data files, you can also merge in text files. To do so you just need to change 
the setting on the ‘Merge in’ line of the ‘Merge in’ dialog to ‘Text’. 

 Data is only able to merge in the first 255 characters of each line in any text file 
that you choose to merge in. 

Compressing your Data files 

When you delete an entry from a Data file, the space it takes up is not automatically 
reclaimed. Similarly, when you re-edit an entry and press  to put in the new 
version, space is still taken up by the old version. You need to “compress” the file to 
reclaim this space; it’s a good idea to do this if you’ve recently deleted or changed a lot 
of entries. 
To reclaim the space used by deleted and modified entries: 
•  Select ‘Compress file’ from the ‘File’ menu. 
The ‘Compress file’ option does not work if the Data file is saved on a Flash SSD, 
though it does if it is saved on a Ram SSD.  
If you fill all of internal memory and are unable to enter more information into your 
Series 3c, one of the first things to do is to compress your database (or databases). If 
this does happen to you, see the ‘Troubleshooting’ chapter for more ideas about freeing 
internal memory. 

Saving Data files on Flash SSDs 
If you have a large database which you change very rarely, it may be a good idea to 
store your database files on a Flash SSD, as it is an extremely secure place to keep 
information. Additionally, as Data reads entries from the file into internal memory only 
when necessary, you can look at large database files without running out of memory. 
However, every time you delete or update an entry, the space used by the deleted 
information on the Flash SSD is not reclaimed. 
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To compress Data files stored on SSDs: 
•  Select the ‘Save as’ option to create a new copy of the file on the internal disk, or 

on another SSD. Wherever you create the new file, it will be compressed.  
To reclaim the space used by the Data file on the SSD you will need to copy all the 
information you wish to keep on the SSD to another location, reformat the SSD, then 
copy the information back. See the ‘System screen’ chapter for further information 
about using SSDs. 

Saving Data files as plain text files 

To save a Data file as an ASCII text file, for use on another computer for example: 
1. Select the ‘Save as’ option on the ‘File’ menu. 
2. Set the ‘Save as’ line to ‘Text’ to save a copy of the database as plain text. 
3. Now specify how the lines of information in each entry of your database should be 

delimited (separated) with the setting on the ‘Delimeter’ line. You can make each 
line of information start on a new line in the text file, or have all the information on 
the same line, separating each piece of information by a tab, comma, semi-colon or 
any other ASCII character.  

 If you choose ‘Other’ as the delimiter, type the character code of the character to 
use on the next line of the dialog. (The Series 3c character codes are listed in an 
appendix to this manual.) 

 If the file was previously sorted into alphabetical order, the text file you create will 
preserve this order. 

 Data can only save the first 255 characters in each line of your entries. 

Dialling 
Modern phone systems understand DTMF signals - the sounds you hear when dialling 
from a push-button phone. The Series 3c can generate these DTMF signals, and you can 
use it to dial numbers from most phones. 
You can: 

•  dial numbers directly from any Data file, such as an address book, and from any 
Agenda file. As long as you take a little care in the way you enter international 
numbers, the Series 3c will also generate the correct code for international calls, 
wherever you set your current ‘home city’. 

•  dial numbers from a “Free-form dialler” - you simply type in the number to dial. 

•  insert a “dial out code” if you are dialling from a private exchange, or if you need 
to insert a code before a number to use a telephone chargecard or calling card. 
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•  dial numbers up to 24 digits long. If you dial a number which is longer than 24 
digits, you will see a ‘Number not valid’ message. 

All you have to do is find or enter the number that you wish to dial and press the Dial 
keypress, wherever you are. 

 Phone systems do vary. DTMF dialling cannot be guaranteed to work with all 
types of phones. 

Setting up for dialling 
Before you can use the Dialling feature, you need to select various dialling settings: 
1. Move to the System screen, and select the ‘Dialling’ option on the ‘Control’ menu: 

 

•  If you wish to dial out from a workplace or other environment, set the ‘Dial out 
code’ line to the code you use to get an outside line. You can enter up to five 
characters; use a comma for a short pause, which is often required when requesting 
an outside line. When you dial a number in the future, you will be given the option 
of dialling it directly or dialling this code at the beginning. 

•  Set the ‘Default country’ line of the dialog to the country for ordinary (non-
international) phone numbers in your address book. This will normally be the same 
as your usual home country. 

 It is important to set this correctly, so that when you travel abroad and change the 
setting for your ‘Home city’, the Series 3c will supply you with the correct 
international dialling codes. 

•  You can customise tone dialling using the other three lines of this dialog. ‘Tone 
time’ and ‘Delay time’ are the length of each tone and the length of the gap 
between each tone; ‘Pause time’ is the length of the pause caused by a comma, as 
described above. All three are specified in 1/32 of a second. 

 You can probably leave these settings as they are. However, you may find you can 
obtain quicker connections by reducing the ‘Tone time’ or ‘Delay time’ settings. 

 You may find that increasing ‘Tone time’ and ‘Delay time’ improves the chance of 
success over less-than-perfect connections. If you have no problems with dialling, 
though, you may like to reduce these values, to reduce the time taken by DTMF 
dialling. 
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How to ‘dial’ a number 

You can dial numbers in your Series 3c directly from the Find or List screen in Data, or 
from any view in the Agenda. 
From Data, you can only dial numbers that appear on lines that include the � symbol 
either in the label or the entry text, e.g. �Home. � is a special symbol, which marks 
the line for “phone numbers for dialling”. Data allows you to dial numbers on these 
lines even if you have chosen to hide the labels.  

Dialling numbers in a Data entry 
1. Find the database entry which contains the phone number you wish to dial, then 

press  (Dial). The ‘Dial’ dialog will appear, giving a list of all the 
phone numbers in the entry: 

 

 If the number you want to dial is not shown, press  to remove the dialog and 
check that either its label or the line itself has a phone symbol. (It is also possible 
for a single entry to have too many phone numbers to be shown on the screen.) 

2. Select the number that you wish to dial. If you need to, you can edit the phone 
number on the highlighted line like any other text on the Series 3c. Any characters 
you enter which cannot be dialled will be ignored when you dial. (A comma 
generates a pause.) 

3. Hold the mouthpiece close to the Series 3c, about an inch or so away. In noisy 
conditions, it may be better to hold the Series 3c with the loudspeaker itself (on the 
underside of the Series 3c) above the mouthpiece. 

4. Press  to dial the number directly. At work, you may need to press , to 
dial the number with the ‘dial out’ code (set with the ‘Dialling’ option in the 
System screen). 

5. If you need to dial further digits, such as when dialling automatic tone-controlled 
systems, press . The ‘Free-form dialling’ dialog will appear in which you can 
type the extra digits. Digits are then dialled as you type them. You can press  
to redial them, if necessary. When you’ve finished with free-form dialling, press 

. 
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 Entering other numbers in Data 

 You can also mark a telephone number on any other line of the database entry, 
perhaps in the ‘Notes:’ line, or in any Agenda entry. Press  to 
insert the � symbol, follow this with a title for this phone number, if you wish; 
then enter the number itself. 

 See ‘Changing the database labels’ for information about editing labels, and 
inserting the � symbol yourself. 

Dialling numbers in an Agenda entry 
You can enter phone numbers in any Agenda entry. You don’t need to insert a 
telephone symbol before the number to mark it as a phone number, unless the entry also 
contains other numbers - e.g. “Phone A’s taxis � 071 333 4444”. To insert a phone 
symbol at the cursor position in an entry, press . 

To dial the number: 

•  Move the cursor to the Agenda entry and press . 

If you travel abroad 
Set your home city to your new location, or to that of a nearby city in the same country. 
As long as the local phone system understands DTMF signals, dialling should be 
possible. 

Entering phone numbers in Data 

How you enter type in each telephone number into your Series 3c (i.e. into Data or 
Agenda) can affect how the DTMF dialling works in your own country and more 
especially, if you travel abroad: 

•  Type telephone numbers which are in your own country with their area codes. This 
applies to local numbers too, so that they can be dialled correctly when you leave 
your local area.  

•  Use a space or hyphen to separate the area code from the rest of the number - e.g. 
0171-9998080, 415 0009999, or 0636 999111. 

•  You can also use slash characters ( ‘/’ ) and brackets in the number.  

•  Numbers which have no non-numeric characters - just the digits themselves - are 
treated as work extensions, or similar codes, and are always dialled exactly as they 
appear. 

•  You can enter text after the number if you wish. Nothing after the text will be 
dialled. For example, you can enter an extension as in 0636 999111 x444 only 
the main number will be dialled, because of the x . 

•  A dot (full stop) terminates an entry, i.e. digits after it will be ignored. 
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Entering international numbers 
If you want to be able to travel abroad and still dial numbers from the Series 3c, enter 
international numbers in one of two ways: 

•  If you know the country code, you can begin the number with +, then the country 
code. You can enter the Swedish number 031 999999 as +46 31 999999, or 
+46 (0)31 999999 . (The country code for Sweden is 46. In the area code 
031, the 0 is the national prefix. You don’t have to enter it, but if you do it must be 
in brackets.) 

•  If you do not know the country code, you can just assign the correct country to the 
telephone number, then let the Series 3c insert the correct code when you dial. 
Move the cursor to the end of the number, and press  to 
display the ‘Append country’ dialog. Select the country and press . The 
country name will appear at the end of the number, between square brackets - for 
example: 031 999999[Sweden] With this system the national prefix is 
optional. 

 You can, if you wish, type the square brackets and country name yourself, without 
using .  and  produce the left and 
right square bracket characters. 

 Make sure that you type the country name correctly; if you try to dial a phone 
number which includes the name of a country which the Series 3c does not 
recognise, a ‘Number is not valid’ message is displayed. 

When dialling such a number from a different country, any national (STD) prefix is 
removed. The number to dial will begin with the international access code of your 
current home country, then the country code of the country you are dialling. For 
example, with the home city in the UK, the Swedish number would be dialled as 
00-46-31-999999 . (00 is the international access code from the UK.) 

 

 If you enter the international access code yourself, the number can only be dialled 
correctly while you stay in that country. 

 A few small countries share their dialling code with a nearby larger country. They 
are shown in World as if they were a city within the larger country, and you should 
use the name or dialling code of the larger country. 
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Entering numbers while abroad 
If you go abroad, you should still enter numbers in exactly the same way. Numbers for 
your default dial country do not need the country code or name adding, even though 
you are abroad. All other numbers, including those of the country you are in, must have 
the country code or name. 
You should change your home city when travelling, but do not change your default dial 
country. If you do, you will not be able to dial existing numbers correctly. 

 Work extensions, or other codes, should be entered with no spaces or hyphens. 
They will then always be dialled exactly as they appear, and no checking of 
international codes will take place. 

Dialing in the USA 
If your home city is in the USA, then when you dial from an address book the digit 1 
(the national prefix) will be added at the start of all numbers in the USA. This generates 
the correct number for most calls around the country. The number to be dialed can be 
edited, though, so you can always remove an unwanted 1 (and/or any area code, if you 
so wish) by pressing . 

If most of your calls are local and you do not want the 1 to be added in this way, find a 
city in the USA in the World application, use the ‘Update country’ option and remove 
the national prefix. 

Dialling problems 

If dialling fails, try altering the distance between mouthpiece and speaker. If this still 
fails, you can try increasing the ‘tone time’ and ‘delay time’, using the ‘Dialling’ option 
on the System screen. The longer the time you set for ‘tone time’ and ‘delay time’, the 
better the chance of tone dialling succeeding when the phone connection is poor. 

 Remember that phone systems do vary, and DTMF dialling cannot be guaranteed 
to work on all phones. 

Free-form dialling 

Whatever you’re doing with the Series 3c, you can almost always press 
 to display the free-form dialler. 

As explained beforehand, digits are now dialled as you type them. The digits you type 
are displayed on the screen, and you can press  to redial them, if necessary. 

 Very occasionally, such as when an alarm is being shown, free-form dialling is not 
available. 
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Example setups 
There are many uses for Data files. The examples here may give you some ideas to get 
started. 

A business contacts database 

You can set up a Data file as a business contact list, and change the labels to match your 
business requirements accordingly: 

 

A CD catalogue 

You can also keep records of a collection, perhaps music or books. 

•  You can add labels such as ‘Artist:’, ‘Title:’ and ‘Format:’ perhaps for music, or 
‘Author’ and ‘Title’ for books. 

•  If you want to catalogue classical CDs, you may prefer to include labels for 
‘Composer:’, ‘Orchestra:’, ‘Conductor’ and so on. 

Your database will be useful if you ever need to assess the value of your collection, e.g. 
for insurance purposes. As with all files, back up the file to an SSD or PC, in case you 
lose your Series 3c. See the ‘Security & backups’ chapter for more about backing up 
your files. 



 97

 

Jotter 

The Jotter is the ‘notepad’ in your Series 3c. You can use it to note 
down information quickly, perhaps while on the telephone or in a 
meeting. 

This chapter shows you how to: 

••••  write a note. 

•  copy a note, or text from a note, to another application. 

•  change a note, or delete it. 

•  set up Jotter so that a blank note is available whenever you 
switch on using the Jotter button. 
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Introduction 
You can use Jotter to note down information quickly, perhaps while on the telephone or 
in a meeting. If you need to, you can copy the information to another Series 3c 
application later, or send it by Infrared to another. Or, you can just leave it as a note in 
Jotter. 
There is no limit to the number of notes you can keep in Jotter. You can even keep 
notes in different Jotter “files” (See ‘Working with Jotter files’ later).  

Adding notes 
The first time you open Jotter, it will display the Add view ready for you to type in your 
first note: 

 

To type your note: 
1. Just type in whatever text you need. Your note can continue onto more pages if 

necessary; simply carry on typing. 
 You can use the usual options on the ‘Edit’ menu to copy and insert text. 

 To insert the current date in a note, select ‘Insert date’ from the ‘Edit’ menu. 

2. When your note is complete, press  to move to the List view, or select 
‘Add note’ again to display a blank page. 

To start a new note at other times, you can: 

•  Press  until the Add view is displayed, or select ‘Add’ from the  menu. 

•  Select the ‘Add note’option on the ‘Edit’ menu. 

•  Highlight a blank entry in the List view and press  - the last entry in the List 
view is always a blank note indicated by a blank line with a square bullet. 

•  Press the Jotter button on the Buttonbar (if you have set up a preference to start 
new notes this way). It is a good idea to set up Jotter in this way so that it is always 
available if you need to note something down quickly. See ‘Starting in Add view’ 
later for more details. 
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Starting in Add view 

 You can set up Jotter so that a blank note is ready for you whenever you press the 
Jotter button. You can then start writing a note after a single keypress, even if your 
Series 3c is switched off. 

To do this: 
1. Select ‘Set preferences’ from the ‘Special’ menu. 
2. For a new note: 

•  Whenever you press the Jotter button (i.e. if you switch on or move from another 
application), set ‘Always start in “Add”’ to ‘Yes’. 

•  Whenever you press the Jotter button to switch on your Series 3c, set it to ‘Only 
when turning On’. 

 Alternatively, set ‘Always start in “Add”’ to ‘No’. Jotter will then start in the List 
or Edit view, depending on which view you were last using. 

Important: If you want to use these quick keypresses, make sure that you leave Jotter 
running all the time - press another application button to move on to your next task, 
rather than exiting. Otherwise, you will need to open Jotter in the System screen before 
you add a note. 

Finding notes 
You will often be able to find the note you want by glancing at the list of notes in the 
List view, especially if you entered a “title” which helps to identify the note straight 
away. 
You can also move between notes easily in the Edit view. Use ‘Next note’ and 
‘Previous note’ on the ‘Search’ menu. 

Showing a list of notes 

You can list all the notes in your Jotter file by title: simply press  until the List view 
is displayed: 
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The first few words or characters of each note in the Jotter file is displayed on each 
separate line. The text shown can be thought of as a “title” for the note. A comma in the 
title is used to indicate the start of a new line in the note. 

 You can choose whether Jotter shows a line between each note in List view. Select 
‘Show grid’ or ‘Hide grid’ from the ‘Special’ menu as appropriate. 

•  To scroll the list: use ; use Pg Up and Pg Dn if the list of notes extends 
onto more than one page. 

•  To display a note in Edit view: highlight the title and press . 

•  To start a new note: press  on the last line in the list - a blank line with a 
note bullet. 

Listing notes by date 
When you first use Jotter, you will see the notes listed in the order in which you wrote 
them. New notes are added to the bottom of the list. You can change the display so that 
the most recent notes are shown at the top or bottom of the list. 
To lists notes by date: select ‘View by’ from the ‘Search’ menu. Set the ‘View order’ 
to ‘Most recent’ and the ‘Direction’ to ‘Forwards’ or ‘Backwards’ as required. 
Although the notes are listed according to the order in which they were written, the date 
itself is not shown automatically. If you want to show the date in the List view, use 
‘Insert date’ from the ‘Edit’ menu to insert the date in the title, perhaps even as the first 
“word” of the note. 

Listing notes alphabetically 
To list the notes alphabetically: select ‘View by’ from the ‘Search’ menu. Set ‘View 
order’ to ‘Alphabetical’ and the ‘Direction’ to ‘Forwards’ or ‘Backwards’ as required. 
If you like to use your Jotter alphabetically, you can perhaps use a keyword or phrase as 
the first word of each note to index them. The note will then be easier to find in the list. 

Searching for a particular note 

1. Select ‘Find’ on the ‘Search menu. 

2. Type the text you want to find and press . 

Jotter will search for this text in all the notes, not just in the titles. 
If you search in: 

•  List view - the line for the first note Jotter finds which contains the text is 
highlighted. Simply press  to display the note in Edit view. 

•  Edit view - Jotter will display the first note which contains the text. 
In either case, use the ‘Find again’ option to find the next note which contains the text. 
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Reading & changing notes 
You can read and change any note. Highlight the note you need in List view, then 
display it in Edit view by either: 

•  Pressing . 

•  Pressing  until Edit view is displayed, or select ‘Edit’ from the ‘♦ ’ menu. 

•  Select ‘Edit note’ from the Edit’ menu. 

You can then make your changes. Use the ‘Copy text’ option or  to copy or 
move highlighted text to the clipboard. Use ‘Insert text’ to insert it again. Your changes 
will be saved when you ‘close’ the note, i.e. change to the List view, or exit Jotter. 

 You may want to control which views are used in the ♦  list using ‘Set up ♦  list’ 
on the ‘♦ ’ menu. You could perhaps remove the Edit view from the list so that 
you can move more quickly between the Add and List views. You can still edit a 
note from the List view by highlighting it and pressing , or selecting ‘Edit’ 
from the ‘♦ ’ menu. 

Deleting notes 
To delete a note, highlight the note in the List view and either: 

•  press , or 

•  select the ‘Delete note’ option on the ‘Edit’ menu. 

Copying notes 
You can use Jotter to store all your notes for as long as you like, although it is easy to 
copy notes, or parts of them, to other applications on your Series 3c. You can also use 
Infrared to send notes from Jotter to other Psions which have Infrared. 

Copying notes to other applications 
Use the ‘Bring’ option in other applications to copy notes or text from Jotter. 
To copy: 

•  An entire note: Highlight the note in the List view, switch to the other application 
and use its ‘Bring’ option. 

•  Part of a note: Display the note in the Edit view, and highlight the text to copy 
using . Switch to the other application, and use ‘Bring’. 
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 The note, or the text you highlight, is copied, rather than moved when you use 
‘Bring’. You can copy the same note from Jotter to more than one application if 
you want to.  

If you don’t need to keep the note in Jotter after you have copied it to another 
application, remember to delete it. 

Sending notes by Infrared 
You can use Infrared to transfer notes from Jotter to another Series 3c or Siena. 
You can send notes (or highlighted information) to the Jotter application on the Psion 
you are transferring to, or directly to another application (e.g. Data, Word). 
See the ‘Infrared’ chapter for more details. 

Working with Jotter files 
All the notes you enter in Jotter are saved in a “file”, just like all the other information 
you enter on your Series 3c. See ‘The System screen’ chapter for detailed information 
about files on the Series 3c. 
If you want to, you can create other Jotter files. 
You could start a new Jotter file solely for notes on a particular subject, for example, or 
keep separate files for work and personal notes. 
If your Jotter file becomes large, you do not have to delete entries. You can simply start 
another file and keep the original file on your Series 3c for reference. Alternatively, you 
could move the original file to your PC or an SSD (Solid State Disk). 
To start a new file, either: 

•  use the ‘New file’ option on the ‘File’ menu in Jotter, or 

•  highlight the Jotter icon in the System screen and use ‘New file’ there. 

Compressing Jotter files 
A Jotter file should be compressed periodically to remove all the deleted notes, which 
will still take up space on your Series 3c - even though they are no longer visible. 

•  Select the ‘Compress file’ option from the ‘File’ menu. 
See ‘The System screen’ chapter for more information about compressing files. 
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Time 

When you switched on your Series 3c for the first time, you 
probably used the Time application to set:  

••••  the time and date, and 

••••  your home city. 

The Time application lets you do much more: 

••••  display the time and date in the format of your choice. 

••••  specify your workdays, and on which day your week starts. 

••••  turn summer times on and off for cities all over the world. 

••••  set alarms to wake you in the morning, or remind you of 
something. 

••••  check the alarms you’ve set in the Agenda. 
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Time screen 

 

Press the  button on the Buttonbar to move to the Time application. The Time 
screen shows: 

•  the current time, as both a digital and a large analog clock; 

•  the date; 

•  your home city; 

•  details of any alarms you have set (you can set up to six alarms); 

•  a reminder of the time until the next alarm. 

 Time is the only application on your Series 3c that is always running and cannot be 
exited. 

Setting the time & date 

If you haven’t already set the current time and date, you should do so now. 
Firstly set your Home city: 
1. Select ‘Home city’ from the ‘Settings’ menu. 
2. Set the ‘City’ line to your home town or city.  

 If the Series 3c beeps, then it doesn’t know about this city. Press , then 
either:  
•  enter the name of a nearby town or city, or 
•  add your own town/city - see the ‘World’ chapter for more details. 

Then set the current time and date: 
1. Select ‘Time and date’ from the ‘Settings’ menu. 
2. Enter the correct time and date. 

 The Series 3c is accurate to within a few seconds a week. Use the ‘Time and date’ 
option again if you ever need to correct the time. 
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 If you go on a short trip abroad, you don’t need to reset the time on your Series 3c. 
Use ‘Set Home city’ in the World application to change the home city to the place 
you are visiting. When you want to phone home, select your real home city on the 
left of the screen to find out the time at home and the dialling code you need. Set 
an alarm to remind you to reset your home city when you get back home! 

Changing the time & date formats 
The Series 3c initially presents dates in the form Day/Month/Year and times in am-pm 
with a colon (:) as the “separator” between hours, minutes and seconds. 
To change the way the time and date are displayed: 
1. Select ‘Formats’ from the ‘Settings’ menu. 
2. Set the ‘Date format’ to the way you prefer your dates to be displayed, for example 

‘Month/Year/Day’. 
3. Set the ‘Time format’ line to either ‘am-pm’ or ‘24 hour’, depending on how you 

like times to be shown. 
4. You can also change both the date and time separators: enter the character you 

want to use to separate the numbers in dates (when displayed in dialogs) and times. 

 You can always display the current time and date, no matter what you are doing on 
your Series 3c, just by pressing . A status window showing the time 
will be displayed for a few seconds. In most applications, you can press  

 to turn on a permanent status window. 

Setting workdays & the start of the week 

Workdays 
You can tell the Series 3c which days of the week you go to work (initially they are set 
to Monday to Friday). Then you can set alarms to go off on just those days (and not 
when you’re hoping to have a lie-in!). 
To change the workdays: 
1. Select ‘Workdays’ from the ‘Settings’ menu. 

2. Use  to move through the days, and choose  (workday) or  (rest day) 
for each day. 

3. Press . 

 Press  to see a vertical list of all seven days with their settings. See ‘Setting an 
alarm’ in this chapter for information on setting workday alarms. 
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Start of the week 
If you would prefer weeks in the Agenda application to start on a different day (and 
week numbers to reflect this): 
1. Select ‘Start of week’ from the ‘Settings’ menu. 
2. Change the setting to the day on which you prefer weeks to start, e.g. Sunday. 

Summer time or daylight saving 

Many countries set their clocks forwards an hour in the summer. There are two ways to 
deal with this to ensure that the Series 3c gives the correct time for your country: 

•  Set the time on the Series 3c to the current time, then use the ‘Time and date’ 
option to change the Series 3c’s time whenever the clocks go forward or back. 

 Create an Agenda entry to remind you when to change the summer time settings on 
the Series 3c. 

•  Or, set the time on the Series 3c to your country's winter time (in the UK, this is 
GMT - Greenwich Mean Time). Then, if the clocks are currently set to summer 
time in your country, use ‘Summer times’ on the ‘Settings’ menu, and set the 
‘Home is’ line to ‘On’; this will automatically change the displayed time by one 
hour. When the clocks go back to using winter time, use the ‘Summer times’ 
option again and change the ‘Home is’ line to ‘Off’. 

Countries around the world tend to fall into three separate zones, or groups, each of 
which treats summer time in a similar way. 
To take account of the summer time settings for other countries in the World 
application: 
•  Select ‘Summer times’ on the ‘Settings’ menu, and set the dialog lines to ‘On’ for 

approximately these periods:  
‘European’ end of March - end of September 
‘Northern’ early April - end October 
‘Southern’ late October - end of February 

An asterisk (*) is displayed below the current time for the Home country and selected 
country in World whenever those countries are set to summer time.  

 If you’re not concerned by some of the World times being wrong by an hour, you 
can forget the complexity of zones. Use the ‘Summer times’ option to change the 
summer time for your ‘Home’ on the first line of the dialog, and leave the three 
zones set to ‘Off’. 

Refer to the ‘World’ chapter for more details about zones. 



 107

Alarms 
The first time you move to the Time application there will not be any alarms set. You 
can set up to six alarms, which are displayed in the centre of the Time screen. 

Setting an alarm 

1. Using the  keys, move the cursor to any line which says No alarm set. 
Start typing either the time for the alarm, or the text you want to appear on the 
screen when the alarm rings. The ‘New alarm’ dialog is shown. 

 Note: You can also use ‘New alarm’ on the ‘Alarm’ menu. 

 

2. Type the ‘Time’ you want the alarm to ring, and choose the ‘Day’ that it should 
ring (leave set ‘Day’ to ‘Within 24 hours’ if you want it to ring later today or 
tomorrow morning).  

 Important: If you use ‘am-pm’ format, make sure you set “am” or “pm” correctly. 
3. For a single alarm: leave the ‘Repeat’ line set to ‘Once’. 
 For a repeating alarm: you can set the alarm to repeat ‘Daily’ (for example, a 

wake-up alarm that rings every day), ‘Weekly’ or ‘Workday’ (if you want an alarm 
to ring on your workdays only).  

 If you set a Workday alarm, you will need to use the ‘Workdays’ option on the 
‘Settings’ menu to specify the days you work. 

4. If you want a text message to appear with the alarm, type it on the ‘Text’ line. 

5. Select the ‘Sound’ for the alarm and press . 

 You can select any sound file on your disks to be the alarm sound, including those 
recorded using the Sound application. See the ‘Soundmaster’ chapter for more 
details. 



 108

The alarm details appear in the Time screen: 

 

•  If you set a workday or daily repeat, the day the alarm will next ring is shown in 
the alarm line. 

•  If the next alarm is due to ring in under 24 hours (including alarms set on Agenda 
entries), this is shown at the bottom of the screen. 

To change or delete an alarm 

•  Move the cursor onto the line for the alarm, then ... 
To change the alarm: 

•  Press . Change any of the details in the ‘Edit alarm’ dialog and press  
to save the changes. 

To delete the alarm: 

•  Press . Then press  to confirm deleting the alarm. 

 You can also use the ‘Edit alarm’ and ‘Delete alarm’ options on the ‘Alarm’ menu. 

Responding to a ringing alarm 

When an alarm rings, a dialog appears showing the text for the alarm and the time it was 
set for.  
Note: The Series 3c will turn on automatically, if necessary. 
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The dialog has the following buttons that you can use to respond to the alarm: 

 to clear the alarm 

 (Spacebar) to snooze the alarm for five minutes. Note: You can't use the 
Series 3c while an alarm is snoozed. To clear a snoozed alarm, press . 

 to silence the alarm 

•  Single alarms are removed from the list of alarms once they have rung. 

•  Repeating alarms are automatically set to ring on the next repeat date. 

•  Each press of   will snooze the alarm for five minutes at a time, up to a 
maximum of 60 minutes. To snooze the alarm for 15 minutes, for example, press 

 three times. 

 When the 60 minute maximum is reached, the Series 3c beeps and the snooze time 
returns to five minutes. If you accidentally snooze the alarm for longer than you 
intended (in the dark, for example), press  until you hear a beep and the 
snooze time will automatically return to five minutes. 

If you do not respond to a ringing alarm, it will ring at increasing intervals: 

•  For the first three minutes, it will ring every minute. 

•  The intervals increase to an hour. 

•  After the second hour-long pause, it will ring for the last time.  
The next time you turn on the Series 3c, the alarm dialog will still be shown. 

Agenda alarms 

You can also set alarms in the Agenda application. 

•  These are shown in the Time application when they are next to ring.  

•  Respond to Agenda alarms in the same way as for alarms set in the Time 
application. 

•  To see when the next Agenda alarm is due, select ‘View next alarms’ on the 
‘Alarm’ menu. 

Viewing next alarms 

You can check when the next alarm is due for Time and Agenda: 

•  Select ‘View next alarms’ on the ‘Alarm’ menu. 

•  If you do not have any alarms set in your Agenda or in Time, a ‘No alarm pending’ 
message will be displayed. 
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•  If an alarm is set, a dialog appears showing the length of time until the next alarm, 
the time of the event for which the alarm is set and the text of the entry or alarm. 

Disabling alarms 

You may want to temporarily disable an alarm, for example, your morning workday 
alarm when you have a day off work. 

•  Move the cursor onto the line for the alarm and select ‘Disable alarm’ on the 
‘Alarm’ menu. 

 An X will be shown by the alarm, and it will not ring. 

•  When you want the alarm to ring again, move the cursor to the disabled alarm and 
select ‘Enable alarm’ on the ‘Alarm’ menu. 

Turning off all alarm sounds 
You may want to do this to prevent alarms ringing while you are in a meeting, etc. To 
do so: 

•  Move to the System screen and select ‘Sound’ on the ‘Control’ menu. Set ‘Alarm 
sounds’ to ‘Off’. 
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Calc 

This chapter explains the features of Calc, the Series 3c calculator 
application. You can use it to: 

••••  perform quick calculations as you do with a simple pocket 
calculator, or more complex scientific calculations using, for 
example, scientific or hexadecimal formats. 

••••  calculate percentages. 
••••  perform calculations using trigonometric functions, logarithms 

and powers. 
Calc has one memory in the Desk view, and 10 separate memories 
in the Advanced view. 
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Introduction 
Calc has two different views that you can switch between with the  key: 

•  Desk view - for most calculations. When you first open Calc you will see the Desk 
view. 

•  Advanced view - for scientific calculations involving trigonometric functions (sine, 
cosine etc.), logs or powers. 

Calculations in both views are accurate to 12 digits. 

 Although Desk view only displays 10 digits on screen, the calculations are still 
performed to an accuracy of 12 digits. 

Pressing the  key in each view displays help for that view only. 

Calculations in the Desk view  
Just type in your calculation using the number and operator keys (+, - , * and / ) on the 
keyboard. 

•  Press = or  to get the result. The calculations and results appear on the 
“till roll” in the main part of the screen: 

 

•  Calculations are worked out from left to right - there is no operator precedence, 
e.g. 7+3*4=40 in this view. 

 When using a number between 0 and 1 in a calculation, you can miss out the 0, 
e.g. you can use .5 instead of 0.5, and so on. 

•  To multiply a number by itself quickly (i.e. to square it), use *=. 

•  To multiply a number by two (i.e. to add it to itself), use +=. 

•  To calculate a reciprocal, use /= , e.g. 5/= for 1/5. 

Changing the sign of a number 
•  Use ‘Change sign’ on the ‘Edit’ menu to change the sign of the current number. 
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Clearing calculations 
•  Press  once to clear the last number entered, or select ‘Clear entry’ from the 

‘Edit’ menu. 

•  Press  twice or select ‘Clear all’ from the ‘Edit menu to clear the entire 
current calculation. 

•  Press  a third time to clear the till roll. 

Starting a new calculation 
•  Type the first number and the calculation line will clear. Or, press  to clear 

the calculation line. 

Errors 
If you accidentally type something that cannot be calculated, e.g. 7/0=, you’ll see the 
error message E.
•  Press  to remove the ‘E.’ from the calculation line. Start a new calculation 

as usual. 

Constant expressions 

In the Desk view, you can use a constant expression when you want to repeat a 
calculation, using the result of one calculation as part of the next. For example, to 
repeatedly add 2 to 3, you can type: 
3 + 2 = (result 5) 
5 + 2 = (result 7) 
7 + 2 = ... and so on. 

Alternatively, you can enter the ‘+ 2’ part of the calculation as a constant expression. 
This is a bit like storing the number and the operator in a memory - you can use + , - , / 
and * in constant expressions. 
1. Type the number and then the operator twice, e.g. 2 + + . The Desk view is now in 

‘constant’ mode and a ‘K’ appears in the display: 
 

 

2. Press ‘=’ repeatedly for each result, e.g. 2 + + 3 = = = (result 5,7,9...). 

‘K’ symbol - Desk view 
in ‘constant’ mode
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Calculations in the Advanced view 
Just type in your calculation using the number and operator keys (+, - , * and / and ** ). 
The numbers and operators appear on the calculation line as you type them. 

•  Press = or  for the result. The calculation will move into the list of 
calculations: 

 

Operator precedence in this view is as follows: 
Highest: **  (to the power of) 
 -  (make negative) 
 *  (multiply) / (divide) 
Lowest: +  (add) - (subtract) 
So 7+3*4=19 in this view and not 40. 

 To force a particular part of a calculation to be worked out first, contrary to the 
operator precedence, insert brackets around it, e.g. 7+3*4=19, but (7+3)*4=40. 

To use numbers from the list of previous calculations 
•  To re-edit the previous calculation, press  or . 

•  Press  to move the highlight to the line in the list that you want and press 
 (or select ‘Bring from list’ on the ‘Edit’ menu) to insert it at the cursor 

position in the calculation line. You can edit the calculation line in the normal way. 

•  To use numbers in the list in trigonometric, powers or log calculations, highlight a 
figure in the list, and then select a menu option from the ‘Trig’, ‘Powers’ or ‘Logs’ 
menus. The result will appear on the calculation line. 

To clear the list of previous calculations 
•  Select the ‘New list’ option on the ‘Special’ menu. 

Errors 
•  If you accidentally type something that cannot be calculated, e.g. 7-x5, you’ll see 

an error message such as Syntax error. 

Using powers - multiplying a number by itself 
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In the Advanced view, you can raise a number to a power (i.e. multiply it by itself 1 or 
more times) by: 

•  typing a sum involving **, e.g. 34**3 will calculate 343=34*34*34. 

•  selecting the ‘x2’ option from the ‘Powers’ menu. This is a quick way to square a 
number and to get ()**2 on the calculation line - simply type the number or sum 
you want to square into the brackets. If you have already typed in the number or 
sum you want to square, highlight it first then select ‘x2’. 

•  You can calculate a reciprocal (i.e. 1/x or x -1 where x represents the number in 
your calculation) by selecting the ‘1/x’ option from the ‘Powers’ menu. This is a 
quick way to get 1/() on the calculation line - simply type the number or sum you 
want to find the reciprocal of into the brackets. If you have already typed in the 
number or sum you want to find the reciprocal of, highlight it first then select 
‘1/x’. 

See the ‘Logarithms’ section for details about calculating 10x and ex. 

Square roots 
In the Advanced view, you can find the square root (√) of a number or sum (the square 
root of a number is multiplied by itself to get back to the original number, i.e. √16=4, 
42=16) by: 

•  selecting the ‘Square root’ option from the ‘Powers’ menu. This is a quick way to 
get sqr() on the calculation line - simply type the number or sum you want to find 
the square root of into the brackets. 

 If you have already typed in the number or sum you want to find the square root of, 
highlight it first then select ‘Square root’. 

•  Alternatively, you can just type sqr followed by your number (in brackets) 
straight onto the calculation line, e.g. type sqr(64)= (result 8). 

Trigonometry - Sin(x), Cos(x), Tan(x) etc. 

In the Advanced view you can perform calculations using trigonometric functions by: 

•  selecting the appropriate option from the ‘Trig’ menu. Type the number on which 
the function should operate between the brackets on the calculation line. 

•  Alternatively, you can just type the name of the function followed by the number to 
operate on straight onto the calculation line, e.g. Sin(90). 

 The options on the ‘Trig’ menu initially work in degrees. To switch to radians, 
select the ‘Use radians’ option on the ‘Special’ menu. 

 If you need to use PI (3.141...), you can simply type it in as PI, e.g. SIN(PI/2). 

Logarithms 

In the Advanced view, use the functions on the ‘Logs’ menu: 
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•  ‘ln(x)’ - to calculate the natural logarithm, to the base e, of x in brackets. 

•  ‘log(x)’ - to calculate the log10 of x in brackets. 

•  ‘ex’’ - to raise the exponent e to the power of x, i.e. an inverse natural logarithm. 

•  ‘10x’ - to raise 10 to the power of x, i.e. an inverse base 10 logarithm. 
You can also type the functions LOG, LN, or EXP straight onto the calculation line, e.g. 
LOG(10)=1. 

Exponent notation - very large and very small numbers 

If you need to use a very large or very small number in your calculation, use the 
Advanced view and use an E (capital or lower case) as an exponent in the number. This 
is known as ‘Scientific’ format and is a shorter way of writing numbers. Calc will also 
display results in this format if a result is too large or too small to display normally. 

 Exponents 

 An E usually follows a number between 1 and 10, and is itself followed by another 
number. The E means “times ten to the power of”. Its effect is to move the decimal 
place in the first number to the right, by the number of places specified by the 
second number. For example, 3.14159E3 means 3141.59. 

 You may have to imagine extra zeros (or even the decimal point itself) in the left-
hand number, to visualise the number. For example, if you think of 1E5 as 
1.00000E5, you can then move the decimal place and see that it means 100000. 

 If the second number is negative, you must move the decimal place to the left to 
work out the number. For example, 4.1E-5 is 0.000041. 

The Advanced view calculator can handle numbers as big as 9.99999999999E99 and as 
small as 1E-99. It can also handle negative numbers as big as -9.99999999999E99 and 
as small as -1E-99. If a result or a number you enter is larger than these ranges, the 
message ‘Overflow’ is displayed. An ‘Underflow’ or ‘Bad number’ message is shown if 
non-zero numbers are smaller than ±1E-99. 

 When you type in numbers in this format, note that 3.14159E3 and 4.13E-5 are 
single numbers, not calculations, and have no spaces. In a very large result, the 
positive exponent is displayed with a + sign; 1E+10 and 1E10 being the same 
number. 

 You can display all your calculation results in this notation - see ‘Decimal places 
and number formats’ later for more details. 
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Calculator memories 
•  There is one memory in the Desk view. 

•  There are 10 separate memories in the Advanced view. 

In the Desk view... 

Use the options on the ‘Memory’ menu to work on the number in memory in the Desk 
view. 

•  To store a number in memory: use ‘M in’ to put the current number (on the 
calculation line) into the memory. An ‘M’ appears to the left of the calculation line 
when a number is stored in memory: 

 

 

 

 Any number already in memory when you use ‘M in’ will be lost. 

•  To add to or subtract from the number in memory: use ‘M +’ to add the current 
number to the one in memory, and put the result into memory. The original number 
in the memory is lost. 

 Use ‘M -’ to subtract the current number from the one in memory, and put the 
result into memory. The original number in the memory is lost. 

••••  To ‘recall’ the number in memory: use ‘M recall’ to display the number in 
memory on the calculation line as the current number. 

 You can use ‘M recall’ to include the number in memory as part of the current 
calculation. The number in memory is placed at the current cursor position on the 
calculation line. 

••••  To clear the memory: use ‘M clear’ to clear the number in memory. The original 
number in memory is lost. 

‘M’ symbol - the memory 
contains a number 
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In the Advanced view... 

There are 10 memories in the Advanced view: 

•  The memories are initially numbered ‘M0’ through to ‘M9’, though you can 
change the names if you want to - see ‘Renaming memories’. 

•  One of the memories is always “current”. The name of the current memory and the 
number stored is displayed in the top right-hand corner of the screen. 

•  Set a different memory as the current one by selecting the ‘Change memories’ 
option from the ‘Memories’ menu, and setting the ‘Current memory’ line. 

To store a number in a memory 
1. If necessary, change the current memory to the one you want (see above).  
2. Use the ‘M in’ option to put the current number (on the calculation line) into the 

current memory. 

 

 

•  To store a number in another memory, change the current memory, and use ‘M in’. 

 You can also put numbers in memory using the ‘Change memories’ dialog. Set the 
‘List of memories’ line to the memory you want to set, then type in the value you 
want in the ‘New memory value’ line. 

 This is useful if you want to set more than one memory - perhaps if you store 
current exchange rates in different memories, for example, you can update them all 
at once. If you do store exchange rate, tax information, or other ‘constant’ values, 
it is a good idea to rename the memories - see ‘Renaming memories’. 

Using the numbers in the memories 
•  To add to or subtract from the number in a memory: use ‘M +’ and ‘M -’ to 

add or subtract the current number (or results of the current calculation) to the one 
in the current memory. The original number in the current memory is lost. 

••••  To ‘recall’ a number in memory: use ‘M recall’ to display the number in the 
current memory on the calculation line. The number in memory is placed at the 
current cursor position. 

 

Current memory name, and number stored. 
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Alternatively, you can type the memory name straight on to the calculation line: 

 

••••  To clear a memory: use ‘M clear’ to clear the current memory. The original 
number in memory is lost. 

Renaming memories 
You can rename any of the memories in the Advanced view, perhaps to give them more 
meaningful names. 
To rename a memory: select ‘Change memories’ from the ‘Memories’ menu, and set 
the ‘List of memories’ line to the memory you want to set. Type the new memory name 
into the ‘New memory name’ line. 

 You could name one of the memories ‘TAX’ and enter the current rate of tax. You 
can then simply type TAX on the calculation line when you want to use the current 
rate in a calculation. 

 You could also do the same for an exchange rate, or any other constant number 
which has a special meaning. For example, set one of the memories to the current 
dollar exchange rate and rename it ‘dollar’ - then you can simply type 
34.33*dollar on the calculation line to calculate a cost in dollars. 

Entering percentage calculations 
You can perform the following percentage calculations in both views: 

•  To add a percentage to the current number: 
 60 + 15% calculates 60 + (15% of 60) = 69 

•  To subtract a percentage from the current number: 
 60 - 15% calculates 60 - (15% of 60) = 51 

••••  To find a certain percentage of the current number: 
 60 * 15% calculates 15% of 60 = 9 

•  To find a proportion of the current number as a percentage: 
 9 / 15% calculates what percentage 9 is of 15 = 60% 
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You can also perform the following percentage calculations in Advanced view only: 

•  To find which number must be increased by a known percentage to obtain the 
current number: 

 69>15% finds the number which becomes 69 when increased by 15% = 60 

•  To find how much a known percentage increase contributed: 
69<15% calculates how much of 69 was a 15% increase = 9 

 You can use the > and < percentage operators if you want to work out how much 
of a particular payment is tax, for example. Type a calculation in the form 
34.22<17.5% if you want to calculate how much of £34.22 was the tax at 
17.5%. 

 Similarly, 34.22>17.5% will give you the original amount paid (without tax at 
17.5%). 

Important: You should insert a space before the % symbol if it follows a memory 
name, e.g. if you entered 5+M1 %. 

Decimal places and number formats 

In the Desk view... 

Your results show as many decimal places as necessary. For example, 1/3 gives 
0.333333333, while 1/4 gives 0.25. 
Alternatively, you can display your results to a fixed number of decimal places (i.e. the 
same number of characters always appear after the decimal separator). This format is 
known as ‘Fixed point’ - the number will always be displayed to a set number of 
decimal places. 
To use ‘Fixed point’ format: 
1. Select ‘Format’ from the ‘Special’ menu. 
2. Set the ‘Fixed point’ line to ‘Yes’ and then set the ‘Decimal places’ line to the 

number of decimal places to display. For example, if you set the ‘Decimal places’ 
line to 4, 1/3 gives 0.3333 and 1/4 gives 0.2500. 

An ‘F’ symbol appears on screen when you are using ‘Fixed point’ format. 

 If you do most of your calculations on numbers which represent money, you may 
want to use ‘Fixed point’ format and set the ‘Decimal places’ line to reflect the 
usual way the currency is represented, e.g. ‘2’ for sterling or dollars. Calc will 
round the results of your calculations to the nearest penny, cent etc. 
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‘Too big for fixed format’ message 
If the result of a calculation cannot be displayed in 10 characters because trailing zeros 
in the ‘Fixed point’ decimal places make the number too wide, the message ‘Too big for 
fixed format’ is displayed. 
Your result is still correct, and the result is displayed with as many decimal places as 
necessary (as if you had switched ‘Fixed point’ format off for that calculation). For 
example, 1000000.1000 cannot be shown, so 1000000.1 is displayed instead. 

This does not affect the accuracy of the calculations, and results of any subsequent 
calculations are displayed with the requested number of decimal places as usual. 

In the Advanced view 

Results are initially shown in ‘General’ format, showing as many decimal places as 
necessary, up to the maximum of 12. 
Use the ‘Format’ option in the ‘Special’ menu to specify the way you want the results of 
your calculations to be shown: 

•  General: as many decimal places are displayed as were calculated. Large or small 
numbers are shown as exponentials, e.g. 1.1E+30. 

•  Hexadecimal: results are shown as hexadecimal whole numbers (see below). 

•  Fixed: results are shown to the number of decimal places you specify on the 
‘Decimal places’ line. The accuracy is still 12 digits, and results are rounded, if 
necessary, to ensure that there are the correct number of decimal places. 

•  Scientific: results are always shown as exponentials to the number of significant 
digits - digits either side of the decimal point - you specify on the ‘Significant 
digits’ line. The result may be rounded to ensure that this happens. The minimum 
number of significant digits is 2. 

Hexadecimal numbers 
Hexadecimal numbers are also known as base 16. They are used in computing as an 
alternative to decimal notation. 
To insert a hexadecimal number at any time: type a ‘&’ symbol before the 
hexadecimal number. 
For results in hexadecimal notation: set the ‘Format’ option in the ‘Special’ menu to 
‘Hexadecimal’. 
You can use hexadecimal numbers in any calculation, regardless of the format used for 
results. For example, &F9*2 is the same as 249*2, and gives the same result: 498, or 
&1F in hexadecimal format. 
An arithmetic operation between two hexadecimal numbers always gives a whole 
number result. So whereas 3/2 and &3/2 give 1.5 as the result, &3/&2 gives 1. 
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Functions 
In the Advanced view, you can use “functions” to work out calculations, e.g. you might 
type SUM(2,8,14) on the calculation line, then press = or  to work out 
2+8+14= (result 24). 

The Advanced view has the following calculator functions: 
MAX largest number in the list, e.g. MAX(2,8,14)=14 
MIN smallest number in the list, e.g. MIN(2,8,14)=2 
MEAN average of numbers in the list, e.g. MEAN(2,8,14)=8 
 (Note that this result is the “arithmetic mean”.) 
STD sample standard deviation, e.g. STD(2,8,14)=6 
SUM sum of numbers in the list, e.g. SUM(2,8,14)=24 
VAR variance, e.g. VAR(2,8,14)=36 

 When using more than one number in a function list, separate them with commas 
as shown above. If you use comma as your decimal separator, use a semicolon 
instead. 

You can also use: 

•  Date & Time functions: DAY, MONTH, YEAR, HOUR, MINUTE, SECOND. For 
example, at 3:52:06 pm HOUR would give 15, MINUTE 52 and SECOND 6. 

•  Numeric functions provided by “OPL” (the Series 3c programming language). The 
mathematical functions in Calc (SIN, COS and so on) are provided by OPL − they 
are the same ‘keywords’ you would use in an OPL program. 

 There are two types of keywords used in OPL: 
commands − which just perform an action, and 
functions −which return a value of some kind. 
The functions themselves come in two varieties: 
string functions − which return a string of characters, and  
numeric functions − which return a number. 

 You can use any numeric OPL function from within the Advanced view: 
simply type the function name on the calculation line and the numbers on which it 
is to work in brackets after it. 

See the ‘Program editor’ chapter for more information about OPL and its functions, or 
refer to an OPL Programming manual (available from your Psion distributor). 

 You can experiment with any and all of the numeric functions, though most 
non-mathematical ones will either not work in the Calculator, or do nothing useful. 
However, do not use the CALL, OS or USR functions. These are for advanced 
use only, and if you use them negligently, you may lose some or all of your 
information. 

OPL functions can produce a wide range of error messages. See an OPL Programming 
manual for details (available from your Psion distributor). 
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Using your own OPL procedures 

If you have an OPL file or module containing procedures which return a number of 
some kind, you can use these modules in Calc. You can also pass values from Calc to 
parameters in the procedures - just use brackets on the calculation line. 
To make your procedures available for use: 
1. Select the ‘Load OPL’ option from the ‘Special’ menu. 
2. Select the OPL module to use (or the file containing it) using the File selector. See 

the ‘System screen’ chapter for more information about using the File selector. 
For example, there is no operator for “modulus”, the remainder after a division of whole 
numbers (9 modulo 4 is 1). You might write and translate an OPL module containing 
this procedure: 
PROC mod:(a,b)

RETURN a-INT(a/b)*b
ENDP 

Once you’ve used the ‘Load OPL’ option and given the module name, you can, for 
example, type mod:(9,4) and get a result of 1. 

•  If an error occurs in one of your own procedures, the cursor is positioned to the 
start of the calculation line. 

•  If you need to use more than one file, the module you specify with ‘Load OPL’ 
should use the OPL LOADM command to load any other modules itself.  

•  To “unload” the OPL module you have loaded, you can exit Calc using the ‘Exit’ 
option on the ‘Special’ menu. 

 Passing parameters to OPL 

 All parameters passed from Calc to procedures which it calls are by default passed 
as floating-point numbers. 

 If a procedure is declared as requiring a long integer parameter, use the INT 
function on the number you wish to pass - for example, 
myproc:(INT(101500)). 

‘Module does not exist’  
If you delete an OPL module or procedure which is loaded in Calc (or remove the SSD 
on which it is stored) a ‘Module does not exist’ message will be shown on every future 
calculation - even those that do not contain the procedure. There are two ways to 
solve the problem: 

•  If you do not need to use the procedure again: simply ‘Exit’ then re-open Calc. 

•  Alternatively, reinsert (i.e. use ‘Load OPL’ again) or recreate the translated OPL 
module.
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World 

World displays a map of the world, and gives you the following 
information on about 500 cities: 

•  dial code (from the home city). 

•  current time. 

•  position on the map, and distance to the home city. 

•  sunrise and sunset times. 
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The World Screen 
When you run World, you see a screen like this: 
 

 
 
 
 
 
In the World screen: 

•  Information about the home city (where you are based) is displayed on the right. 

•  Information about another city (the selected city) is displayed on the left.  
Usually you select a city to set as your home city, then select other cities on the left. 
You can adjust the way World appears using settings on the ‘Special’ menu - see ‘How 
World looks’. 
Important: Some information displayed in World is affected by whether you have set 
your home city and the correct date and time; to do this see ‘Setting the time & date’ in 
the chapter on the Time application. 
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Selecting a city or country 
There are two ways to select a city or country: 

•  By looking through an alphabetical list: 

 Press  to move the highlight onto either the city or the country line, then 
press  to look through the countries or cities. 

•  By typing a particular name: 

 Move the highlight using , then start typing the name of the city or country 
you want to find. 

 As you press each key, the cursor moves to the right, and World will try to find a 
name which matches the letters you have typed. 

 Use  to delete the last letter typed, moving the cursor to the left. 

 Use  to move the cursor back to the start of the city or country name, to start 
typing a different one. 

 If at any point the Series 3c can’t find a city/country to match the letters you’ve 
typed, it will beep. 

As the selected city changes, the clock above it changes to show the time in the city. 
After a short pause, the position of the city is marked on the map, and the dial code, 
distance and sunrise/sunset times are updated. 
If you’re typing in country names, the capital cities are displayed, together with their 
time, dial code and so on. 

Looking at all the cities in one country 
You can look at all of the cities World knows about for a particular country: 
1. Select the country, as described above. 

2. Then select the ‘Current country only’ option on the ‘Edit’ menu, or press . 

 You will see a padlock symbol appear on the country line. 

3. Press  to move through the cities in that country.  

4. Press  to remove the lock on the country. 

How names are stored 
These countries are stored in the following way: 

•  USA, not United States of America. 

•  United Kingdom, not UK, GB, England etc. 

 A small number of cities are split into more than one area because they have more 
than one area code for dialling. London, for example, is split into London Inner 
and London Outer. 
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About the home city 

To set the home city in World: 
1. Select the city you wish to set as your home city. 
2. Select the ‘Set home city’ option on the ‘Special’ menu. 

3. Press  to confirm your choice and your home city will be set. 

The ‘Set home city’ option has the same effect as the ‘Home city’ option in the Time 
application (see the ‘Time’ chapter), and can cause the current time and date to change. 
If you travel, set a new home city whenever you change country, or move to a different 
time zone, to keep the time and dial codes correct. 

Summer times 
•  Most countries set their times forward by an hour during their summer. The timing 

of these ‘summer times’ (or ‘daylight saving’) in different countries is not 
something that can be calculated precisely, so the Series 3c cannot automatically 
change times to allow for it. 

 If you are not going to travel or make use of world times, summer times will not 
affect your use of the Series 3c, so you do not need to set them. 

•  Fortunately, countries can be grouped into three zones - European, Northern and 
Southern - in each of which summer times change at around the same time. World 
knows which zone each city is in.  

 The easiest way to use summer times is to think of World as two hemispheres - 
Northern/European combined, and Southern. Some World times will then 
occasionally be wrong by an hour, but that is all. 

•  When the clocks go forward in your home city, set your hemisphere and home city 
to ‘On’, and the other ‘Off’. The time on the Series 3c will go forward by one hour. 

•  When the clocks go back again, set your hemisphere and home city to ‘Off’, and 
the other ‘On’. The time on the Series 3c will go back by one hour. 
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Setting summer times 

1. Select the ‘Summer times’ option on the ‘Settings’ menu in the Time application. 
2. You should set summer times ‘On’ for approximately these periods: 
 Northern  early April to end of October 

Europe  end of March to end of September 
Southern  late October to end of February 

If you set summer times on and off according to these dates, your World times should in 
general be correct. If you know the exact changeover dates for countries you’re 
interested in, you can change the summer time settings on those dates. 

•  If the summer time setting for your home city is temporarily (or even permanently) 
different to that of the zone it is in, you can also use the ‘Summer times’ option to 
override the setting for your home city. Set the ‘Home is’ line to ‘On’ or ‘Off’. 

 If the currently selected city in World is in a zone where the summer time is set, 
you will see an ‘S’ beside the clock above it. 

•  To see which zone a city is in, select ‘Update city’ from the ‘Edit’ menu, then 
press  to quit the dialog. (Cities are in the zone which best matches their 
changeover dates, not their geographical position.) 

 If you change the summer time settings of your home city in any way, the time on 
the Series 3c will change accordingly by an hour. If you didn’t want this to happen, 
use the ‘Time and date’ option in the Time application, to set it back. 

Adding and changing information 

Adding a city 

When you first run World, it contains information about many of the major cities in the 
world. However if your home town or city is not included, or if you simply want to add 
other towns or cities, you can add them. You’ll be asked for longitude and latitude, 
GMT offset (the hours ahead of or behind London’s “Greenwich Mean Time”) and zone 
for summer times, and you’ll need to give its position on the map. Don’t worry if you 
don’t know all of this information, you can estimate it from the settings of a city near 
yours. 
1. Find a city already in World that is close to the one you want to add. 
2. Select the ‘Add city’ option on the ‘Edit’ menu. The dialog below will appear. The 

settings on each line are those for the city you’ve just found. These should be 
approximately right for the city you want to add. 
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3. Enter details for the city you want to add on the appropriate lines. (Latitude and 
longitude are used to calculate sunrise and sunset times, so they are worth entering 
if you know them.) Press  to save these details. 

4. Use  to position the crosshair on the city’s approximate position on 
the map, then press  to save its position. 

 You can also use  to move the crosshair in larger steps 
across the map. 

‘Adding’ a country 

Strictly speaking, you cannot add a new country to World. You can, however, modify 
the details of a country that is already there using the ‘Update country’ option. Before 
doing this, it may be helpful to look at a country which you know is near the one you 
wish to add, and note its zone for summer times, and its GMT offset. You can then add 
these details to the ‘Update Country’ dialog. 
1. Select a country, preferably one which you don’t expect to use. 
2. Select the ‘Update country’ option on the ‘Edit’ menu.  
3. Enter the details of the country you wish to add. Don’t worry which city is shown 

as the capital city, for now; you can add the real one later after you have entered it 
as a new city.  

 Enter the national phone code used to call this country from abroad (e.g. 44 for the 
UK). Also give the national (STD) prefix, and the code used when starting an 
international call (e.g. 00 in the UK).  

 Enter the GMT offset (the hours ahead of or behind London’s “Greenwich Mean 
Time”) and the summer time zone. 
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4. Select the ‘Add city’ option on the ‘Edit’ menu as described earlier to add the 
capital city of the new country. Select the ‘Update country’ option again and set 
the new city as the capital of the country. 

 If you frequently travel to a particular country and you’d find it helpful to add 
cities from this country, create a new World file using the country name for the file 
name. Then add all the required cities to this file, and set the home city to the place 
you stay in. You can store this file on an SSD to save internal memory when you 
aren’t in that country. 

Updating city or country information 

•  You can use the ‘Update City’ or ‘Update Country’ options on the ‘Edit’ menu to 
enter city or country details that have changed, such as dial codes. The ‘Update 
City’ option requires the same information as ‘Add City’. 

•  If you use ‘Update Country’ and change the GMT offset of a country, all cities in 
that country will have their current times changed by the same amount. If you 
change a country’s summer time ‘Zone’, its current time may change; all cities in 
that country which have their ‘Zone’ set to ‘As country’ will also change. 

Added/changed information 

•  Information entered using ‘Add city’, ‘Update city’ and ‘Update Country’ is kept 
as a file. Unless you specify otherwise, it is kept on the Internal disk, with World 
as the filename. It can contain information on up to 32 new or changed 
cities/countries. 

•  You can, if you wish, make more than one file of added/changed information. 
Select the ‘New file’ option on the ‘File’ menu to create the new file before 
changing the city or country information. Any future changes would be saved in 
this file. If your home city is in your current World file, because you added or 
updated it, it will be copied into the new file. 

•  Any files you create appear in the file list under the World icon on the System 
screen. 

•  You can keep the file or files on an SSD, if you like: to do this set the ‘Disk’ line 
in the ‘New file’ or ‘Open file’ dialog to the SSD drive, A or B. This frees more 
internal memory for other information. Note, though, that the whole file is saved 
every time you make a change. 

 World files are closely linked to the particular version of the Series 3c on which 
they are made, and may not work on other Psion machines. 
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Deleting added or updated information 

1. Find the city you wish to delete and select the ‘Delete city’ option on the ‘Edit’ 
menu. 

 Use the ‘Delete city’ option to delete a city you’ve added, or if you’ve updated a 
city but wish to revert back to its original information.  

 You can’t delete a city if it is set as your home city. So if you do want to delete the 
city you have set as your home city, set a different home city first. 

2. Press  to confirm that you want to delete the city. 

To remove all added or updated information 
1. Exit the World application. 
2. In the System screen, select the World file and use the ‘Delete file’ option onthe 

‘File’ menu. This will remove all added/updated information by deleting the file in 
which the added/updated information was saved. 

How World looks 

You can use the options on the ‘Special’ menu to change how information is displayed 
in the World screen: 

•  A black or grey map. 

•  Analog or digital clocks. 

•  Distance units in miles, kilometres or nautical miles. 
To change to a 24 hour clock, select the ‘Formats’ option on the ‘Settings’ menu in 
Time and change the ‘Time format’ line from ‘am-pm’ to ‘24 hour’. 
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Word 

Word allows you to type in all kinds of information, from short 
letters to reports or longer documents. 

You can: 

••••  cut and paste text. 

••••  use bold, underlining and italics. 

••••  align paragraphs and headings. 

••••  use styles and templates for documents you frequently type. 

••••  use an outline view which shows the main headings for large 
documents. 
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Entering text 
The Series 3c Word processor is as powerful as many word processors used on desktop 
computers. You can use it as a notepad for typing very simple unformatted notes, or you 
can use it with larger documents using bold, aligned text, with bulleted lists and tables. 

 If you have PsiWin, you can transfer your Psion Word processor documents to a 
word processing application on a PC (e.g. Microsoft Word), or from your PC 
straight back to your Series 3c. Your documents will retain most of their original 
formatting, and will be converted to the correct format as they are transferred.. 

 See your Psion distributor for more details about PsiWin. 

The Word screen 
The first time you press the Word button, the screen will be blank and the cursor will be 
in the top left-hand corner, ready for you to type some text: 

 

 To change the size of the Status window or turn it off and on, press . 

•  You can just start typing your document. 
 Everything you type appears in the main part of the screen. The text you type 

“word-wraps” when it reaches the right-hand side.  

•  Press  when you want to start a new paragraph. The cursor moves to the 
start of the next line. 

•  Use  to start a new line without starting a new paragraph − for 
example when typing an address. This is known as a “forced line break”; a ↓  
symbol appears at the end of the line to represent it. See ‘Displaying “hidden” 
characters e.g. Tab, Space’ later for more details. 
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 Word allows you to apply formatting on a paragraph-by-paragraph basis, e.g. 
alignment. So you may want to use a forced line break (press ), rather 
than a paragraph break (press ), between lines that you wish to format 
together, e.g. the lines of an address at the top of a letter. 

If you are new to word processors, you might like to type in any kind of text at all for 
the moment, and try out the keypresses and options suggested in this chapter. 

•  As in many other Series 3c applications you can use the ‘Zoom in’ and ‘Zoom out’ 
options on the ‘Special’ menu to change the display size of the text you type. 

Starting a new page 
Your typing will automatically move onto additional pages as required. Page breaks are 
not shown on screen. 
To force the start of a new page: select the ‘Spacing’ option on the ‘Format’ menu, 
and set the ‘Start new page’ line to ‘Yes’. Press . 

 The page break is not displayed on screen until you select ‘Paginate’, 
‘Print preview’ or ‘Print’. If you want to see the page breaks on screen, select 
‘Paginate’, then press  to return to the normal view. Inserted page breaks are 
marked with a dotted line. 

Wrapping text 
Word-wrapping occurs at the last suitable space or hyphen in a line. 
You can, however, control word-wrapping yourself using the following keypresses: 

 to force a line break, and make text start on a new line. 

 to insert a “non-breaking space” where word-wrap cannot 
take place. Use them between words or characters which 
should always stay together − a forename and surname, 
perhaps, like ‘John Smith’. 

 to insert a “hard hyphen” where word-wrap cannot take 
place. 

 to mark a place at which hyphenation for word-wrap can 
occur if necessary. A “soft hyphen” only appears on a 
printout if it causes word-wrap to occur. 

 Text is initially word-wrapped to the screen width. This is not how your text will 
appear if you print it. If you select the ‘Use printer layout’ option on the ‘Word’ 
menu, you can see your document (and even edit it) word-wrapped as it would be 
on the printed page. 
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Starting a new document 
The document you type is saved as a “file”. When you want to start a new document, 
use the ‘New file’ option on the ‘File’ menu. Your new file will be listed beneath the 
Word icon in the System screen. See ‘Working with Word documents’ later for more 
details about files. 

Editing text 
This section covers editing text in a document. If you are an experienced word 
processor user you will find the methods used for editing text very similar to other word 
processors, so you may not need to read this section in detail. 

Moving the cursor & highlighting text 

Moving the cursor 
Whatever you type is always inserted at the cursor position. You can move the cursor 
around the text with the  keys.  

You can also use the following keypresses: 

   to move the cursor a word at a time. 

  to move to the start and end of the line respectively. 

  to move the cursor up and down by a paragraph at a time. 

  to move the cursor up and down by a screenful at a time. 

 to move the cursor to the top and bottom of the document. 

Highlighting text 
Word allows you to copy, delete and apply formatting to selected text.; it uses 
“highlighting” as a means of selecting text. 

To highlight text, move the cursor to the start of the text to select, hold down  
then press : 

 

You can also use: 
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   to highlight text one character at a time. 

  to highlight text a line at a time. 

 to highlight the current word. 

 to highlight the current paragraph. 

You can use  with the previous ‘cursor movement’ keypresses to start or extend a 
highlight by the same amount. For example, use  to highlight a screenful 
of text. 
You can use the ‘Highlight all text’ option on the ‘Edit’ menu to highlight all the text in 
a document. 

To remove a highlight: press . 

Deleting text 

To delete characters you have typed, position the cursor and use: 

   to delete the character to the left of the cursor. 

   to delete the character to the right of the cursor. 

  to delete to the beginning of the line. 

  to delete to the end of the line. 

•  You can use a highlight to mark an area of text. Then press  to delete the 
whole area. 

 Text that is deleted by highlighting an area of text and then pressing  
is placed on the “clipboard”. (This is like the ‘cut’ function on some other 
computers.) The text on the clipboard remains intact until you copy or delete 
something else onto it, or you exit Word. To delete highlighted text without 
replacing the clipboard, press . 

 If you delete text by mistake, use the ‘Insert text’ option to put it back (to 
“undelete” it). 

 You cannot use ‘Insert text’ to replace characters deleted with . 

As you delete text, paragraphs are word-wrapped again. 

If you press  when the cursor is at the start of a paragraph, the two paragraphs 
either side of the cursor are joined together. The same happens if you press  

 when the cursor is at the end of a paragraph. 
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Copying text 

Copying text in Word 
You can copy any area of text and insert new copies of it elsewhere in your document: 
1. Highlight the area to copy using the keys listed above. 
2. Select ‘Copy text’ from the ‘Edit’ menu. A copy of the text is placed on the 

clipboard. Any text previously on the clipboard is lost. 
3. Move the cursor to the place where you wish to insert the copy, and select ‘Insert 

text’ from the ‘Edit’ menu. You can use this option to insert as many copies of the 
text as you like, anywhere in your document. 

Copying text to other applications 
You can copy information from a file in one application to a file in another. 
For example, you can highlight a note in Jotter (or even just part of a note) to insert as 
part of a document in Word. To do this: 
1. In Jotter, for example, highlight the area in the note that you want to copy. 
2. Switch over to the document in Word, and select the ‘Bring text’ option from the 

‘Edit’ menu. 

 You can also do this in reverse, by ‘bringing’ text from Word to Jotter. 

You can also use the ‘Bring text’ option to copy text between two Word files. See the 
‘System screen’ chapter for instructions on how to open two files at the same time so 
that you can copy text between them. 

Copying text using Infrared 
You can use Infrared to transfer information from Word to another Series 3c or Siena. 
You can transfer: 

•  Your complete document (or file): just exit the file, and highlight its name on the 
System screen. 

••••  Part of a document: highlight the part you want to copy. 
See the ‘Infrared’ chapter for more details. 



 139

Moving text 

To move text around, just delete it, move the cursor to the new position, and insert it: 
1. Highlight the area to move. 

2. Press . Word removes the text from the document and puts it on the 
clipboard. 

3. Move the cursor to the place where you wish the text to be, and select the ‘Insert 
text’ option on the ‘Edit’ menu. You can insert more than one copy, if you wish, 
by using ‘Insert text’ again. 

Displaying “hidden” characters, e.g. Tab, Space 

The ‘Set preferences’ option on the ‘Special’ menu lets you display special characters 
for paragraph ends, spaces, tabs, etc. which are not always easy to see: 
Special character:  Display as: 
Tab   → 
Space   . 
Paragraph end   ↵   
Soft hyphen  - - 
Forced line break  ↓  
This only affects the screen display; these symbols are not printed. 

 Non-breaking spaces are always displayed as spaces, even if you set spaces to 
display as dots. 

 Some special characters that you may want to type and print are listed in the 
character set in the appendix. 

Using the Spell checker and Thesaurus 

If you are typing a long document and you don’t want to check your typing too 
frequently as you type, just type a first draft of the document and then select 
‘Spell check’ from the Word menu. You can also use the ‘Thesaurus’ option to look up 
or replace words you have used. See the ‘Spell’ chapter for more details. 

Counting Words 

Select ‘Count’ from the ‘Search’ menu to see how many words there are in your 
document. 
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Finding & replacing text 

Finding text 

You can use the ‘Find’ option to locate a particular piece of text in the current 
document. You can then use the ‘Find again’ option to locate further occurrences of that 
piece of text, without having to enter the details of the text in any further dialog. 
1.  Select the ‘Find text’ option on the ‘Search’ menu: 

 

2. Type the text to find on the ‘Search for’ line (maximum 20 characters). 
3. Specify on the ‘Direction’ line whether to search forwards or backwards from the 

cursor position. 
4. Set the ‘Case sensitive’ line to ‘Yes’ if you would like to make the search case 

sensitive. If not, leave it set to ‘No’. For example, if you want to find Mark with a 
capital ‘M’, and do not want the search to stop on ‘mark’ with a lower-case ‘m’, 
set ‘Case sensitive’ to ‘Yes’. 

5. Press  to complete the dialog and start the search. The found text will be 
highlighted. 

 Next time you use ‘Find text’, the same text is suggested in the ‘Find’ dialog. To 
remove this, just type new text to search for and the old text will be replaced. 

 You can use the ‘Find’ option to help you move around a long document. If you 
know a couple of adjacent words in the paragraph which you want to move to, type 
these on the ‘Search for’ line to save you having to move the cursor manually. 

To search for the same text again: 
•  Select the ‘Find again’ option on the ‘Search’ menu to carry on searching, for the 

same text, from the current cursor position. 
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Finding and replacing text 

You can use the ‘Replace’ option to find and replace any number of occurrences of a 
particular piece of text in your document. 

 Before using the ‘Replace’ option it may be a good idea to use the ‘Save’ option 
on the ‘File’ menu so that you can revert to this copy of the document if you 
accidentally replace text you didn’t mean to change. 

1. Select the ‘Replace’ option from the ‘Search’ menu. 
2. Type the text that you want to find on the ‘Search for’ line, and the text that you 

want to replace it with on the ‘Replace with’ line. 
3. In the same way as when finding text, select the ‘Direction’ and set ‘Case 

sensitive’ as appropriate. 
Word will search for the text from the cursor position, in the direction you specify. If it 
finds a match for the text, it highlights it, and displays a number of choices at the 
bottom of the screen: 

 

•  Press  to replace the highlighted text, then carry on searching in the same 
direction for the next occurrence of the text. 

•  Press  to leave the highlighted text as it is, and then carry on searching in the 
same direction for the next occurrence. 

•  Press  to replace this and any other occurrences found in the same direction, 
without asking for any further confirmation.  

 Be very careful if you replace ‘All’. 

 It’s easy for ‘Replace’ to find an unexpected match − in the middle of a word, 
perhaps − for the text you typed. For example, replacing ‘eg’ with ‘e.g.’ will also 
replace the ‘eg’ in ‘negligible’ and ‘Egypt’. 

 You can interrupt a ‘Replace All’ by pressing . 

•  Press  (or ) to leave ‘Replace’ and to return to normal editing. 
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Deleting occurrences of text 
You can use ‘Replace’ to delete any or all occurrences of a particular piece of text − 
leave the ‘Replace with’ line of the dialog blank. Each “replacement” that occurs will 
remove the matched text, but insert nothing in its place. 

Moving to a particular page 

If you type a long document, you can move from page to page with the ‘Jump to page’ 
option on the ‘Search’ menu. Word calculates where pages would begin and end if you 
were to print, and lets you move to the start of any page. 
Page ends are shown as a dotted line across the screen. See ‘Starting a new page’ earlier 
for instructions on inserting a page break, and refer to the ‘Printing’ chapter for more 
details. 

 If you type long documents and use headings to break the text into different 
sections, you may find it useful to view an “outline” of the document so that you 
can see its structure more easily. (An outline is a summary that shows only the 
headings in a document.) See ‘Using the Outline view’ later in this chapter. 

Changing the appearance of text 
In Word, changing the appearance of text is known as formatting. This can be applied 
on a letter-by-letter, or paragraph-by-paragraph basis. 

Using Bold, Italic and Underlined text 

You can change the appearance of any highlighted word or text by holding down 
 and typing the two-letter “shortcode” of the “emphasis” you wish to use:  

Shortcode: Emphasis: Shortcode: Emphasis: 
 bold superscript 

underline  bold and italic 
italic  bold and underline 
subscript  italic and underline 

 resets to normal text 

All of these settings are shown both on the screen and on the printed page. 

 You don’t have to highlight an area first. If you want to start typing bold letters, for 
example, hold down  and press  twice, and start typing. To return to 
normal letters, hold down  and press  twice. 
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These settings are pre-defined “emphases”. You can also set up your own shortcodes for 
text styles, perhaps if you wanted to set up a shortcode for text that is bold, italic and 
underlined. See ‘Applying text formatting - “emphases”’ later for more details. 

About paragraphs 

Paragraphs are an important concept in most word processors. 
Many display features, such as alignment or font settings, are often applied to 
paragraphs as a whole. 

•  Every time you press , you end the current paragraph and start a new one. 
So, the word “paragraph” applies even to headings, or to a few words on their own. 

•  When you press , you force Word to start a new line (a ↓  symbolises 
the forced line break), but not a new paragraph. A single paragraph can continue 
onto several lines using forced line breaks ( ), e.g. an address. 

Any formatting can be applied to the whole of the paragraph. For example, you could 
centre a title, or left-align an address paragraph. 

 You can see more clearly where paragraphs start and end by selecting 
‘Set preferences’ from the ‘Special’ menu and set the ‘Show paragraph ends’ line 
to ‘Yes’. This displays an angled arrow at the end of each paragraph. A ↓  symbol 
marks a paragraph with lines linked by forced line breaks. 

 Marking the start and of each paragraph in this way does not affect the printed 
document. 

Selecting paragraphs 
Before you can apply formatting to a paragraph, you need to select it. 

•  You do not need to highlight all the text in a paragraph to select it, even if the 
paragraph is on more than one line. Just move the cursor into the paragraph to 
apply formatting to it. 

•  To select more than one paragraph, move the cursor into the first paragraph, then 
press  and move the highlight into the other paragraphs you want to 
select. 

How paragraphs look on the screen 
Many settings in Word are for the printed page, or for documents which are later 
transferred to a PC word processing application. 

•  Some settings, such as paragraph indents, are not shown exactly on the screen. 

•  Text is normally word-wrapped to the screen width as you type (rather than the 
width of the printed page).  

If you want to print the document, the ‘Use printer layout’ option will display the 
document laid out as it will appear on paper. 
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•  Some settings, such as font size, cannot be shown on the screen at all. 

 Different fonts are not shown on the screen. However, if a font has “serifs” − the 
“tails” on the corners of letters, which guide the eye along lines of text − a serif 
display font will be used. (Conventionally, as in this manual itself, the main text of 
a document uses a serif font, while headings use a “sans serif” - no serif - font.) 
Monospaced and proportional fonts are also distinguished on the screen. 

Aligning paragraphs 

You can specify how the left and right edges of a paragraph are aligned: 
1. Select the paragraph(s) to align. See ‘Selecting paragraphs’ earlier for more details. 
2. Select the ‘Alignment’ option on the ‘Format’ menu and set the ‘Alignment’ to: 

••••  Left: the left edges of every line are lined up, while the right edges are not. This 
alignment is sometimes called “ragged right”. 

•  Right: the right edges of every line are lined up, while the left edges are not. This 
alignment is sometimes called “ragged left”, and is sometimes used for address 
paragraphs at the top of letters. 

••••  Centred: every line is centred on the screen. This is usually for one-line 
paragraphs, e.g. titles. 

•  Justified: both the left and right edges of every line are neatly lined up. 

 Justified alignment cannot be shown on the screen, and paragraphs set to use it are 
displayed on the screen using left alignment. However, when printed or transferred 
to another word processing application on a PC using PsiWin, the correct 
justification is used. 

 See your Psion supplier for more information about PsiWin. 

3. Make sure the ‘Alter’ line is set to ‘Current paragraph(s)’ and press . 

The following example shows paragraphs using left, right and centred alignment: 

 

 When you first type in paragraphs of text, they use ‘Justified’ alignment. 
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Changing the font type and size 

The ‘Paragraph font’ option on the ‘Format’ menu allows you to set font and size, 
underline, bold, italic and print position for text in a selected paragraph.  

 Different fonts and font sizes cannot be shown on the screen − they are used when 
the document is printed, or transferred to another word processing application on a 
PC using PsiWin. 

The fonts and sizes available for you to choose from are governed by the printer 
model the Series 3c is set to use. You can set the printer model with the ‘Print setup’ 
option on the ‘Special’ menu. (See the ‘Printing’ chapter for more details.) 
To change the font or font size: 
1. Move to the paragraph, or highlight the paragraphs whose font you wish to change, 

and select the ‘Paragraph font’ option on the ‘Format’ menu. 
2. Set the ‘Font’ line to the font you want and select the size on the ‘Size’ line. Font 

sizes are specified in “points”; there are 72 points in an inch. 

 All fonts are either “proportional” (i.e. the characters vary in width) or 
“monospaced” (the characters are all the same width), and they are shown as such 
on the screen. 

3. Use the other lines of this dialog to set any combination of bold, underline and 
italic, to be applied to the paragraph as a whole. You don’t need to set the ‘Print 
position’ line. 

Bold, underline and italic are shown on the screen.  

 ‘Font’, ‘Underline’, ‘Bold’ and ‘Italic’ may all have an ‘Inherited’ setting in 
addition to their other settings, but this will only be of use when you begin to use 
styles. See ‘Quick formatting with emphases and styles’ later for more details.  

4. Set the ‘Alter’ line to ‘Current paragraph(s)’ and press . 

Indents & Tabs 

Indents move the edges of a paragraph away from the margins of a page. 

•  A ‘Left’ indent will indent all but the first line of the paragraph (this is sometimes 
called a “hanging indent”) in relation to the other paragraphs.  

•  ‘First line’ lets you set an indent for the first line of the paragraph, as is common in 
letters. If you set both ‘First line’ and ‘Left’ indents, the whole paragraph will be 
indented. 

•  Right indents position the text away from the right-hand margin by the amount you 
specify. 
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 In its normal display, (screen layout) Word cannot always position tabbed text 
exactly the way it will be positioned when printed. To be sure of how your table 
will be laid out in print, select ‘Use printer layout’ from the ‘Word’ menu. (The 
option becomes ‘Use screen layout’; select it to return to normal editing). See the 
‘Printing’ chapter for more about ‘Use printer layout’. 

Indenting a paragraph 
1. Move to the paragraph (or highlight the paragraphs) you wish to indent, and select 

the ‘Indents’ option on the ‘Format’ menu. The ‘Set indents’ dialog is displayed.  
2. Set the type of indents you want, ‘Left’, ‘Right’ or ‘First Line’ and how far from 

the left or right you want to position the text. 

3. Set the ‘Alter’ line to change to ‘Current paragraph(s)’ and press . 

 The size of the indents is measured in the units shown in brackets in the title of the 
dialog (either inches or centimetres). See ‘Units of measurement’ for how to 
change these. 

 These are not margin settings for the document. When you come to print, you’ll 
find separate options which set the overall left and right margins on the paper. 

Setting tab positions 
When you press the  key while typing, the cursor moves to the next pre-defined tab 
position to the right. You can define up to eight tab positions for a paragraph. For 
example, you might set the first tab position to 1cm from the left-hand side, the second 
to 2cm, and so on. Tab positions are measured in the units − inches or centimetres − you 
specify with the ‘Printer’ option on the ‘Control’ menu in the System screen - see ‘Units 
of measurement’ later. 
To set or change tab positions: 
1. Move to the paragraph or highlight the paragraphs whose tab positions you wish to 

set and select ‘Tabs’ from the ‘Format’ menu. The ‘Set tabs’ dialog is displayed. 
The title of the dialog indicates which unit of measurement is in use.  

2. Select the Tab number (1 to 8) on the ‘Select tab’ line and type the distance from 
the left-hand margin for the Tab ‘Position’. 

3. Set the ‘Type’ of tab you want to use. There are three types of Tab: 

•  Left tabs are like Tabs on a typewriter, aligning the start of the text to the tab 
position. 

•  Right tabs align the right-hand side of words. 

•  Centre tabs centre a word around the tab position. 
You can set up any combination of left, centre and right tabs. All three tab types can be 
shown on the screen. 

 4. Set the ‘Alter’ line to change to ‘Current paragraph(s)’ and press . 
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You can display the tabs in your document by selecting ‘Set preferences’ from the 
‘Special’ menu and setting the ‘Show tabs’ line to ‘Yes’. 

 If you press  when the next Tab position is close to, or beyond the right edge 
of the screen (or if the cursor is already past the rightmost Tab position), the 
correct indentation cannot be displayed on screen. Instead, the Tab space is 
indicated by a single space. 

Units of measurement 
Some settings are distances on the printed page − e.g. paragraph indents and tab 
positions. These are measured in inches or centimetres, according to the ‘Units’ that are 
set in the ‘Printer’ option on the ‘Control’ menu, in the System screen. 

 Word only takes account of this setting when opening (moving to) a file. If you 
want to change the units for the file which is currently open, select the ‘Exit’ 
option on the ‘Special’ menu to exit the file, change the unit of measurement, then 
open the file again. 

Tables 

Creating tables using tabs 
Tabs can be used to display items of information as a table. Type each item of 
information that is to appear on a single line (including row and column headings) 
separated by Tabs. At the end of each line press  rather than  so that 
the table remains a single paragraph. 

 You might find it useful to switch to printer layout when formatting a table. Select 
the ‘Use printer layout’ option from the ‘Word’ menu. Select ‘Use screen layout’ 
when you have finished. 

•  Use the ‘Tab’ option on the ‘Format’ menu, and set the tabs for this paragraph to 
suitable positions on the page to form the columns of the table. 

•  Use ‘left’, ‘centred’ and ‘right’ tabs as appropriate to control how the columns line 
up, and align the column headings. 

 If you are going to print your table, you can make sure that it is always printed on a 
single page. Move the cursor onto the table, select the ‘Spacing’ option on the 
‘Format’ menu, and set ‘Keep together’ to ‘Yes’. 

 If you want to add up columns of numbers, highlight the whole table, then go into 
the Spreadsheet and use ‘Bring’ to copy the table in. You can then use the SUM 
function to add up a column: if, for example, the column goes from cell B2 to cell 
B6, sum it by entering =SUM(B2:B6) in some other empty cell. 
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Quick formatting with emphases & styles 
•  An “emphasis” is a collection of character formats - bold, italics, font and so on, 

which can be applied to text. 

•  A “style” is a similar collection of formats which is applied to a complete 
paragraph. Styles can also use particular alignment, tab setting, line spacing etc. 

How emphases and styles work 
•  Emphases and styles can have shortcodes which you can use to apply them 

quickly. 

•  Some emphases and styles are built into Word so you can use them straight away, 
or you can set up your own. 

•  Each document can be saved with its own emphases and styles, and you can copy 
them between different documents easily. 

 If you find that you use a particular set of styles often, you can group the styles 
together in a “template”. You can “open” a new document with a template so that 
the styles it contains are available. 

 See ‘Using templates for documents’ later for more details. 

Applying text formatting - “emphases” 

The shortcodes described in ‘Using bold, italics and underlined text’ are examples of 
the “default emphases” which are automatically assigned to each new Word file. 
Select ‘Emphasis gallery’ from the ‘Styles’ menu to see the list of emphases: 

•  You can use  on the ‘Emphasis’ line to see each emphasis and its shortcode 
in turn, or press  to see a vertical list: 

 

Using an emphasis shortcode 
•  Highlight the text you want to format, hold down  and then press the 

shortcode of the emphasis you want, e.g. hold down  and press  then 
 for bold, italic text. 
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•  To ‘type’ using an emphasis, hold down  and press the shortcode, then just 
start typing. Repeat this using the ‘Normal’ shortcode when you want to return to 
normal text.  

•  Alternatively, you can select the ‘Emphasis housekeeping’ option, then ‘Apply’. 
You can use this method if you’ve forgotten the shortcode of the emphasis you 
wish to use. 

Defining new emphases 
To create your own emphasis and shortcodes: 
1. Select ‘Emphasis housekeeping’ from the ‘Styles’ menu, then ‘Define’. 

 When you use ‘Emphasis housekeeping’ and define a new emphasis the settings 
suggested in the dialog are those of the emphasis at the cursor position. So you will 
usually see the settings of the ‘Normal’ emphasis. 

2. Change the settings on any line with : 

 

•  On: Set a type of format to ‘On’ to use it in this emphasis. 

•  Inherited: the ‘Inherited’ setting on any line means that the emphasised text will 
use the same setting as that in the paragraph in which it occurs. For example, the 
BB emphasis, has ‘Bold’ set to ‘On’, and the other lines set to ‘Inherited’ so text 
with this emphasis will always be bold, but in other respects (font, underline 
on/off, italic on/off), it will look the same as the rest of the paragraph. 

•  Off: set this if you want to turn off a particular formatting in an emphasis. For 
example, if you set ‘Bold’ and ‘Italic’ to ‘Off’, text using this emphasis will not be 
bold and italic, even if the rest of the text in the paragraph is. 

•  You can also set the new emphasis to use superscript or subscript, by changing the 
setting on the ‘Print position’ line. Since paragraph styles do not have this setting, 
you can’t set this line to ‘Inherited’. 

3. Press . You can now enter a name and shortcode for the new emphasis. 

4. Type a descriptive name (up to 15 letters) for the new emphasis on the ‘Name’ 
line. Type the two-letter shortcode you want to use to identify it on the ‘Shortcode’ 
line, e.g. LB for the shortcode of a large, bold emphasis. It must be different to any 
other shortcode used by a style or another emphasis. 

5. Press  and the new emphasis is defined.  
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If you had highlighted an area, this emphasis is applied to it. If not, this emphasis will 
be applied to letters you now type. When you have finished, hold down  and 
press  twice to return to normal letters. (If you don’t want to type anything with this 
emphasis just yet, move the cursor away instead.) 

Reviewing and changing emphasis settings 
To see which emphases are defined for the document you are using, select ‘Emphasis 
gallery’ from the ‘Styles’ menu. 

When the highlight is on the top line, use  to move between the different 
emphases. As you do so, the settings for each emphasis are shown in the rest of the 
dialog. Move the highlight down to change the settings for any of the emphases. 

Applying paragraph formatting - “styles” 

•  Styles are similar to emphases except that you use a style to applying formatting to 
a whole paragraph (or multiple paragraphs). 

 You cannot apply styles just to text highlighted in a paragraph - use an emphasis 
for this instead. 

Displaying styles 
When you open a new Word file there will be a set of built-in or “default styles” 
automatically assigned to the document. 
The style that you are using when you type in normally is called ‘Body text’ and is 
given the two letter shortcode ‘BT’. 
To see which style is being used for each paragraph: 
1. Select the ‘Set preferences’ option from the ‘Special’ menu. 
2. Set the ‘Show style bar’ line to ‘On’ in the ‘Set preferences’ dialog and press 

. The shortcode of the style for each paragraph will then be shown on the left 
of the screen. 
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Applying the “built-in” styles 
Word usually has four built-in or “predefined” styles for each document you create.  
Style:  Shortcode: Description: 
Body text BT a style for ordinary paragraphs of text. 
Heading A HA a style for a paragraph which is a major heading, or 

title. 
Heading B HB 

 
a style for a sub-heading, perhaps describing a few 
paragraphs which follow it. 

Bulleted List BL a style for a paragraph which is in a list. 

•  You can format a document straight away using these styles. You may find that 
you can format many documents without worrying about any additional styles. 

To apply a style for a paragraph: move the cursor into the paragraph, hold down the 
 key and type the two-letter shortcode of the style you want to use. For example, 

to change the style of a paragraph to the ‘Bulleted list’ style, you would hold down 
 and press  then . 

You can apply these styles to a document straight away. You can insert a ‘bullet’ 
character, perhaps a ‘*’, in your bulleted list as well: 

 

 The predefined styles in a document can vary depending on which “template” you 
are using - e.g. the Memo template will have different default styles to those in the 
Faxcover template. See ‘Using templates for documents’ later for more about 
templates. 

 To see which styles have been defined for the document you are using: select the 
‘Style gallery’ option on the ‘Styles’ menu. When the highlight is on the top line 
you can use  to move between the different styles, or press  to see a 
vertical list. 
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Creating and applying your own styles 

You can always set up your own styles and shortcodes, and apply them to your 
documents in the same way as you can apply the built-in styles. 

Creating your own styles 
When you create a new style, you can change all the settings that you can change 
normally from the ‘Format’ menu, and you can also give the style the name and 
shortcode you choose. 
1. Select the ‘Style housekeeping’ option on the ‘Styles’ menu and then the ‘Define’ 

option. The ‘Define style’ dialog is displayed: 

 

 The initial settings in the dialog are those of the style of the paragraph the cursor 
was in. So, if you want to define a new style which is similar to an existing style, it 
is a good idea to start from a paragraph which uses the existing style. Many of the 
settings in the dialog will then be correct straight away. 

2. Make the changes you want to the settings on each line. For dialog lines displaying 
‘...’ you need to press  to display a further dialog where you can change the 
setting. 

•  The ‘Font’, ‘Bold’, ‘Underline’ and ‘Italic’ lines in the ‘Font’ dialog also have the 
setting ‘Inherited’. If you use the ‘Inherited’ setting, the new style will always take 
that particular setting from the ‘Body text’ style. If, at a later stage, you then 
change the ‘Body text’ style − say, to use a different font − all styles which have 
‘Font’ set to ‘Inherited’ will change accordingly. 

3. Press . 

4. Type a descriptive name (up to 15 letters) for the new style on the ‘Name’ line. 
Type the two-letter shortcode you want to use to identify this style on the 
‘Shortcode’ line. It must be different to any other style shortcode, and to the 
shortcodes that can be used for emphases − BB for bold, UU for underline etc. 

5. Press  to define the new style, and apply it to the current paragraph. 



 153

Applying your own styles 
To apply a style to the current paragraph (i.e. the one in which the cursor is in): 
hold down the  key and type the two-letter shortcode of the style you want to 
use. 
Alternatively, you can select the ‘Styles housekeeping’ option on the ‘Styles’ menu and 
choose ‘Apply’. You can use this method if you’ve forgotten the shortcode of the style 
you wish to use. 

 If a paragraph doesn’t appear to change to the right style, check no emphasis (bold, 
italic etc.) has been applied separately to the whole paragraph − highlight it, and 
apply the ‘Normal’ emphasis. Then apply the style shortcode again. 

Reviewing or changing existing styles 
To see which styles are defined for the document you are using, select ‘Style gallery’ 
from the ‘Styles’ menu. 

When the highlight is on the top line, use  to move between the different styles. 
As you do so, the settings for each style are shown in the rest of the dialog. Move the 
highlight down to change the settings for each style. 

Modifying paragraphs with the same style 
The options on the ‘Format’ menu allow you to set the font, indents, tabs, text 
alignment and line spacing for a paragraph. 
You would normally use the ‘Format’ options to change the appearance of just the 
current paragraph. You can, however, use them to change all the paragraphs which use 
this style: 

•  Use the required option on the ‘Format’ menu and set the ‘Alter’ line in the option 
dialog to ‘All using this style’. This will apply the formatting to all the paragraphs 
which use this style, without changing the style itself. 

 If you apply extra formatting to a paragraph, Word can detect that the paragraph is 
no longer using the ‘true’, defined style. Word creates a new style for you. It gives 
the style a shortcode, starting from ‘ZA’, then ‘ZB’, ‘ZC’ and so on. 



 154

Managing styles and emphases 

Keeping track of styles and emphases 

When you are using styles in your document, you can remind yourself which paragraph 
styles you have used by displaying the style codes on the left-hand side of the screen. 
To do this: select the ‘Set preferences’ option on the ‘Special’ menu and set the ‘Show 
style bar’ line in the dialog to ‘Yes’. 

Finding styles and emphases 
To find a heading or particular style in your document: 
1. To search for a particular emphasis: select ‘Emphasis housekeeping’ from the 

‘Styles’ menu, then select ‘Find’. 
 To search for a particular style: select ‘Style housekeeping’ from the ‘Styles’ 

menu, then select ‘Find’. 
2. To skip to the next emphasis or style of any kind set the ‘Find’ line to ‘All’. 
 To find a particular emphasis or style select its name on the ‘Find’ line.  
Use ‘Find again’ on the ‘Search’ menu to skip to each successive emphasis or style.  

Renaming a style or emphasis 
You can rename any style or emphasis used in the current document. 
1. To rename a style: select the ‘Style housekeeping’ option from the ‘Styles’ menu, 

then the ‘Rename’ option. 
 To rename an emphasis: select the ‘Emphasis housekeeping’ option, then the 

‘Rename’ option. 

2. Press  (or the first letter of the shortcode) and select the style or emphasis 
you want to rename.  

3. Move the highlight to the ‘Name’ and ‘Shortcode’ lines, and change them as 
required. 

Deleting an emphasis or style 
You can delete: 

•  any particular emphasis in a document except the ‘Normal’ emphasis (you can, 
however, rename the ‘Normal’ emphasis). 

•  any particular style except the ‘Body text’ style (you can, however, rename the 
‘Body text’ style). 

•  any emphases or styles in a document which are not being used. 
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1. To delete emphases, select the ‘Emphasis housekeeping’ option on the ‘Styles’ 
menu, then ‘Delete’. Similarly, for styles, select ‘Style housekeeping’, then 
‘Delete’. 

2. To delete a particular style or emphasis: press  (or the first letter of the 
shortcode) to select a particular one that you wish to delete, then press  to 
delete it. 

 To delete all the unused styles or emphases: press . 

A message will be displayed to tell you how many styles or emphases were deleted. 

 Styles and emphases are deleted as soon as you press  or . Pressing 
 to end this dialog will not restore deleted styles. You can only retrieve a 

deleted style by reverting to a previously saved version of the document, by 
copying it from another document (see later), or by creating it again from scratch. 

If you try to delete a style or emphasis which is still in use in your document, an ‘In 
use’ message will be shown. Before you can delete it, you must find any paragraphs 
which are using it, and change them to use a different style. You can use ‘Find’ on the 
‘Style housekeeping’ menu to find all the styles that you need to change - see ‘Keeping 
track of styles and emphases’ earlier. 

Copying styles and emphases between documents 
You can move emphases and styles between documents in the same way: 
1. Highlight an area containing the style(s), emphasis or emphases to move. It does 

not matter what text you highlight as you can delete it from the new document, just 
leaving the style behind. 

2. Open the second document by highlighting it in the System screen and pressing 
. 

3. Select the ‘Bring text’ option from the ‘Edit’ menu, then press  to delete 
the text. As long as there were no clashes between shortcodes, the styles or 
emphases will have been copied to the second document. 
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Using templates for documents 
Template files can be used to load styles, settings and text into any new file that is 
created with the ‘New file’ option. If you do not choose to use a template file, new files 
are given the standard set of styles and settings. Any document can be saved as a 
template file. 
You might use templates for a variety of reasons: 

•  To save the styles, emphases, settings and text that you want to use for a particular 
type of document, e.g. standard letters, memos, etc. The template file will even 
save the cursor position. 

•  To save an empty document which has the styles and emphases that you wish to 
use for new files. You can change the settings and/or styles for all new files, by 
creating a “default template” − described later in this chapter. 

•  To save all of your favourite settings, such as those in ‘Set preferences’ and ‘Print 
setup’ to use with new files. 

 Templates are not the same as stylesheets on other word processors, as you can 
save settings and text as well as paragraph styles. 

 You cannot apply templates to existing files, though. If you need to use the 
styles from the template in the existing file, you can copy them across - see 
‘Managing styles and emphases’. 

‘Faxcover’ and ‘Memo’ - the built-in templates 
The Series 3c has two built-in templates which you can use to write a memo, and a fax. 
They contain text and styles which you can use straight away. 

Using a template 

You can use a template when you open a new file: 
1. In Word, select the ‘New file’ option and set the ‘Template’ line to: 

•  the filename of a template you have created. See ‘Creating templates’ later for 
more details. 

•  ‘(Standard)’ to use the standard Word styles in your file, or to use your own 
“default template”. See ‘Creating a default template’ later for more about this. 

•  ‘Faxcover’ or ‘Memo’ to use the built-in template for a fax coversheet or memo. 

2. Type a name for the new file on the ‘File: Name’ line and press . For 
example, for the ‘Memo’ template: 
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•  You can just type in the details for this memo, and then use ‘Save’ to save the 
memo as usual. 

Creating templates 

You can create as many templates as you need, for different types of files. Perhaps one 
for a standard letter: 
1. Open a file which has the styles, emphases and text that you want to save in the 

template file. 
2. Use ‘Save as’ to create a temporary copy of the file. Set the ‘Use new file’ line to 

‘Yes’. 

3. Check that all of the settings − as in ‘Set preferences’, ‘Printer setup’ and so on − 
are as you want them. 

4. Delete all of the unwanted text in the file. If you want to delete it all, select 
‘Highlight all text’ from the ‘Edit’ menu, then press . 

5. Select the ‘Save as Template’ option on the ‘File’ menu, and type a name for the 
template file on the ‘File name’ line (you can use a maximum of 8 characters for 
the name and it must start with a letter). Press  to create the template. 

 The Series 3c adds the file extension .wrt to template filenames. You don’t need 
to enter this yourself, though. 

 If you’re careful, you can do all of this without making a temporary file: just 
remove the unwanted text from a real document, use ‘Save as template’, then use 
‘Revert’. However, if you were to exit the document for any reason before you 
used ‘Revert’, you would lose your original file. 

6. You can now use ‘Revert ’ to return to your original file and select ‘Exit’. You can 
then delete your temporary file. 

 If you use more than one printer you may even wish to create different versions of 
your favourite templates, each set for the appropriate printer model, and each 
tailored to the fonts it provides. 
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Creating a default template file 
You may wish to create a default template, with the settings, styles and emphases 
that you wish to use in all (or most of) your new documents.  
If you use ‘Save as template’ and give default as the filename to use, this template 
becomes the template to use when: 

•  creating a new file from the System screen, and 

•  the ‘(Standard)’ template is selected when creating a new file from within Word. 
The default template is kept on the default disk. This is initially ‘Internal’, but you can 
set it with the ‘Default disk’ option in the System screen. 
Important: if you use ‘Create new list’ in the System screen, and create a new file list 
for Word, the name of the default template for this list will be the same as the name you 
gave the list itself. (If you save the list as letters, say, then you can create a template 
called letters and it will be the default for all new files in this list.) 

 If you forget the original name you gave to a list, use the ‘About application’ 
option in the System screen. The top line of the resulting dialog tells you the name. 

Deleting templates 

You can delete any of the template files you have used with Word if you no longer wish 
to use them, or wish to free up space on your disks.  
To delete one, find it using the Files application or the File selector. Template files are 
stored in the \WDR directory. You will now see a list of files, including template files 
(which have a .wrt file extension). 

File extensions and the File selector are explained in greater detail in the ‘System 
screen’ chapter. See ‘The Files application’ chapter for more about using the Files 
application. 
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Using the Outline view 
If you type long documents and use headings to break the text into different sections, 
you may find it useful to view an “outline” of the document so that you can see the 
structure of the document more easily. 
An outline is a summary that shows only the headings in a document. You can press 

 to switch to an Outline view: 

 

 The exact appearance of the outline view of your document is dependent upon the 
paragraph styles you have used. 

Press  again to return to Normal view. 

To use a document in Outline view: 

•  When you are typing your document, use paragraph styles to differentiate 
paragraphs.  

•  Each paragraph style in Word has an “outline level”. The outline level determines 
the ranking of the paragraph style in terms of the document outline, i.e. whether the 
paragraph is a major heading, minor heading, sub-heading, and so on. 

•  Word allows you to set nine outline levels − 1 is the highest level and 9 the lowest. 
The pre-defined paragraph style ‘Body text’ initially has level 9, and the 
‘Heading A’ style has level 1. 

 Outlining only makes sense when you are using headings. If all of the paragraphs 
in your document use the ‘Body text’ style, there is no outline to show, and when 
you try to switch to the outline you will see the message Nothing to show
in outline. 

Setting paragraph outline levels 
•  You can set the outline level for a new paragraph style on the ‘Outline level’ line 

in the ‘Define style’ dialog. 

•  You can set the outline level for an existing paragraph style with the ‘Style gallery’ 
option on the ‘Styles’ menu. 

 If you just want to change the outline level of one particular paragraph, leaving the 
others of the same style unchanged, you have to create a new paragraph style for 
the paragraph. You can then set an outline level for this new style. 
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Turning the outline on and off 
•  Press  to switch to the Outline view. 

The outline view is initially set to display paragraphs whose styles have an outline level 
between 1 and 8 − any styles except those with an outline level of 9 (i.e. ‘Body text’). 

•  To change the outline levels shown, select the ‘Set outline level’ option on the 
‘Word’ menu.  

For example, the outline view below has been set to show paragraphs with outline 
levels between 1 and 3: 

 

Here, the major headings have style HA (outline level 1). Further sub-headings have 
outline levels of 2 (HB) or 3 (a new style, HC). Apart from the temporary change of 
indentation, the paragraphs are shown with their current settings, such as the font 
settings. 
While outlining, you can only move the cursor around the outline. As soon as you make 
any change to the document, Word stops outlining and returns to the Normal view. 
 While outlining, you can use the ‘Expand outline’and ‘Collapse outline’ options on the 
‘Word’ menu to increase/decrease the number of levels shown in the outline by 1. 

•  Press  to return to the Normal view. 

Using a highlight while outlining 
If you highlight an area while outlining, and the highlight extends from one paragraph 
to another, it includes any hidden paragraphs of a lower outline level which are between 
the two paragraphs shown. If you delete (‘Cut’) or copy this highlighted area, Word 
comes out of Outline, and you can see that the whole area has been cut or copied to the 
clipboard. 

Printing document summaries 
Outlining also allows you to print document summaries. If an outline is shown, the 
‘Print’ option will print the outline, not the whole document. 
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Working with Word documents 
In Word, you should use a separate Word file for each separate document, memo, fax 
and so on that you type. You can create new files from within Word, or on the System 
screen. 
Where this manual talks about copying, deleting and merging files; in the context of 
Word files, it means doing all these things to separate documents. 

Creating new documents 

You can create new files from within Word, or from the System screen. 

 If you want to use a template other than the default template, create the new file 
from within Word. 

1. Select the ‘New file’ option on the ‘File’ menu. 
2. The ‘Create new file’ dialog will appear. Type the name for the new file on the 

‘File: Name’ line, for example memo1. The name can be from one to eight letters 
and numbers long , and must begin with a letter. 

 From within Word, you can specify a template to use: select the name of the 
template file on the ‘Template:’ line. Select ‘(Standard)’ to use the standard Word 
settings, or the default template (if you have created one). 

 From the System screen: the new file will use the default template (if it exists), or 
will not use a template at all. 

 See ‘Using templates for documents’ earlier for more details. 

3. Press  and the new file is created. 

Saving & reverting 

Saving the document to disk 
If you are about to make large changes to your document or are experimenting with 
Word’s features, you may wish to save the document as it is, so that you can revert back 
to the way it was if anything goes wrong. 

•  Use the ‘Save’ option on the ‘File’ menu, before you make the changes, to copy 
this working version to the real file on the disk. 

•  As with any important information, you should back up your document files 
regularly either to an SSD (which you keep separate from your Series 3c), or via 
PsiWin to another computer. 
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 Your document is also saved when you use the ‘Exit’ option, or if you change to a 
different file, either with the ‘Open file’ option on the ‘File’ menu, or from the file 
list in the System screen. 

 Important: It is usually better to keep documents which change on the ‘Internal’ 
disk or a Ram SSD. A Flash SSD will slowly fill up as you keep saving revised 
versions of a document to disk. 

Reverting to the saved document 
Word does not work directly on a file; it loads the information from the file into 
memory, and it is this “in-memory” working version which you edit.  

•  Select the ‘Revert’ option on the ‘File’ menu to revert to the previously saved 
version of your document. ‘Revert’ re-loads the original saved copy of the file 
from disk, losing any changes you had made to the in-memory version. 

 To exit Word and lose any changes you have made to the file, select ‘Exit, lose 
changes’ from the ‘Special’ menu. 

If your disk is nearly full... 
Whenever it saves a file, Word deletes the old version from the disk, then saves the new 
one. First, though, it checks the free disk space; if there might not be enough space to 
save the new version, it displays a message. 
In rare circumstances, though, Word can try to save and still fail with a ‘Disk full’ error. 
It will then display a ‘File deleted: cannot exit until file is saved’ message. Even the 
‘Exit, lose changes’ option will not work, because the original file on disk has been 
deleted. If you were to quit, the file would be gone forever. 

•  To save the file, use the System screen to free some more disk space, then try 
Word’s ‘Save’ option. Once you have successfully saved the file you will be able 
to exit it. (See the ‘Troubleshooting’ chapter for more information about freeing 
disk space.) 

 Alternatively, use ‘Save as’ to make a new version of the file on a different disk. In 
the ‘Save as’ dialog, you must set ‘Use new file’ to ‘Yes’. 

•  If you want to abandon the file, even though it has been deleted from the disk, 
go to the System screen, move the highlight to this file under the Word icon, and 
select ‘Kill application’ from the ‘Apps’ menu. 
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Size of document files 

Word can handle up to about 40,000 characters of text (about 40K in file size) in each 
file. If you try to open a file which is larger than this, an ‘Overflow’ message will be 
displayed. 

 To avoid exceeding Word’s memory limit, you can split a long document file into 
two shorter ones. 

 File size can also be restricted by the number of internal “index entries” in use. 
Word uses one index entry for each paragraph, and two for each emphasis (phrases 
which are bold, underline etc.). Its limit is 1700 index entries. A long document 
consisting only of very short single-line paragraphs might hit this limit before it 
reaches the actual 40K limit. 

If you have copied or deleted a very large area of text, this reduces the current 
maximum size by a similar amount. 
If you are typing or trying to insert text from the clipboard, and you reach the size limit, 
a Maximum number of characters reached message is displayed. 

 When Word has a large file open, certain operations (such as copying a large area 
of text to the clipboard) can cause a ‘No system memory’ message to be displayed. 
See the ‘Troubleshooting’ chapter for more information about internal memory. 

Merging document files 

You can use the ‘Merge in’ option to add a copy of another document into the current 
document, at the cursor position. You might, for example, save an often-used 
paragraph as a separate document, and merge it into any document which needed it. 

•  Select ‘Merge in’ from the ‘File’ menu to display the ‘Merge file’ dialog. Select 
the name of the file that you want to insert at the cursor position and press . 

Any styles and emphases in the document you merge in are also merged with those of 
your current document.  
If a shortcode already exists in your current document, it overrides any shortcode of the 
same name in the document being merged. If this happens, you may find that 
paragraphs from the file being merged change their appearance, as different styles are 
applied to them. To avoid this, open the document you wish to merge, and rename the 
styles concerned. 

 You should ensure there are no clashes between emphasis shortcodes in one 
document and style shortcodes in the other. 

  Your document is automatically saved before the Merge begins. If you merge the 
wrong file, or insert it in the wrong place, select the ‘Revert’ option on the ‘File’ 
menu to “un-do” the Merge. 
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Printing 
The ‘Printing’ chapter deals with printing information from the Series 3c. After showing 
you how to set up the Series 3c for a given printer, it covers “simple printing” from 
Word, before moving on to more advanced topics. 

 Features which affect printing, such as the ‘Spacing’ option in the ‘Format’ menu, 
are covered in the ‘Printing’ chapter. 

Other file formats 
From Word, your documents are saved in the Psion Word processor format. 
Alternatively, you can save any file as: 

•  RTF file format. 

•  Plain text (ASCII). 

 If you have PsiWin, you can copy and convert document files from Word on your 
Psion to other Word processing applications on other computers (e.g. Microsoft 
Word or WordPerfect on a PC). The conversion is automatic - and you can use the 
document straight away on the other computer without worrying about the file type 
or conversion. 

 See your Psion distributor for more details about PsiWin. 

Plain text files 

Psion Word files contain text that you type in, plus coded information about text 
formatting. This coded information is put into the file by Word.  

Saving a plain text file 
1. Select the ‘Set preferences’ option from the ‘Special’ menu. Select the setting on 

the ‘Text file type’ line that is appropriate:  

•  ‘Paragraph’: each paragraph in the document will be saved as a single line of text, 
with no blank lines between paragraphs. Most word processors will understand this 
format. 

•  ‘Line’: each paragraph will be word-wrapped to a width of less than 80 characters, 
and a blank line will separate paragraphs. Text editors, and many word processors, 
understand this format. 

2. Select the ‘Save as’ option on the ‘File’ menu. Type a different name for the new 
file on the ‘File Name:’ line. Set the ‘File type’ line to ‘Text’ and press .  
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Opening a plain text file 
Word can open any plain text file. 
1. Select ‘Set preferences’, as when saving a plain text file, and set ‘Text file type’ to 

the setting − ‘Paragraph’ or ‘Line’ − which corresponds to the file you wish to 
open. 

 If paragraphs in the text file are separated with blank lines, select ‘Line’ as the 
‘Text file type’ in order to display the file in Word with its original layout. 

2. Select ‘Open file’, and type the name of the file to use. Word recognises that the 
file does not have Word’s own format, and so treats it as plain text. The file will 
inherit the same styles and emphases as the file you were previously editing. 

Important: when you next use the ‘Save’ option, or you switch to a different file, the 
current document will be saved in Word format, including style and emphasis 
information. The filename will be changed to use the standard .wrd file extension.  

You can also use ‘Save as’ to save it as a text file, as described before. 

Full filenames, including file extensions, are shown when you press  in the 
System screen. See the ‘System screen’ chapter for more details. 

Plain text editing 
If you do need to keep some documents in plain text format all the time, you can create 
a list (an additional Word icon in the System screen) which uses Word as a plain text 
editor. (Don’t worry if you don’t understand some of the terms mentioned in this 
procedure.) 

 For more about creating lists, see the ‘System screen’ chapter. 

1. Move the highlight in the System screen to the Word icon. Select the ‘Create new 
list’ option on the ‘Special’ menu. 

2. On the ‘Directory for files’ line, enter a name of up to 8 letters for the directory to 
keep text files in. For example, enter text. 

3. On the ‘Extension for files’ line you can enter a different file extension for your 
text files, if you wish. It should be from one to three characters; txt is usually 
used. 

4. Make sure the ‘Type’ line is set to ‘Text editor’. 

5. On the ‘Save list as: Name’ line, enter a name to save this information as − 
textedit, perhaps. 

6. Press . A dialog is shown, listing your choices; press  again to confirm 
them. 

A new Word icon is shown in the System screen. All files you create with it will be 
plain text files. It does not have the menu options for features (e.g. styles, emphases and 
passwords) which require non-textual information to be saved in files. There are a few 
other differences: 
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•  There is an ‘Indentation’ option, for setting the tab width and turning 
auto-indentation on and off. 

•  There is no outlining facility. 

•  The ‘New file’ option will only ever use a default template (stored as 
default.$). When you select ‘Save as template’, you are given the option of 
replacing this template. Do not try to swap templates between Word and the 
Text editor. 

•  ‘Set preferences’ has settings for bold/normal and mono/proportional text. 

 Use the Program editor icon in the System screen if you want to edit OPL 
programs. 

 The Text editor, like the Program editor, does not save the Status window or 
“Zoom” settings to file, as its files only contain the plain text you type. So when 
you open a file, it may not have the same Status window or Zoom settings as it had 
the last time you used it. 

Rich Text Format (RTF) files 

RTF files are compatible with Microsoft Word for Windows, Microsoft Word on the 
Macintosh, Microsoft Word for DOS and other word processors. 
Important: if you open an RTF file in Word, then when you next use the ‘Save’ option, 
or you switch to a different file, the file will be saved in Word’s format, complete with 
style and emphasis information. The filename will be changed to use the standard .wrd 
file extension. If you later want to send the file back to a PC or Macintosh in RTF 
format, you will need to use the ‘Save as’ option and make a new RTF version of the 
file first. 
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Example setups 

Using a letter template 
Your templates do not always need to include styles. You can set up the main pieces of 
text you want in a particular alignment in a template, for example, for a letter: 

 

•  Type in the text you want to include in the template, then use ‘Save as template’. 

•  Use ‘New file’ from within Word when you want to use this template to start a 
document. 

•  You can then type all the extra details for your document into the spaces. 

Organising Word files in the System screen 
You can keep different lists of Word files under more than one Word icon in the System 
screen using ‘Lists’. If you have lots of different types of document, you can organise 
the lists into different types of document, e.g. letters, memos, reports, perhaps: 

 

•  The files in each list are kept in different “directories” (a different place on the 
Internal disk) so you can use a different default template for each type of file. See 
‘Saving a default template’ for more details about how to set this up. 

 You can therefore just open a file from the System screen and use the correct 
template automatically. 

•  If you find that you have too many Word icons in the System screen, you can 
create a “group” which contains all the icons. This takes up the space of one icon 
in the System screen: 
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•  However, it “expands” when you highlight it and press  to show all the icons 
and files in the group: 

 

See ‘The System screen’ chapter for more information about file lists, groups, and full 
instructions on how to create and use them. 
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Spell 

This chapter tells you how to use Spell - the Spell-checker and the 
Thesaurus. 

You can: 

••••  Check the spelling of a single word in Spell, or in Word. You 
can also check a complete document (or part of it) in Word. 

••••  Find similar words using the Thesaurus. 

••••  Solve crossword clues - solving anagrams and finding missing 
letters. 

••••  Add words you use to Spell’s dictionary, or even keep 
dictionaries for different Word documents. 
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Introduction 
You can use the Speller and Thesaurus to check and improve anything you write on 
your Series 3c. You can also use it to solve crosswords or play word games. 
The Speller and Thesaurus has the following powerful features: 

•  Spell, which checks your spellings against a list of around 100,000 different 
words, and which corrects any mistakes. You can even check the spelling of 
common abbreviations and “proper nouns” - the names of people and places. 

 The UK version of the Speller and Thesaurus uses British English spellings while 
the US version uses American English, e.g. colour (UK) or color (US), 
centre (UK) or center (US). 

•  A Thesaurus, which finds synonyms (words with the same meaning) for words 
you enter. It contains about 660,000 synonyms. 

 You can use the above features from within Word. This allows you to spell-
check entire Word documents, if you wish, or to look up synonyms for a word as 
you edit a document. 

 You can extend Spell’s dictionary with your own words. You might, for example, 
add specialised words that you need for your job, or certain rare words that you 
have trouble with. You can even keep separate dictionaries for different Word 
processor documents. 

•  An anagram solver, and a “missing letter” solver, which finds words when you 
only know some of the letters - when solving a crossword, for example. 

Memory requirements 
The Speller and Thesaurus application requires around 10K of memory in order to run. 

Running Spell 

 

To run Spell: move the highlight to the Spell icon in the System screen 
and press . 

 Alternatively, you can hold down  and press the ‘Data’ button on the 
Buttonbar; this keypress is pre-assigned to take you to Spell. See ‘Assigning a 
button to an application’ in ‘The System screen’ chapter for more about assigning 
a keypress to an application. 
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The “input screen” is shown, with the cursor flashing on the input line: 

 

A copyright message is displayed briefly, but you can type in a word regardless of this. 
You can now enter a word, then select one of the four options shown on the screen:  

•  Look up (the Thesaurus), 

•  Anagram, 
•  Xword (the “missing letter” solver) and 

•  Spell. 

 If there is more than one word on the input line (i.e. you have entered spaces), the 
word at the cursor will be used. 

You can press  at almost any time, as in other Series 3c applications. In Spell the 
help is “context-sensitive”; the first help screen displayed will be relevant to whichever 
feature you are using at the time. 

Spell-checking and correction 

There are two main types of words in the spelling dictionary: 

•  Ordinary, everyday words make up the vast majority of the dictionary. These are 
stored in lower case, as in giggle. 

•  Proper nouns are the names of people and places. These are stored with the first 
letter in upper case, as in Tennyson. 

 You can also enter both kinds of words all in upper case. This might be useful if 
you encounter a word which you don’t recognise, and which may or may not be a 
proper noun. 

There are some other types of words in the spelling dictionary: 

•  Acronyms (words formed from the initial letters of other words), such as NATO. 
These are in uppercase. 

•  Upper-case abbreviations of names, such as BBC and EEC. 

•  Ordinary abbreviations, such as etc. and Dr. 

•  Roman numerals, like xix. 
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The provision of words like these helps in the spell-checking of documents. These 
types of word are not used by Spell when trying to correct a misspelled word. 
Some other non-alphabetic characters appear in the dictionary - for example, 
apostrophes, as used in wouldn’t, and hyphens, as used in well-heeled. 

Some characters, including * ’ ” [ ( { # \ - ©, are ignored when they appear 
at the beginning of a word. A similar group of characters, including ! ? ] ) } : ;, 
are ignored at the end of a word. This is another feature designed to assist the spell-
checking of documents. 
Although the spelling dictionary contains around 100,000 words, no one selection of 
words can satisfy everyone; you may well find words which Spell does not know, just as 
it may suggest words which you have not met before. As you’ll see, you can add your 
own words, if necessary. 

Spell-checking a word 
Type a word to spell-check in the input screen. Enter words as you would normally - for 
example, proper nouns should begin with an upper case letter. (You can, if you wish, 
use all upper case for any word.) 

You can use all the normal Series 3c editing keys - for example, use  to move 
the cursor,  to delete the character to the left of the cursor, and  
to delete the character to the right of the cursor. 

To restore the previous input line: press .  

To clear the input line: press  again. 

When you have typed the word, press  to spell-check it. 

Spelling correction 
If Spell finds the word you typed in its dictionaries, it will display a message at the 
bottom right of the screen, telling you your word is correct. 
If Spell thinks the word was not spelled correctly, a ‘Scanning’ message is displayed 
and the spell correction screen appears: 

 

Spell tries to correct the spelling, according to the methods chosen in the ‘Options’ 
dialog. (These methods are described later in ‘Spelling options in Word’; note that 
“phonetic” correction is initially not used.) 

•  If no suitable correctly spelled word can be found, the message ‘No words found’ 
is displayed. 
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•  If a suitable correctly spelled word is found in the dictionary, it is displayed in the 
box on the right of the screen. If there are several suitable words, they are listed as 
they are found: 

 

•  You can use  to move a highlight up and down this list, even while the list 
is still being compiled. You don’t have to wait for Spell to finish searching. 

•  Words which scroll off the screen aren’t lost - you can use  to move back to 
them. When you reach the end of the list,  has no effect.  

•  Spell will list up to a maximum of 50 suggestions. 

•  The highlighted word is also shown beneath ‘Replace with:’ on the left of the 
screen. Press  to return with this word to the input screen or  to go 
back to the input screen with your original word unchanged. 

 If you wish, you can edit the word shown under ‘Replace with:’, although this is of 
more use when spell-checking from within Word. 

If you know the word you entered is a correctly spelled word, or you wish to spell it 
in the way that you entered it, you may wish to add it to Spell’s dictionary. Press 

, and after a dialog asking for confirmation, the new word will be added to the 
“global dictionary”, and will be available for subsequent spell-checking and correcting. 
There is more about this under ‘Adding your own words’, later in this chapter. 

Search options 
You can determine which errors Spell will be able to offer corrections for. (This does 
not affect the initial “spell-checking” of the word you enter.) Select ‘Options’ from the 
‘Setup’ menu: 

•  Typo substitution/deletion - if set to ‘Yes’, Spell can correct a missing or extra 
letter, or one which has been typed in place of another. So, ‘festival’ will be 
offered as the correction for ‘feastival’, and ‘separate’ as the correction for 
‘seperate’. 

•  Typo transposition - if set to ‘Yes’, Spell is able to correct two letters which have 
been swapped around. For example, it can correct ‘recieve’ to ‘receive’ and ‘adn’ 
to ‘and’. 

••••  Case and accents - allows you to correct mistakes with capital and lower case 
letters. If set to ‘Yes’, ‘english’ would be corrected to ‘English’ and ‘mclean’ to 
‘McLean’. If you add non-English words, this option also corrects missing or extra 
accents on letters. 
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•  Phonetics - can correct a wrong spelling which sounds like the correct word, for 
example ‘diarea’ to ‘diarrhoea’. The ‘Phonetics’ option is initially set to ‘No’, as 
it can slow down the search for corrections considerably. You may wish to set it 
on permanently, or just for the occasional word or document. If your spelling is 
generally quite good, you may prefer to leave this option set to ‘No’. 

•  Run-on words - use this option to correct two words run together, such as ‘alot’ 
typed incorrectly for ‘a lot’ or ‘ragdoll’ for ‘rag doll’. 

You will probably want to set a combination of these options; you must set at least 
one. 
Your settings are also used when you use Spell from within Word. (This is why the 
‘Typo transposition’ and ‘Run-on words’ checks, intended mainly for typing errors, are 
initially set to ‘Yes’.) 
Additional options specific to searching through a document can be set inside Word; 
see ‘Spell-checking in Word’ later. 

Using words from the history list 
Spell remembers the most recent correct spellings, whether you entered them yourself or 
picked from the list of suggestions, as a “history list”. This can contain up to 20 words. 
Looking at the history list is a quick way to check on a word you misspell often. 
Select ‘History’ on the ‘Special’ menu to see the ‘History’ dialog:  

 

•  To expand the dialog line to show the whole list: press . 

•  To remove the currently displayed word from the list: press . 

•  To return to the input screen with the word shown: press . 

 When you leave Spell, with the ‘Exit’ option or by using the  key in the 
System screen, the history list is emptied. 
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The Thesaurus 

The Thesaurus finds synonyms (words with the same meaning) for the word you type 
in. It also tells you whether the word is a noun, verb, or adjective (and so on). 
When a word has several meanings, it finds a separate group of synonyms for each 
meaning.  
You can enter a word in the same way as in Spell; however, as the input screen 
suggests, you need to press  instead of . The Thesaurus displays a ‘Busy’ 
message, then a screen like this one: 

 

A list of synonyms for the word you entered is displayed. You can move the highlight 
with the  keys;  will usually scroll the screen to show more groups of 
words. 

••••  To return with the highlighted word: press . 

••••  To find synonyms for the highlighted word: press . 

The groups of synonyms are ordered according to their “part of speech” - for example, 
noun groups first, then verb groups, and so on. Each separate group ends with a 
semicolon. Different groups may have similar or different meanings, according to the 
meanings of the word you are looking up in the Thesaurus.  
The parts of speech you may see are: 

adj adjective pron pronoun 
adv adverb verb verb 
conj conjunction vi intransitive verb 
noun noun vt transitive verb 
prep preposition

•  Synonyms are normally the infinitive form of verbs (e.g. ensue not ensued), 
and the singular form of nouns (e.g. heart not hearts). 

•  Sometimes the synonyms may contain hyphens, such as clear-cut, and 
sometimes a synonym may consist of more than one word, such as take out. To 
look up synonyms for more than one word, you can highlight the whole phrase 
on the input screen, using , before pressing . Alternatively, use 
hyphens to link the words - instead of well heeled, for example, you can enter 
well-heeled. 
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Solving anagrams and missing letters 

You can solve anagrams and missing letter problems up to 20 letters long. (If you try to 
use more than this, a Word or phrase too long message will be displayed.)  

Note that the longer an anagram is, or the more missing letters you have, the longer it 
will take for Spell to find solutions. The time taken can grow very quickly as you use 
longer “words”. 
Spell and the Thesaurus can list up to 50 solutions to each problem. 

Anagrams 
Type the jumbled letters, and press * . Full anagrams using all the letters you typed are 
found first, followed by shorter anagrams which use only some of the letters. 
Only ordinary words are returned as anagrams - proper nouns and abbreviations, for 
example, are not. 

Missing letters 
Crossword solvers in particular may want to find words when they only know some of 
the letters. To list all the words which match, enter the word with the missing letter or 
letters represented by question marks (e.g. f??ak) or underscores (e.g. f_ _ak).  

•  Press  to select the ‘Xword’ feature. 

•  A list of matching words is displayed, just as in spelling correction. 
You can even enter a word consisting solely of question marks or underscores.  

If, for example, you enter ????? and then press , Spell will start listing all the five-
letter words which it knows. (Here, of course, it will hit the 50-word limit fairly soon.) 
You can solve “missing letter” problems on proper nouns and on acronyms, but not on 
other abbreviations. 

The ‘Bring’ option 
You can copy text from another application into the input screen by using the ‘Bring’ 
option, and you can then use one of the four main functions on this word. 
If you copy over more than one word, position the cursor in the word you want to use. 
You can only use the ‘Bring’ option in the input screen, not in the other screens. 
You can also copy a word back to other applications, such as Agenda, Data or Program, 
which have their own ‘Bring’ option. The word must be highlighted in the input screen. 
(If you are in a different screen, such as the Spell correction screen or the Thesaurus 
screen, move the highlight to the word and press .) You can then switch to the 
other open application, and use its ‘Bring’ option. 
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Spell-checking in Word 
•  You can access Spell and the Thesaurus features from inside Word - you can even 

spell-check entire documents. 

•  The features for solving anagrams and “missing letters” are not available inside 
Word. 

When you select the ‘Spell check’ option in Word a new menu is shown: 

 

The first two options let you spell-check the word at the cursor position, or the entire 
document. 
Spell correction will use the same correction methods set by ‘Options’ in Spell. 

Spell-checking a word 
If you select ‘Word’ from the ‘Spell’ menu in Word, the word at the cursor will be 
spell-checked. If it spells correctly, a ‘Correct’ message will be displayed; if not, the 
corrections screen will be shown, and Spell will try to find corrections. 

 Any “words” of 50 characters or more will be assumed to be correct. 

•  As soon as you see the correction you want in the corrections screen, you can move 
the highlight onto it and press , to insert it into your document. You never 
have to wait for Spell to finish searching. 

••••  If you want to make the correction yourself, you can edit the “Replace with” line 
yourself, then press . 

•  If your original word has been replaced under “Replace with” by one of the 
suggested corrections, you can if you wish restore it by pressing , 
before you start editing. 

Spell-checking a document 
If you select ‘Document’ on the ‘Spell check’ menu in Word Spell starts checking each 
word from the current cursor position.  
As soon as it finds a word it does not recognise, it highlights the word and displays a 
series of options, like this: 
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Press  for ‘Correct’,  for ‘Add’, and so on. The options have the following 
effects: 

•  Correct tries to correct the highlighted word, as in the Spell application. The same 
corrections screen will be shown. Use  to select a correction from those 
found, and press . It will replace the original word in your document, and 
Spell will carry on checking the rest of the document. 

•  If you wish, you can press  to swap between the corrections screen and 
the Word document, to remind yourself of the context in which the word was used. 

 If you decide not to use one of the corrections, press . 

•  Add allows you to add this word to Spell’s dictionary.  
 There are more details of this later. If you’re in any doubt as to the spelling, you 

should use ‘Correct’ to see whether Spell can correct it; if it can’t, you may then 
wish to add the word. 

•  Skip tells Spell to ignore this word. 

•  Skip all tells Spell to ignore this word, and any future occurrences of it in the 
document. 

•  When Spell reaches the end of the document, it will display a Check start of
document? message, asking you whether you now wish to check from the start 
of the document, back to the cursor position. 

When you have finished checking the document, Spell returns to Word. 

Spell-checking a section of a document 
Highlight the section to check in the Word document, then use the ‘Spell check’ option. 
You will then see a ‘Highlight’ option on the ‘Spell check’ menu; select it, to spell-
check only the highlighted region. The same ‘Correct’ / ‘Add’ / ‘Skip’ / ‘Skip all’ one-
line dialog will be shown if any unknown words are detected. 

Spelling options in Word 
‘Options’ on the ‘Spell check’ menu controls a range of further settings which 
determine the spell-checking of words in a document: 

•  Ignore nos., symbols, etc. ignores any “word” which contains any numbers or 
certain symbols: $ ~ \ - * #. 

•  Ignore uppercase words skips over “words” entirely in capitals, such as OPL . 



 179

•  Skip repeated words takes no special action if consecutive occurrences of a word 
are encountered. Set this to ‘No’ if you want to look for repeated-word errors like 
and and in your document.  

 If a word is then found repeated during spell-checking, a special one-line dialog 
will be displayed, offering the choice of ‘Delete this occurrence’, or ‘Skip’ to leave 
it unchanged. 

•  Repeats are case-sensitive controls only the detection of repeated words, and is 
only available if you set ‘Skip repeated words’ to ‘No’. If you set this to ‘Yes’, 
then two consecutive occurrences of a word must be identical for ‘Skip repeated 
words’ to not query them: not Not, for example, would not be queried. 

The Thesaurus in Word 
Position the cursor on the word to look up, and select the ‘Thesaurus’ option on the 
‘Word’ menu. If synonyms are found, they are listed in exactly the same way as 
when using the Thesaurus in Spell itself. See ‘The Thesaurus’ earlier for more details. 

•  To replace the original word with one of the synonyms found, move the highlight 
to the new word and press . 

•  To look up further synonyms for one of the words shown, move the highlight to it 
and press . 

•  Again you can, if you wish, press  to swap between the Thesaurus 
screen and the Word document, to remind yourself of the context in which the 
word you are looking up was used. 

To look up synonyms for a phrase which uses more than one word (such as 
once in a while ), highlight the whole phrase using , before 
selecting the ‘Thesaurus’ option. 

Adding your own words 
Many people will have no need to add their own words to the Spell checker. However, 
if you use a specialised vocabulary in your job, or occasionally need certain obscure 
words, then this feature may be useful to you. 
The extra words are used in spell-checking and correcting (though not in phonetic 
correction), and in “missing letter” solving. They are not used in the Thesaurus or in 
anagram solving. 
A separate dictionary is kept for words you add. This is called the “global dictionary”, 
as words you add to it are available in all subsequent uses of Spell - as you’ll see, you 
can have separate dictionaries for different Word documents. 
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 Note that if you keep a dictionary on a Flash SSD and you add to it regularly, this 
can soon begin to use up disk space. 

Adding to the global dictionary 
To set which drive the global dictionary should be created on, run Spell and select the 
‘Install’ option. 
Set the ‘Global dictionary drive’ to the disk required. The file itself will be saved 
in \WDR\, with a name such as UKENG.D$C. 

You can add words from Spell, or when using the Spell features from within a Word 
document. 
When Spell does not recognise a word, it tries to correct it. However, as the 
spell-correction screen suggests, you can press  to add the word to Spell, if you 
know the word exists and was entered correctly. (You may wish to wait while Spell tries 
to correct the word, in case you did make a mistake.) 

•  An ‘Add to dictionary’ confirmation dialog is displayed. If the word has any 
unwanted punctuation (or similar), remove it at this point. 

•  Note that, to match the format of Spell’s dictionaries, words should be entered in 
the following format: 

  Normal words in lower case. 
 Proper nouns in lower case but with a Capital First Letter. 
 Abbreviations in upper or lower case, according to their general use. 

•  Press  to add the word. 

Document dictionaries 
You can, if you wish, keep separate dictionaries to be used with different Word 
documents. Each will be kept on the same disk as the document. 

•  To enable this feature, run Spell and select the ‘Install’ option; set ‘Enable 
document dictionaries’ to ‘Yes’. 

•  If you now try to add a word from within Word, the ‘Add to dictionary’ dialog 
offers you the choice of adding the word either to the global dictionary or to a 
“document dictionary”. 

 Document dictionary files always have the same basic filename as the Word 
document to which they apply, but with the file extension .D$C. They are stored 
in a \D$C\ directory. 

 Once you enable them, document dictionaries will be created (with zero length) as 
soon as you use the ‘Spell check’ option in Word. You can delete unwanted ones 
from time to time, if you wish, though they are harmless. 

 If you wish, you can also edit a dictionary directly. Use the Progam editor 
(dictionaries are just plain text files) and use the File selector to find the dictionary 
in the \D$C or \WDR directory. 
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Patience 

This chapter tells you how to play the Patience game on the 
Series 3c. 
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Running Patience 
Patience is a card solitaire game that can be played by one or two players. The game is 
played with a standard pack of 52 cards and up to 4 Jokers. At the start of a game, cards 
are dealt into 7 ranks of 5 cards with a separate “layout” card. 

 

To run Patience: move the highlight to the Patience icon in the System 
screen and press . 

 Alternatively, you can hold down  and press the ‘Agenda’ button on the 
Buttonbar; this keypress is pre-assigned to take you to Patience. See ‘Assigning a 
button to an application’ in ‘The System screen’ chapter for more about assigning 
a keypress to an application. 

The first time that you run Patience, the cards are dealt for a one-player game; the 
diagram below shows what the different areas and cards on the Patience screen do: 
 

 

 
 
 
 

 Use ‘Set preferences’ on the ‘Special’ menu to change the way that Patience 
works. You can:  

•  Set ‘Card scrolling’ off and on for dealing and playing.  

•  Change the interval and speed of card scrolling.  

•  Turn the ‘Sound effects’ for the game off and on. You might like to turn them off 
when playing Patience on a train, for example. 

Current player

Number of Jokers left in the pack 

Total score 
for Player 1“Layout” 

card 

Pack 

Number of cards 
left in the pack 

Rank cards 

Score and Bonus points 
for this game 
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 How to play - one-player game 
Objective: The aim of the game is to remove the 7 ranks of cards by placing them on 
the “layout” card and earn as many points as possible in the process. 

Rules of play 
•  Place a card from any of the five ranks on the “layout” card; the face value of a 

rank card you play must be 1 greater or 1 less than the “layout” card. Each card 
you play from the rank earns points - see ‘Scoring’ later for more details. 

•  If you can’t play a rank card, play one from the pack to replace the “layout” card 
until you can. 

•  Aces are low but Jokers can have any value - so you can place a Joker onto the 
“layout” card, and start a new “run” with a different card. 

If you manage to remove all 35 rank cards you receive bonus points and the pack is 
re-dealt with one less joker. You continue playing until you cannot play any more cards 
from the rank or pack onto the “layout” card.  

 Use ‘Undo move’ on the ‘Game’ menu to undo the last move you have made. 

Keys to use 
 to select a card - a hand appears over the selected card. The selection 

wraps if the “pack” or last (right-most) rank card is reached. 

 or  to play the currently selected rank card onto the “layout” card or deal 
a new card from the “pack”. 

 to deal a new card from the pack. You can also select the “pack” and 
press  or . 

 to select the “pack”. 

 to select the last (right-most) rank card. 

 to search automatically for a playable card in the ranks.  searches 
for a playable card from left to right, while  searches for a 
playable card from right to left. 

Scoring 
Rank cards played on the “layout” card earn points as follows:  
King 
Queen 
Jack 
Ten 

12 
10 
8 
6 

Nine 
Eight 
Seven
Six 

4 
2 
2 
2 

Five 
Four 
Three 
Two 

4 
6 
8 
10 

Ace 
Joker 

12 
0 

Runs of cards (up or down) score 10 bonus points for the fourth and subsequent cards 
in the sequence. A Joker ends a run of cards.  
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 You can enter your name so that it will be displayed instead of ‘Person 1’. Select 
the ‘Setup’ option from the ‘Game’ menu, then press  to display the ‘Player 
setup’ dialog. Type your name into the ‘Name’ line. 

Gambling and bonus points 
If you manage to play all the 35 rank cards onto the “layout” card, you get 20 bonus 
points, plus 10 points for each remaining card in the pack, and 50 points for each 
remaining Joker in the pack.  
You can gamble these bonus points by betting high or low on the turn of the next card 
to receive more points or win a Joker. As elsewhere, Aces are low when gambling. 
Alternatively, you can press  to collect your bonus points without gambling. 

The High Scores table 
Your score for the current game is shown at the bottom of the screen. 
When the game is over, a message will tell you if your final score is a personal best. If 
you achieve a high score which earns a place in the High Scores table, the table is 
displayed showing your new position. You can display the High Scores table at any 
other time by selecting the ‘High scores’ option on the ‘Special’ menu. 

If you wish to reset the High Scores, press  when the High Scores table is displayed. 

 Select ‘Player statistics’ on the ‘Special’ menu to find out about the games you 
have played - it tells you your average score and highest score to date.  

 If you wish to reset these statistics, select the ‘Setup’ option on the ‘Game’ menu, 
select the player and press  key to display the ‘Setup player’ dialog. Then 
press  to clear the statistics that are currently stored.  

Starting a new game 
Select the ‘New’ option from the ‘Game’ menu to start a new game. When you start a 
new game, your current score and bonus points will be lost. 

How to play - two-player game 
Patience is initially set up to play a single player game. You can also play with two 
players - each player takes a turn to play a game. The player with the highest score after 
a pre-set number of games is the winner. In two-player games, the current player is 
indicated with a diamond at the bottom of the screen. 
To set up the game for two players: select ‘Setup’ from the ‘Game’ menu, then set the 
‘Number of players’ line to ‘2’ and the ‘Number of games’ line to the number of games 
you want in your competition.  
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Soundmaster 

Soundmaster is an application you can use to record sounds with 
your Series 3c and modify pre-recorded sound files. You can: 

••••  record any sound using the Series 3c built-in microphone, and 
play it back straight away. 

•  modify your recorded sounds, increasing volume, speeding the 
sound up, or adding effects. 

•  mix sound files together, insert silence, erase part of the sound, 
or insert another waveform. 

•  use the sound files you have created for alarms in Time or 
Agenda. 

•  play back other .WVE format sound files, and modify them if 
you wish. If you have PsiWin, you can transfer .WVE or .WAV 
files to your Series 3c to use in Soundmaster. 
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Running Soundmaster 

 

To run Soundmaster: move the highlight to the Sound icon in the System 
screen and press . 

 

Alternatively, you can hold down  and press the ‘Time’ button on the 
Buttonbar; this keypress is pre-assigned to take you to Soundmaster. See 
‘Assigning a button to an application’ in ‘The System screen’ chapter for more 
about assigning a keypress to an application. 

The first time that you run Soundmaster, it will be ready for you to record a new sound.  

Recording sounds 

Where is the microphone? 
The microphone is behind the small hole in the Series 3c casing, on the bottom right, 
just in front of the SSD door. 

Recording a new sound 

To record a sound file: 
1. When you first run Soundmaster: you can record your first file straight away. 

Soundmaster displays a ‘Record new file’ dialog with some details, i.e. the 
filename SOUND.WVE, already filled in for you. 

 At any other time: select ‘New file’ from the ‘File’ menu. 
2. Type a name for this sound file on the ‘File: Name’ line. Soundmaster files are 

automatically given the file extension .WVE, so you do not need to type it. 

 You cannot record directly onto Flash SSDs. You can, however, copy the sound 
files created on the Internal disk to a Flash SSD, and play them back from 
Soundmaster. 

3. Set the length of time you want the recording to last on the ‘Duration’ line. 

 The dialog suggests a maximum duration of two seconds. A recording of this 
length will take up 16K of memory. You can set your sound recordings to a longer 
duration if you want to. Sound files with a longer duration can become quite large 
and use up your Internal disk. 

4. Press . 
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You can now prepare to record the sound. Move the microphone closer to the source of 
the sound, if you need to. Then: 

5. Press  to start recording. If you want to finish the recording before the time 
“runs out”, press . 

You may need to record the sound a number of times to see how close the microphone 
needs to be to the source of the sound; start with it fairly close. 
When the recording is complete, you will see a graphical trace of the sound in the 
Soundmaster screen: 

  

The top line of the screen shows: 

•  The name of the sound file (without the .WVE extension). 

•  The length of the file (in seconds or samples). 
Part of the sound file is displayed magnified on screen - this is the “selection”. At the 
bottom is a trace showing the complete file - the current selection is shown highlighted 
in black. 
The three counters on the right side of the top line are: 

•  The starting point of the selection on screen (i.e. the cursor position). 

•  The duration of the selection. 

•  The end point of the selection. 

 If you prefer, you can set the display and counters in “samples”, rather than 
seconds. Select ‘Set preferences’ from the ‘Special’ menu, and set the ‘Counters 
in’ line to ‘samples’. 

 If you use samples, you can keep an eye on your file sizes more easily as each 
sample uses approximately a byte of disk space. A 2 second file will have 16384 
samples, and will take up around 16KB on your Internal disk. 

Each sound recording is kept in a file, which is given the extension .WVE. These files 
are listed under the Sound icon in the System screen. 
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Playing sounds 

Where is the loudspeaker? 
The loudspeaker is on the underside of the Series 3c casing. It is usually fine to rest the 
Series 3c on a table or flat surface while using Soundmaster. 

Playing a sound 
You can play back any of your sounds on your Series 3c using the options on the ‘Play’ 
menu. To play: 

•  The whole of the current sound file: select ‘Play whole file’ or press . 

•  All of the sound files on your Series 3c and SSDs: select ‘Play all files’. 

•  A selection of the current file: select part of the sound file then use ‘Play 
selection’ or press . 

•  A sound as an alarm: see ‘Using sounds as alarms’ later for more details. 
To lower the volume of the sound played in Soundmaster without changing the sound 
files themselves, select ‘Set preferences’ from the ‘Special’ menu and set the ‘Playback 
volume %’ line. 

Selecting part of a sound file 
If you want to select a different part of the sound file to play, use: 

 to move the selection left or right, without changing the duration. 

 to move the selection left or right by exactly 1 second, without 
changing the duration. 

 to extend or reduce the selection. 

 to move to the start/end of the sound file. 

 to extend or reduce the left-side of the selection. 

Alternatively, you can use ‘Go to position’ on the ‘Special’ menu to move the cursor 
straight to a particular point in the sound file, and set the length of the selection you 
want. 

Battery power and sound playback 

 Playing sound (especially loud sound) does use more battery power than normal. 
The louder and longer a sound is, the more battery power is used. 

If you see a ‘Batteries too low for digital audio’ message when playing a sound, the 
batteries are too low at that time to play the sound. 
Alkaline batteries in particular can recover voltage slightly, and you may find later that 
you can still play short or quiet sounds for a while. 
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Using .WAV files 
Many sound files for PCs exist in .WAV format. This format cannot be played on the 
Series 3c; however, if you have PsiWin, you can convert .WAV files straight into .WVE 
files as you copy them from your PC to your Series 3c. You can then play these sound 
files in Soundmaster, or set them as alarms in Agenda or Time. 

Modifying sound files 
You can use the features in Soundmaster to modify sound files, by editing the sound file 
directly using the options on the ‘Edit’ menu, or by adding effects to the sound 
waveform using the options on the ‘Effects’ menu. 

 The options on the ‘Edit’ menu can affect the length of the file and the sound itself, 
while the options on the ‘Effects’ menu can only affect the sound. 

Choosing the range to modify  
The editing and effects options allow you to modify all or part of a sound. Each option’s 
dialog has a ‘Range’ line that you can set to: 

•  Selection - to modify the part of the sound file selected and displayed on the screen 
(and defined exactly by the counters). 

•  Whole file - to modify the whole file. 

•  From cursor - to modify the sound from the start of the current selection onwards 
to the end of the file. 

•  Up to cursor - to modify the sound from the beginning of the file to the start of the 
current selection. 

•  Precise range - to modify a precise range that you define in samples. The sample 
values given are the same as the current selection in seconds, although you can 
change these. 

If you want to apply a change to part of the sound file, see ‘Selecting part of a sound 
file’ earlier for instructions on how to change the selection. 

Using the Workfile 
When you make any change to a sound file, your changes are made on a version of your 
file called ‘Workfile’. This is a copy of your original file (which is still on disk) stored 
in memory while you make your changes. 
The Workfile: 

•  allows you to make changes to files, while keeping your original file safe. 

•  should be saved if you are happy with your sound file modifications. Use ‘Save’ on 
the ‘File’ menu to save the Workfile back to your original file. On some earlier 
versions of Soundmaster, you should select ‘Save as’ on the ‘File’ menu, and type 
in the original filename. 
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 If you want to exit Soundmaster after making changes, simply select the ‘Exit’ 
option from the ‘Special’ menu. Your sound file will be automatically saved back 
to the original filename. 

 On some earlier versions of Soundmaster, you must save the file using ‘Save as’ 
before you can exit. 

Cancelling changes 
Some effects or changes can take a few moments to be carried out. A bar is shown on 
screen, indicating how long the effect is taking to apply. 

To cancel an effect: press  while the bar is visible. 

To cancel all the changes you have made to the Workfile: select ‘Revert’ on the 
‘File’ menu to return to your original file.  

Inserting silence 
To insert silence into a sound file: select ‘Insert silence’ from the ‘Edit’ menu, and set 
the ‘At’ line to ‘Start of file’, ‘End of file’ or ‘At cursor’ as required. Set the ‘Duration’ 
of silence to insert and press . The length of the current file will be increased 
accordingly. 
To replace part of the sound itself with silence: select ‘Blank (erase)’ on the ‘Effects’ 
menu, and set the ‘Range’ as required. Press . 

Fading in and fading out 
You can use the ‘Fade in/Fade out’ option to make gradual changes to the loudness of 
all or part of your sound. If you ‘Fade in’, the sound will get louder over the range that 
you select; if you ‘Fade out’ the sound will get quieter. 

 These effects are useful for modifying the start and end of sound files which begin 
or end suddenly, to make them start or end less abruptly. 

To use fading: 
1. Select ‘Fade in/Fade out’ from the ‘Effects’ menu and set the ‘Type’ line to ‘Fade 

in’ or ‘Fade out’ as required. 
2. Set the ‘Fade volume %’ line as appropriate. This is the volume required at the 

start or end of the fade, as a percentage of the existing volume at that point, e.g.: 

•  Fade in, with a fade volume of 0%, applies a gradual fade in from silence. 

•  Fade out, with a fade volume of 0%, applies a gradual fade out to silence. 

•  Fade in, with a fade volume of 30%, applies a gradual fade from 30% of the 
original volume. 

•  Fade out, with a fade volume of 30% applies a gradual fade to 30% of the original 
volume. 
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Inserting sounds and mixing 
You can insert or mix other sounds into the current sound file, at the start, the current 
cursor position, or at the end of the file. Use the following options on the ‘Edit’ menu: 

•  Insert waveform - to insert a mathematical waveform (e.g. sine, sawtooth, or 
square-wave). You can also insert ‘White noise’, random noise which makes a 
“hissing” sound. 

Insert a ‘Sine’ waveform to include a “pure tone” in your sound file. You can set 
the frequency of the tone when you use ‘Insert waveform’. Use ‘Sawtooth’ or 
‘Square’ to insert a more discordant sound. 

 Inserting waveforms may take quite a long time. The bar may grow slowly while 
Soundmaster calculates the waveform. 

•  Insert file - to insert another sound file. The sound is inserted (or appended) rather 
than “mixed” in. 

•  Mix with file to “mix” another sound file into your current file. The sound files are 
added together. 

 When you use ‘Mix with file’, set the ‘At’ line to ‘Start of file’ or ‘Cursor’ if you 
want the two sounds to be really “mixed together”. If you set it to ‘End of file’, the 
second file is inserted at the end of the file, as if you’d used ‘Insert file’. 

 If you want to start with a ‘blank’ sound file when mixing sound files, select ‘New 
file’ and enter a filename as usual, then press  instead of  in the ‘Record 
new file’ dialog. You can then insert a waveform or another file, and then mix and 
modify it as described in this chapter. 

Increasing or decreasing the volume 
1. Select ‘Volume’ from the ‘Effect’ menu. 
2. Set the ‘Volume %’ line as appropriate A new volume is calculated as a percentage 

of the existing volume, so: 

•  50% is decreasing the volume by a half. 

•  200% is increasing the volume by twice as much, i.e. doubling the volume. 

•  100% is leaving the volume set as it is. 
3. Set the ‘Range’ as appropriate. See ‘Choosing the range to modify’ earlier. 

4. Press . 

Playing sound backwards 
To reverse (i.e. play backwards) a sound file, or part of it: 
1. Select ‘Reverse’ from the ‘Edit’ menu. 
2. Set the ‘Range’ as appropriate. See ‘Choosing the range to modify’ earlier. 

3. Press . 
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Deleting part of a sound file 
If you delete part of a sound, you will remove that section of the file - the duration of 
the sound itself will be reduced.  
To delete part of a sound file: 
1. Select ‘Delete’ from the ‘Edit’ menu. 
2. Select the ‘Range’ to delete as usual. 

3. Press . 

When you delete a selection or range, the range of the current selection does not 
change, e.g. samples 8610 to 9020 are still displayed; however, this section is now a 
different part of the sound. 

Adjusting the speed of a sound 
You can alter the speed of a sound file, or part of it. This is just like playing a record 
slower or faster. To do so: 
1. Select ‘Adjust speed’ from the ‘Edit’ menu. 
2. Type a new speed into the ‘New speed %’ line. The new speed is a percentage of 

the existing speed, so: 

•  50% is reducing the speed by half. 

•  400% is increasing the speed by 4. 
The actual duration of the sound file will change if you adjust the speed of the file.  

Applying sound effects - vibrato and voxcode 
Vibrato and voxcode effects modify the frequency and volume of your files to make 
them sound different. You can still hear the original sound, with the effect mixed in. 
You can apply: 

•  Vibrato. Use the ‘Vibrato’ option on the ‘Edit’ menu for a more “wavering” 
sound. You apply the vibrato effect as a percentage of the existing volume, and set 
the ‘vibrations per second’ line to the amount of vibrato you want. 

•  Church. Use the ‘Voxcode’ option and set ‘Type’ to ‘Church’ to apply a 
reverberant church-like effect to the sound. 

•  Underwater. Use the ‘Voxcode’ option and set ‘Type’ to ‘Underwater’ to apply a 
muffled underwater effect. 

•  Metal. Use the ‘Voxcode’ option and set ‘Type’ to ‘Metal’ to apply a metallic, 
robot-like quality to the sound. 
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Applying single and multiple echoes 
You can use an echo effect in your sound files, so that a selection of the sound is mixed 
in again a few seconds later at a lower volume. 
You can apply: 

•  A single echo - where an echo is mixed in after a time delay as a percentage of the 
volume of the original sound. 

•  Multiple echoes - where a single echo is mixed in, followed by additional echoes 
each one at a lower volume so that the echoes gradually die away. 

To do this: 
1. Select ‘Echo’ from the ‘Effect’ menu, and set the ‘Type’ line to ‘Single echo’ or 

‘Multiple echoes’ as required. 
2. Type the relative volume for the echo(es) on the next line. This is measured as a 

percentage of the original volume, so 50% is an echo half as loud. If you are using 
multiple echoes, the following echoes are also each 50% quieter in turn. 

3. Type the delay in seconds between each sound and its echo on the ‘Delay of echo 
(in seconds)’ line. 

4. Type ‘Extra time (in seconds)’ if you need to extend the length of the sound file to 
accommodate your multiple echoes - it is sometimes needed if you want a multiple 
echo to die out slowly and you need to extend the length of the sound file to allow 
it. You can leave the ‘Extra time’ line set to 0 for a single echo.  

Applying filters 
You can apply filters which affect certain parts of your sound: 
1. Select ‘Filter’ from the ‘Effect’ menu. 
2. Set the type line to ‘Noise reduction’ or ‘Peak reduction’: 

•  Peak reduction - this reduces sections of sound which are higher in volume than 
the rest. This can cut out loud or distorted sound. 

••••  Noise reduction - this reduces the volume of higher frequency sections of the 
sound. This can reduce the “background noise” in a sound. 

3. Set the ‘Filter %’ line as required. 
4. Set the ‘Range’ as appropriate. See ‘Choosing the range to modify’ earlier. 

5. Press . 



 194

Saving part of a sound to a new file 
You can select part of a sound, and then save the selection to a new file: 

•  Simply select ‘Save selection as’ from the ‘File’ menu, and choose the ‘Range’ you 
want to save. See ‘Choosing the range to modify’ earlier. 

Using sounds as alarms  
When you set an alarm in the Time or Agenda application, the ‘Set alarm’ dialog checks 
your disks for sound files, and will offer them on the ‘Sound’ line. You can simply 
select your Sound files straight from the ‘Set alarm’ dialog. 
Alarms are always played three times, with increasing volume, at 15 second intervals. If 
you record a short sound file for use as an alarm, you may wish to make the file repeat 
automatically so the sound lasts for about 15 seconds like other alarms (e.g. Rings, 
Chimes). You can use the ‘Adjust for repeat’ option to do this - you don’t have to add 
repeats by hand. 

Voice messages and alarms 

 You can record voice notes in Soundmaster, and use them for alarms in the 
Agenda. For example, record an ‘It’s my birthday today’ message and set it as an 
alarm on your birthday. 

 If you want to record a voice message, it is often useful to set the duration to quite 
a long value, then press  to cut the recording short when you finish 
recording. 

Adjusting a short sound file for use for a ‘repeating’ alarm 
Use the ‘Adjust for alarm’ option on the ‘Edit’ menu to set the sound file to repeat as 
often as possible in a 15 second period. It also sets the amount of trailing silence (the 
gap after each repeat) to use in order to take the total time to around 15 seconds. 

 When you use ‘Adjust for alarm’ the sound file will not increase in length (i.e. to 
15 seconds), and the file will not sound any different when you play it in 
Soundmaster. It simply inserts information which tells the Series 3c how to repeat 
the sound when the sound file is an alarm. 

 To hear how the sound file will sound as an alarm, select ‘Set preferences’ on the 
‘Special’ menu and set ‘Playback with repeats’ to ‘Enabled’. Then select ‘Play 
whole file’ as usual; you will hear the sound with the repeats and trailing silence as 
it will now sound as an alarm. 

If you want to customise how the repeats occur in the alarm, use the ‘Set repeats’ 
option; this lets you set the number of repeats for the alarm to any value you wish. 
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Sheet 

Sheet, the Series 3c Spreadsheet application allows you to keep all 
sorts of inter-related numerical information, and to perform 
calculations based on it. For example, you might use it to: 

••••  store a table of product prices with VAT calculations, or 

••••  keep a profit & loss account which you use to perform “what 
if?” calculations. 

The information in this chapter is organised in the following way: 

••••  It begins with an introduction to spreadsheets and their uses, 
guiding new users through the everyday features. 

••••  The bulk of the chapter contains a full reference for the various 
functions and features of Sheet. 

••••  The chapter ends with a list of the differences between Sheet 
and other types of spreadsheet that you may have used. 

Like Word, Sheet offers password protection and encryption, to 
keep confidential information secure. Passwords are discussed in 
the ‘Security & backups’ chapter. 
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Introduction 
Sheet is the Series 3c’s spreadsheet. It’s easy to use, yet is as powerful as many of those 
found on desktop PCs - in fact it works in a similar way to the Lotus 1-2-3 package. 
If you are an experienced spreadsheet user, please turn to the ‘Differences between 
Sheet and Lotus 1-2-3’ section at the end of this chapter for an explanation of the 
differences between the Series 3c Spreadsheet application and other types of 
spreadsheet. 
If you are new to spreadsheets, please read this introductory section and as much of 
the sections that follow as you need. 

What is a spreadsheet? 
•  A large table of cells in which you can enter numbers and text, and perform 

calculations on numbers in the cells using formulae: 

 

•  Spreadsheets can save you a good deal of time on lengthy or complicated 
calculations. They also let you do “what if” type calculations. 

•  All the information you enter in the grid is saved as a “file”, just as the information 
that you enter in other applications is saved in files. See the ‘System screen’ 
chapter for more information about files. Spreadsheet files are also known as 
“worksheets”. 

Memory requirements 
•  You need around 60-65K of free memory to run Sheet the first time that you use it. 

You may need more than this later on to open large spreadsheets. 

•  If you see a message such as ‘No system memory’, and are unable to run Sheet, 
you need to free some more memory. See the ‘Troubleshooting’ chapter for 
suggestions on freeing memory. 
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Creating spreadsheets 
To create your first spreadsheet: 
•  Press the Sheet button on the Buttonbar. You will see an empty grid: 

 

About the grid 
•  Each box in the grid is known as a “cell”; each one is identified by its cell 

reference, made from its column letter (A, B, C...) and its row number (1, 2, 3...). 
The top left cell, for example, is called A1. 

•  The cell you are on is indicated by the “cell pointer” - a dark line around the cell. 
The contents of this cell are shown on the “input line” at the top of the screen. 

•  There are 256 columns, labelled A to IV, and 8192 rows, labelled 1 to 8192. The 
display can only show a small part of the grid, and will scroll as required if you try 
moving the cell pointer off the screen. 

•  You can keep different information and calculations in different sections of the 
grid, for example, you could have a worksheet for all aspects of your personal 
finance: 

 

Pay slips, 
month by 
month 

Tax 
calculation 

Share 
dividends

Mortgage 
calculation

Miscellaneous 
expenses

Savings 

Summary of total income 
and total expenses 

Household 
expenses 
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 By keeping records of all your finances in one file in this way, you can link cells 
together and perform calculations that include amounts from various categories of 
finance. 

•  You can give “range names” to each area (see ‘Naming ranges’ later), to identify 
them more easily, and/or add explanatory text. The results of one calculation (say, 
the ‘Miscellaneous expenses’ calculation) can be used in other calculations (say, 
the ‘Grand total’ calculation). 

This manual uses simple example worksheets - your own may well be larger, but they 
will use the same principles. 

 To create a second, and further new spreadsheet files, select the ‘New file’ option 
in Sheet, or move the highlight to the Sheet icon in the System screen, and use the 
‘New file’ option there. 

Moving around & entering information 

Moving around 
•  Use  to move the cell pointer around the grid. As you move the cell 

pointer, you will see the cell reference of the current cell change. 

•  Press -Home ( ) to move to cell A1. 

•  Use Pg Up and Pg Dn (  and ) to move the cell pointer up and 
down the grid a screenful at a time. To move it by one screenful horizontally, use 

 and . 

•  To move to a particular cell, use the ‘Jump to’ option on the ‘Search’ menu. Leave 
it set to ‘Range/cell’, move to the line below, type in the reference for the cell you 
want, and press . 

•  Press  in cell A1 to move to the bottom right corner of the grid (cell 
IV8192). 

 Cell IV8192 is often used for data which needs to be accessible but out of the way 
of the main work area. 

Entering information 
1. Move the cursor to the appropriate cell and start typing. You’ll see what you’re 

typing in the input line at the top of the screen. 
Sheet treats numbers, text and “formulae” (for sums, see ‘Performing calculations’ later) 
in different ways; it decides whether what you’ve typed is a number, text or a formula 
by the first character you type: 
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First character Sheet treats contents of cell as 
0123456789(.+- number (calculations can be performed on it). To make 

Sheet treat a number as text, type a ‘ before the number, e.g. 
you’d type in a phone number like this: ‘0181-999-
0102 

= formula (for a calculation). To make Sheet treat an = as text, 
type a ‘ before the =, i.e. type ‘= 

other character text (ignored in calculations). If the text starts with a ‘ 
character, you need to type the ‘ character twice, i.e. for ‘text 
in the cell, type ‘‘text 

2. Press  to finish entering data in a cell or use the  keys to move 
to another cell. 

•  If the text you type is too long for its cell, the text is displayed on top of adjacent 
cells to the right, as long as they are empty. (Text strings may be up to 236 
characters long.) If a number is too large for its cell, the cell is displayed filled with 
# symbols. 

•  Numbers can be from 1E-99 (inclusive) to 10E99 (exclusive), from -1E-99 
(inclusive) to -10E99 (exclusive), and zero. If a number outside these ranges is 
entered in a cell (through a formula), that cell is filled with **** characters.  

‘Illegal character’ message 
•  If you see this message when you try to enter data, remember that the first 

character you type controls what type of data you are entering. E.g. 30b is illegal, 
as the initial 3 sets the type of data to numbers, so letters, like b, aren’t allowed. 

Adding & displaying titles for tables 
Many worksheets consist of a table with column titles along the top and row titles down 
the side.  
To lock the titles on screen (to remind you of what the data in a given cell means): 
1. Go to the cell immediately below the column titles, and to the right of the row 

titles. This will usually be B2. 
2. Select ‘Titles on’ from the ‘View’ menu.  
Important: You cannot turn titles on if the cell pointer is in A1. 
A thin line now separates the titles area from the working area.  

 You cannot move the cell pointer into the titles area.  

 To enter or edit data in cells which are part of the titles: you must turn titles off. 
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The working area of the grid - the extent 
The extent is the area which encompasses all the cells in which you’ve entered 
information. To move around this area: 

•  Press  and  to go to the left/right edge of the extent. 

Working with ranges (blocks of cells) 

You can highlight a range (block) of cells in Sheet, in the same way that you highlight 
text in Word. Cell ranges have many uses: 

•  You can use them to change the display of a group of cells, or copy data into them 
which is easier than doing it cell by cell. (See ‘Changing the display’ and ‘Cutting 
& copying information’ later for more details.) 

•  You can use them for calculations that work on sets of numbers for example, 
averaging a set of figures. (See ‘Using functions & “ranges of cells” in 
calculations’ later for more details.) 

Highlighting ranges 
••••  To highlight a range: move to a cell in one of the corners of the range you wish to 

highlight. Then hold the  key down and press any arrow key to extend the 
range in that direction. 

 You can press  to highlight the whole of the current row, and 
 to highlight the whole of the current column.  

••••  To remove the highlight on a range of cells: press , or use the arrow keys 
to move the cell pointer outside the highlighted range. 

Moving around a highlighted range 
•  Home/End, / , and /  keep the cell pointer 

within the highlighted range; if you then go outside the range, the highlight is 
removed. 

•  Home and End (  and ) go to the left/right edge of the 
highlighted range. 

•   with Home/End goes to the top left/bottom right of the highlighted range. 

•   and  move one cell right or left respectively. They “wrap around” 
to the next row when they reach the edge. 

•   steps down the first column, then down the second, and so on. When 
it reaches the end of the range, it returns to the beginning. 

•   works in a similar way, moving up and left. 

•  Use ‘Jump to’ to move to a cell in a corner of the highlighted range. 
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Referring to ranges 
You can refer to the numbers contained in ranges of cells in formulae for calculations. 
You do this using the reference to the top left hand cell in the range and the bottom 
right-hand cell in the range, e.g. (A1:D4). See ‘Using functions & “ranges of cells” in 
calculations’ later for more details. 

Naming ranges (blocks of cells) 
If you use a range of cells over and over again, e.g. an area of your spreadsheet where 
you keep your “Bills” calculations, you can give it a range name by which you can refer 
to it. You can use the range name in formulae (see ‘Using range names in formulae’ 
later), and with ‘Jump to’ to move directly to the range (see ‘Moving to a named range’ 
later). 
To name a range: highlight the range, then use the ‘Name range’ option on the ‘Range’ 
menu. Type in a descriptive name for the range.  

 Names can be up to 15 characters long. They can contain letters and numbers, but 
they must start with a letter. Since they can be used in place of cell references, they 
cannot themselves be valid references (such as A1, etc.). 

If you try to use a name which has already been defined, you will be asked whether you 
want to replace the previous definition. 
To edit or delete range names: select the ‘Edit range’ option on the ‘Range’ menu. 
You can re-edit the name of a range, change the range to which a name refers, or delete 
a range name entirely. 

 While a named range is highlighted, you can use ‘Jump to’ to jump to one of the 
corners of the highlighted range: ‘Top left’, ‘Top right’, ‘Bottom left’ or ‘Bottom 
right’. The range will remain highlighted. 

Moving to a named range 
•  Select the ‘Jump to’ option on the ‘Search’ menu. It will offer ‘Named range’ as 

one of the types of places you can jump to. When you jump to a named range, the 
cell pointer goes to the top left corner, and the whole range is highlighted. 
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Performing calculations 

There are two ways to perform a calculation in Sheet: by calculating the sum in a single 
cell, or by using separate cells to store the numbers involved in the sum, and then using 
a “formula” to calculate the result in another cell. 

Calculating a sum in a single cell 
This method is best suited to simple calculations where the numbers will not change: 

•  Move to the cell and enter the entire sum on the input line. The sum is immediately 
calculated and the result is entered in the cell. E.g. if you entered 78*36 you 
would get 2808 as the result in the cell. 

Calculating a sum using a formula 
This method is best suited to more complex calculations where: 

•  you wish to change and update numbers that are used in the calculation to perform 
“what if” type calculations, or 

•  the numbers involved in the calculation are dependent on numbers and calculations 
in other areas of the spreadsheet. 

To use a formula to calculate a sum: 
1. Type all the numbers that are part of your sum in separate cells. E.g. to add four 

numbers together, enter each number in a separate cell, A1, B1 C1, and D1 say. 

2. In another cell, A3 say, type a formula for the sum.  
 You must start the formula with an = character, then enter the cell references A1, 

B2 and so on of the cells that contain the numbers in the sum, separated by the 
mathematical operators that you wish to use (see ‘Mathematical operators - + * / 
etc. in calculations’ later). E.g. type the formula =A1+B1+C1+D1. 

3. Press  to calculate the result. The result is displayed in the formula cell; 
however, you will still see the formula in the input line at the top of the screen.  

 You don’t have to re-type a formula to use it elsewhere in the grid; you can copy 
and paste it; the spreadsheet will update the cell references it contains to account 
for the formula’s new position. See ‘Cutting & copying information’ later for 
details. 

 With complex calculations, it is best to break a calculation down into its 
constituent parts, and store those constituent parts in separate cells that are referred 
to by the formula for the “grand total”. You can have as many levels of formulae as 
you like in a worksheet. You can make a change at any level and the effect will 
‘ripple through’ to the top. 
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Mathematical operators - + * / etc. in calculations 
Operator     precedence 
**   raise to power   1  
-  make negative   2 
* /   multiply, divide   3 
+ - &  add, subtract, string concatenate 4 
= > >= < <= <>  comparison operators  5 
NOT, AND, OR logical operators   6 
%  percent    (precedence varies) 
In this list, the precedence numbers indicate the order in which the calculation is 
performed. E.g. 2+3*4 would evaluate as 2+12, not 5*4. Where precedence is equal, 
calculation is from left to right (except for powers, which evaluate from right to left). To 
override this order of precedence, use brackets. E.g. use (2+3)*4 to get the result of 
5*4. 

AND, OR and NOT work in the same way as in OPL. Refer to an OPL Programming 
manual for more details. 
The % operator 
The percent operator % can be used after a number to mean “divide by 100”. For 
example, as in Calc, 500*10% is the same as 500*0.1 - both mean “10 percent of 
500”. 
The ‘&’ operator  
You can add together (concatenate) two text strings with the & operator. For example, if 
A1 contains xyz and B1 contains abc, the formula =A1&B1 will give the text string 
xyzabc. In practice, string concatenation is rarely used. 

Using functions & “ranges of cells” in calculations 
•  Sheet has a set of functions for various types of calculation which you can use in 

formulae, in a similar way to OPL functions in the Calculator. E.g. the formula 
=COS(A4) uses the COS function to calculate the COSINE of the number in cell 
A4. A full list of Sheet’s functions is given later in this chapter. 

•  You can use a mixture of functions and operators in formulae, e.g. you could use 
the formula =COS(A4)/2 

•  To refer to numbers in the same row or column in a formula, you can enter a 
“range reference”; this is the reference for the first and last cells, separated by a 
colon. E.g. to add up the contents of the cells A1, B1, C1 and D1, you could enter 
the following formula using the SUM function: 
=SUM(A1:D1) 

•  To refer to the numbers in a “block” of cells like this: just enter the reference to the 
top left and bottom right cell in the block. E.g. to add up the contents of the cells 
A1, A2, B1, B2, C1, C2, D1 and D2, you could enter the formula =SUM(A1:D2) 

•  To enter a one-off calculation (as opposed to a formula) which starts with a 
function name, use a + symbol, e.g. +COS(pi/4) 

 You can select a range of cells while typing in a formula, by “range painting”. 
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To paint a range: 

1. Press . A new icon appears in the top right of the screen, and the 
reference of the current cell is inserted, highlighted, in the input line. 

 The arrow keys now move the cell pointer, and as they do so, the highlight in the 
input line changes to reflect the current cell. 

2. Highlight the range you are interested in. 

3. Press , and the cell or range reference appears on the input line. 

Using range names in formulae 
•  To use a range name in formulae, enter it instead of the range reference. If 

totals is a name for the range A3:A12, you could enter the formula 
=SUM(totals) instead of =SUM(A3:A12) 

 Named ranges act as relative references when you copy formulae that contain them. 
(See ‘Cutting, copying & pasting formulae’ later for details.) 

Recalculating sums - changing the numbers & formulae 
•  “What if?” calculations - try different values in the cells that are referred to in 

your formula to see what effect they have on the result. Sheet will recalculate the 
result automatically. 

 You can extend a named range without having to change any formulae that refer to 
it. Just use the ‘Edit range’ option on the ‘Range’ menu to change the cells that are 
included in the named range. 

•  Changing the formula - you can change formulae like any other piece of data; 
when you do, Sheet will recalculate the result automatically. 

 In larger worksheets, a Recalculating message may be shown while Sheet is 
recalculating. You can continue to use all the features of Sheet while it is 
recalculating, e.g. you can move to a different area of the grid and start entering 
data. 

•  Turning automatic recalculation off - select ‘Set preferences’ on the ‘Special’ 
menu, and set ‘Auto recalculation’ to ‘No’. Now, when you make a change, the 
grid will continue to display the old results of formulae. A +/- indicator comes on 
at the right end of the input line, when there are formulae in the grid which need to 
be recalculated to display the correct results. 

 Setting recalculation to manual can save battery power and improve response, 
particularly with large worksheets. 

•  Recalculating manually - if automatic recalculation is off, select the ‘Recalc’ 
option on the ‘Edit’ menu to recalculate all the formulae. 

Circular references - formulae that refer to themselves 
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•  If you enter a formula that refers directly or indirectly to itself, you create a 
“circular reference”. Since you should try to avoid these references because of the 
strange and unpredictable effects they can cause, Sheet will warn you when you 

have done this by displaying the  symbol. 

•  If Sheet warns you of a circular reference, you can jump straight to one of the cells 
involved by selecting the ‘Jump to’ option on the ‘Search’ menu. 

 If you have manual recalculation set on, the circular reference symbol may not be 
up to date, as the worksheet is only checked when you recalculate it manually. See 
‘Recalculating sums - changing the numbers & formulae’ for details of 
recalculating spreadsheets. 

Editing worksheets 

Changing the contents of cells 
•  To edit as you type: press the  key to delete to the left of the cursor. 

Remember that the arrow keys enter the data, then make the cell pointer move. If 
you press  (‘Home’) or  (‘End’) you can use the full range of 
Series 3c editing keys, including . When you’ve finished editing, 
press  to enter the data in the current cell. 

 If Sheet displays an error message such as ‘Illegal character’, because you have 
tried to enter something it doesn’t understand, it will automatically let you edit the 
whole input line. 

•  To re-edit the current cell: press . Here again you can use the full range of 
editing keys, including . 

•  To overwrite the current cell: just type the new entry.  

•  To delete the current cell: press the  key. 

Clearing selected information  
•  The ‘Clear’ option on the ‘Range’ menu lets you selectively clear the information 

in a range of cells. (It does not affect the clipboard.) It has settings for ‘Formulae’, 
‘numbers’ and ‘text’.  

•  If you choose the ‘Formats’ setting, any empty-looking cells which still contain 
format or alignment information are cleared; no other cells are affected. 

•  If you use the ‘Clear’ option, set ‘Formulae’ to ‘Convert to values’, and set all of 
the other options to ‘No’, any formulae in the highlighted range will be replaced by 
their current values. 

Undoing changes  
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•  To “undo” the last change you made to the worksheet: select the ‘Undo’ option on 
the ‘Edit’ menu. The name of the ‘Undo’ option reflects the last operation you 
performed. E.g. delete cell A1. The ‘Undo’ option appears in the menu as ‘Undo 
delete’; select it, and A1 is restored. 

You can use ‘Undo’ on the following operations: 

•  ‘Paste’, ‘Bring’, ‘Paste special’, ‘Insert cells’ and ‘Delete cells’ in the ‘Edit’ menu. 

•  ‘Format’ and ‘Alignment’ in the ‘View’ menu. 

•  ‘Protection’, ‘Clear’ and ‘Sort’ in the ‘Range’ menu. 

•  ‘Data extract’, ‘Data delete’, ‘Table 1’ and ‘Table 2’ in the ‘Database’ menu. 

 Changes made to the clipboard cannot be undone. So if you copy one cell, then 
delete a second, and then select ‘Undo’, the cell which was deleted will be 
restored, but the clipboard will still contain a copy of this second cell, not the cell 
you copied first. 

To disable the ‘Undo’ feature: select ‘Set preferences’ from the ‘Special’ menu and set 
‘Keep undo buffer’ to ‘No’. This can save memory, and also makes Sheet run more 
quickly. 

Making large changes - saving & reverting 
Before making a large change, you may wish to save the worksheet as it is, so that you 
can revert back to the way it was if anything goes wrong. 

•  To save the worksheet: use the ‘Save’ option on the ‘File’ menu. This saves this 
working version to the real file on the disk. 

 The file is also saved when you use the ‘Exit’ option, or if you change to a 
different file, either with the ‘Open file’ option on the ‘File’ menu, or from the file 
list in the System screen. 

•  To revert to the saved worksheet: select the ‘Revert’ option on the ‘File’ menu. 

Preventing cells from being edited 
You can “protect” cells to prevent their contents being modified, e.g. to stop the 
formulae that you have set up being changed. 

••••  To protect cells: highlight them, and then use the ‘Protection’ option on the 
‘Range’ menu. Press the  key to turn protection on for the range. 

A padlock symbol is displayed, at the right-hand end of the input line, if the current cell 
is protected. If you try to paste, delete or clear any cells which have been protected, you 
will see a message ‘Protected cells were not changed’.  

••••  To remove the protection on cells: highlight the cells and then use the 
‘Protection’ option again. This time, press the  key to unprotect the range 
shown. 

••••  To unprotect all protected cells temporarily: select ‘Set preferences’ from the 
‘Special’ menu, and set ‘Override protection’ to ‘Yes’. 
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Cutting & copying information 

The “clipboard” holds all the information about a cell: values, formulae, and format and 
alignment information (see ‘Changing the display’ later for information about 
formatting in Sheet). Cell information remains on the clipboard until you copy 
something else, or delete the contents of a cell. 

Cutting, copying & pasting (inserting) cells 
•  To cut a cell, or all highlighted cells: press . 

•  To copy a cell, or all highlighted cells: use the ‘Copy’ option on the ‘Edit’ menu. 

•  To insert copied cells: move the cell pointer to the right position, then use the 
‘Paste’ option on the ‘Edit’ menu. 

 ‘Paste’ differs from the ‘Insert’ options found in the other built-in applications, as 
it deletes the existing contents of cells and replaces them with the contents of the 
clipboard. To move existing cells out of the way before using ‘Paste’, you need to 
add rows, columns or a block of cells large enough to contain the pasted 
information; see ‘Inserting & removing cells, rows & columns’ for details. 

•  If you mistakenly overwrite something with ‘Paste’, the ‘Undo Paste’ option will 
“undo” the damage. 

•  To copy cells from one worksheet to another: use ‘Copy’, then ‘Open file’ to 
open the other worksheet, and ‘Paste’ to paste the cells into this second worksheet. 

Cutting, copying & pasting formulae 
When you paste a cell containing a formula, all the cell references in the formula 
automatically change to reflect the formula’s new position in the grid. E.g. if A1 
contains the formula =A2+4, and you copy and paste it into cell B1, the formula in B1 
would be =B2+4 not =A2+4. This is in order to preserve the same meaning as in the 
original formula. Cell references that change in this way are known as “relative 
references”. 
Range names in formulae also act as relative references. 
To stop cell references in a formula changing when you cut/copy & paste: 
•  put a $ sign before the parts of the cell references that you don’t want to change. 

E.g. to make =A2+4 stay the same when you copy it from A1 to B1, type the 
formula as =$A$2+4. Cell references like this that do not change when you copy 
them are known as “absolute references”.  

 To make a range name an absolute reference, add a $ symbol in front of the name, 
$totals, for example. 

To fix just the row or the column part of a cell reference: 
•  put a $ before the part you don’t want to change. E.g.: 

Formula in A1 will paste into C3 as 
=$B2   =$B4  
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=B$2   =D$2  
=$B$2   =$B$2  

Inserting & removing cells, rows & columns 
When you insert and remove cells, rows or columns, all cell references in formulae 
contained in cells that shift position are adjusted so that they still refer to the same cells 
in their new positions. 

•  To insert a new row: move onto the row above the position for the new row, and 
press  to highlight the whole row (to insert more than one new row, 
press  and highlight the number of rows to add). Select ‘Insert cells’ from 
the ‘Edit’ menu, set ‘Action’ to ‘Insert entire rows’, and press . 

•  To insert a new column: move to the column that you wish to be on the right side 
of the new column, and press  to highlight it (to insert more than one 
new column, press  and highlight the number of columns to add). Select 
‘Insert cells’ from the ‘Edit’ menu, set ‘Action’ to ‘Insert entire columns’, and 
press . 

 Rows always shift down to make room for the extra row; columns always shift to 
the right if you’re inserting new columns. 

•  To remove rows or columns: highlight the row/column to be removed, with 
 or  (to remove more than one row or column, use  

and an arrow key to extend the highlight). Select ‘Delete cells’ from the menu, set 
‘Action’ to ‘Delete entire rows/columns’, and press . 

•  To insert a block (range) of cells: highlight the range where you wish to insert a 
new rectangle of blank cells, shifting the present cells out of the way. Select ‘Insert 
cells’ from the ‘Edit’ menu, set ‘Action’ to ‘Shift cells right’, or ‘Shift cells down’ 
depending on where you want the cells currently in the range to move to, and press 

. 

•  To remove a block (range) of cells: highlight the range to remove, as if you were 
going to delete it. Select ‘Delete cells’, set ‘Action’ to ‘Shift cells left’, or ‘Shift 
cells up’ as the direction to move cells into this range, and press . 
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Choosing the cell contents to paste  
Use the ‘Paste special’ option, rather than ‘Paste’ if you want to choose which aspects 
of the cell information to paste: 

••••  If the cell you copied contained a formula: set the ‘Formula’ line to ‘Yes’ to 
insert the formula in the new cell. To paste the result of the formula, not the 
formula itself, set ‘Formula’ to ‘No’, and set ‘Numbers’ to ‘Yes’. 

••••  If the cell you copied contained numbers: make sure the ‘Numbers’ line is set to 
‘Yes’, otherwise nothing will be pasted in the new cell. 

••••  If the cell you copied contained text: make sure the ‘Text’ line is set to ‘Yes’, 
otherwise nothing will be pasted in the new cell. 

••••  If the cell you copied had formatted characters: set the ‘Formats’ line to ‘Yes’ 
to make the pasted information retain its formatting. 

Choosing the pasting action - adding to cell contents etc. 
Use the ‘Paste special’ option, rather than ‘Paste’ if you want to choose how pasted data 
will affect the current contents of a cell. Change the setting on the ‘Action’ line: 

••••  To insert the new data: select ‘Overwrite’. The existing contents of the cells will 
be deleted and replaced. 

••••  To add the pasted data to the current contents of the cell: select ‘Add’. 
Formulae and/or numbers are added together; text strings are concatenated (joined 
together). 

••••  To subtract the pasted data from the current contents of the cell: select 
‘Subtract’: numbers and formulae on the clipboard are subtracted from the existing 
ones. (Subtracting has no effect on cells which contain text.) 

If you try to mix text with numeric values, the cell will be left with its contents 
unchanged. 

Pasting when a range is highlighted 
•  If you highlight a range which is smaller than the range on the clipboard, no paste 

will be done at all. 

•  If you highlight a range which is larger, the clipboard contents will be repeated as 
many times as possible within the range. 

For example, you may want to fill a range of cells with the same formula. Enter the 
formula once, copy it, highlight the whole range and select ‘Paste’. The cell references 
will be automatically modified, because they are relative references. 



 210

Copying to & from other applications with ‘Bring’ 
You can use the ‘Bring’ option on the ‘Edit’ menu to copy data highlighted in another 
application. To get data out of the Sheet, highlight it, then select ‘Bring’ in the other 
application. 
1. In the file you are copying from, highlight the data to be copied. 
2. Move to the file to which you want to copy the data. Position the cursor or cell 

pointer where you want the data to go, and select ‘Bring’ from the ‘Edit’ menu. 
The data is copied in. In Sheet, it will overwrite cells, just like ‘Paste’. 

•  Between two worksheets all values, text and formulae are copied. This is as if 
you’d used ‘Copy’, then opened the second worksheet and pasted the data in. 
Relative references in formulae are automatically updated. Absolute references are 
left as they are. The format, alignment and protection information are also copied. 

 Both files must be open at the same time. To open the second one without exiting 
the first one, highlight it in the System screen and select it with . 

•  Between a Sheet and other applications, everything you can see is pasted. 
Formulae are copied as the values they display on the screen. Format information 
is lost. A row in the Sheet corresponds to a line in the other application.  

Some applications will limit the amount of data they accept, for example, taking only 
the first line of the data. 
If you separate numbers and text in Word with tab characters, you can ‘Bring’ them into 
separate cells in Sheet.  

Error messages when entering data 

These are the error messages specific to Sheet. They may occur when you try to enter 
data into a cell. After one of these errors, the cursor is automatically positioned in the 
input line at the point where the error was detected. 

••••  Illegal character: You’ve tried to enter a number or formula containing a 
character not allowed in that type of data. 

••••  Function argument error: You’ve given the wrong number of arguments to one 
of the Sheet functions. See the ‘Function reference’ later for more information. 

••••  Type mismatch: You’ve given the wrong type of argument (for example a range 
instead of a cell reference) to one of the functions. 

••••  Syntax error: You’ve mistyped a formula. 

••••  Mismatched ( or ): You’ve missed out an opening or closing bracket. 

••••  Too complex: You’ve tried to type in a formula which is too complex for the Sheet 
to evaluate. 
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Sorting information 
To sort a table of data into alphabetic or numeric order, e.g. to sort product information 
by price: 

 

1. Highlight all the cells in the table, (not just the ones that contain the data on which 
the sort is to be based), then use the ‘Sort’ option on the ‘Range’ menu: 

 

2. In this example, each row has the data for one product, so you want to leave ‘Sort 
by’ set to ‘Rows’. The ‘1st key’ is the sort key - “what to sort by”; to sort 
according to price in the example, use column B as the 1st key. 

 If you have rows/columns which have the same value for the first sort key, you can 
sort them according to a second sort key. 

3. The second line of the ‘Sort’ dialog controls the order in which the rows/columns 
are sorted. ‘Ascending’ means that cells are ordered from lowest to highest. 

When you press , the rows are rearranged in the desired order. Any relative 
references in formulae are automatically modified. 

 Cells containing text are sorted alphabetically, before (“lower than”) cells 
containing numeric data. If you set ‘Case sensitive’ to ‘Yes’ in the ‘Sort’ dialog, 
lower-case characters always sort after upper-case characters. 
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Searching for text, numbers & formulae 

To search the entire spreadsheet 
1. Select the ‘Find’ option on the ‘Search’ menu. 
2. On the ‘Search for’ line, type in the characters to search for.  

 You can’t use “wildcards” in search clues. 

3. Set the ‘In’ line to control where to search. ‘Values’ means text, numbers, and the 
current results of formulae; ‘Formulae’ means only the formulae, not their results; 
‘Values & formulae’ means all of the data in your worksheet. 

4. To find only cells with an exact match, set the ‘Exact match only’ line to ‘Yes’. If 
you set the ‘Case sensitive’ line to ‘Yes’, characters must also have the same case. 

The first cell in which a match is found becomes the current cell.  

 If you have titles on, cells in the titles area will not be found. 

To find the next occurrence 
•  Select the ‘Find again’ option, also on the ‘Search’ menu. Keep selecting ‘Find 

again’ until you find the cell you are looking for. 

 ‘Find’ starts searching from the current cell. ‘Find again’ starts searching from the 
cell after the current cell. They then search across the current row to the edge of the 
extent. Then they search from the left end of the next row, and so on. At the end of 
the worksheet area, they loop back and start searching from cell A1. 

To search within a particular block (range) of cells 
•  Highlight the range before you start the search. ‘Find’ and ‘Find again’ will then 

only search inside this range. 
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Changing the display 

Changing column widths 
••••  To change the width of whole columns: use the ‘Column widths’ option on the 

‘View’ menu. (If you want to change more than one adjacent column, first 
highlight any range of cells which extends across the columns to change.)  

••••  To reset columns to the current default width: set the ‘Action’ line of the 
‘Column widths’ dialog to ‘Restore’. 

 Column width is measured in numeric character widths - in other words, the width 
of a zero. The default width is initially 8 characters. 

If a number cannot be displayed because the column is not wide enough, the cell is 
filled with # symbols. The cell contents are unaffected; if you move the cell pointer 
onto such a cell, the contents will be displayed in the input line.  

Aligning text & numbers in cells 
By default text aligns left, and numbers and formulae align right. 

••••  To align text as you enter it: start the text with one of these alignment prefixes: 
 ‘  align left 

"  align right 
^  centre  
\  repeated (The \ prefix repeats text in a cell as many times as will fit.) 

••••  To align a cell or range: move to the cell, or highlight the range, and use the 
‘Alignment’ option on the ‘View’ menu. 

 Leave the top line of the ‘Alignment’ dialog set to ‘Range’. You can set either the 
alignment to be used for displaying text, or the alignment for displaying numeric 
data. Set ‘Cell type’ to ‘Text’ or ‘Numeric’, then set ‘Align’ to the desired 
alignment. 

 ‘Numeric’ alignment can only be set to ‘Left’ or ‘Right’. ‘Text’ alignment also has 
‘Centred’ and ‘Repeated’ options. 

 If you want to set both text and numeric alignment for a cell or range, you must use 
the ‘Alignment’ option twice. 

 Setting the alignment of empty cells takes up memory, so do this only for cells 
which are going to contain data. If you highlight a whole column or row, the range 
shown in the dialog will be cropped either to row 100/column Z or to the extent, 
whichever is larger. 

•  To change the default alignment: (used for all cells which have not had their own 
alignment set) in the ‘Alignment’ dialog, set the top line to ‘Default’. You can set 
the alignment either for text or for numeric data, in the same way as before. 
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Changing number formats 
These affect cells containing numeric data (numbers, and the results of formulae). Cells 
containing text are not in general affected by the ‘Format’ option. 
To set a display format: move to the cell you wish to set (or highlight a cell range, 
columns or rows), then use the ‘Format’ option on the ‘View’ menu and set the ‘Show 
as’ line to the format you wish to use. 
To change the default format: change the setting in the ‘Set’ line to ‘Default’ and 
select the format as before. 

 Setting number formats for blank cells does use up memory. 

Available formats include: 
•  Fixed - numbers are displayed to a fixed number of decimal places. 

•  Scientific - numbers are displayed in scientific (exponential) notation for example, 
3.24E-1 . 

•  Currency - like ‘Fixed’, but with a currency symbol. Negative numbers are shown 
either in brackets (the default setting), for example (£54.00), or preceded by a 
minus sign, for example -£54.00. 

•  Percent - like ‘Fixed’, but with a % sign. Percentages should be entered as decimal 
fractions, so to enter 71%, type in 0.71 . 

•  Triad - like ‘Fixed’, but with a Triad separator (a comma) between every three 
digits. 

•  General - numbers are displayed to as many decimal places as will fit in the cell at 
its current width. 

•  Default - numbers are displayed in whichever format is the default, as set in the 
‘Format’ dialog. 

•  Hidden - hides the contents of cells. The contents are still shown in the input line. 

•  Bargraph - numbers are displayed as horizontal bargraphs. Like text, bargraphs 
overflow across adjacent cells if they can’t fit into a cell at its current width, as 
long as the adjacent cells are empty. Negative values are shown as bars with no 
outline. 

•  Show formulae - formulae are displayed as they appear in the input line. 
(Numbers are displayed in ‘General’ format.) 

•  Date and Time - numbers generated by the date and time functions (described 
later in this chapter) are displayed as dates and times. 

Changing the style of text in cells 
•  Highlight the cells whose text you want to change and select the ‘Change styles’ 

option. The font styles work rather like styles in Word: you can set any range to 
have any of the four font styles. 
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•  Initially, the font styles are defined to use the same font, but in normal, bold, italic 
and bold/italic. The screen display reflects the underline/bold/italic settings of the 
font styles. 

See the ‘Printing’ chapter for more details of these styles. 

Changing how numbers are displayed 
If you make changes to these settings, Sheet takes your settings into account when you 
return to it. This also causes a recalculation. To change the settings: 
1. Select the ‘Number formats’ option on the ‘Control’ menu in the System screen. 

2. Press  on the dialog line for the numeric settings you wish to change. 

If you select ‘Number separators...’: you can set the decimal point character, 
thousands separator, and whether thousands should be separated. 
If you select ‘Currency...’: you can change the currency symbol, decimal places, 
symbol position in relation to the amount, and how negative amounts are displayed. 
To enter a character not on the keyboard as the currency symbol: 
1. Look up the decimal code of the character that you wish to use in the Appendix to 

this manual. Note its decimal code. 

2. Hold down  and type the character’s 3-digit decimal code, then release the 
 key. E.g. to enter the ¥ character for Yen, you would hold down  

and type 190. 
Sheet treats the ‘Number separators’ settings as follows: 
•  The ‘Decimal point’ setting is used in all decimal numbers displayed by Sheet. If 

you use dot as the decimal point character, use a comma between parameters to 
functions. If you use comma as the decimal point, use a semicolon between 
parameters. (You will have to do the same in Calc, when you call a function or 
OPL procedure.)  

•  When displaying numbers in ‘Triad’ format, Sheet will separate every three digits 
with the ‘Thousands separator’ character. If ‘Separate thousands’ is set to ‘10000 
and above’, no separator will be used for four digit numbers. 

•  When displaying numbers in ‘Currency’ format, the ‘Separate thousands’ setting 
controls whether every group of three digits is separated (the way they are in 
‘Triads’ format).  

•  Sheet uses the settings on the ‘Currency’ line only when displaying numbers in 
‘Currency’ format, taking all four settings into account. 

Showing / hiding grid lines 
•  Select the ‘Show’ option on the ‘View’ menu and set ‘Grid lines’ to ‘Yes’ or ‘No’. 

Hiding cells containing zero 
•  Select the ‘Show’ option on the ‘View’ menu and set ‘Zero values’ to ‘No’. 
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Working with spreadsheet files 
Important: Sheet does not work directly on a file: when you edit a file, you change the 
version which is currently held in memory, not the version on the disk. 

Exiting Sheet & saving files 
•  As in other Series 3c applications, the normal ‘Exit’ option will always save the 

current worksheet to file. 

•  To save the worksheet at other times: use the ‘Save’ option on the ‘File’ menu. 

 Although the position of the cell pointer is stored as part of the file, a worksheet 
will not be re-saved if moving the cell pointer is the only change you make. 

•  To exit without saving your changes: use the ‘Exit, lose changes’ option instead. 

Managing spreadsheet files 
You can create, open, copy and delete worksheet files in the same way as Word 
documents. E.g. to create a new file: 

•  In Sheet: use the ‘New file’ option on the ‘File’ menu. 

•  On the System screen: move the highlight to below the Sheet icon and select the 
System screen’s ‘New file’ option. 

In the ‘Create new file’ dialog shown, type a name for the new file, for example, 
budget. The name can be from one to eight letters and numbers, and must begin with 
a letter. See ‘System screen’ chapter for more information about working with files. 
Important: It is usually better to keep worksheets on the ‘Internal’ disk or a Ram SSD. 
A Flash SSD will slowly fill up as you keep saving worksheets to disk. 

 If you keep more than one spreadsheet open, you can assign one of the application 
buttons to act as another Sheet button. You can then simply press that application 
button to switch between your two spreadsheets. See the ‘System screen’ chapter 
for more information on how to do this. 

As with any important information, you should back up your worksheet files regularly 
either to an SSD which you keep separate from your Series 3c, or via PsiWin to another 
computer. See your Psion distributor for more information about PsiWin. 

Backup files  
•  To keep the previous version of a file as a backup, whenever you save a file: 

use ‘Set preferences’ from the ‘Special’ menu and set the ‘Keep backup files’ line 
to ‘Yes’. The backup file will be in the same directory and have the same filename, 
but with the .SP! file extension.  
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Important: ‘Disk full’ error message 
If a ‘Disk full’ error prevents Sheet from saving a file, a ‘Not saved, continue anyway?’ 
message will appear.  

•  Press  to answer ‘No’ to this, and your changes are safe; Sheet will stay as it 
was, keeping the file open. Use the System screen to free some more disk space, 
then try again. (If the file is on a Flash SSD, use ‘Save as’ to save the file onto a 
different disk.) 

•  If you answer ‘Yes’ to the ‘Not saved, continue anyway?’ message, you will exit 
Sheet and lose any changes. The previous version of the file will still exist, though 
it will normally have a .SP! file extension, like backups. You can find it if you 
move the highlight in the System screen to below the Sheet icon, and press . 

Exchanging files with other spreadsheets  

Using Sheet files on other Psion computers 
•  You can use Sheet files from the Series 3c with the Sheet application on other 

Psion computers (the Siena, Series 3a, Series 3, MC and Workabout) without any 
need to convert the file. 

 The SPR file format on the Series 3c is a superset of that used by the Psion MC 
Spreadsheet. You can transfer files between the computers in both directions, but 
with one proviso: if you move a Series 3c worksheet to the MC and save it on the 
MC, any information not used by the MC Spreadsheet, graphs, for example, will be 
lost. 

•  To transfer a Sheet file to another Series 3c or Siena: simply “beam” the Sheet file 
across to the other Psion. See the ‘Infrared’ chapter for more information about 
copying files with Infrared. 

•  To transfer a Sheet file to another Psion computer that doesn’t support Infrared: 
copy the file to an SSD, and then copy the file on the SSD onto the other Psion 
computer. 

Using Sheet files with PC spreadsheet applications 
•  Files from Sheet can be loaded into other spreadsheet packages, such as Excel or 

Lotus 1-2-3, and vice versa. 

•  You can use PsiWin to transfer worksheet files between the Series 3c and a PC. 
See your Psion distributor for more information about PsiWin.  

•  You don’t have to transfer files at all, though; while linked to a PC you can save 
and open worksheet files directly on the other computer, without copying the file 
to the Series 3c. (When linked, the PC drives become available to you as the 
REM:: filing system. See the PsiWin User Guide for full details.) 



 218

Exporting - saving a spreadsheet in a different format 
To “export” to another spreadsheet program, use ‘Save as’, and set the ‘File type’ to one 
suitable for your other spreadsheet program. The file extension will be set to match the 
file type. 

Spreadsheet formats supported by Sheet 
The file formats which Sheet supports have these file extensions: 

•  SPR - the Series 3/3a and Series 3c Sheet format. (You can transfer SPR files to 
and from a Series 3, as long as you do not use the ‘Password’ option in the Series 
3c Sheet.) 

•  WKS or WK1 - a standard format which most spreadsheet programs support, in 
which virtually all the information in your worksheet is saved. 

 SPR files are smaller than WKS and WK1 files, so save files as SPR until you need 
to export them, and only then save them as WKS or WK1. 

 Most accented characters, and symbols used by certain languages (such as ¿ , « 
and » ) should be converted correctly. Some other symbols with values above 127 
in the character set cannot be converted. 

•  DIF - use only when your other spreadsheet program supports DIF but neither 
WKS nor WK1. The DIF format only transfers numbers, text and evaluated results. 
All other information, e.g. formulae, is lost. 

Opening a different type of worksheet 
You can use ‘Open file’ directly on files with the WKS, WK1 and DIF formats. When 
you press  to complete the ‘Open file’ dialog, a ‘Convert to SPR format’ dialog is 
shown. This is to remind you that when the file is next saved it will be in Sheet’s own 
format, with a .SPR extension. This dialog allows you to set the filename to use when 
this happens. 

Lotus 1-2-3 WKS/WK1 compatibility 
All cell information is converted i.e. format and alignment information, column widths, 
formulae, values, text, range names and protection. Note: 

•  Sheet cannot understand macros from Lotus. The cells containing the instructions 
making up the macro will be left intact - you just cannot run the macro in Sheet. If 
you subsequently transfer the file back to Lotus, the macro will run as it did 
originally. 

•  The differences in notation listed in the ‘Differences between Sheet and Lotus 
1-2-3’ section later, such as using = to start formulae, are handled automatically. 

 Day numbers are the same as in Lotus except before 28/2/1900, because Lotus 
treats 1900 as a leap year. Sheet displays only the D4 and D8 date/time formats. If 
you import a Lotus file you may get others returned in functions such as CELL. 
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The graph features closely match those of Lotus 1-2-3. You can even create .PIC files, 
which you can print with the Lotus PrintGraph utility. However, a few graph features 
change when you transfer files: 

•  A few graph settings are lost when you convert to Lotus format: whether to use 3D; 
whether to show titles and axis titles; fixed axis limits; whether to show values on 
pie charts; and the name of the current graph, which changes to the next available 
name like Graph1, Graph2 etc. Also, Lotus can only display one cell reference 
in any piece of text on a graph, while the Sheet can use many e.g. \b1....\c1 . 

•  If you do not define a graph in your Lotus worksheet, Lotus saves it with a current 
graph showing no information. This is what you will see initially if you open the 
file on the Series 3c. 

•  The Series 3c Spreadsheet application supports neither colour codes nor exploding 
codes when displaying pie charts. 

Graphs 
You can create a graph to display the current values of one or more ranges in a 
worksheet. You can define any number of graphs in each worksheet. The  key 
changes the display between the normal worksheet and graph views.  

Creating the first graph 

1. Enter the numbers for which you want to create the graph in a single row (or 
column) and highlight them, using . 

 

 To display several sets of data on the same graph, enter each set in adjacent rows 
(or columns) and highlight them all. 

 If the top left cell in a range contains text, the top row will be used as labels along 
the bottom of the graph. 

2. Press the  key, and the numbers are displayed as a 3D Bar graph: 
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To return to the worksheet: press the  key again (or the  key). You might 
then highlight a different range of figures, and press the  key to see them displayed 
as a graph. 
While the graph is displayed, a different set of menus is available. As soon as you 
use any of their options to change the appearance of the graph, the graph will be saved 
(see ‘Saving graphs’ below). 

 A graph may take a little time to draw if it contains a very large number of cells. 
However, you can use options on the menus while the graph is redrawing, or press 

 to return to the worksheet. 

Selecting the graph type - stack-bar, pie chart, line, etc. 
1. Select the ‘Format’ option on the ‘Display’ menu. 
2. Set the ‘Type’ line to the new graph type (see ‘Graph types’ later for more 

information about the various graph types). 

 For ‘Bar’, ‘Stack-bar’ and ‘Pie’ graphs, you can set the ‘3D’ line to ‘Yes’ to 
display a 3D graph, if you wish. 

Adding further ranges (sets of data) to the graph  
You can include up to six sets of figures on one graph. The first set that you added 
when you created the graph is called range A. Further ranges are named from B to F. 

To add further ranges: 

1. Type the new figures in a range in the spreadsheet, then press the  key.  

 To add figures from several adjacent rows (or columns) to the graph, highlight the 
figures as a block.  

 If there are more rows than columns in the highlighted range, Sheet treats each 
column as a new graph range. Otherwise, each row becomes a new graph range. 

The current graph is shown, as before. 

2. Select the ‘Set ranges’ option. Set the top line of the dialog to B, then press . 
This sets ‘Enabled’ to ‘Yes’, and the range you highlighted appears on the ‘Range’ 
line of the dialog. 

 If you highlighted more than one row or column, you will need to repeat step 2 
above and define each new range for the graph. 
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3. Press , and the graph will now show the two sets of figures, side by side, 
each with a different shading pattern. 

 Graph range X is a special graph range, used to label the X-axis. See ‘Adding 
labels to the X-axis’ later for more information. 

 If, for example, you want a graph of “yearly profit”, adding the figures throughout 
the year, you may wish to set the graph ranges to be 12 cells wide, right from the 
start. You could then fill in the cells month by month. 

Named ranges 
•  If you’ve named the ranges that contain the figures you want to plot on your graph, 

you can follow the instructions above, and type the names of the ranges in place of 
their range references in the ‘Set ranges’ dialog. 

Saving graphs 
•  When you change the appearance of your first graph, Sheet saves it under the name 

Graph1. (It is not saved as a separate file, but part of the worksheet itself.)  

•  Once graphs have been saved, the current graph - the one most recently displayed - 
will always be displayed when you press the  key. 

Adding labels, titles & grid lines 

The following picture shows all the text labels that you can add to a graph: 

main title

axis titles axis labels

grid lines

labels on each bar
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Adding a main title to a graph  
To add the title: select the ‘Titles’ option on the ‘Display’ menu, set the ‘Show titles’ 
line to ‘Yes’, and type the title on the ‘First’ line. If you wish, enter a second line of title 
text on the ‘Second’ line. Press  to complete the dialog. 

To turn the titles off and on: select the ‘Titles’ dialog again, and set the top line to 
‘No’ or ‘Yes’. Note, turning titles off doesn’t lose the titles themselves. 
Titles do not affect the name which is given to the graph. 

 To insert the contents of a cell (text or numbers) into text that you are entering for 
a graph (e.g. when you are adding the text for the title), type the \ character and 
the cell reference. For example, to enter the title Result:, followed by the 
contents of cell B2, you would type Result: \b2 in the ‘First’ line of the 
‘Titles’ dialog. 
To enter a \ character itself in text you must type it twice. 

Adding a title to an axis  
•  Select the ‘Axis titles’ option on the ‘Display’ menu, set the ‘Show X-axis title’ 

and/or ‘Show Y-axis title’ line(s) to ‘Yes’ and type the text that you want to use 
(you can use up to 39 characters). 

Adding a legend (description) for graph ranges  
To add a legend (description) for each range: 
1. Select the ‘Set ranges’ option on the ‘Ranges’ menu.  
2. Type a name for each graph range on the ‘Legend’ line, e.g. ‘Sales’, ‘Profits’ and 

so on.  
To display the legend: select the ‘View legends’ option on the ‘Special’ menu to 
display a box containing the graph’s legends.  
To remove the legend from the screen: press any key. 

Adding labels to the X-axis  
The labels on the Y axis are produced automatically. If you wish to enter labels for the 
X axis: 
1. Move back to the worksheet, type the text for the labels in a single row or column, 

then highlight that row or column. 

 If your graph displays just one set of figures, you can show the figures 
corresponding to the bars on the X-axis, by highlighting the range of figures 
themselves. 

2. Press  to display the graph, then select the ‘Set ranges’ option. 

3. Set the top line of the dialog to ‘X’. Then press : this sets the ‘Enabled’ line 
to ‘Yes’ and fills in the range you highlighted. Press  to complete the dialog. 
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 If the X-labels are too wide and overwrite each other, select ‘Set ranges’, set the 
top line of the dialog to ‘X’, and change the setting in the ‘Step’ line to a number 
greater than 1. If, for example, you set it to 3, only every third X-label is shown. 

Adding labels to each bar  
You can use text or numbers in the worksheet as labels on the top of each bar, to show 
what each bar represents: 
1. Highlight the range of cells to use as labels, display the graph and select the ‘Set 

labels’ option. 
2. Set the top line of the dialog to the graph range for the labels, e.g. A. Then press 

: this sets the ‘Enabled’ line to ‘Yes’ and fills in the range you highlighted. 
Press  to complete the dialog. 

 If you use numbers as labels, they are shown in exactly the same way as they are 
shown in Sheet. 

As with ‘Set ranges’, you can highlight several rows or columns before selecting the 
option. You would then enable each graph range to have labels in turn by pressing 

 (Spacebar). 

Changing the font size of text labels & titles 
To change the font size: select the ‘Format’ option on the ‘Display’ menu. Set the 
‘Font size’ line to: 

•  Small: a 5x3 pixel font will be used. 

•  Medium: a bigger font will be used. Medium is used as the default font size for text 
and numbers on graphs. 

•  Big: an even bigger font will be used; on the Series 3c, the standard system font is 
used. 

To cycle through the font sizes: use the ‘Zoom in’ and ‘Zoom out’ options on the 
‘Special’ menu. 

Adding grid lines  
To add grid lines (so that you can read across more easily from a bar or point to its 
value on the Y-axis): 

•  Select the ‘Format’ option, and set the ‘Horizontal grid’ line to ‘Yes’. You may 
also wish to do the same to ‘Vertical grid’. 

 Grid lines are not shown in ‘Pie’ format. 
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Changing the numbers on the axes 

Normally, axes are automatically sized to accommodate the values you are displaying. 
Numbers on the axes are initially displayed using the ‘General’ format. 

•  To set the axis limits manually: select the ‘Axis’ option on the ‘Display’ menu. 
Select the axis that you wish to modify, then change the ‘Limits’ line from 
‘Automatic’ to ‘Manual’. Type the new limits on the ‘Upper’ and ‘Lower’ lines, 
and press . 

 You can only change the X-axis when using the ‘XY/scatter’ format. 

•  To change the number format used: select the ‘Axis’ option on the ‘Display’ 
menu. Set the ‘Format’ line to the new number format. Change the ‘Decimal 
places’ line, if required, and press . 

 You can use any of the formats used by Sheet to display numbers in cells, apart 
from ‘Show formulae’ and ‘Default’. 

 When you use the ‘General’ number format with very large values, Sheet will 
automatically display the words THOUSANDS or MILLIONS vertically down the 
Y-axis, and use correspondingly smaller numbers to label the axis itself. 

Working with multiple graphs 

Creating a new graph 
1. Enter the numbers for which you want to create the graph in a single row (or 

column) and highlight them. 

2. Press the  key to move to the graph view. Your previous graph will still be 
shown. 

3. Select the ‘New graph’ option on the ‘Graphs’ menu. 
4. Type a name for this new graph. Leave ‘Keep data’ set to ‘No’ for a brand new 

graph. If you set it to ‘Yes’ your new graph inherits the same sets of figures as the 
previous graph. 

5. To use all of the same settings as before: format, text, and so on, set ‘Keep 
settings’ to ‘Yes’. To start with a 3D bar graph, with no legends, axis settings (etc.) 
set at all, set ‘Keep settings’ to ‘No’. 

See ‘Adding further ranges (sets of data) to the graph’ earlier to see how to add further 
sets of figures to your new graph. 
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Viewing graphs 
To move between your graphs: press .  cycles round in the opposite 
direction. 

To select a graph by name: select the ‘Use graph’ option. If you press  here, you 
can see a list of all the defined graphs. 

Managing your graphs 
To rename the current graph: select the ‘Rename graph’ option on the ‘Graphs’ 
menu. 
To delete an unwanted graph: use the ‘Delete graph’ option on the ‘Graphs’ menu. 
This also frees the memory which it took up. If you delete all existing graphs, you are 
returned to the worksheet. 

Graph types 

To change the “type” of the currently displayed graph: 
1. Select the ‘Format’ option on the ‘Display’ menu. 
2. Set the ‘Type’ line to the new graph type. 

Stack-bar 
Use this type of graph when several sets of figures comprise a breakdown of one larger 
set of figures, e.g. a graph showing bars for sales in months Jan to May, where the bar 
for each month comprises sections for corporate, retail and direct sales. You can set this 
graph type to 2D or 3D. 

Pie chart 
This type can only display one set of figures. Use it to reflect the percentage of some 
overall figure taken by each of its parts. E.g. a pie could show the breakdown of sales, 
with slices for corporate, retail and direct sales. 
The pie chart displays the values in the first enabled graph range usually A. Any 
negative numbers in the graph range will be ignored. The X-label for each value is 
shown alongside its slice of the pie. 
When defining a pie chart you can use the ‘Pie labels’ line to make the value of each 
slice appear next to any X-label. You can choose the way to display the value 
‘Percentages’, ‘Values’ or ‘None’. 
On pie charts you cannot display labels (set with the ‘Set labels’ option) or use the 
‘View legends’ option. You can set this graph type to 2D or 3D. 

Line graph 
Use this type to show several sets of figures. Values are displayed as symbols, joined 
together by lines. You can set each graph range to show lines, symbols, or both, with 
the ‘Line formats’ option on the ‘Ranges’ menu. 
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X-labels for a range initially appear centred on the symbol positions. You can change 
the position of the X-labels by changing the setting in the ‘Alignment’ line in the ‘Set 
labels’ dialog. Or you might turn the lines and symbols off and show just labels in the 
centred position. 
Lines, when set, are only shown between values in adjacent cells. If a cell within a 
range is blank, no line will be drawn between the values of the cells before and after it. 

XY/Scatter graph 
Use this format when sets of figures are dependent on some other variable. The values 
in graph ranges still represent a position “up the screen”, but their positions “across the 
screen” are determined by the values in graph range ‘X’. 

For example, you measure the temperature at five points in the day: 19°C at 09:00, 
27°C at 12:00, 29°C at 15:00 (3pm), 26°C at 19:00 (7pm), and 21°C at 20:00 (8pm). 
You can set the temperatures (19, 27, 29, 26, 21) as graph range ‘A’, the times (9, 12, 
15, 19, 20) as graph range ‘X’, and use the XY/Scatter format: 

 

You can use the ‘Axis’ option on the ‘Display’ menu to set the limits and/or number 
formats for the X-axis as well as the Y-axis (see ‘Changing the numbers on the axes’ 
later in this chapter for further details). For other aspects of the display, the 
‘XY/Scatter’ format acts like the ‘Line’ format. 

Printing graphs via .PIC files 

You cannot print graphs directly, because the Series 3c does not have graphics-based 
printer drivers.  
To print a graph, you have to save it as Sheet’s “industry-standard” .PIC file, transfer 
the file to another computer and use that computer’s spreadsheet, word processor, or 
print utilities to print it. 

 The .PIC files mentioned here have no connection with OPL bitmaps, which also 
use .PIC as the default file extension.  

To save a graph as a .PIC file 
1. Display the graph by pressing  to cycle to it. 

2. Select the ‘Create PIC file’ option on the ‘Special’ menu. 
3. Type the name to use for the .PIC file on the ‘File: Name’ line. 
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The ‘Colour’ line controls whether areas are saved as filled blocks (‘Yes’) or as shading 
patterns (‘No’). (Colour information is, in fact, always saved, but will only be used if 
you print to a colour printer.) 
4. If you intend to use a black and white printer, set ‘Colour’ to ‘No’.  

 You can change the shading pattern used for a set of figures by entering it in a 
different graph range (‘A’ to ‘F’). 

About .PIC files 
•  The .PIC file format stores information on the items which make up the graph. It is 

not a pixel-by-pixel format; the resolution and precise detail of the printed graph 
depend on the resolution of your printer, and of the program which prints the .PIC 
file. 

•  All bar graphs are stored as 2D. Only pie charts can be 3D. 

•  Titles are always printed, if they have been entered, even if they are not shown on 
screen. 

•  A guide to the different graph ranges is always included. This performs the same 
function as the box shown by the ‘View legends’ option, which is itself not 
included in the .PIC file. 

•  .PIC files are by default kept in a \SPR directory the same as worksheet files 
themselves. 

Using Databases 

What is a database? 
A database is a table of information which you can sort and search by various “criteria”. 
For example, here is a database of contractors working for an agency: 

 

You could repeatedly search it to find candidates who fulfil certain conditions, e.g. 
whether they can work in London, and have shorthand; Walker and Miles would fulfil 
these conditions. 
The information about your customers, products or whatever - as in the previous 
diagram - forms the database itself. A separate “criterion range” tells Sheet how to 
search the database: 
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 Databases in Sheet have no connection with the Data application. 

This section uses the example worksheet shown in the two pictures above. 

Setting up a database 

Entering the database records  
1. Type the data for your database in columns. Each column must have a heading. 

These headings are the “field names” of the database: 

 

 To make it easier to see which column or row to enter data into: use ‘Titles on’ to 
make the field names display no matter how far down the grid you move.  

2. Select the whole range, including the field names. In this example, the range is 
A1:F6.  

 If you turned ‘Titles on’ you will need to turn them off again before you can select 
the entire database range. 

3. Select the ‘Set database’ option on the ‘Database’ menu. The database is now 
defined. 

Important: You can only define one database at one time in a worksheet.  
Setting the database simply creates a named range called database. You can check or 
change the database range at any time by using the ‘Edit ranges’ option. 

Adding & changing records or fields 
•  Enter new records at the bottom of the range. Be sure to enter the data in the 

correct columns. 
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Important: Remember to extend the database range to include the new record. 

•  To add or remove records or fields in the middle of a database, use the ‘Insert 
cells’ option. ‘Insert cells’ automatically updates the database range. 

 The easiest way to extend the database range is to use ‘Jump to’, and select the 
database range. (When you jump to a range, the whole range is also 
highlighted.) Then extend the highlight to include all the new cells and select the 
‘Set database’ option on the ‘Database’ menu. 

Sorting the database records 
You can sort the Database range in exactly the same way as any other range, as 
described in ‘Sorting information’ earlier. 

Searching the database for entries 

“Criteria” specify conditions which a record has to meet in order to be highlighted when 
you search the database, rather like search-clues in the ‘Find’ option. However, criteria 
can be more complex: 

•  You can specify several conditions at once. 

•  A condition can make use of Sheet’s functions and logical operators. 

Setting up the criterion range (search clues) 
Each criterion that you want to search by has to be entered in another range in the 
worksheet. To create this range: 
1. Type the field names used in the first row of the database in the first row of the 

criterion range.  

 You can use the ‘Copy’ and ‘Paste’ options to copy the field names in the database 
range, and then paste them into the cells you wish to use as the criterion range. 
Although you would normally copy all the field names, this is not obligatory: you 
can quite happily copy only those that are of interest. The order of field names is 
unimportant. See ‘Cutting, copying & pasting information’ for more details. 

2. Type each criterion (clue) that you want to search by in rows below - then when 
you come to find matching records in the database, Sheet would scan down the 
‘Car’ field of the database, and each time it saw a Y it would match that record. 

3. Highlight the entire range containing your criterion. (Make sure you do not 
highlight any blank rows below the criteria - all records will match with a blank 
criteria.) 

4. Select the ‘Set criteria’ option on the ‘Database’ menu. 
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Checking or changing the criterion range (search clues) 
•  As with the database, the criterion range is actually just a named range - in this 

case, criterion. You can check the current criterion range with ‘Jump to’, and 
modify the range if necessary with  and the arrow keys, or from within the 
‘Edit names’ dialog.  

Searching for records that match the criteria 
•  Select the ‘Data find’ option on the ‘Database’ menu. The first record (from the 

top downwards) meeting the current criterion range is highlighted. Select ‘Data 
find again’ from this menu to highlight the next matching record. 

Extracting records that match the criteria 
To make Sheet copy all records that match the criteria into an area away from the 
database: 
1. Set the criterion range as if you were going to use the ‘Data find’ option. 
2. Go to the top of the database range. Copy the field headers. 
3. Find a suitable area away from both the database and the criteria. Paste in the field 

names. You don’t have to use them all, and you can rearrange them in any order. 
4. Select the cells in which you’ve just pasted the field headers, and plenty of rows 

below - enough to fit all the matching records. 
5. Select the ‘Data extract’ option on the ‘Database’ menu. 

 If you choose ‘Extract unique records only?’, you will only get one copy of any 
identical records in the Database. (Identical includes different formulae 
returning the same result.) 

All the matching records are copied into the selected range. You are told if no matches 
are found, or if the range isn’t big enough to fit all the matches in. 

Deleting records that match the criteria 
1. Set the criteria, then select the ‘Data find’ option again. 
2. Select the ‘Data delete’ option on the ‘Database’ menu. 
If there are any matching records, you are asked for confirmation, and then all matching 
records are deleted. 
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When a record is deleted, the records below automatically shift up to fill the space. 
Formulae are adjusted accordingly. 

About criteria 
•  The search-clue is always case-sensitive. So if you entered y as the criterion, no 

records would match, since the columns in the database have Y in them. To check 
for either y or Y you could use the OR operator, described later in this chapter. 

•  In the criteria, fields which have an empty cell are ignored - in other words, all 
records match for that particular field. 

Copying criterion and database ranges 
•  The database and criterion named ranges, like other named ranges, are 

normally relative. If you copy or move a function which uses a named range you 
will find that this range will change. To stop this, use absolute references by 
adding a $ symbol: $database and $criterion. 

Using advanced criteria (search clues) 

Matching less than & greater than values 
•  Enter the criterion as a formula containing the appropriate comparison operator, 

and a reference to the field name of the column of the database that is to be 
searched. E.g. if A2 contains the database field name Age, and you wish to sort the 
database to find entries where the person’s age is less than or equal to 30, you 
would enter =A2<=30 as the criterion. 

•  Comparison operators that you can use in criteria include: 
< less than   > greater than  
<= less than or equal to >= greater than or equal to  
<> not equal to 

 For criterion cells which use formulae - in this example, I2 - use the ‘Format’ 
option to set their display format to ‘Show formulae’. Otherwise unwanted results 
will be displayed in these cells. 

Finding records that match one of two criteria etc. 
To set two conditions, and select records which match either one of them: 

•  Enter the first alternative criterion on the first row of the criterion range (below the 
field names) and then enter the second alternative criterion on the second row. 

You must extend the criterion range to include all of the criteria you wish to use. 
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Using the AND & OR operators  
•  Sheet effectively acts as if each cell in a criterion row is joined with the AND 

operator, and as if each criterion row is joined with the OR operator. So you could 
enter a criterion as: 

 =(D2=“Y” AND F2<=55) OR (D2=“N” AND F2<=40) 
 However, it is usually simpler and easier to understand if you separate the 

conditions onto separate rows. 
Lotus 1-2-3 users - note that no # signs are needed around AND and OR. 

Referring to cells outside the database range 
•  If, in a criterion, you wish to refer to a cell outside the database range, use the 

absolute cell reference - for example, $G$8. Otherwise, the cell accessed will vary 
from record to record - maintaining the same relative offset to the database. So if 
you specified the criteria =E2>G8, the condition which cell E2 would have to 
match would be G8, but the condition which cell E3 would have to match would 
be G9. 

Using wildcards in criteria 
You can use these wildcards in criteria: 
? any one character  
* any number of characters  
~ anything except what follows  
For example, the criteria *Jones* would match all records with Jones somewhere in 
that field. ~*Jones* would match all records which don’t have Jones in that field. 

Using functions in criteria 
Any of the Sheet functions can be used in criteria. For example: 
=F2>AVG(F$2:F$6)

would search for all those in the previous example with above average w.p.m. Note the 
use of absolute references. If you didn’t use absolute references, the criteria the second 
record, in row 3, would need to match would change to w.p.m. AVG(F3:F7) - which 
is incorrect. 
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Using Tables 
Tables let you perform sensitivity analyses, or ‘what if’ calculations. This is where you 
try a range of values in a calculation and see how the result changes. There are two 
types of table: 

•  Table 1 - this tries different values in one particular cell (the input cell) elsewhere 
in the worksheet. (As an example: you have several “profit” cells, all dependent on 
an “exchange rate” cell, and you want to see what the profit figures would be for 
different exchange rates.) 

•  Table 2 - this tries different pairs of values in two particular input cells elsewhere 
in the worksheet. (As an example: you have a “profit” cell, dependent on an 
“exchange rate” cell and a “unit cost” cell, and you want to see what the profit 
figures would be for different exchange rates and unit costs.) 

Table 1 

A Table 1 tries different values in one particular cell (the input cell) elsewhere in the 
worksheet. Each time it does so it recalculates the whole worksheet, and records the 
results of several formulae. 
1. Find a blank rectangular area of your worksheet, to use as the table. Leave the top 

left cell of this area blank. 
2. Down the first column, below the top left cell, enter the values you want to try for 

the input cell. (In the example: some different exchange rates.) 
3. Across the first row, to the right of the top left cell, enter the formulae you wish to 

work out. (In the example: simple formulae, like =F7, referring to the cells which 
have the profits.) You may wish to use the ‘Format’ option to set these cells to the 
‘Show formulae’ format. 

4. Highlight the whole area and select the ‘Table 1’ option on the ‘Database’ menu. 
In the dialog, enter the reference of the ‘Input cell’ - the cell to try the different 
values in. (In the example: the “exchange rate” cell.) 

The table is filled in. Each cell in the body of the table shows the value the formula 
gives, when each different value is copied into the input cell. 
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Table 2 

A Table 2 tries different pairs of values in two particular input cells elsewhere in the 
worksheet. Each time it does so it recalculates the worksheet, and records the result of 
one formula. 
1. Find a blank rectangular area of your worksheet, to use as the table. In the top left 

cell of this area, enter the formula you wish to work out. (In the example: a simple 
reference to the profit cell, e.g. =F6.) You may wish to use the ‘Format’ option to 
set this cell to the ‘Show formulae’ format. 

2. Down the first column, below the top left cell, enter the values you want to try for 
the first input cell. (In the example: some different exchange rates.) 

3. Across the first row, to the right of the top left cell, enter the values you want to try 
for the second input cell. (In the example: some different unit costs.) 

4. Highlight the whole area and select the ‘Table 2’ option on the ‘Database’ menu. 
In the dialog, enter the references of the two cells ‘Input cell 1’ and ‘Input cell 2’ 
to try the different values in. (In the example: the “exchange rate” and “unit cost” 
cells.) 

The table is filled in. Each cell in the body of the table shows the value the formula 
gives, using the different example values that are copied into the two input cells. 

More about tables 

•  The formulae and the values may contain references to cells containing values or 
expressions, using any of Sheet’s functions.  

•  The original contents of the input cells are restored after the table has been filled. 

•  To make the table recalculate every time a change is made to the worksheet, use 
‘Set preferences’ on the ‘Special’ menu to turn ‘Table recalculation’ on. This may 
slow down recalculation. 

•  You can use the ‘Table 1’ and ‘Table 2’ options in conjunction with databases. 
The input cells for the table should be in the criterion range; the formulae you are 
calculating should be database statistical functions. In this way, various different 
criteria are tried, resulting in various sets of records matching. The data in the 
matching records is then analysed by the database statistical functions. 
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Function reference 
This section contains detailed information about all the functions available in Sheet. 
Functions are broken down into the following groups: 

•  Mathematical & logical functions 

•  Financial functions 

•  Date & time functions 

•  String functions 

•  Statistical & database functions 

•  Range and cell functions 

•  Error functions 

Mathematical & logical functions 

Trigonometric functions  
These functions use angles expressed in radians, not in degrees. If you want to type in 
and display angles in degrees, convert the angle using these formulae: 
radians = PI*degrees/180
degrees = 180*radians/PI

PI Returns the value of the mathematical constant PI. 

ACOS(x) Returns COS-1(x) - the angle in radians whose cosine is x. 

ASIN(x) Returns SIN-1(x) - the angle in radians whose sine is x. 

ATAN(x) Returns TAN-1(x) - the angle in radians whose tangent is x. 

ATAN2(x,y) Returns TAN-1(y/x) - that is, the angle, in radians, whose tangent is 
y/x - using the signs of x and y to return an angle in the appropriate quadrant: 
x and y  value returned 
x>0 and y>0 between 0 and π/2 
x<0 and y>0 between π/2 and π 
x<0 and y<0 between -π and -π/2 
x>0 and y<0 between -π/2 and 0 
COS(x) Returns the cosine of the specified (radian) angle x. 

SIN(x) Returns the sine of the specified (radian) angle x. 

TAN(x) Returns the tangent of the specified (radian) angle x. 
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Logs 
EXP(x) Returns the value of the mathematical constant e raised to the power of x. x 
can be negative. 
LN(x) Returns the natural (base e) logarithm of x, or ERR if x is less than zero. 

LOG(x) Returns the logarithm base 10 of x, or ERR if x is less than zero. 

General functions 
ABS(x) Returns the absolute, that is positive, value of x. 
For example =ABS(-4.56) returns 4.56. 

CHOOSE(x,v0,v1...vn) Returns the xth item in the list v0,v1...vn. The list may 
contain a mixture of strings and values. The first item in the list has the number 0, not 1. 
For example =CHOOSE(2,B1,5.6,C4) returns the value in cell C4, since cell C4 is 
the third item (x is 2) in the list B1,5.6,C4. 
Returns ERR if x is greater than the number of items in the list minus 1. 

INT(x) Returns the integer portion of x by truncating towards zero. 
For example =INT(6.9987) returns 6, and =INT(-21.9) returns -21. 

ROUND(x,n) Returns x rounded to n places. n must be between 15 and -15 inclusive. 
If it is not an integer, just its integer part is used. 
n0 x is rounded to n decimal places 
n=0 x is rounded to the nearest integer 
n<0 x is rounded to the nth power of ten - that is, to the nearest ten, hundred, 
thousand... 
For example: 
=ROUND(26858.30458,-3) returns 27000
=ROUND(26858.30458,-1) returns 26860
=ROUND(26858.30458,0) returns 26858
=ROUND(26858.30458,1) returns 26858.3
=ROUND(26858.30458,3) returns 26858.305 

RAND Returns a random number between 0.0 (inclusive) and 1.0 (exclusive), to 16 
decimal places. Multiply by 10 to get a number between 0 and 10. Use the expression 
=INT(RAND*6)+1 to get a number between 1 and 6. 

MOD(x,y) Returns the remainder of x divided by y. Returns ERR if y is zero. 
For example =MOD(16.054,3.307) returns 2.826, that is 16.054-(4*3.307). 

SQRT(x) Returns the square root of x, or ERR if x is less than zero. 
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Logical functions - True and False 
TRUE Returns 1.0 (true). 

FALSE Returns 0.0 (false). 

IF(x,then,else) x, then and else may be cell references, values or 
expressions. Returns the value of then if x is non-zero (true) or the value of else if x 
is zero (false). 
‘Divide by zero’ 
A common use of the IF function is to check for a ‘divide by zero’ error. For example, if 
a cell contains the formula: =23/A2 and it is possible that A2 will contain the value 0, 
then you could change the formula to this: =23/IF(A2,A2,1). This formula 
evaluates like this:  

•  if A2 is true (that is, contains a non-zero value) then use the value in A2 - so the 
formula becomes =23/A2. 

•  if A2 is false (that is, contains the value zero) then use the value 1 - so the formula 
becomes =23/1. 

If instead you use =IF(A2,23/IF(A2,A2,1),”Infinite”), the text 
Infinite will appear if A2 contains zero. 

Financial functions 

Entering percentage rates 
When using these functions: 

•  Enter rates as either a percentage or as a decimal - for example, an interest rate 
could be typed in as 12.3% or 0.123. 

•  Enter the interest rate for the same unit of time as used for the term. So if you 
specify that a loan lasts for 12 months, rather than 1 year, enter the interest rate per 
month, not per year.  

Notes on APR 
Interest rates are often quoted as a percentage for a monthly period. If you want to 
calculate the annual rate, however, you cannot just multiply by 12, since paying 1% 
interest every month is not the same as paying 12% a year. To calculate the annual 
percentage rate (APR) use the following formula: 
annual rate = ((1+monthly rate)**12)-1

More generally, to convert from an interest rate for one period to the equivalent interest 
rate for another period, use the formula: 
rate2 = (1+rate1)**(period2/period1)-1

where period1 and period2 are measured in the same units. 
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Lump sum investments 
These functions assume that a lump sum earns a fixed rate of interest. You can 
calculate: 

•  How long it would take for the investment to increase by a certain amount, with 
CTERM. 

•  What interest rate is needed for the investment to increase by a certain amount, 
with RATE. 

CTERM(interest,future_value,principal) Calculates how long it will 
take for an investment of principal to increase to future-value, given that the 
investment is earning interest at a fixed rate of interest per period. 
For example, you deposit £5000 in an account which pays 10% annual interest. How 
long will it take to double in value? 
=CTERM(0.1,10000,5000)
returns 7.3 (7 years 4 months), as the time the investment takes to mature. 
The CTERM function uses the formula: 
term = ln(future value/principal)/ln(1+interest)
where ln is the natural logarithm. 
To calculate how much the investment will be worth after a certain period of time, use 
the formula: 
future_value = principal*(1+interest)**term

RATE(future_value,principal,term) Calculates the interest rate needed for 
an investment of principal to increase to future-value over a term of 
compounding periods. 
For example, you invest £5000 in a bond which will mature for £10000 in 5 years’ time. 
What monthly interest rate is this earning? 
=RATE(10000,5000,60)
returns 0.0116, or 1.16%, as the interest rate of this investment per month (the term 
was specified in months, not years). 
The RATE function uses the formula: 
interest rate = ((future_value/principal)1/term )- 1

Cash flows 
These functions compare the value of a lump sum earning a fixed rate of interest with a 
regular series of receipts over a period of time. 
For example, you invest £4000 in a new machine. This money could have been earning 
6% interest in an account, but in improved productivity it saves you £200, £600, £1000, 
£1500 and £1500 in the next five years. Was this a wise investment? 

•  If you know the principal and the receipts earned, you can calculate the effective 
interest rate with IRR. 

•  If you know the receipts and the interest rate earned, you can calculate the 
principal, with NPV. 
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In these functions, the parameter cash_flows is a range reference, specifying the 
cells containing the initial cost and the receipts. 
Enter the cash flows in chronological order. 
Enter outflows (expenditures) as negative and inflows (receipts) as positive. 
The first cell in the range is taken to be the initial cost, if there is one. The 
remaining cells in the range specify the receipts. 
Receipts may be of varying amounts, but must be listed in the order in which they are 
paid. The cells in the range are read from left to right, top to bottom. So in the example 
above, the initial cost is £1000 and the sequence of receipts is: £250, £250, £300, £350 
and £450.  
The cash flows are assumed to occur at equal time intervals, at the end of each period.  
If there is no receipt during one period, leave the cell blank. 
IRR(guess,cash_flows) Calculates the Internal Rate of Return (the effective 
interest rate earned) on an investment returned in a series of cash flows. 
guess is a value, or the reference of a cell containing a value. This value is your guess 
at the interest rate. Sheet needs this as the first in a series of approximations, which is 
how it calculates the interest rate. Specify a number between 0 and 1 (that is, between 
0% and 100%). 
NPV(interest,cash_flows) Calculates how much an investment would be 
worth if it were possessed as a lump sum now (before earning any interest) rather than 
as a series of future receipts - i.e. the present value. Interest is the interest rate per 
receipt period. 
The NPV function (Net Present Value) assumes that the receipts (cash flows) occur at 
the end of each period. To calculate the NPV, where cash flows occur at the beginning 
of each period, use the function like this: 
npv = first_receipt + NPV(interest, remaining_receipts)
- since the first receipt is received before it earns any interest. 
The NPV function uses the formula: 
∑(cashflowi/(1+interest)i)
where cashflowi...cashflown is the series of cashflows. 

Annuity investments 
An annuity is an investment of a series of equal payments earning a fixed rate of interest 
- such as a savings account into which you pay £200 every month.  
You can calculate: 

•  How much an investment will be worth after a certain time, with FV. 

•  How much a series of payments, with matured interest, would be worth if they 
were a lump sum possessed now, with PV. 

•  How long it will take for an investment to mature to a certain amount, with TERM. 
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Annuity due 
The following functions assume that the annuity is an ordinary annuity - in other words, 
payment is made at the end of each period.  
The functions can be modified for an ‘annuity due’ - that is, an annuity where payment 
is made at the beginning of each period.  
An annuity due is always worth more than an ordinary annuity, since the interest has 
longer to mature. 
FV(payment,interest,term) Returns the matured value of an investment given 
the payment per period, the interest rate per period, and the term of the 
investment (a number of periods). 
The FV function uses the formula:  
future value = payment*((1+interest)n-1)/interest
where n is the number of periods. 
Annuity due
Use the function like this:  
=FV(payment,interest,term)*(1+interest)
For example if, in the case above, you make the payment, and interest is added, on the 
first day of each year, 
=FV(100,0.02,2*12)*(1+0.02)
This returns £3103.03 as the value of the investment in 2 years’ time. 
PV(payment,interest,term) Returns the present value of an investment given 
the payment per period, the interest rate per period, and the term of the 
investment (a number of periods). 
The PV function uses the formula:  
present_value = payment*(1-(1+interest)-n)/interest

Annuity due 
The PV function assumes that payments are made at the end of each period. If payments 
are made at the beginning of each period, use the function like this: 
=PV(payment,interest,term)*(1+interest) 
TERM(payments,interest,future_value) Returns the number of payments 
needed to accumulate future-value from a series of payments earning a periodic 
interest rate. 

The TERM function uses the formula: 
number of payments = ln(1+future_value*interest/payment))
divided by LN(1+interest)
where LN() is the natural logarithm. 

Annuity due 
TERM assumes that payments are made at the end of each period. If payments are made 
at the beginning of each period, use the function like this: 
=TERM(payment,interest,future_value/(1+interest))
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Loan payments 
PMT(principal,interest,term) Returns the amount to be repaid per period 
on a loan, given the principal of the loan, the interest rate per period and the 
term the loan has to run (expressed as the number of periods).  
This function assumes that repayment is made at the end of each period. For a loan 
where repayment is made at the beginning of each period, use the function like this: 
=PMT(principal,interest,term)/(1+interest)

The PMT function uses the formula:  
payment = principal*interest/(1-(1+interest)-term)
See also the TERM function. 

Depreciation 
These functions calculate the depreciation of an asset over a period of time. For 
example, you buy a new machine costing £10000; five-year-old machines sell for 
£5000; you can calculate how much the machine depreciates in value after each year of 
its life. In these functions, 

•  The asset has the initial (‘book’) value cost. 

•  The asset has the value salvage at the end of its life. 

•  The asset’s salvage value is taken at the end of life number of periods. 

•  The periods of depreciation are period length of time. 

The functions provided by Sheet allow you to spread the depreciation in three ways. 
Straight-line method: 
SLN(cost,salvage,life) This method assumes that the asset loses the same 
amount of value during every period of its life - in other words, the depreciation is 
spread evenly over the life of the asset. 
The SLN function uses the formula:  
depreciation per period = (cost-salvage)/life

Sum-of-the-years’-digits: 
SYD(cost,salvage,life,period) With this method, the asset depreciates 
more at the beginning of its life than at the end: 
The SYD function uses the formula:  
depreciation per period = (cost-salvage)*(life-period+1)
divided by (life*(life+1)/2)

Double-declining balance: 
DDB(cost,salvage,life,period) With this method, the asset depreciates 
much more at the beginning of its life than at the end: 
The DDB function uses the formula:  
depreciation per period = (book value*2)/life
where 
book value at the start of each period = (total cost -
total depreciation over all previous periods) 
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Date & time functions 

Using date and time functions, you can calculate, for example, how many days there are 
before a deadline, or the number of days overdue, etc. 

Entering dates and times for use in formulae 
Sheet’s functions need dates and times to be passed to them as date and time numbers; 
these are not recognisable as dates and times. To type in dates and times in a 
recognisable form, and still use them in functions: 

•  Enter dates and times using the following formulae: 
=DATE(year,month,day) for entering dates 
=TIME(hour,minute,second) for entering times 
and then set the cell to ‘Date’ or ‘Time’ format as appropriate with ‘Format’ from 
the ‘View’ menu. 

•  Enter dates and times as text strings using the ‘ prefix. Then in formulae which 
refer to these cells use one of these functions: 
DATEVALUE(cell) for dates 
TIMEVALUE(cell) for times 
where cell is the reference of the cell containing the date or time entered as text. 

Date and time style 
The ‘Formats’ option in the ‘Time’ application controls the precise display of dates and 
times. Apart from ‘Clock type’, all of these settings affect the display of dates and times 
in Sheet. 

Date functions 
The various date functions require dates specified in one of two ways: 

•  In the form year,month,day where day is between 1 and 31, month between 
1 and 12 and year from 0 (1900) through 99 (1999) to 255 (2155). (Single digit 
values can, if required, be preceded by a zero - for example, 09 instead of 9.) 

•  As a day number, using a count of days since 31/12/1899. 1/1/1900 has day 
number 2; 23/12/1993 has day number 34326. Every date can in this way be 
specified by a single number, from which the year, month day, and day of the week 
can be calculated. Any fractional part of day numbers (e.g. the 34 in 24326.34) 
is ignored. 

You never need to work out day numbers yourself. Use the DATE function to do it 
for you. (Lotus users - day numbers are the same as in Lotus except before 28/2/1900, 
because Lotus treats 1900 as a leap year.) 
Day 93503 (31st December 2155) is the day furthest in the future allowed. 
DATE(year,month,day) Returns the appropriate day number, given the date in 
numbers. 
For example =DATE(90,9,8) returns 33124.  
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year, month and day must be between 0 and 255, 1 and 12, and 1 and 31 
respectively. 
DATEVALUE(datestring) Returns the appropriate day number given the date as a 
string, e.g. =DATEVALUE("8/9/90") returns 33124. 
datestring must be in the overall Series 3c format, as set up in the Time 
application. 
DAY(x) Returns the day of the month (1 to 31) calculated from the day number x.  
For example =DAY(33124) returns 8 since day 33124 falls on the 8th day of a month. 

MONTH(x) Returns the month number (1 to 12) from the day number x.  
For example =MONTH(33124) returns 9 since day 33124 falls in September. 

YEAR(x) Returns the year number (0 to 255) from the day number x. 
For example =YEAR(33124) returns 90 since day 33124 falls in 1990. 
See also the NOW function at the end of the Time functions. 

Time functions 
For these functions, specify times in one of two ways: 

•  In the form hour,minute,second where hour is between 0 and 23, minute 
between 1 and 59 and second between 1 and 59. 

•  As a time number between 0 (midnight) through 0.5 (noon) to 0.999... (just before 
midnight). Any integer part of the time number is ignored. 

You never need to work out time numbers yourself. Use the TIME function to do it 
for you. 
HOUR(x) Returns the ‘hour value’ between 0 and 23, according to the time number x. 
For example =HOUR(.33) returns 7. 

MINUTE(x) Returns the ‘minute value’ between 0 and 59 according to the time 
number x. 
For example =MINUTE(0.679) returns 17. 

SECOND(x) Returns the ‘second value’ between 0 and 59 according to the time 
number x. 
For example =SECOND(0.01) returns 24. 

TIME(hour,minute,second) Returns the time number for the specified hour, 
minute and second.  
For example =TIME(13,43,6) returns 0.571. 
Returns ERR if hour,minute,second is 24,00,00 or above, or if any of the 
values are negative. 
TIMEVALUE(timestring) Returns the time number given the time as a string. 
For example =TIMEVALUE("12:00:00AM") returns 0.  
timestring must be in one of these formats: 
"hour:minute:second"
"hour:minute:second" AM (or PM instead of AM). 
You can omit second if you like. 
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Combined date and time function 
NOW Returns the combined date and time number, corresponding to the current time on 
the Series 3c. 
For example =NOW at 6:00pm on 14/6/1993 returns 34134.75.

 To display the current date, use the formula =NOW and set the cell to ‘Date’ format. 
To display the current time, use the formula =NOW and set the cell to ‘Time’ 
format. 

 This date and time will not automatically update; recalculate the worksheet in order 
to update the date/time display.  

String functions 

In these functions, string may be either a series of characters enclosed in quotation 
marks, e.g. “hello”, or a formula which results in a string, for example =B2 where 
cell B2 contains a text string. 

Editing strings 
You can join strings together by ‘concatenating’ them. For example, the formula 
="help"&"mate" would return the string value helpmate.  

You can also use the comparison operators to return the value ‘true’ (non-zero) or 
‘false’ (zero) from a string expression. The operators compare the character codes of the 
first characters in the strings, as in the ‘Sort’ option. For example, the formula =A1<B1 
would return 1 if A1 were "Brown" and B1 were "Smithson" since the character 
code of ‘B’ is less than that of ‘S’. 
To manipulate strings, use the following functions: 
EXACT(string1,string2) Returns 1.0 (true) if string1 is exactly the same as 
string2, otherwise returns 0.0 (false).  
EXACT is case-sensitive and notes accents. The = operator treats upper case and lower 
case as the same, and letters with and without accents as the same. 
FIND(searchstring,string,start_position) Returns the position in 
string where searchstring starts. The search begins from start-position 
in string. 
Make start-position 0 to start searching from the first character of string. The 
number returned is 0 for the first character in string, 1 for the second and so on. 
If searchstring isn’t found or if start-position is negative, FIND returns 
ERR.  
Only the integer part of start-position is used. Once you have located a substring 
within another string, use MID to extract the substring. 
For example, if B4 contains the string Jones, AF then  
=FIND(", ",B4,0) returns 5. 

LEFT(string,n) Returns a string comprising the first n characters of string. 
For example =LEFT("Bravura",5) returns Bravu. 
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LENGTH(string) Returns the number of characters in string. 

LOWER(string) Returns string converted entirely to lower case.  

MID(string,start_position,n) Returns a string comprising n characters 
taken from start-position in string. For start-position, 0 is the first 
character, 1 the second and so on. 
For example, =MID("Bravura",2,4) returns avur. 

PROPER(string) Returns string with “proper capitalization” - i.e. the first letter 
of each word in upper case, and the rest in lower case. 
REPEAT(string,n) Returns string repeated n times. The string may overflow 
into adjacent cells, whereas the \ prefix repeats a string only to the width of the cell. 
For example =REPEAT("-",50) would produce a bar ------------- 50 
characters wide. 
REPLACE(string,start_position,n,newstring) Removes n characters 
from string, starting from start-position. Then inserts newstring at 
start-position, and returns the resulting string. 
For example =REPLACE("Bravura",4,3,"ado") returns Bravado.  
start-position can be immediately after the end of string, in which case no 
characters are removed (n is ignored, but a number must still be provided to it) and 
newstring is simply added to the end of string.  
For example, =REPLACE("Bravura",7,0,"s") returns Bravuras. 
This has the same effect as ="Bravura"&"s". 

RIGHT(string,n) Returns a string comprising the last n characters of string. 
For example =RIGHT("Bravura",5) returns avura. 

TRIM(string) Returns string with all leading and trailing spaces removed, and 
any consecutive spaces replaced by single spaces. 
UPPER(string) Returns string converted entirely to upper case. 

Strings and numbers 
AT(string) Returns the contents of the cell at the reference specified by string.  
For example, if B2 contained the value 54, =AT("B"&"2") would return 54. AT 
needs a cell reference as a string. If you use AT(C1), for example, AT looks in cell C1 
for a string to use as the cell reference; if C1 contained the text string D1, AT would 
return the contents of D1. 
CHAR(x) Returns the character with the character code x, or ERR if x is not an integer 
between 1 and 255.  
For example, =CHAR(87) returns W. 
The Series 3c character set is listed in an appendix to this manual. 
CODE(string) Returns the character code of the first character in string.  
For example, =CODE("Wellington") returns 87, the code for ‘W’. 

STRING(x,n) Returns the number x as a string, to n decimal places. Uses ‘Fixed’ 
format for x, and rounds if necessary. 
For example, =STRING(3.496,1) returns the string "3.5". 
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VALUE(string) Returns string converted to a numeric value.  
For example, =VALUE("445.8") returns the number 445.8. 
String may specify a decimal or scientific number, or may include a fraction - for 
example "0.34", "4.2E3" or "91 3/4". 
Returns 0 for blank cells and null strings. Leading and trailing spaces are ignored.  

Identifying strings from numbers 
ISNUMBER(x) Returns 1.0 if x is a number or a formula returning a number. 
Otherwise returns zero. 
ISSTRING(x) Returns 1.0 if x is a string (even a null string) or a formula returning a 
string. Otherwise returns zero. 

Statistical & database functions 

The statistical functions perform calculations on lists of values. A list is a variable 
number of parameters, where each parameter is either: 

•  A single value, for example H45, 4.65, "sales" or B2*4.56, or a range name. 

•  A range reference, for example H45:I46, or range name.  

In a list, empty cells are ignored - in other words they are taken to contain the value 
zero and do not add one to any count of cells. But the individual reference of a blank 
cell does count.  

•  For example, if these cells have these values: 10 in A1, A2 empty, and 5 in A3, 
=COUNT(A1,A2,A3) returns 3 but =COUNT(A1:A3) returns 2. 

AVG(list) Returns the average of the values in list - that is, 
SUM(list)/COUNT(list). 

COUNT(list) Returns the count of the items in list. 

MAX(list) Returns the maximum value in list. Takes account of sign - e.g. +2 is 
greater than -100. 
MIN(list) Returns the minimum value in list. Takes account of sign - e.g. -100 is 
taken as less than +2. 
SUM(list) Returns the sum of the values in list. 

Standard deviation and variance 
These are measures of the extent to which individual values in a list vary from the mean 
(average) of the list. The less the variance or standard deviation, the closer values are to 
the average - and the more reliable is the mean. 
A variance/standard deviation of zero means that all the values in the list are the same. 
Difference between STD and VAR: STD returns a result in the same units as the input 
values, whereas VAR=STD2. 
STD(list) Returns the standard deviation of the values in list. 
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The STD function uses the formula: 

standard deviation = √∑(Vi-AVG)2/n

where n is the number of items in list, AVG the average of list and Vi the ith item 
in list. 

VAR(list) Returns the variance of the values in list. 

The VAR function uses the formula: 

variance = ∑(Vi-AVG)2/n

where n is the number of items in list, AVG the average of list and Vi the ith item 
in list. 

Database statistical functions 
These perform the same kinds of calculations as the statistical functions. However, they 
get the values to use from cells in a specified field (column) of those records in a range 
which match criteria in another range. 
Although you can use any two ranges for the database and criteria, you would normally 
use database and criterion - the named ranges defined by ‘Set database’ and 
‘Set criteria’. 
All of the database statistical functions have these parameters: 
=DAVG(range1, column, range2)

where range1 is a range to use as the database, and range2 is a range to use as the 
criterion.  
The column parameter is an integer specifying the field from which the figures are to 
be taken. Column 0 is the leftmost column in the database range, column 1 the one to 
the right of that, and so on. So if the database range was C2:E20, column 0 would be 
column C. 
DAVG(database,column,criterion) Returns the average of the values in the 
field column of those records in database matching the specified criterion. 

DCOUNT(database,column,criterion) Returns the number of items in the 
field column of those records in database matching the specified criterion. 

DMAX(database,column,criterion) Returns the maximum of the values in 
the field column of those records in database matching the specified criterion. 

DMIN(database,column,criterion) Returns the minimum of the values in the 
field column of those records in database matching the specified criterion. 

DSTD(database,column,criterion) Returns the standard deviation of the 
values in the field column of those records in database matching the specified 
criterion. 
DSUM(database,column,criterion) Returns the sum of the values in the field 
column of those records in database matching the specified criteria. 

DVAR(database,column,criterion) Returns the variance of the values in the 
field column of those records in database matching the specified criteria. 
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Range and cell functions 

Important: all of these functions require a full range reference. Should you wish to 
specify a single cell perhaps with the N, S or CELL functions enter it as a range (e.g. 
A1:A1). 

General functions 
COLS(range) Returns the number of columns in range. 

ROWS(range) Returns the number of rows in range. 

INDEX(range,column,row) Returns the contents of the cell at position 
(column,row) in range, where the upper left-hand cell in range is the ‘origin’ 
(column 0, row 0). 
For example =INDEX(A1:C3,2,2) returns the contents of cell C3. 

N(range) Returns the value of the upper left-hand cell in range as a number. If the 
cell contains a string, 0 is returned. 
S(range) Returns the value of the top left-hand cell in range as a string. If the cell 
does not contain a string, a null string ("") is returned. 

Cell attribute functions 
CELL(attribute,range) Returns attribute information about the upper left-hand 
cell in range. The value for attribute must be enclosed in quotation marks; it is 
not case sensitive. 
CELLPOINTER(attribute) Returns attribute information like the CELL function, 
but about the cell which was current at the last recalculation. 
A list of all the possible values of attribute, and the values they return follows: 

Attribute: Value returned: 
address absolute cell address 
row  from 1 to 8192 - row number 
col  from 1 to 256 - column number 
contents contents of cell, e.g. text or number string 
type  data type in cell: 
   b   for blank 
   v   for a number or formula 
   l    for text 
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prefix text prefix in cell: 
   ‘    for left-aligned text 
   "   for right-aligned text 
   ^   for centre-aligned text 
   \    for repeated 
   blank if no prefix. 
protect 1 if cell is protected 
  0 if unprotected 
width  from 1 to 99 - column width 
format numeric format:  
   F0 to F15 - fixed, 0 to 15 decimal places 
   S0 to S15 - scientific, 0 to 15 decimal places 
   C0 to C15 - currency, 0 to 15 decimal places 
   ,0 to ,15 - comma, 0 to 15 decimal places 
   P0 to P15 - percent, 0 to 15 decimal places 
   G - general 
   D1 - date format DD-MMM-YY * 
   D2 - date DD-MMM 
   D3 - date MMM-YY 
   D4 - date Long International 
   D5 - date Short Internationl 
   D6 - time format HH:MM:SS AM/PM 
   D7 - time HH:MM AM/PM 
   D8 - time Long International 
   D9 - time Short International 
   T - text (Show formulae) 
   H - hidden 
   B - bargraph 
* Of the D formats, Sheet displays only D4 and D8. If you import a file from Lotus, you 
may get the others returned. 
For example, if clients is the name of range A1:C3, 
=CELL("Address",clients) returns A1. 

LOOKUP functions 
HLOOKUP(x,range,offset) The HLOOKUP function looks along the top row of 
a range until it finds the value x. 
When it finds it, HLOOKUP then looks down to the cell which is offset number of 
rows below, and returns the value of that cell. 
The range you give should include the whole of the area, including the row containing 
the values you look up. 
The first row of the range must contain values in ascending order with no duplicates. 
HLOOKUP in fact finds the last cell which is less than or equal to x. The result of this 
is that each column covers a range of numbers. For example, if the values in the top row 
of the range are 1, 2 and 3, HLOOKUP will look in the first column when x is from 1 to 
1.99999...., in the second column when x is from 2 to 2.99999...., and in the third 
column when x is 3 or above. 
HLOOKUP returns ERR if x is less than the value in the first cell of the top row. 
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VLOOKUP(x,range,offset) VLOOKUP does the same as HLOOKUP, except 
that it tracks down and then looks across. It locates the last cell in the first column of 
range which is less than or equal to x. It then looks across to the cell offset number 
of columns to the right, and returns the value of that cell. 
The first column of range must contain values in ascending order with no duplicates. 

Error functions 

Any cells which refer to cells containing ERR or NA also have ERR or NA in them. 
You can check for this ripple-through effect with ISERR or ISNA. 
ERR Returns ERR (error). 

NA Returns NA (not available). 

ISERR(x) Where x is a cell reference. Returns 1.0 (true) if the value in x is ERR, or 
0.0 (false) if the value in x is not ERR. 

ISNA(x) Where x is a cell reference. Returns 1.0 (true) if the value in x is NA, or zero 
(false) if the value in x is not NA. 

See also ISNUMBER, ISSTRING in the ‘String functions’ section. 

Differences between Sheet and Lotus 1-2-3 
Sheet works in a very similar way to versions 1A and 2 of Lotus. The main differences 
to note are: 

•  Use = (not +) to start a formula. 

•  No @ symbol is needed on function names. 

•  Range references use a colon; A1..C3 in Lotus is A1:C3 in Sheet. 

•  ** is the power operator; Lotus uses ^. (The precedence of all the operators is the 
same.) 

Other differences: 

•  To hide columns, set their column width to zero. 

•  Numbers in ‘Bargraph’ format are shown as a graphical bar. 

•  The logical operators AND and OR do not need # symbols around them as they do 
in Lotus; for example, the formula A1=1#AND#A2=2 in Lotus would be =A1=1
AND A2=2 in Sheet. 

•  Sheet has a % operator. 

•  The @ function is called AT in Sheet. 
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The System screen 

This chapter explains the features of the Series 3c’s System screen, 
how the Series 3c stores your information in files, and how you can 
use the System screen to manage your Series 3c more effectively. It 
covers the following topics: 

••••  the general settings you can control from the System screen, e.g. 
automatic switch off, setting a password, controlling how Tips 
appear. 

••••  communicating with other machines. 
••••  installing and removing applications. 
••••  organising the icons in System screen. 
••••  disk, battery and memory management. 
••••  files and directories. 
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Introduction 

 

The System screen is the control centre of your Series 3c. It doesn’t do a specific job 
like the Series 3c’s applications - Data, Word and so on - but it helps you organise and 
use those applications effectively. 
It is also the place to find the options which control how the Series 3c works as a whole, 
e.g. setting owner information and a password, choosing communications options, or 
even just choosing how loud you want the keys to click when you press them. 
This chapter covers: 

•  the System screen settings which control how your Series 3c looks, works and even 
sounds! 

•  information about using icons and applications. 

•  how to manage files and directories from the System screen. 
Some of this information is covered in more detail in other parts of this manual. 

Displaying the System screen 
•  Press the System button on the Buttonbar at any time to move to the System 

screen. You don’t have to exit the application you are currently in. 

•  You can also move straight to the System screen, and move the highlight to a 
particular application’s icon (whatever you’re doing on your Series 3c) by holding 
down  and pressing the application button. 
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General settings 

Setting owner information and a password 

•  It is always a good idea to select the ‘Set owner’ option on the ‘Info’ menu and fill 
in a contact telephone number or address, just in case you lose your Series 3c. 

•  Also, set a password so that your information is more secure. You must then type 
in the password whenever you switch on your Series 3c: 

  

 If you set a password, the owner information and the current time is always 
displayed when you switch on your Series 3c. You can check the time quickly just 
by switching on, but no-one can reach your information as the password is set. 

 See the ‘Security & backups’ chapter for more information. 

Setting automatic switch-off 

To save power, your Series 3c is initially set to switch off automatically if you do not 
use it for a five minute period.  
The ‘Auto switch off’ option on the ‘Control’ menu allows you to control whether or 
not this happens, and after how long: 

•  If you sometimes use mains power but also use batteries as well, it is a good idea to 
set ‘Auto switch off’ to ‘If no external power’ - the Series 3c will then switch off 
only if you are using batteries and not mains power. 

•  If you always use batteries, it is usually best to leave the ‘Auto switch off’ set to 
‘Yes’. You can change the switch off time interval, if you want a shorter or longer 
time. 

 If you set ‘Switch off’ to ‘No’, the Series 3c will never switch itself off. This 
means that if the Series 3c is running on batteries and you don’t physically turn the 
Series 3c off by pressing the OFF key, it will stay on until the batteries run down. 
If this happens, your data will be safe as long as the backup battery is good, but 
you will not be able to use the Series 3c again until you have replaced or recharged 
the main batteries. 
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Using a Status window  

You can press  to include a “Status window” in the System screen, and in 
most other applications. A Status window usually indicates the different views in an 
application (the “diamond list”), always shows the current date and time, and can also 
display symbols to help you see the status of the Series 3c. 
See ‘Displaying a Status window’ in the ‘Getting started’ chapter for more about the 
Status window; what the various symbols mean, and how to control its display. 

Displaying a “memory bar” 

•  Press  in the System screen to display a memory bar showing the amount of 
memory used and free: 

 

•  Press  again if you want to remove it. 

 You can leave this bar displayed all the time if you want to, or just switch it on 
from time to time to check your memory. 

Controlling the sounds the Series 3c can make 

The ‘Sound’ option on the ‘Control’ menu controls sound settings for the whole 
machine: 
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To.... 

•  Turn the sound off completely: set the ‘All sound’ line to ‘Off’. The Series 3c 
will not make any sounds, even alarms. You might set this to ‘Off’ when going to a 
meeting; remember to turn it on again afterwards. 

•  Turn alarm sounds on and off: set the ‘Alarm sounds’ line as appropriate. 

 You will be unable to record sounds using Soundmaster if you set ‘All sound’ or 
‘Alarm sounds’ to Off’; you will see a ‘Sound is disabled’ message when you try to 
record. Set both ‘Alarm sounds’ and ‘All sounds’ to ‘On’ to record sounds again. 

••••  Make the keyboard keys ‘click’ as you type: set the ‘Key click’ to ‘Quiet’ or 
‘Loud’. Set this line to ‘Off’ if you do not want the keys to click at all. 

•  Control the error beeps: set the ‘Beeps’ line to ‘Quiet’ or ‘Loud’, or set it to ‘Off’ 
for no error beeps.   

•  Show negatives. Controls the way the Series 3c indicates that a currency amount is 
negative. You can either do this by showing the amount in brackets (as accountants 
do) or by putting a minus sign (-) in front of it. 

‘Evaluate’ format - working out sums 

 Advanced use only. 

Many of the Series 3c’s applications, such as Word, Data and Calc, can do instant 
calculations. If the application has an ‘Evaluate’ option on the ‘Edit’ menu, you can 
highlight any numeric expression (for example, ‘2+2’) and select ‘Evaluate’. The result 
of the calculation is inserted into the document (in this example, ‘4’). 

•  The “Evaluate” format option on the ‘Control’ menu allows you to control various 
things about the way the Series 3c does these instant calculations: 

 

The ‘Trigonometry units’ line specifies whether the Series 3c works in radians or 
degrees. For an explanation of the available ‘Format’ options, ‘Decimal places’ and 
‘Significant digits’, refer to the ‘Calc’ chapter. 
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How numbers and currency are displayed 

 Advanced use only. 

The ‘Number formats’ option on the ‘Control’ menu lets you control how the Series 3c 
applications display numbers and amounts of money. It has two lines: ‘Number 
separators’ and ‘Currency’. Press  on either line to display the further dialog. 

‘Number separators...’ 
•  Decimal point. This sets the character the Series 3c displays for the decimal point - 

either a dot (as used in the UK and US) or a comma (as used in European 
countries). 

•  Thousands separator. This sets the character the Series 3c displays to separate 
groups of thousands (in the figure 1,000,000 the thousands separator is a comma). 

•  Separate thousands. This controls whether or not a thousands separator is 
displayed. 

 Some applications override these with their own settings. 

‘Currency...’ 
•  Symbol. The symbol used to indicate currency (for example, ‘£’ for sterling, or ‘$’ 

for dollars, or ‘A$’ for Australian dollars). 

•  Position. Determines whether the currency symbol is shown before or after the 
amount. 

•  With space. Determines whether there is a space between the currency symbol and 
the amount. 

•  Decimal places. The number of decimal places to display in currency amounts 
(normally 2, but you can have up to 15). 

Changing the size of the text 

•  If you want to make the text larger and more readable, select the ‘Zoom in’ option 
on the ‘Special’ menu. 

•  Alternatively, use ‘Zoom out’ to make the text smaller. 

 These settings are for the System screen only, not for the whole machine. So, for 
example, you can use a smaller “zoom” setting in the System screen to increase the 
number of icons and files visible on screen, and use a larger zoom setting in other 
applications, e.g. Data. 
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Changing the font, or typeface, used in the System screen 

Select the ‘Set preferences’ option from the ‘Special’ menu and set the ‘Font’ line to: 

•  ‘Roman’ - a serif font, where the letters have “tails” (like this). 

•  ‘Swiss’ - a sans serif font, with no “tails” (like this). 

Controlling when Tips appear  

Tips can tell you useful information about your Series 3c, explain terminology, and can 
give you some ideas about how to get the most out of it. When you first get your 
Series 3c, you will see that a Tip appears once per day, when you first switch the 
machine on. 
If you want to: 

•  display a Tip every time you switch on: select Set preferences’ on the ‘Special’ 
menu, and set the ‘Tips’ line to ‘Always’. 

•  move to more advanced tips: use  when the Tips screen is displayed to move 
on to a more advanced Tip. The Tips are specially designed to guide you as you 
start using your Series 3c, and become more advanced as further tips are shown. If 
you find that the early tips are too basic (perhaps if you have used a Series 3 or 
Series 3a before) you can quickly move on to more advanced information - press 

 when you reach the Tip you want to start on. When you next switch on, the 
Tips continue from this point. 

•  turn off tips altogether: set the ‘Tips’ line to ‘Never’, or press  to disable 
them when the Tips screen is displayed. You may want to do this when you have 
seen all of the tips. 

 Displaying Tips at other times 

 Sometimes, you may want to remind yourself of a tip that has been displayed 
recently. If your tips only usually appear once a day, you can still get to the Tips 
screen: 

•  Select ‘Set preferences’ from the ‘Special’ menu and set the ‘Tips’ line to 
‘Always’. Then switch your Series 3c off, and then on again. 

•  When the Tips screen is displayed, use  to move to the Tip you want. 

•  Remember to switch the ‘Tips’ line back to ‘Once per day’ when you have 
finished. 
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Communicating with other machines 

The System screen controls the way the Series 3c communicates with other devices 
(other computers, printers and so on). Select the ‘Communications’ option on the 
‘Special’ menu: 

 

Infrared 
When ‘Use’ is set to ‘Psion IR’, you can control the Infrared power by setting the 
‘Power setting’ line to ‘High’ or ‘Low’. You should always use ‘High’ unless the 
Series 3c is very close to the other Psion and you wish to save power, in which case set 
it to ‘Low’. 
See the ‘Infrared’ chapter for more about sending information and files to another 
Series 3c or Siena, and the ‘Printing’ chapter for details of printing to an IrDA 
compatible printer. 

Link cable 
When ‘Use’ is set to ‘Link cable’, you can set the communication speed using the ‘Baud 
rate’ line. You should set this to match the fastest speed available on the other device 
(for example, a modem or another computer). 
If you don’t know the speed of the other device, a general rule is to start with the fastest 
rate (57600) and decrease it one step at a time until it works. 

 Don’t leave the Series 3c’s communications system set to ‘Link cable’ when you’re 
not using the cable. If you leave it set, the Series 3c uses more power when turned 
on, reducing the battery life. It reduces security too: someone could then copy files 
from the Series 3c via a serial cable, even if you had a password set for the 
machine. 

Battery and power usage 

The ‘Battery info’ and ‘Usage monitor’ options on the ‘Info’ menu can help you keep 
track the battery levels, and power usage. The “usage monitor” can tell you how well a 
particular brand of battery is performing, and how much battery power the Series 3c is 
using. See ‘Understanding battery levels and power usage’ in the ‘Getting started’ 
chapter for more details. 
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Printing 

The ‘Printer’ option on the ‘Control’ menu configures printer settings for all 
applications which can print, including: 

•  The ‘printer device’. This is probably the only setting you need set: the likeliest 
settings are ‘Parallel’ for a direct cable link to the printer, ‘Serial’ if printing via a 
PC with PsiWin, or ‘Infrared’ if your printer has an IrDA Infrared receiver. 

See the ‘Printing’ chapter for more about printing. 

Applications, icons and file lists 
The application icons are listed across the screen. Where you’ve created files with an 
application, those files are listed below the icon: 

 

From here you can: 

•  Open an application (i.e. a file): highlight the name of the file and press  to 
open it. Some applications, like Calc, do not use files, and always appear with their 
application name under their icon. To start such an application from the System 
screen, just move the highlight to its name and press . 

•  Open an application with a new file: move the highlight to the application icon 
and selecting ‘New file’ from the ‘File’ menu. In the dialog, type the name you 
want to give the new file from the ‘Name’ line and press . If you want to 
store the file on a disk other than ‘Internal’, set the ‘Disk’ line to the appropriate 
disk. 

•  Close an application (i.e. a filename shown in bold): highlight the name of its 
open file and press . 

•  Delete a file: highlight the file, and select ‘Delete file’ from the ‘File’ menu, or 
press . 

 If you need to free a large amount of memory quickly, select ‘Exit all applications’ 
on the ‘Apps’ menu. 
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 If an application is busy or unable to exit for some reason (e.g. if it “crashes” - and 
appears to stop working), you can “kill” it by selecting ‘Kill application’ from the 
‘Apps’ menu. This should be as a last resort only; any unsaved data in the 
application would be lost. You are unlikely to need to do this in practice. See the 
‘Troubleshooting’ chapter for more about killing applications. 

Updating the file lists 
The System screen needs to update its display periodically to reflect any changes: new 
files, deleted files, opened or closed applications and so forth. The ‘Update lists’ setting 
allows you to specify whether this should happen automatically (every time a change 
occurs), or only when you press the ‘System’ button. 
If you have a large number of files and applications, the display update can take a 
second or two, and you may wish to set ‘Update lists’ to ‘System key’ so that the 
display is only updated when necessary. The normal setting is ‘Automatic’. 

 A file list can include three dots (...) to signify that some files could not be shown. 
See ‘Three dots (...) in file lists’ in the ‘Troubleshooting’ chapter for more details. 

Opening more than one file of the same type 

Usually, when you open a file (e.g. in Word), any other file of the same type which is 
already open is closed automatically. You may want to keep two files from one 
application open at the same time, perhaps to copy information between two Word files, 
or simply to make it easier to quickly switch between your work and personal diaries.  
To do this: 

1. Open the first file as normal using . 

2. Press the System button to return to the System screen, and move the highlight to 
the second file. 

3. Press  to open it instead of  and the first file remains open. The 
names of both files are shown in bold type in the System screen. 

•   Use the application button on the Buttonbar to cycle through all each open file.  

•  Using  and the application button cycles round the other way. 

•  Remember to exit a file manually when you’ve finished with it - the Series 3c will 
not now do it for you automatically when you open a new one. 

 If you often have plenty of free memory, you might prefer to swap the actions of 
 and , so that opening a file with  does not exit a 

previously open file. Select ‘Set preferences’ to set this. 
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Installing new (“add-on”) applications 

You’re not limited to the applications which are built into the Series 3c. You can buy 
add-on applications, for example on an SSD, which you can “install” on the System 
screen. The new application then appears as an icon exactly like the built-in 
applications, and is effectively made part of the Series 3c, until you “uninstall” it. 

 Installing just lets the System screen know about the application. If the application 
is on an SSD and you subsequently remove the SSD, you will not be able to use it. 
(If you have enough free memory, though, you may decide to copy the whole of an 
application onto the Series 3c’s internal disk, and install it from there; it will then 
work even without the SSD.) 

Installing an application from an SSD 
1. Move the highlight to the position where you want the application’s icon to be 

inserted on the System screen. 
2. Select ‘Install’ from the ‘Apps’ menu. The ‘Install’ dialog will appear: 

 

3. Set the ‘Disk’ line to the disk you’re installing from. 
4. Select the application’s name from the ‘File: Name’ line. 

 If it is not listed, the application may not be in the standard ‘APP’ directory of the 
disk; if you think it may be somewhere else, press  on this line to use the “File 
selector” to find the application file. (There is more about the File selector later in 
this chapter.) 

5. Set the ‘Position’ line to where you want the application’s icon to appear on the 
System screen: 

•  ‘Current’ places the new icon just to the left of the currently highlighted icon. 

•  ‘First’ places the new icon at the far left. 

•  ‘Last’ places the new icon at the far right. 
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Assigning a button to an application 

•  Some of the Series 3c’s standard, built-in applications (such as Word and Data) 
have their own button on the Buttonbar.  

•  For the built-in applications which do not have a Buttonbar button of their own, 
you can usually hold down the  key and press a particular Buttonbar button 
to move there, for example,  and the Agenda button will go to the Patience 
game. 

If you use add-on applications, you can assign a Buttonbar button and  keypress 
to your new application. For example, you might make  and the Data button 
open a application. 

 If you find you don’t use one of the built-in applications very often, you can even 
reassign its button - without the  key - to activate some other application. 
You can always open the original application by highlighting its icon in the System 
screen. 

To assign a Buttonbar button to an application: 
1. Highlight the application in the System screen. 
2. Select the ‘Assign button’ option on the ‘Apps’ menu. The ‘Assign button to...’ 

dialog is displayed. 
3. Set the ‘Modifier’ line to ‘Ctrl’ or ‘None’, depending whether you want to use the 

button in conjunction with , or just on its own. 

4. Set the ‘Button’ line to the appropriate button and press . 

From now on, when you use the set keypress, the Series 3c will switch to that 
application in the same way as for the standard applications. 

 You cannot reassign the ‘System’ button. 

Removing an icon 

If you find you don’t use a particular application (either an add-on application that you 
have installed yourself, or one of the built-in applications), you might consider 
removing the icon to tidy up your System screen. This is known as “uninstalling” the 
icon. 

 Check that the files listed for the application you want to remove are not “open”. If 
they are, close them before removing the application icon. If you remove an 
application icon while files are still open, the open files can slow down the 
Series 3c. See ‘If the Series 3c seems slow’ in the ‘Troubleshooting’ chapter for 
more details. 
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To remove an application icon: 
1. Move the highlight to it and select the ‘Remove’ option on the ‘Apps’ menu. 
2. Follow the instructions to confirm that you want to remove the application. 
The application itself will not be deleted from the disk - it will simply not appear on the 
System screen until you install it again. 
Of course, if you do delete an add-on application (or no longer use its SSD) you should 
uninstall it from the System screen display as well, since the icon in the System screen 
will no longer work. 

 It is impossible to actually delete one of the built-in applications. 

Re-installing standard applications 
If you don’t use one of the applications built into the Series 3c, you can if you wish 
uninstall it in the same way as an add-on application - with ‘Remove’ from the ‘Apps’ 
menu. 
If, later, you want to reinstall it, select ‘Install standard’ from the ‘Apps’ menu. You can 
select the standard application you want to reinstall. 

 Only those applications not already installed will be available when you use 
‘Install standard’. If you want to install two copies of an application icon, perhaps 
if your file list is getting too long, or if you have different types of files that you 
want to keep separate (e.g. letters and memos in Word), you can create a new “list” 
in the System screen. See ‘Organising icons and files: “lists”’ for more details. 

Rearranging icons 

 You might rearrange the icons so that the ones you use less often are at the end of 
the row of icons on the System screen. This makes the icons you use frequently 
more easily accessible. 

•  To move an icon you need to remove it, then re-install it in the position you 
choose, i.e. move the highlight to the place you want the icon to appear and then 
use ‘Install’ or ‘Install standard’ as described above with the ‘Position’ line set to 
‘Current’. 
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Organising icons and files: “lists” 

•  If you accumulate a lot of files of a particular type (Word files, say), they form a 
long list under the icon, and you need to scroll through the list using  to 
find the file you want. 

•  To help organise your files better, the System screen lets you create new “lists”. 
For example, you might want to keep all your personal letters together in one list, 
and all your business documents in a separate list.  

To do this, you can create a new list for the Word application. A new Word icon then 
appears on the System screen, so that you now have two, each with their own separate 
lists of files. 

 

Lists work by storing each set of files in a separate “directory”. (Directories are 
described in detail under ‘Advanced use of files and disks’, later.) A directory is a 
‘place’ on the Series 3c’s disk where a file can be stored. 

Creating a new list 
1. Move to the application icon you want to create a new list for (e.g. Word). 
2. Select ‘Create new list’ from the ‘Special’ menu: 

 

3. Enter the name of the directory you want to store the new files in on the ‘Directory 
for files’ line. You can use up to eight letters for the name of the directory. For 
example, if you wanted to create a new Word list for storing your letters, you might 
decide to store the files in a directory called LETTER. If you are used to 
directories, you may find it easier if you type a backslash (“\”) in front of the name 
at this point, e.g. \LETTER.  

4. Enter a name for the new list (e.g. ‘Letters’) on the ‘Save list as: Name’ line. 
5. The Series 3c fills in the ‘Extension for files’ and ‘Icon’ lines for you, so you don’t 

normally need to alter these. 
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 Important: Creating lists for Word has an extra complication over other 
applications, in that Word has two possible ‘incarnations’: as a normal word 
processor, or as a plain text editor. As you can see from the picture above, there is 
an extra ‘Type’ line in the dialog to specify which of these you want for the new 
‘Word’ list. Normally you should always set it to ‘Word processor’. (See the 
‘Word’ chapter for information about using Word as a text editor.) 

If you’re happy with the new list setup, press  and follow the instructions to 
confirm. 

•  The new icon will now appear on the screen. 

•  To create a new file for this list: just move the highlight to the icon and select 
‘New file’ from the ‘File’ menu. 

•  To copy existing files into the new list: see ‘Moving files between lists’ below. 

•  To check where files for each list are stored: move the highlight to it and use 
‘About application’ from the ‘Info’ menu. This will tell you the directory and file 
extension used for files in this list. 

Moving files between lists 
Sometimes you’ll have existing files which you want to move over into the new list. In 
order to do this, you need to copy the files from their old directory to the new one. 
You can do this using the File selector, as described below, or using the Files 
application. See the ‘Files application’ chapter for more details about copying files 
using the Files application. 

 This procedure involves the File selector, tagging, and file extensions. All of these 
are dealt with in detail later in this chapter. 

1. Move the highlight to the list where the files are (e.g. your original Word icon). 

2. Press . The “File selector” dialog will be displayed: 

 

3. Tag each of the files you want to move by moving the highlight to their name, then 
pressing . (The filenames are shown followed by their “file extensions” - 
e.g. “wrd” for Word files.) When you tag each file a little tick symbol will appear 
next to it. Repeat this for each file you want to move into the new list. 

4. Press , and select ‘Copy file’ from the small menu shown. 
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5. On to ‘To file: Name’ line of the ‘Copy file’ dialog, enter the name of the new 
list’s directory, including the backslash, like this: 

 

 If you didn’t use a backslash when entering the directory for the new list, the files 
are stored in a “subdirectory” from the WRD directory. 

6. Press . The files will be copied to their new location. 

The files should now appear under the new list’s icon. Notice that the original files are 
still listed under the original icon as well. You may want to keep the originals as a 
backup and edit the new copies, or you may want to delete the originals to avoid 
confusion. 
To delete the original files: 
1. Move the highlight to the original file list (the one you copied them from). 

2. Press . As before, the File selector will be displayed. Tag the files you’ve just 
copied. 

3. Press , and select ‘Delete file’ from the small menu shown. The Series 3c 
displays the ‘Delete file’ dialog.  

4. Press  to complete the dialog. Follow the instructions to confirm that you are 
sure that you want to delete the files. 

If you delete the files, you will see their names disappear from the original list. 

Removing a list 

1. Move the highlight to the list and select ‘Remove’ from the ‘Apps’ menu. 
2. Follow the instructions to confirm that you want to remove the list. 
Any files which were shown on that list will still exist on disk in the directory you typed 
in when creating the list; this action does not delete them. If you reinstall the list later, 
the files will again be listed. 
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Organising applications: “groups” 

Just as lists are for organising files, “groups” are for organising applications. 

•  Each “group” is a selection of applications or icons which are kept together, but 
the group is listed under a single icon in the System screen. (You can even put 
“lists” into these groups too.) 

 

•  You can still “open” applications in a group from the System screen. In the 
example above, you can move the highlight to ‘Patience’ or the add-on application 
‘Chess’ and press  to start playing. 

•  Each group appears as a single icon on the System screen, but you can “open” it by 
moving to it and pressing the Spacebar. It’s like having little mini-System screens, 
each in their own window: 

 

 You can reduce the number of icons in the System screen display by putting those 
applications which generally don’t have file lists - Time, World, Calc, Spell and so 
on - into a new group, and removing them from the main System screen. 
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Creating a new group 

1. Select ‘Create new group’ from the ‘Special’ menu: 

 

2. Enter a suitable name for the group (for example, ‘Work’ or ‘Games’). Press  
to go ahead and create the group. 

The new group icon appears on the System screen with the name you chose underneath 
in italics (which indicates there are no applications in it yet). 

Installing applications in a group 
1. Highlight the group and press  (the Spacebar) to open the group. 

2. Use ‘Install’ or ‘Install standard’ from the ‘Apps’ menu to install applications just 
as you normally would. You can also install lists you’ve created. 

 Pressing  again, or , closes the group. 

 As mentioned earlier, you can go directly to an application’s icon in the System 
screen by holding down  and pressing the application button. If the 
application is inside a group, the System screen will open the group for you and 
position the highlight automatically. 

Removing a group 
1. Close the group, if it’s open, and position the highlight on it. 
2. Select ‘Remove’ from the ‘Apps’ menu and follow the instructions to confirm that 

you want to remove the group. 
You can reinstall a group just as you can with an application, provided that you 
haven’t deleted any of the applications installed in that group. If you have, the 
Series 3c will complain that it can’t find the deleted application and will not let you 
reinstall the group.  

 You can get round this, if you need to: just reinstall the application, or if you don’t 
have it, copy another application and rename the copy to the name of the missing 
application. You can find out how to do this in ‘Understanding files and 
directories’ later. 
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Managing disks and memory 
The Series 3c has an internal ‘memory pool’ which it has to share out between the 
applications running in memory, and your files on disk. As you enter information into 
your Series 3c, you will find that the Internal disk begins to fill up, leaving you less 
space in memory to run applications. If it gets close to full, you will need to 
‘housekeep’ your disk, removing old files and/or moving others elsewhere, for example 
onto an SSD. 

Monitoring memory 

Use the ‘Memory’ view of the System screen to show how much space is left at any 
time. To do this, press the  key in the System screen. A gauge will appear at the 
bottom of the screen showing how much of the memory is used. To remove the gauge, 
press  again. 

You can also examine exactly how much memory each application is using. Select 
‘Memory info’ from the ‘Info’ menu to show the ‘Memory’ dialog.  

Use the  keys to cycle through the displays for the System, the Internal disk and 
all the open applications: 

 

Monitoring disk space 

You can see how much space is left for files on the Internal disk, and any SSDs, with 
‘Disk info’ on the ‘Info’ menu: 
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What happens when memory is full 

There is no danger of losing any data if you temporarily run out of memory or disk 
space. One of two things will happen: 

•  the Series 3c may refuse to run an application, saying ‘No system memory’, if 
Internal memory is full; 

•  an application may be unable to save a file, and will give the same message. If the 
file is held on the Internal disk, this means that the Internal memory (which is used 
by the ‘Internal’ disk and by each running application) is full; if it is on an SSD, it 
means that SSD is full. 

In the latter case, any changes you have made to the file since you opened it will not be 
saved until you have cleared some memory space. You can do this in one of the 
following ways: 

•  If the file is on the Internal disk, you can exit any other running applications - just 
highlight their names in the System screen and press . 

•  On any disk, you can remove some files from the disk, either by deleting unwanted 
ones or by making copies of them on another disk and deleting the originals. Both 
methods are described above. 

 If you copy a file from a disk which is full to another disk, and delete the original, 
the space it took up is not immediately freed if it was on a Flash SSD. You will 
need to “compress” the disk - copy the files off, format it, and copy them back. 

When you have freed enough memory you should be able to save your work or open the 
new application. 

Understanding Solid State Disks (SSDs) 

Solid State Disks (SSDs) can store any of the information normally kept on the Internal 
disk. The main reasons for using them are: 

•  To provide more room for storing information. 

•  To make backup copies of information. 

•  As a way of swapping information with another Psion, perhaps a Series 3a (which 
do not have Infrared). 
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Ram SSDs... 
•  can store information securely for day-to-day use. 

•  are useful as a store for information which may change a lot (e.g. a document you 
are working on) because space on the disk is re-used when you delete or replace 
information. 

•  are “powered” by the Series 3c when in an SSD drive, and have a built-in battery 
to preserve the information when it is not. When out of the Series 3c, Ram SSDs 
rely on the power of their built-in batteries; a fresh battery will typically preserve 
the information for at least three months. 

 Ram SSD are for storing all kinds of information, e.g. draft copies of a Word 
document. You can re-use the disk many times without needing to reformat it. 
However, remember that the battery power will run down if it is not in the 
Series 3c, so do not keep very important information on a Ram SSD. 

Flash SSDs... 
•  do not rely on any form of battery power, so they can store information in a 

completely secure form for many years. 

•  cannot re-use disk space once information is saved. Deleting or replacing old 
information on a Flash SSD is like crossing out notes in a book - the information is 
gone, but the space is still occupied. 

•  need to be “formatted” before you can use this space again. This “wipes it clean” 
by removing (deleting) all the saved information on it and allows you to use all the 
space on the complete disk again. 

 If you want to keep the information on a Flash SSD, but need to reformat it to free 
more disk space, copy all the files you wish to keep to another disk first. 

 Flash SSDs are for storing important and/or “finished” information. 

Formatting SSDs 
“Formatting” an SSD wipes it completely clean. Do not format a disk unless you no 
longer want any of the files it contains - copy the files to another disk if you want to 
reclaim space on Flash SSD. 

•  A Ram SSD needs formatting before use. 

•  A Flash SSD needs to be formatted before it can be used again. The existing 
information is deleted, and all the disk space is available again. 

 You can format an SSD from the System screen, or using the Files application. See 
the ‘Files application’ chapter for more details. 

To format an SSD: 
1. Insert the SSD into one of the SSD drives. 
2. Select the ‘Format disk’ option from the ‘Disk’ menu. 
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3. Select the drive containing the disk on the ‘Disk’ line. Be sure to choose the 
correct SSD drive - A or B - and be sure not to choose Internal. 

4. If you wish, you can type a “volume name” for a disk onto the ‘Name’ line, e.g. 
PROJECT2. This can help you to identify the disk. 

5. Press . A progress bar is displayed to show you the progress of the 
formatting. 

You can press an application button and continue to use the Series 3c while formatting 
is taking place. You can press the System button to return to the System screen, to 
check the progress of the formatting. 

 Ram SSDs with low battery 

 The Series 3c can check the state of the battery in some Ram SSDs. If it can, it will 
do so when formatting. You will be warned if the battery is low; either the battery 
is fitted incorrectly, or it no longer has sufficient power to preserve information 
when out of the Series 3c. Do not use the disk because it will lose any information 
it contains if it is taken out of the Series 3c. 

“Write-protecting” SSDs 
Each SSD has a switch to let you “write-protect” the information on it: 

•  To make the disk read-only: set the switch to the ‘Protect’ position. You can only 
read the information the disk contains; you cannot save anything to it, or delete or 
alter anything. 

 Before you write-protect an SSD, you should exit any open files on it.  

•  To remove write-protection: set the switch back to the ‘Write’ position. 

Checking the battery in a RAM SSD 
Ram SSDs have a built-in battery which preserves information when the SSD is out of 
the Series 3c. The Series 3c will usually be able to check the battery; either when 
formatting the disk, or if you select the ‘Disk info’ option: 
1. Insert the SSD in one of the Series 3c disk drives. 
2. Select the ‘Disk info’ option on the ‘Info’ menu. 
3. Press the key corresponding to the drive containing the Ram SSD: 
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•  The message ‘Battery good’ may appear in the top line of the dialog, after the size 
of the SSD. 

•  If you see ‘Battery low’ or ‘Media is corrupt’, check that the battery is fitted 
correctly. If the message still appears, the battery has insufficient power to preserve 
information out of the Series 3c. 

•  If there is no message after the SSD size, remove the SSD and repeat the procedure 
a few minutes later. 

Setting the default disk 

Whenever you are asked to supply a filename in any application, the Series 3c suggests 
a disk for you. This is usually Internal, but if you have an SSD, you may wish to set this 
as the “default disk”. 
To change the default disk: 
1. Select the ‘Default disk’ option from the ‘Disk’ menu. 

2. Set the ‘Disk’ line to the disk you want. Press  to confirm this. 

Giving names to your disks 

Each disk, whether it be Internal or an SSD, can have a name associated with it. You 
can set this name to whatever you like. You might find this particularly useful if you 
have several SSDs, and you need to identify each one easily. The standard name for the 
Internal disk is ‘RAMDRIVE’, but you can also change this if you want to. 

To set the name of a disk: 
1. Select the ‘Name disk’ option from the ‘Disk’ menu. 
2. On the ‘Disk’ line, select the disk you want to name. 
3. On the ‘Name’ line, type in the name you want to give the disk. This can contain 

up to 8 letters and numbers. Press  to confirm your entry. 

 As with filenames, you can add on an extension - i.e. you can use 8 letters, then a 
dot and three more. 
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Understanding files and directories 
All of your information is stored in “files”. Files are stored on the disk, but organised 
into different “directories”. A directory is a named area of a disk where files can be 
stored. Directories are really a way of grouping similar or related files - for example, all 
Data files are usually stored in a directory called DAT, and all Word files in WRD. You 
can create your own directories if you need to, but you probably won’t find this 
necessary unless you use your Series 3c heavily and store a great deal of information on 
it. 

•  The Series 3c stores its files and directories in a ‘tree’ structure, like in the 
Windows File Manager on PCs. In other words, a directory can contain both files 
and other directories (sometimes referred to as “subdirectories”). 

•  Subdirectories are created inside directories, e.g. you can create LETTER and 
MEMO subdirectories (using lists, perhaps) inside the WRD directory. 

•  The top-level directory is always written as a single backslash character ‘\’, and is 
called the “root” directory. 

A Series 3c file always has a name associated with it, which is up to eight characters 
long. It can also have an “extension” - a three-letter tag on the end of the name. The 
extension is generally considered part of the filename, as is the separating full stop. 

INCOME.SPR

Name Separator Extension  

The extension helps to identify what type of file you’re dealing with. For example, the 
.SPR extension shown above is associated with Sheet files. Sheet always creates new 
files with a .SPR extension unless you tell it otherwise. 

There is a standard extension associated with each of the Series 3c applications: .WRD 
for Word files, .DBF for Data files, .AGN for Agenda files, and so on. 

Generally, when you’re asked for a filename, you don’t need to supply the 
extension - the Series 3c will work it out for itself. (In fact, the Series 3c generally 
hides extensions from you, except in such places as the File selector.) However, if you 
start using lists to organise files, you may want to use specific extensions to identify a 
related group of files - .LET for letters, for example. 
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Where the Series 3c stores files 

Your files are saved in these directories, and with these file extensions: 
Type of file Directory File extension 
Agenda \AGN .AGN 
Data \DAT .DBF 
Sheet \SPR .SPR 
World \WLD .WLD 
Word \WRD .WRD 
Word templates \WDR .WRT 
Sheet \SPR .SPR 
Jotter \JOT .JOT 
Soundmaster \WVE .WVE 
Printer drivers \WDR .WDR 
Program editor \OPL .OPL 
RunOPL \OPO .OPO 
Applications \APP or \IMG .APP, .OPA, .IMG 
other OPL files \OPD .ODB, .PIC 
System screen lists/groups \APP .ALS, .GRP 
If you have an Agenda called PERSONAL, its filename is really PERSONAL.AGN, and 
it is kept in the \AGN directory. 

 A freshly formatted SSD has only the “root” directory on it. The Series 3c makes 
the directories on a disk whenever it needs them. For example, if you copy a Data 
file to an SSD, the Series 3c will create a \DAT directory if it is not already there, 
and copy the file to this directory. 

Deleting files 

If you never delete files you no longer use, eventually the disk will become full up and 
you will not be able to create any new files. To avoid this, you should periodically 
delete the files you no longer need. 
Important: Once a file is deleted, it cannot be recovered. Make absolutely sure that you 
don’t need the file anymore before deleting it. 
To delete a file: 
1. Position the highlight on its name in the System screen. 
2. Select ‘Delete file’ from the ‘File’ menu. 

3. Press  and follow the instructions to confirm that you want to delete the file. 
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Copying files 

If you want to make second copy of a file - for security reasons, or just to create a new 
file with the same contents as an existing file: 
1. Position the highlight on its name in the System screen. 
2. Select ‘Copy file’ from the ‘File’ menu. 
3. Type a filename for the new file on the ‘To file: Name’ line. If you want the new 

copy to be on a different disk, set the ‘To file: Disk’ line accordingly; in this case, 
you can leave the ‘To file: Name’ line blank if you wish the copy to have the same 
name, and just be on a different disk. 

4. Press  to confirm the copy. 

This results in two versions of the file: the original, and the copy that you’ve created. 
These two files are separate entities. If you edit and change one, the other will not be 
affected. 

 Copying files to a different directory 

 You can use the File selector to copy a file to a different directory. Press  on 
the ‘To file: Name’ line to display the File selector, and locate the position where 
you want to copy the file to. See ‘Using the File selector’ later for more details. 

Renaming files 

Renaming a file is a bit like making a copy of it in the same directory and deleting the 
original, but quicker. 
To rename a file: 
1. Use the File selector to locate the file, or position the highlight on its name in the 

System screen. 
2. Select the ‘Rename file’ option from the ‘File’ menu. 

3. Move to the ‘To: Name’ line and enter the new name for the file. Press  to 
confirm the operation. 
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Using the File selector 

The File selector is a standard dialog which helps you navigate around the Series 3c’s 
directory structure. Whenever you are prompted to enter the name of a file, you can 
almost always press  to display the File selector. You can also access it by simply 
pressing  in the System screen. 

 

•  To show files for a particular application: move the highlight to the application 
and press  to open the File selector showing the files for that application. 

•  To show files and directories on the “root” of the disk: move the highlight to 
either the Time or Calc application, and press . 

 If you press  while the File selector is displayed, you will see that menu 
options are available for copying, deleting and renaming files, and for making and 
removing directories. 

Finding files 
Use the  keys to move the highlight up and down the list of files. If you move 
the highlight to the very top line and press , the File selector switches to the 
parent directory of the one currently shown. 
Conversely, if you move the highlight to one of the subdirectory names shown and press 

, the File selector switches to that directory. 

If you position the highlight on a file name and press , what happens will depend 
on what you were doing before using the File selector: 

•  If you pressed  in a dialog where a file name was required, the file name you 
selected will be inserted into the dialog. 

•  If you pressed  in the normal System screen display, the Series 3c will attempt 
to open the file you selected in the application whose icon was highlighted when 
you pressed . For example, if you position the highlight on the Word icon, 
press , navigate to the \DAT directory and select a Data file, the Series 3c will 
try to open the Data file in Word. 
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 Do not try this. Opening files of the wrong type can cause unpredictable results, 
and possibly the loss of data. If you do use this function, use it only to open files of 
the correct type - Word files in Word, Data files in Data, and so on - and use it 
with care. 

•  You can use the  keys to cycle through the available disks. 

Selecting files 
Most of the things you can do to a single file you can also do to several files at once. 
For example, you could copy ten files by copying each file individually, but it would 
take a long time. A better way is to “tag”, or select, each file you want to copy and then 
do the whole lot in one go. 
You can use the File selector for tagging files. 

•  Press  to open the File selector, then go to each file you want and press 
 or , or . A tick mark will appear next to the name of the tagged 

file. You can tag as many files as you need to. 

•  To ‘untag’ a file, just go to its name and press  or  again, or just 
use . 

•  Press  to tag all the files in the list, and  to untag all of the tagged files. 

Once you’ve tagged all the files you want, you can then use the ‘Copy’ option or 
perform whatever action you wanted to do with them; and instead of a filename the 
dialog will show ‘(Tagged files)’. 

Creating a new directory 

As you become more experienced at using the Series 3c, you will probably find that 
your disk becomes cluttered with lots of files in no particular order. Directories can help 
you arrange files logically, making them easier to find. The System screen uses 
directories to arrange things into lists (described earlier in this chapter). 
To create a new directory: 

1. Press  to open the File selector. 

2. Position the highlight on the name of the directory which will be the “parent” of 
your new directory. 

The new directory will become a subdirectory of the one highlighted. For example, if 
you want to make your new directory a subdirectory of DAT, move to the root directory 
and highlight \DAT. 

3. Select ‘Make directory’ from the ‘Directory’ menu. 
4. Enter the name for your new directory on the ‘Name’ line. You can use up to eight 

letters or digits in the name. 

5. Press . 
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To remove an existing directory: 

 Important: Before deleting a directory you should make sure either that it is 
empty, or that you no longer need the files contained in it. Deleting a directory also 
deletes all files contained in that directory and any subdirectories of it, and the files 
in those, and so on. Think of it as lopping off a tree branch - you also remove all 
the sub-branches of that branch and all the leaves on each of them. 

1. Press  to open the File selector. 

2. Navigate to the parent directory of the one you want to remove. For example, to 
remove the directory BANK which is a subdirectory of SPR, move to the SPR 
directory. 

3. Position the highlight on the name of the subdirectory you want to remove. 
4. Select ‘Remove directory’ from the ‘Directory’ menu. 

5. Press  to confirm the operation. The Series 3c will ask you if you want to 
delete the files in that directory. (This happens even if there are no files in the 
directory, or if there are only subdirectories.) 

6. Follow the instructions to confirm that you want to delete the directory. The 
directory and all its subdirectories will be deleted. 

Full pathnames for files 

 Advanced use only. 

Because each of the Series 3c’s directories is logically separate from the next, it’s 
perfectly all right to have many files with the same name, as long as they’re all in 
different directories. This creates a problem, though, in that you often need to uniquely 
identify a file. 
A file’s unique identifier is called its “pathname”. This is like a longer version of its 
filename, and contains four pieces of information: 

•  the “filing system” where the file is stored 

•  the disk where the file is stored 

•  the “directory path” identifying the file’s directory 

•  its name, including the extension 
For example LOC::M:\PERSONAL\LETTERS\DORIS.WRD

Here, 

•  LOC:: is the filing system 

•  M: is the disk (M: is another name for the Internal disk) 

•  \PERSONAL\LETTERS\ is the directory path 

•  DORIS.WRD is the filename 
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The filing system is, essentially, the computer which the file is stored on. The 
Series 3c’s internal (or “local”) filing system is called LOC::. If the Series 3c is linked 
to another computer, the files on the remote machine are considered to be on the 
“remote” filing system, called REM::. 
No two files can have exactly the same pathname, so a full pathname always uniquely 
identifies a file. 

File attributes 

Associated with each file is a set of “attributes” which specify certain properties of the 
file. These attributes are compatible with those of the MS-DOS filing system, although 
not all are used by the Series 3c. 

Attribute Meaning, if this attribute is set 
Read only You can’t change, delete or rename the file. 
Modified The file has changed since it was last backed up. 
Hidden The file won’t appear in the System screen. 
System Not used. 

•  You will not usually need to worry about or ever change these settings, except 
perhaps to protect a file by setting the ‘Read only’ attribute, or to remove the read-
only protection. See ‘Preventing files being changed’ in the ‘Security & backups’ 
chapter for more details. 

If you do need to look at or change the attributes of a particular file: 
1. Use the File selector to locate the file, or position the highlight on its name in the 

System screen. 
2. Select the ‘File attributes’ option from the ‘File’ menu. 

3. To change any of the attributes, move to the appropriate line and use  to 
change the setting. 

4. Press  when you have finished editing the settings. 

 You can also set the attributes of a file using the Files application, and display the 
attributes of all files on screen. See the ‘Files application’ chapter for more details. 
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Backing up and restoring files 

The System screen provides facilities for you to back up your files (make copies of them 
in case the originals are lost or damaged), either to the Internal disk or to an SSD. For 
more information on how to do this, please refer to the ‘Security & backups’ chapter. 

Copying disks 

The Series 3c also allows you to copy a whole disk in one go. 
If you just want to back up your Internal disk, see the ‘Security & backups’ chapter. 
To copy an entire disk: 
1. Select ‘Copy disk’ from the ‘Disk’ menu. 
2. Set the ‘From disk’ line to the “source disk” (the one you want to copy). 
3. Set the ‘To dir: Disk’ line to the “target disk” (the one you want to put the copy 

on). 
4. If you want to copy the disk into a subdirectory of the target disk, set the ‘To dir: 

Name’ line to the appropriate directory name or press  to use the File selector. 
Otherwise, leave this line blank. Press  to start the process. 

5. The Series 3c will summarise the details you have just entered and ask you to 
confirm once more by pressing . 

The Series 3c will now copy the disk. 
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Files application 

This chapter shows you how you can use the Files application 
to display information about the disks, files and directories on 
your Series 3c. 

It tells you how to: 

••••  display lists of files and directories, as well as memory and disk 
information. 

•  copy, move, rename or delete files. 

•  create new directories. 

•  associate files with applications, so you can open a file in the 
correct application from within the Files application. 

•  set up and run utilities. 
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Introduction 
The Series 3c is designed so that you don’t really need to concern yourself too much 
with the actual files where your information is stored. It will keep your files in the 
correct directory and display them for you on the System screen - you will not usually 
need to move files about, create new directories or copy files to other directories. 
However, if you do need to find out more about your files or memory, copy a file or 
move it to a new location, or re-organise the files on an SSD, for example, it is still 
quite easy: 
You can either: 

•  Use the System screen. 
The menu options and the file selector in the System screen should allow you to 

perform most simple file operations quickly and easily. See the ‘System screen’ 
chapter for more details. 

•  Use the Files application.  
 This is an application which can help you organise your files from a single 

application. It works in a similar way to the Windows File Manager. 

 This Files application is sometimes known simply as Files. Where you see “Files” 
with a capital “F”, it means the Files application; “files” with a lower case “f” 
refers to the files where your information is stored.  

You can use whichever method you prefer, or use them both.  
For example, you may prefer to do all your file management tasks while you can see the 
System screen, or you might prefer to use the Files application to help you navigate 
more easily around the directories on your disk. It’s up to you. 

Running the Files application 

 

To run the Files application: move the highlight to the Files icon in the 
System screen and press . 

The first time that you run the Files application, two lists are displayed in the File list 
view: 
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•  These lists are known as the ‘Left’ and ‘Right’ lists. 

•  One of the lists is the “current list” and the highlight is black; in the other list the 
highlight is displayed in grey. 

•  You can move the highlight up and down the list of files and directories in this 
view using . 

•  Press  to move the highlight between the left and right lists. 

Looking at files on your Series 3c 

The view you initially see is known as the File list view. You can always return to it by 
pressing  until it is displayed, or by selecting the ‘File list’ option on the ‘♦ ’ menu. 

The top line of the File list view shows you the “path” to the files or directories 
displayed: 

•  ‘Internal:\’ indicates the built-in disk inside your Series 3c.  

•  ‘Internal:\WLD’ indicates the \WLD directory on the Internal disk. 

 You will find that some directories are already set up on your Series 3c. These are 
the filing system the Series 3c uses to keep files for each built-in application, for 
example: 
 \WRD For Word files. 
 \AGN For Agenda files. 
 \SPR For Sheet files. 
 \DAT For Data files. 

•  Some files have an icon, to show they are linked to a particular application. 

Moving around the File list view 
•  To select a file or directory: use  to move the highlight. 

•  To show the files and sub-directories in a directory: select the directory and 
press  to “expand” it. 

••••  To show the files and directories in the level above: select the ‘...’ line at the top 
of the list and press  to “go up” a level. 

•  To show the files on a different disk (i.e. an SSD): select the ‘Select disk’ option 
on the ‘Left’ or ‘Right’ menu and set the disk to ‘A’, ‘B’ etc. as appropriate. 

•  To open a file in its application: select the file and press . You can only do 
this for files which are “associated” with an application. See ‘Associating files with 
applications’ later for more information. 
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 You can move to application from the File list view in this way. For example, to 
run Sheet using the file SHEET.SPR, move to the \SPR directory, highlight 
SHEET.SPR and press . The Series 3c will open Sheet automatically and 
move there, with the file open. 

Choosing how the File list looks and works 
You can change the way the file lists appear in the Files application: 
To change the order the files are displayed in: select ‘Sort list’ on the ‘Left’ or 
‘Right’ menu as appropriate, and set ‘Sort by’ to: 

•  ‘Extension’ - to sort the list according to “file extension”, e.g. DAT or WRD. Files 
of the same type are listed together. 

•  ‘Size’ - to sort the list in order of size, largest first. 

•  ‘Time’ - to sort the list in chronological order, so that the newest or most recently 
changed files appear at the top of the list. 

•  ‘Name’ - to sort the list alphabetically according to the filename. 
To choose what is displayed in the File list: select the ‘Set up File list’ option on the 
‘Left’ or ‘Right’ menu as appropriate and choose which items you want to display for 
each file. 
To “hide” some of the files: select the ‘Filter list’ option from the ‘Left’ or ‘Right’ 
menu as appropriate and set the ‘Include’ and ‘Exclude’ lines to select which files 
should be included in the file list, and which should be excluded. 
You can use “wildcards” to select groups of files, e.g. * means all files, *.DBF means 
all files with the extension DBF, and Sheet*.* means all the files starting with the 
letters “Sheet”. 

 Be careful when you are “filtering” the list in this way. When files are excluded, 
they do not appear in the file lists at all, and it is easy to forget that the list is 
filtered.  

 So, if your file lists seem to you to have files missing, make sure that these files are 
not just being excluded by the filtering. 

File attributes 
Files and directories have certain attributes you can set which can control how the file is 
used by the Series 3c. The file attributes are displayed in the bottom line of the File list 
view when the file is selected, and can be either not set, showing a dash, - , or set to: 
‘R’ for Read only.  This indicates the file is read-only. See ‘Protecting files’ below. 
‘A’ for Modified.  This indicates the file has changed since it was last backed up. 
‘H’ for Hidden.  This stops a file from appearing in the System screen file lists; you 

should not normally use this setting. 
‘S’ for System. This setting is used by the Series 3c; you should not normally need 

to use this setting. 
See the ‘File attributes’ section in the ‘System screen’ chapter for more details. 
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Looking at directories 

If you want to look at the directory structure of your disk without the files themselves 
being listed, you can use the Tree view in either the left or right list: 

 

To display this view: press  to select the list you want and press  until the Tree 
view is displayed. Alternatively, select the ‘View’ option on the ‘Right’ or ‘Left’ menu 
and set it to ‘Tree view’. 

•  To select a disk: move the highlight to the disk name: 
Internal: 
Disk A: 
Disk B: 
Disk C: 
REM::A:\ etc. 

is the disk inside your Series 3c. 
is the left-hand SSD drive.  
is the right-hand SSD drive. 
is an additional Psion disk or add-on drive, if present.  
are the disks on a PC - the “remote disks”, and are only 
displayed if you are linked to a PC using PsiWin. 

 If a File list view is displayed in the opposite list when you change disks in Tree 
view, this list will also change to display the File list view for the new disk. 

•  To show the directories on a disk: select the disk and press  or  to 
“expand” it. 

•  To “Hide” the directories on a disk: select the disk and press  to “collapse” 
the directory structure. 

 If you press  to display a Status window, the ♦  in the “diamond list” 
indicates the view in the ‘current’ list - the one in black rather than grey. 
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Looking at disk information 

If you want to look at information about your disk and the amount of memory used, you 
can use the Status view in either the left or right list: 

 

To display this view: press  to select the list you want and press  until the 
Status view is displayed. Alternatively, select the ‘View’ option on the ‘Right’ or ‘Left’ 
menu and set it to ‘Status view’. 

 The information in the Status view is always applicable to the File list or Tree view 
shown in the opposite list. For example, status information about the Internal disk 
is displayed if a File list view of the Internal disk is displayed in the opposite list. 

•  To see how much memory is free: display the Status view as described, and check 
the ‘Free’ and ‘In Use’ lines. You can also see the proportion of memory in use by 
looking at the shaded bar. 

•  To display status information about a different disk: make sure the highlight is 
in the opposite list to that showing the Status view, and use ‘Select disk’ on the 
‘Left’ or ‘Right’ menu as required. 

 As the Status view always reflects the disk selected in the opposite list, both views 
will change to display information about the selected disk. 

 If the Tree view is displayed in the opposite list, you can always select a different 
disk by highlighting the disk name in the tree structure and pressing . 
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 Working with files and directories 
You can use each view in the left or right list individually, perhaps with both lists 
displaying the File list view - one list displaying your Internal disk and the other 
showing the files on an SSD: 

 

Alternatively, since the views are linked, you may find it easier to use the File list view 
and the Tree view together to give you a fast and comprehensive view of your disks, 
directories and files: 

 

Selecting more than one file or directory 
If you want to perform a particular task on a number of files, copying all the files on an 
SSD for example, you can usually save time by selecting, or “tagging” the files first in 
the File list view, and then copying them in a single operation. 

•  To tag a file or directory: press . The “tagged” files are marked with a 
✔ : 

 

•  To “untag”, or de-select one: highlight it and press  again. 

To tag a particular set of files quickly: select ‘Tag files/directories’ on the 
‘Commands’ menu, and type in a ‘Criterion’ using “wildcards”, e.g. *.AGN for all the 
files in the list with an AGN extension, or * to tag all the files.  
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You can “untag” a particular set of files in a similar way, using the ‘Untag 
files/directories’ option on the ‘Commands’ menu.  

 It is sometimes useful to tag a particular set of files, then untag others, in order to 
get a particular selection quickly. For example, if you want to select all your WRD 
files, except your letters which have filenames starting with ‘Let’, you can tag all 
the files using the ‘Criterion’ *, then untag the Letter files using the 
‘Criterion’ let*.*. 

Copying, moving and renaming 

To copy... 
1. If necessary, press  to move to the File list view. 

2. Use  to move the highlight to the file or directory you want to copy. If you 
want to copy more than one file or directory, tag the ones you want to copy as 
described above. 

3. Select the ‘Copy’ option on the ‘File’ menu. 
4. The ‘To’ line will suggest the location currently selected in the opposite list 

(shown with a grey highlight). If you want to copy to this location, just  
press . 

 Alternatively, press  on the ‘To’ line and navigate to where you want the file 
copied, or simply type the path directly on the ‘To’ line, e.g. WRD. Change the disk 
as well, if necessary. 

 It is a good idea to make sure that the location is already selected in the other view 
before copying the file. It will save you typing in the new path, or selecting it with 
the File selector. 

To move... 
••••  Follow the instructions above for copying files, selecting ‘Move’ instead of ‘Copy’ 

in step 3. 

To rename... 
•  Follow the instructions given for copying files, selecting ‘Rename’ instead of 

‘Copy’ in step 3. 
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Deleting files and directories 

You should delete the files that you no longer need to save space on your Series 3c. 
You can also delete directories that are no longer required. 

 If you delete a directory, all the files and sub-directories in it will also be deleted.  

To delete... 
1. If necessary, press  to move to the File list view. 

2. Use  to move the highlight to the file you want to delete, or tag your 
selection, then: 

•  press , or 

•  select the ‘Delete’ option on the ‘File’ menu. 
 You will be asked to confirm that you are sure you want to delete the file. Follow 

the instructions on screen. 

 The “confirmation dialogs” help to make sure that you do not delete files or 
directories by mistake. You can choose when these “Confirmation dialogs” appear 
when deleting files and directories. Select the ‘Set preferences’ option and set the 
‘Delete confirmation’ line as required. 

Finding files 

You can find a particular file by name, or by searching for some text that it contains: 
1. Select the ‘Find file’ option on the ‘Commands’ menu. 
2. If you know the complete filename: type it straight in on the ‘Find file’ line. 
 If you only know part of the filename, or want to find more than one file with 

similar names: type the filename using “wildcards”, e.g. *.agn, * or A*.*. 

 If you only know a piece of text that the file contains: type this on the 
‘Containing’ line. 

3. Set the ‘Look in’ line to the disks you want to search.  

4. Press . The ‘results’ of the search are displayed in Found view: 
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•  You can use  in the Found view, and select, copy, move and delete the files 
just like in the other view. 

•  Press  to remove the ‘Found’ results and return to the standard Files application 
view. 

Associating files with applications 

When you highlight certain files in the File list view, and press , the Files 
application opens the file in the appropriate application. For example, highlight a .WRD 
file and press  - the Word application runs. 

You can set up your own associations, so that a file with a extension is opened in an 
application you choose. You may, for example, have an add-on application 
ADDON.APP which uses .ADD files. 

To set up or change a file association: 
1. If possible, highlight a file with the correct extension in the File list view. If it is 

not possible to do this don’t worry - selecting a file with the right extension simply 
saves you from typing it in later on! 

2. Select the ‘File associations’ option on the ‘Special’ menu. A dialog is shown 
listing any additional applications you have already set up with filename 
associations. When you first run the Files application, this list will be blank. 

 The standard file associations for the Series 3c applications (e.g. the Agenda 
application for .AGN files, the Database application for .DAT files etc.) are fixed, 
and are not displayed in the list. 

3. To set up a new file association: press . 

 To change an existing association: press  (Spacebar). 

4. If necessary, type the filename extension for this type of file in the ‘Extension’ 
line. A filename extension can have up 1 to 3 characters. 

5. Select the file or application to use with this type of file extension on the ‘Open 
with: Name’ line. Press  to use the File selector to locate the application if you 
need to. 

6. Type in any additional parameters on the ‘Parameters’ line, if necessary. These will 
depend on the application you are associating the file with. 

7. Press  to confirm the association - it will appear in the list of associations. 
Press  again to remove the dialog. 
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Organising disks and directories 

Creating a directory 
1. Select the correct disk in Tree view. 
2. If you want to make a new directory on the “root” of the disk, you can simply leave 

the highlight on that disk, e.g. ‘Internal:’. 

 If you want to make a new “sub-directory”, use  as usual to move to the 
directory in which you want to create your new one. 

3. Select the ‘Make directory’ option on the ‘Disk’ menu. 
4. Type the new name for the directory on to the ‘Name’ line. 

5. Press . 

Comparing directories 
You can use the ‘Compare directories’ option on the ‘Commands’ menu to find out the 
differences between the file lists in two directories. For example, you may want to check 
that you have copied some files from your Internal disk to a directory on an SSD. 
1. Display the first directory in the File list view in the left list, and the other directory 

in the File list view in the right list. 
2. Select the ‘Compare directories’ option on the ‘Commands’ menu. A progress bar 

is displayed as the Files application compares the files in the directories. 

•  Files which are present in one list, but not the other, are tagged with a ✔ . 

•  Files which have the same filename in each list, but are different in other ways, for 
example if they have been edited or changed, are also tagged on both lists. 

Naming disks 
You can give a disk a “Volume name”, perhaps to remind you of the contents of the 
SSD for instance: 

•  select the ‘Name disk’ option on the ‘Disk’ menu, set the ‘Disk’ line to the disk 
you want to name, and type your new name onto the ‘Name’ line. 

Formatting a disk 
You can “format” a disk - wipe it clean and delete all the files on it so that you can use 
the space again. Ram SSDs also need formatting before you can use them. 
To format a disk: 
•  select the ‘Format’ option on the ‘Disk’, set the ‘Disk’ line to the disk you want to 

format (be sure not to choose Internal or you will lose all your files), and press 
. Follow the confirmation instructions on screen - just to make sure that you 

really do want to delete all the files. 
See the ‘System screen’ chapter for more about formatting disks. 
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Running utilities from the Files application 
You can set up other applications as utilities to run from the Files application. For 
example, if you have written an OPL utility to view a picture, you can specify the 
viewer as a utility and run it from the Files application. 
To set up a new utility: 
1. Select the ‘Utility list’ option on the ‘Special’ menu. A dialog is shown listing the 

utilities you have set up. When you first run the Files application, this list will be 
blank. 

2. Press  to create a new utility. 

3. Type the name for the utility on the ‘Name’ line, and select the file on the 
‘File: Name’ line. You will probably need to press  on the ‘Name’ line to 
navigate to the file using the File selector. 

4. If there are parameters which can be used with the utility, type them onto the 
‘Parameters’ line and press . 

The new utility is now available for you to run from the Files application. You can set 
up various utilities in this way, and run a utility from a complete list: 
1. Select the ‘Run utility’ option on the ‘Commands’ menu. A list showing the 

utilities you have set up is displayed. 

2. Highlight the name of the utility that you want to run using  and press 
 to run it. 

Removing a utility: 
1. Select the ‘Utility list’ option on the ‘Special’ menu, and then move the highlight 

to the utility to remove using . 

2. Press , then confirm that you want to delete the utility. 
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The Program editor 

This chapter includes: 

••••  a basic introduction to the Program editor which you can use to 
write your own programs for the Series 3c using the built-in 
programming language, OPL. 

••••  a summary of the differences between Series 3c OPL and 
Series 3 OPL for those experienced in programming in OPL on 
the Series 3. 

••••  note that this chapter does not contain detailed information 
about programming in OPL; for this you should refer to an 
OPL programming manual which is available from Psion. 
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Introduction 

There are three stages to producing a program using OPL: 

•  Firstly, type the program in the Program editor. 

•  Secondly, translate the program to create a new version of the program in a format 
that can run on the Series 3c. 

•  Thirdly, run the program. If it doesn’t work as you expected, you can re-edit it, 
translate and run it again. 

A simple example in this chapter shows you the principles of all these stages. 

 If you are familiar with OPL through using it to create programs for the Series 3, 
please read the ‘Summary for experienced OPL users’ section later in this chapter 
for details of the differences between OPL for the Series 3 and OPL for the 
Series 3c. 

 There are no functional differences between OPL for the Series 3a and OPL for the 
Series 3c. Programs translated on the Series 3a will run on the Series 3c without 
re-translation. 

Running the Program editor 

 

To run the Program editor: move the highlight to the Program icon in the 
System screen and press . 

Alternatively, you can hold down  and press the ‘Word’ button on the 
Buttonbar; this keypress is pre-assigned to take you to the Program editor. See 
‘Assigning a button to an application’ in ‘The System screen’ chapter for more 
about assigning a keypress to an application. 

The first time that you run the Program editor, it will be ready for you to type in your 
first OPL program. 
You will see that PROC : has already been entered on the first line, and ENDP on the 
third: 
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These are the “keywords” that mark the start and end of an OPL “procedure”. You need 
to type in the list of “statements” or instructions that form the first procedure in your 
program between PROC : and ENDP. 

About OPL 
OPL is a procedure-based programming language: the procedure or task is the basic 
building-block of all programs written in OPL. Each procedure can contain a number of 
statements or commands which the Series 3c acts upon. When you come to run the 
program, the Series 3c goes through the statements one by one. When the last statement 
has been acted upon and ENDP is reached, the procedure ends. 

Although a simple OPL program may have a single procedure, a number of procedures 
can be linked to form a “module” for more sophisticated programs. In this case, a 
controlling procedure “calls” (runs) other procedures and passes values to them. These 
procedures then return results and information to the controlling procedure. 

 Creating your first program 
Before you enter the statements that constitute the first procedure in the program, you 
must type a name for it between the keyword PROC and the colon (:) that follows it; the 
cursor is automatically in the right place for you to do this. (Procedure names can be up 
to 8 characters long.) When you have done this you can enter the list of statements (or 
commands) in the procedure. 

Editing your program 
You can type and edit in the Program editor in much the same way as you would in 
Word, except that the text you type does not word-wrap - you must press  at the 
end of each line to start a new one.  
The menus available are the same as those in Word except that the ‘Word’ menu has 
been replaced with the ‘Prog’ menu and there is no ‘Paragraphs’ or ‘Styles’ menu. 
While you are typing in your procedure, all the options on the ‘Edit’ menu - such as 
‘Copy text’ and ‘Insert text’ - are available and can be used in the same way as those in 
Word. See the ‘Word’ chapter earlier in this manual for more information on text 
editing. 
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Writing an example program 

You might like to type in the following example procedure; it converts Pounds Sterling 
to Deutschmarks. When it is run, the program asks you to type in two numbers: the 
number of Pounds Sterling and the current exchange rate. The values that you enter are 
assigned to the “variables” pounds and rate, and the result of the conversion is then 
displayed on the screen. It shows how some of the common OPL keywords (LOCAL, 
AT, PRINT, INPUT and GET) can be used. 
PROC exchange:

LOCAL pounds, rate
AT 1,4
PRINT "How many pounds sterling?",
INPUT pounds :REM value from keyboard
PRINT "Exchange rate (DM to £1)?",
INPUT rate :REM value from keyboard
PRINT "=",pounds*rate, "Deutschmarks"
GET

ENDP 

You will have noticed as you pressed  at the end of each line that each new line 
between the PROC: and ENDP is automatically indented. Indents like this are 
typically used to make a procedure easier to read, they are not obligatory. However, 
other spacing, such as the space between AT and 1, is essential for the procedure to 
work properly. 

 You can use upper or lower case when entering OPL keywords. 

The program you have just created is saved with the filename PROGRAM.OPL.  

If you wish to give it another name, select the ‘Save as’ option on the ‘File’ menu and 
give it a new 8 character filename; you do not need to enter the .OPL extension as this 
will be done for you. 
You can use the other Series 3c applications at any time while you are editing an OPL 
procedure, just switch between the open applications as usual. 

OPL keywords in the example 
The keywords used in the example program above do the following when the program 
is run: 
LOCAL - sets up the variables, pounds and rate, that you wish to use in the 
procedure.  
AT - sets the position where the cursor and messages will appear on the screen. 

PRINT - displays the prompts (i.e. the text that you enter between the quote marks) that 
tell you what information you need to type in and displays the result. The PRINT 
statements which require an input value from the keyboard end with a comma; this 
displays a space on the screen and keeps the cursor on the same line. 
INPUT - takes the number that you type on the keyboard and passes it to the specified 
variable, pounds or rate. 
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:REM - marks the text that follows it as a comment, i.e. something that is not an 
instruction to the Series 3c, but an explanatory note about the procedure line for the 
programmer. 
GET - waits for a key to be pressed on the keyboard. 

There are OPL keywords for a host of operations. 

 Detailed information about all OPL keywords and programming techniques in 
OPL is beyond the scope of this manual. You should refer to an OPL Programming 
manual, available from Psion, for further information. 

Translating and running a program 

When you have finished typing a procedure, you can compile or “translate” it to convert 
it into a format which the Series 3c can run. Then, when you run the program, the 
Series 3c reads and acts upon each statement in the procedure, one by one. 
There are two options on the ‘Prog’ menu for translating your program: 

•  The ‘Translate’ option translates your program for running on the Series 3c only. 
This is the option that you would normally use. 

•  The ‘S3 Translate’ option translates programs for running on the Series 3c or 
Series 3. 

If any errors are found in the program during the translation process, a message will 
appear to tell you and the cursor will be positioned on or near the likely cause of the 
error. Alternatively, you can use the ‘Show error’ option on the ‘Prog’ menu to position 
the cursor at the most recent error found during translation. 
You can then correct the mistake and re-translate your program. 
If your program translates without any problems, a prompt appears asking you if you 
wish to run it. Press  to run your program. When it is finished you can press  
to move back to the Program editor where you can continue to work on your program. 

 OPL programs can be translated as applications which appear with their own icon 
in the System screen. See an OPL programming manual for more information.  

Running translated OPL programs 

Translated OPL programs are listed beneath the RunOPL icon in the System screen.  
You can run them in two ways: 

•  From the System screen, by highlighting the name of the translated program under 
the RunOpl icon and pressing , or: 

•  From inside the Program editor, by using the ‘Run’ option on the ‘Prog’ menu. 
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Managing programs 

Stopping a running program 
•  Usually, you can press  to stop a program which is running. If you 

need to, you can move to the bold filename in the System screen and press  
to return to a running program. 

 When you write more complex programs, you should include an ‘Exit’ menu 
option which would call the STOP keyword. Using  should really only 
be as a last resort to exit, as the program cannot save its data if  is 
pressed to exit. To avoid this, some programs may insist on the use of a menu 
option to exit (the program has set ESCAPE OFF) and  will not work. 

Creating new programs 
•  To create a new program, either highlight the Program icon in the System screen 

and select the ‘New file’ option on the ‘File’ menu, or select the ‘New file’ option 
in the Program editor. 

 If the Program editor is busy running a translated program, and you open a second 
file (e.g. a new file) you will not be able to type anything into the second file - you 
will hear a beep. 

 You should stop the running program in the Program editor, as described above.  

Editing existing programs 
To make changes to an existing program, highlight its filename under the Program icon 
in the System screen and press . 

Program files and directories 
OPL program files are stored in the following directories, with the following filename 
extensions: 
Type of file  Directory Filename extension 
OPL programs  \OPL  .OPL 
translated programs  \OPO  .OPO 
translated applications \OPA  .OPA 
data files   \OPD  .ODB 
bitmaps   \OPD  .PIC 
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Finding out more about OPL 
If you wish to create your own OPL programs, please refer to an OPL programming 
manual available from Psion, or refer to the Psion SIBO OPL SDK (Software 
Development Kit). 
If you intend to program in ‘C’, please refer the Psion SIBO ‘C’ SDK (Software 
Development Kit).  The Psion SDKs are available from your Psion distributor. 

Summary for experienced OPL users 
If you have used OPL on a Series 3a, you can move straight on to your Series 3c. 
There are no functional differences between OPL for the Series 3a and the 
Series 3a, although minor bugs have been fixed. 
Programs translated on the Series 3a will run on the Series 3c without re-translation. 
This section is intended for those who have gained experience in OPL through writing 
programs for the Series 3. It gives details of the differences in OPL between the Series 3 
and Series 3c, and explains some of the compatibility issues that have to be dealt with 
when programming for the Series 3 and Series 3c. 

Changes from Series 3 to Series 3c OPL 

Everyday features 
A new SCREENINFO command provides information about the screen size and type. 
You can use it to write machine-independent programs, as described later in this 
chapter. 
All appropriate graphics keywords can now draw in grey as well as black. To allow 
drawing in grey use DEFAULTWIN 1. By default grey is not available, because 
drawing grey as well as black uses more memory and takes longer. 
TYPE supports new larger black/grey icons, and allows you to specify different icons 
for the Series 3 and Series 3c. It also supports new actions and icon types for OPAs. 
New FONT and STYLE keywords set the font and style for displaying text with PRINT. 

gFONT and FONT can access many new fonts which are built into the Series 3c ROM. 

gCLOCK supports many more types of clocks. 

A dialog on the Series 3 can have up to seven lines including the title, whereas a dialog 
on the Series 3c can have nine. 
A menu on the Series 3 can have up to six options whereas a menu on the Series 3c can 
have eight. The MENU function allows you to set which menu and item should be 
highlighted initially. 
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Series 3 programs will always run correctly in compatibility mode but if re-translated 
(in normal Series 3c mode) may need changing as follows: 
Menu keywords support case-dependent hot-keys. The hot-keys you specify should now 
be in the correct case - upper or lower.  

If you specify %R (upper case), for example, this is the hot-key . On 
selecting an option, MENU returns the hot-key keycode in the case which you specified. 

 On some very early versions of the Series 3, menus exited when any key was 
pressed together with the  key. Later Series 3 versions, and all Series 3a and 
Series 3c versions exit menus only when valid hot-keys are pressed. 

STATUSWIN ON displays a large Series 3c Status window containing an icon. This is 
64 pixels wide, whereas it was 50 pixels wide on the Series 3. 

DIAMINIT and DIAMPOS allow a ♦  list to be displayed in the Status window. 

STATWININFO returns information about the sizes of status windows and/or the 
current status window.  
gBUTTON draws keys such as those displayed in certain dialogs. 

gDRAWOBJECT draws a “graphics object”. You can use this to draw the “lozenge” used 
to display the words ‘City’ and ‘Home’ in the World application. 
gXBORDER draws bordered boxes, such as those used to display dialogs. (The
gBORDER keyword works as it did on the Series 3.) 

FINDFIELD finds text in a particular field, or group of fields. 

BEEP cannot play tones as high as those played on the Series 3. 

gPEEKLINE can now read from the screen as a whole. 

CURSOR can display new kinds of cursors, and gINFO can return this (and other) 
information. 

Advanced features 
IOC performs an asynchronous I/O request, like IOA, but with guaranteed completion.
IOCANCEL cancels any outstanding IOA or IOC. 

A new set of keywords supports the definition of a “sprite”, which you can move around 
“on top of” the rest of the screen. The sprite can be animated, displaying a sequence of 
different bitmaps. 
Cacheing - keeping frequently used procedures in memory instead of loading them from 
file every time they are called - can help increase the speed of OPL programs. 
New keywords provide access to dynamic libraries (or “DYLs”), to the memory 
allocator and to Operating System data file calls. 
UADD and USUB allow addition and subtraction of pointers/addresses without the risk 
of ‘Integer overflow’. 
GETEVENT now returns the event $405 when the date changes. 
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Compatibility between Series 3 and Series 3c 

Compatibility mode and normal mode 
A program translated for the Series 3 can run on the Series 3c without re-translation - 
the program runs in “compatibility mode”. This mode makes use of the fact that the 
Series 3c screen has exactly twice as many pixels as the Series 3 screen in both the 
horizontal and vertical directions: the Series 3c screen has 480x160 pixels and the 
Series 3 has 240x80 pixels. When a Series 3 program runs on the Series 3c, four pixels 
(2x2) are actually drawn or cleared for each pixel that would have been drawn or 
cleared on a Series 3. Also, all keywords that explicitly or implicitly specify a screen 
position (e.g. gAT, gMOVE, gBOX and AT) are automatically rescaled. 

One or two of the special symbols (characters between 0 and 31 in the character set) are 
different on the Series 3c. However, in compatibility mode the fonts have the same 
character set as on the Series 3. 
A program translated for the Series 3c runs in “normal mode” on the Series 3c. It will 
not run on the Series 3. 

Slowing down Series 3 programs 

The Series 3c is much faster than the Series 3, and you may find that some programs 
written for the Series 3 are too fast to use when running on a Series 3c. 
If you wish to slow down a program - such as one of the games on Psion’s Games SSDs 
for the Series 3 you can write a OPL program to run in the background, like this: 
proc slowdn:

local i%,j
print "Slow down Series 3c"
call($138b) rem "unmark as active"
while 1

i%=10 :j=j+1
while i% :i%=i%-1 :endwh
if j=300000
j=0 :pause 2

else
pause 1

endif
endwh

endp 

If you change the number 10 assigned to i% at the top of the WHILE loop, you can 
control the amount by which the Series 3c slows down - a bigger value slows it down by 
more, and a smaller value by less. You may need to use different values for different 
Series 3 programs. 

 Running this program will cause the Series 3c to use more battery power. 
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The loop which j counts is designed to do a pause 2 instead of a pause 1, 
roughly every twenty five minutes. A pause 2 gives just enough delay for the 
automatic turn off of the Series 3c to have a chance to work. Without this, automatic 
turn off cannot work. 
Using pause 2 in the main delay loop might cause the foreground process to have a 
noticeably jerky appearance. You can change the value 300000 to change the time 
before automatic turn off will occur. If you make it too small you may notice the
pause 2 occasionally. (If you make i% a lot bigger than 10 in the loop, you may 
also find the period before automatic turn off increases.) 

 If you do not allow automatic turn off like this, and you then forget to exit the 
“slowdown” program, no automatic turn off can occur. If you left the Series 3c 
turned on - or if it woke up for an alarm when you were not present - it would stay 
on until the batteries run down. It would then turn off, and you would not be able 
to use it again until you changed the batteries. 

•  Do not forget to exit the program from the System screen (use the  key) 
when you want to use the Series 3c at full speed again. 

Combining modules translated for Series 3 and Series 3c 
The rest of this section relies on the following important rules: 

•  A program runs in normal mode if its top-level module was translated for the 
Series 3c, and in compatibility mode otherwise. 

•  When running in normal mode, a module translated for the Series 3 may be loaded 
but will run in normal mode. 

•  When running in compatibility mode, a Series 3c module cannot be loaded and 
will cause an ‘Incompatible translator version’ error (-107). 

For a program to run on both machines, you could therefore do one of the following: 

•  translate the whole program for the Series 3, in which case it will also run on the 
Series 3c in compatibility mode. 

•  translate the top-level module only both for the Series 3c and for the Series 3, and 
the rest of the program for the Series 3 only. There are then effectively two 
programs, although they share all except for the top-level module. 

 The program with Series 3c top-level runs only on the Series 3c and only in normal 
mode. The program with Series 3 top-level runs in compatibility mode on the 
Series 3c or normally on the Series 3. 

 For this method to work you should not assume that the physical screen has a fixed 
number of pixels or that the text screen size and characters in its font have a fixed 
width and height. Use gINFO, SCREENINFO, gWIDTH and gHEIGHT to find 
out the values at runtime. e.g. pixel (120,0) is half-way across the screen on the 
Series 3 but is only a quarter-way across on the Series 3c, whereas pixel
(gWIDTH/2,0) is half-way across in both cases. 

Clearly Series 3c keywords cannot be included in any program to be run on both 
machines. The following ‘trick’ may however prove useful.  
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It relies on the failure to load a Series 3c module when running in compatibility mode 
on the Series 3c (or when running on the Series 3 itself). The steps are: 
1. Create a module containing procedures using Series 3c keywords which are needed 

when running in normal mode. For example, module s3cprocs.opl might 
contain:  

PROC scrinfo:(pinfo%)
SCREENINFO #pinfo%

ENDP

PROC font:(font%,style%)
FONT font%,style%

ENDP 

2. Translate for the Series 3c (it won’t translate for the Series 3 anyway). 
3. Call the procedures in s3cprocs.opl as follows, to set up global variables 

containing text screen information - if running in compatibility mode, simply set 
the globals to known values that apply on the Series 3: 

LOCAL err%,info%(10),... 
TRAP LOADM "S3cprocs"

IF ERR=0 OR ERR=-104
REM if not 'Incompatible translator' error
REM or if already loaded, then in normal mode

err%=ERR
font%=$9a REM system font
font:(font%,16) REM mono-ised style
scrInfo:(ADDR(info%))
marginX%=info%(1) REM pixels from left of screen
marginY%=info%(2) REM pixels from top of screen
chrW%=info%(7) REM character width in pixels
chrH%=info%(8) REM ...and height
screenX%=gWIDTH/chrW% REM char screen width, height
screenY%=(gHEIGHT+1)/chrH%
IF err%-104 REM if loaded here

UNLOADM "S3cprocs"
ENDIF

ELSE

REM else on Series 3 or in compatibility mode
REM so just use fixed values

marginX%=0 REM no margins on Series 3
marginY%=0
chrW%=6 REM default console char width
chrH%=9 REM ...and height
screenX%=40 REM character columns
screenY%=9 REM character rows
font%=1 REM font ID = 1 on Series 3

ENDIF

This example assumes that the default font has not been changed using the  
IOW(-2,7,17,...) function (as described in the Series 3 Programming Manual) 
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when running on the Series 3 or in compatibility mode on the Series 3c. In normal 
mode on the Series 3c, you must use the FONT command instead. 

A quick way to check that the program is not running on a Series 3 is to call gINFO 
and check the 31st integer of the information array. If it was 0 before the gINFO and 
still is afterwards, the program is running on a Series 3. This method cannot be used to 
determine whether a program is running in normal mode or compatibility mode. 
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Comms & Script 

This chapter introduces you to the Comms application that is built 
into the Series 3c. Comms provides terminal emulation and file 
transfer to other computers. You can use it for: 

••••  connecting your Series 3c directly to another computer, or 

••••  connecting your Series 3c via a modem to access electronic mail 
systems and bulletin boards. 

You can use the Script application to write “Scripts” which can 
automate the process of trying to connect to a remote system via a 
modem, and then to log on to it. 

Note: The Comms application and the Script application are not 
pre-installed; you will not see the icons for them on the System 
screen until you install them, as described in this chapter. 
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Using the Comms application 
This chapter provides an introduction to the Comms application and the Script 
language. More detailed information about using Comms, and writing scripts, is 
included in the PsiWin User Guide. 

 In order to connect the Series 3c to another computer you need a suitable serial 
cable. The PC Link cable, supplied with PsiWin, is one such cable; this cable will 
be referred to throughout the rest of this chapter. Contact your Psion supplier for 
details of other serial cables, suitable for the Series 3c. 

 If you have PsiWin, you will find that Psion Manager provides a simple method for 
transferring files between your PC and Series 3c. If you have PsiWin and only 
need to transfer files, you do not have to worry about the Comms application, or 
the Script language. 

Direct connection 
If you connect the PC Link cable directly to a serial port of another computer, and you 
configure that serial port to have the same communications settings as set in the Comms 
application, the two computers can communicate. 
The 9-pin connector on the PC Link cable is likely to work with the RS-232 serial port 
on most other computers. Consult your computer’s manual if you are unsure about 
serial ports on your computer. 
If the other computer allows direct input via its serial port, you can use the Series 3c as 
a terminal, typing commands to the other computer and displaying its responses on the 
Series 3c screen. Many multi-user computers are designed for use by terminals 
connected to serial ports in this way.  

Connection via a modem 
You can use the Comms application to dial a remote computer system via a modem. 
You would usually do this in order to access electronic mail systems or bulletin boards, 
or other multi-user computer systems. (You might also wish to do this to a desktop 
computer, if you have somebody else to enter the necessary commands for you at the 
other end of the phone link.) 

 You will need a modem adaptor, as supplied by Psion, to connect the PC Link 
cable to the modem; see your Psion supplier for details 

Using the Comms application, you can type commands directly to the attached modem - 
for example, to tell it to dial a particular number. See your modem's manual for more 
information about the commands for controlling your modem. 

File transfer to another computer 
To transfer files between some other computer and the Series 3c, the other computer 
must have communications software that supports one or preferably both of the 
following services: 
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•  Terminal emulation with the ability to transmit and receive/capture ASCII files. 

•  XMODEM, YMODEM or ZMODEM file transfer. 
Instead of terminal emulation, you may be able to configure the serial port and then 
copy to and from it using the operating system commands - if your operating system is 
sufficiently advanced.  
If you have a choice of Baud rates, use the highest supported by both computers. On the 
Series 3c, the communications software supports rates up to 57600. 

Installing the Comms application 
To install the Comms application: 
1. Select the ‘Install standard’ option from the ‘Apps’ menu. 
2. Select ‘Comms.app’ on the ‘Application’ line. 
3. Move to the ‘Position’ line. ‘Current’ means “wherever the highlight is on the 

System screen”; you may wish to set this line to ‘First’ or ‘Last’. 

4. Press . 

A new icon will be installed in the System screen: 

 

 

To run the Comms application: move the highlight onto ‘Comms’ 
under the Comms icon, and press . 

The screen will clear and an ‘Online...’ message will be briefly shown. This is the 
Terminal Emulation screen. 
When using the Terminal Emulation screen, each character you type is transmitted via 
the serial port provided by the PC Link cable; when a character is received via the PC 
Link cable it is displayed on the screen. 
Important: If you have been using the PC Link cable to link your Series 3c to a PC, for 
example to use the PsiWin applications (see your Psion distributor for more information 
about PsiWin), you must first turn off the communications software; if you do not, you 
will see a ‘File or device in use’ message when you try to run Comms.  
To turn off the communications software: select the ‘Communications’ option on the 
‘Special’ menu and set the ‘Use’ line to ‘Psion IR’ or ‘None’. 
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What are scripts? 
•  The relationship between the Script and Comms applications is similar to that of 

the Program and RunOpl icons on the Series 3c. Script files are listed under the 
Script icon. When you translate one, the translated version of the file appears under 
the Comms icon, ready to be run. If it does not work as you had intended, re-edit it, 
then translate and run it again. 

•  Scripts read in an English-like way, to make them easy to understand. A script is a 
sequence of commands, run one after the other. The design of the language is 
similar in many ways to that of the OPL language built into the Series 3c. 
However, there are only commands in the Script language - there is no concept of 
functions returning values. Also, there is only one ‘script’ per file, and 
consequently no ‘procedure’ names. 

•  When a script finishes running, you are left in the Terminal Emulation screen in 
the Comms application. You can run another script, if you need to, either from the 
System screen, or with the ‘Execute script’ option on the ‘File’ menu.  

Installing the Script editor 

1. If you have not already done so, install the Comms icon, as described in the 
‘Installing the Comms application’ section earlier in this manual. 

2. In the System screen, select the ‘Install standard’ option from the ‘Apps’ menu. 
3. Select ‘Script’ on the ‘Application’ line. 
4. Move to the ‘Position’ line. ‘Current’ means "wherever the highlight is on the 

System screen"; you may wish to set this line to ‘First’ or ‘Last’. 

5. Press . 

 

The Script icon is the same as the Comms icon, but with the image of a 
piece of paper around it, signifying editing. 

Full instructions on how to write and translate scripts is beyond the scope of this 
manual. See the PsiWin User Guide for more about writing scripts, and a full 
description of all the commands in the Script language. 
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Security & backups 

There are several simple measures you can take to protect the 
information on your Series 3c. You can: 

••••  enter “owner information” to identify the Series 3c as your 
own. It can then be returned if you lose it. 

••••  set a “system password” to stop others using your Series 3c. 

••••  make regular “backup” copies of your information. 

••••  “password-protect” individual Word and Sheet files memos 
attached to Agenda entries. 

••••  set “file attributes” to prevent files being accidentally changed 
or deleted. 



 312

How secure is my Series 3c?  
You can take some simple precautionary measures to preserve the information you store 
on your Series 3c.  
You can make your files ‘read-only’ to avoid accidental deletion; backup your files 
regularly in case they get lost; set passwords to protect your information from prying 
eyes; and enter your personal details so your Series 3c can be returned if you lose it. 

Precautions against losing your Series 3c 

•  The ‘Set owner’ option on the ‘Info’ menu in the System screen allows you to 
enter information about yourself in case you lose your Series 3c.  

•  The dialog allows you to enter 4 lines of information - you don’t have to stick to 
the suggested labels (just delete them and type in whatever you want). 

 

•  If you have a password set (see ‘Setting a system password’ in this chapter), your 
“owner information” will appear each time the Series 3c turns on and asks for your 
password. 

•  You can always view (or change) your owner information by selecting the ‘Set 
owner’ option again. 

 You should avoid putting your home address in your owner information, in case 
you lose your Series 3c at the same time as your house keys. Enter a contact 
number, such as your work telephone number, and possibly your work address. 

Securing files against loss 

•  Keep backup copies (see ‘Backing up & restoring files’ in this chapter). Then if 
anything goes wrong with the originals, you can restore the backup copies. 

 There are no known problems with passing the Series 3c through airport security 
machines and other X-rays. 
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Preventing files being changed 

To prevent an important file from being accidentally changed or deleted, you can set its 
‘Read-only’ attribute. This means you can view the file, but you can’t make changes to 
it. To do so: 
1. Highlight the file in the System screen. 
2. Select ‘File attributes’ on the ‘File’ menu. 
3. Set the ‘Read only’ line to ‘Yes’. (Set it to ‘No’ when you want to edit the file 

again.) 

 The ‘Modified’ attribute indicates that a file has been altered since it was last 
backed up. This attribute is set every time a file is created or changed. ‘Hidden’ 
and ‘System’ attributes are used by the Series 3c; you shouldn't normally set them. 

Security & Infrared 

•  It isn't possible for anyone to copy information from or to your Series 3c using 
Infrared, unless they are able to access its Infrared ‘Send’ and ‘Receive’ keys (i.e. 

 then  ).  

Using passwords 
You can prevent others using your Series 3c by setting a system password, which you 
will have to enter each time you use the Series 3c. You can also set a password on Word 
or Sheet files, or memos in Agenda, to protect confidential information. 

Choosing a password 
•  Choose a password that you won’t forget! 

•  If you keep important information on your Series 3c, think carefully about your 
choice of password. Don’t use a password that could be easily guessed by others, 
such as your car registration, your spouse’s name etc. 

•  Don’t use lots of different passwords for different files - the more you use, the 
more likely you are to forget one. 

•  Your password can have up to 8 characters. 

 Use passwords with care. If you password-protect a file and then later find that you 
cannot recall the password, you will not be able to use the file again and all the 
information in it will be lost. 
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Setting a system password 

To set a password: 
1. Move to the System screen and select the ‘Password’ option on the ‘Special’ menu. 

 

2. Type your password on the ‘Enter password’ line. Padlock symbols will appear in 
place of the characters you type to prevent anyone else seeing your password. 

3. Type the password again on the ‘Confirm password’ line and press  to save 
it. 

 Setting a password makes your information secure. However, if you forget the 
system password, you will have to reset the Series 3c before you can use it again. 
All your information stored on the Internal disk will be deleted. See the 
‘Troubleshooting’ chapter for information about resetting the Series 3c. 

 A System password does not prevent others copying files from the Series 3c when 
it is linked to a PC and its Communications option is set to ‘Link cable’; be sure to 
set the ‘Use’ line to ‘None’ or ‘Psion IR’ when you are not using the link to the 
PC. 

Changing the system password 
1. Select  the ‘Password’ option again, and type in your current password when 

prompted to. 
2. Type in your new password on the ‘New password’ line, then again on the 

‘Confirm password’ line. Press  and the new password is set. 

Disabling the system password 
You might want to do this if you are using the Series 3c at home, say, and don't want to 
have to enter the password each time you turn it on. To do so: 

•  Select the ‘Password’ option again and type in your password when prompted to. 
Then set the ‘Password set’ dialog line to ‘Off’. 
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Setting passwords for files 

You can prevent other people opening your Word and Sheet files and your Agenda 
memos by setting a password on them. To do so: 

1. Open the file in its application, then select the ‘Password’ option on the: 
‘Word’ menu, in Word, 
‘File’ menu in Sheet, 
‘Memo’ menu in Agenda (memo). 

 

2. Type your password on the ‘Enter password’ line. Padlock symbols will appear in 
place of the characters you type to prevent anyone else seeing your password. 

3. Type the password again on the ‘Confirm password’ line and press  to save 
it. 

Whenever you try to open this file in future, a dialog will be displayed prompting you to 
enter your password. 
Important: Don't forget the password - if you do, you won't be able to access the 
information in the file. 
•  To change the password: 

Select the ‘Password’ option again and enter your password. Press  and type 
in your new password in the ‘Change password’ dialog. 

•  To remove the password: 
Select the ‘Password’ option again and enter your password. Then press  to 
close the ‘Change password’ dialog without entering a new password. 

 The file remains password-protected when copied to an SSD or when transferred to 
another Psion using Infrared. 

 Remember to use the ‘Exit’ option to exit a password-protected file when you have 
finished using it - otherwise it could be accessed simply by pressing the Word, 
Sheet or Agenda buttons. 
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Backing up & restoring files 
It is always advisable to make regular backup copies of your information. Unlike paper 
address books and diaries, it is easy to backup information from a Series 3c. 
You can back up files to and restore them from: 

•  an SSD (Solid State Disk). 

•  a personal computer.  

Backing up & restoring files using SSDs 

You can backup any number of files to an SSD. You may want to backup all the files on 
the Internal disk of your Series 3c, or just one file containing vital information that you 
can’t afford to lose. You can perform incremental backups, so that each time you 
backup your files, only those that have changed or been created since the last backup 
are copied. 

The differences between Flash and Ram SSDs 
Flash SSDs 

•  The best type of SSD for storing backups of information that doesn’t often change, 
for example Data files. 

•  They do not require any form of battery power to keep data secure. 

•  Information is safe from everything except accidental deletion for at least 10 years. 

•  Deleting or replacing information is like crossing out notes in a paper book - the 
information is gone, but the space is still occupied. When a Flash SSD eventually 
becomes full, you will need to copy the data to another disk, then format the disk 
and copy the information back. 

Ram SSDs 

•  Use an internal battery to keep data secure when they are out of the Series 3c 
(when in one of the SSD drives, they are powered by the Series 3c). 

•  Deleting or replacing information automatically frees the space for re-use. 

•  Useful for all kinds of information, including files that you frequently change, such 
as Agenda files. 

See the ‘System screen’ chapter for full details of using SSDs. 

Backing up all your files 
1. Insert the SSD you are going to use for the backup into one of the Series 3c’s SSD 

drives. 
2. Move to the System screen and select ‘Backup files’ from the ‘File’ menu. The 

‘Backup files’ dialog will appear. 
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3. Set the ‘Backup files on’ line to the disk you want to back up, usually the Internal 
disk. 

4. The ‘To dir: Name’ line determines where the files will be stored on the SSD. 
Important: 
•  If you use the SSD for backups only, enter a \ (backslash) on the ‘To dir: Name’ 

line. To type a backslash, press . 

 If you enter just a name on this line (without a backslash) the backed up files will 
be placed in a subdirectory of that name on the backup SSD, and will not be visible 
on the System screen when you insert the SSD in the Series 3c. Your files are not 
lost - you will just need to enter this subdirectory name if you use the ‘Restore 
files’ option. 

•  If you want to use the SSD for storing other files as well, type a directory name, 
adding a backslash before and after the name, e.g. \BACKUP\. 

5. On the ‘Disk’ line specify the drive that contains your SSD (either A or B). 

6. If this is the first time the disk has been used for backup, or if it has just been 
formatted: 
Set the ‘Files’ line to ‘All’ to specify that you want to copy all the files. 
On subsequent occasions: 
Set the ‘Files’ line to ‘Modified since last backup’ to copy only those files which 
have changed or been created since you last used the ‘Backup files’ option to 
backup the disk. 

 

7. Press , then  again to confirm. 

 If the message Disk full appears, you may need to “format” the SSD and then 
backup your files again, ensuring that the ‘Files’ line is set to ‘All’ (see above). See 
‘The System screen’ chapter for more about formatting disks. 
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•  If you entered a single backslash on the ‘To dir: Name’ line, duplicate copies of all 
the files will appear on the System screen with the same names but with [A] or 
[B] after them (indicating that the files are on a disk in drive A or B). When you 
remove the SSD these files will disappear from the screen. 

•  If you entered a different directory name on the ‘To dir: Name’ line, there will be 
no change to the files listed in the System screen. 

Important: Keep your backup SSD in a safe place, separate from the machine. 

Restoring files 
If you lose all your files, you can restore them all in one go using the ‘Restore files’ 
option. Alternatively, if you have lost just one file, you can easily revert to your backed 
up copy using the ‘Copy file’ option. 

 Beware of overwriting up-to-date files with out-of-date files! 

 Before restoring, check the files that are on your backup SSD - if there are any out-
of-date files which you have subsequently deleted from the Internal disk of your 
Series 3c, you can delete them from the backup directory before you restore from 
it. 

Restoring all your backed up files 
Important: If you have modified any of the files on your disk since you last backed 
them up, and you need to restore just one file, you should not use the ‘Restore files’ 
option: your current files would be overwritten with out-of-date files. See ‘Restoring 
just one file’ in this chapter. 
To restore all your files: 
1. Move to the System screen and select ‘Restore files’ on the ‘File’ menu. The 

‘Restore files’ dialog will appear. 

 

2. Set the ‘Restore files to’ line to the disk you want to use for the restored files, 
usually the Internal disk. 

3. If you entered a \ as the directory name when you originally backed up, leave the 
‘From dir: Name’ set to \, and change the ‘Disk’ line to the drive containing the 
backup SSD, either A or B. 
If you typed a directory name when you backed up, move to the ‘From dir: 
Name’ line and press . A ‘Specify filelist’ dialog will appear. Type in 
the correct directory path on the 'Full path' line, for example LOC::A:\BACKUP\ 
(or LOC::B:\BACKUP\ if the SSD is in the B: drive), and press  twice. 
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4. Press . A confirmation dialog will appear; press  again to start the 
restore process. 

Restoring just one file 
If you lose just one file, you can easily revert to your backed-up copy of it using the 
‘Copy file’ option. 

•  If you used \ as the directory name when you backed up the Internal disk, all the 
files will appear under the appropriate icons on the System screen when you insert 
the backup SSD into the machine (with either [A] or [B] after their filenames). 
To restore a single file to the Internal disk, highlight it, and use ‘Copy file’ on the 
‘File’ menu. 

•  If you used a different directory name, e.g. \BACKUP\, use the File selector or 
the Files application to find the file, then copy it from the SSD to the Internal disk. 
Consult the ‘System screen’ and ‘The Files application’ chapters for more details. 

Backing up a single file or groups of files to an SSD 
Instead of backing up the whole disk, you may prefer to copy and restore a specific file 
or group of files to and from an SSD. 
To copy a single file: 
1. Insert the SSD you are going to use for the backup into one of the Series 3c’s SSD 

drives. 
2. Move to the System screen, highlight the file you want to copy and select ‘Copy 

file’ on the ‘File’ menu.  

 

3. If you want the copy of the file to have the same name as the original, leave the ‘To 
file: Name’ blank, otherwise type in the new name. 

4. Set the ‘Disk’ line to A or B as appropriate. 

5. Press . 
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To copy several files: 
1. Move to the System screen, highlight one of the files you want to copy and select 

‘Copy file’ on the ‘File’ menu. 

2. On the ‘From file: Name’ line, press  to display the File selector. 

3. Tag the files you want to copy using . (See the ‘System screen’ 
chapter for more details on tagging files in the File selector.) 

4. Press  when you have tagged all the files. The ‘From file: Name’ line is now 
set to ‘(Tagged files)’. 

5. Leave the ‘To file: Name’ blank. 
6. Set the ‘Disk’ line to A or B as appropriate. 

7. Press . 

 You may prefer to use the Files application to copy your files to SSDs. Refer to 
‘The Files application’ chapter for more details. 

You can now continue to work on the file on the Internal disk, safe in the knowledge 
that if you do lose the original file, you can copy the file from the SSD back to the 
Internal disk. You will then only lose changes made since you backed up the file on the 
SSD. 

Backing up files using a personal computer 

•  Using Psion’s PsiWin, you can backup and restore your files to and from the PC, 
and also keep archive copies of files on the PC that you have since deleted from 
your Series 3c. See your Psion distributor for more details about PsiWin. 

•  The backup and restore process is controlled from your PC - please see the 
documentation supplied with PsiWin for more details.  
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Printing 

You can print text from Word, Sheet, Agenda, Data, Jotter and the 
Program editor. All have identical ‘Print setup’ options to specify 
the page layout you wish to use - headers, footers, margins and so 
on. They also have ‘Print preview’ options. 

Word is a special case, with advanced printer support in its design. 

There are three areas to consider before printing: 

••••  setting up the way you are going to print. 

••••  choosing the printer driver for the Series 3c to use. 

••••  designing the page layout. 

Printing does not hold you up: you can start printing one open file, 
then carry on using the Series 3c while the printing is in progress. 
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Printing from your Series 3c 
There are a number of ways you can print from your Series 3c: 

•  using PsiWin to print via a PC. 

•  using a Parallel Printer Link to connect directly to a parallel printer. 

•  using Infrared to transfer information directly to a printer which is IrDA Infrared 
compatible. 

•  using a PC Link cable with a Serial Printer Converter to connect to a serial printer.  
See your Psion distributor for more details about PsiWin, the Parallel Printer Link, and 
the Serial Printer Converter. 

Setting up the printer configuration 

Firstly, you need to set up the way in which you are going to print. Use the ‘Printer’ 
option on the ‘Control’ menu in the System screen to select whether you are printing to 
a parallel, serial or infrared printer, or to a file.  

 You don’t have to return to the System screen every time to select the way you 
want to print. Each application you can print from has a ‘Print setup’ option on the 
‘Special’ menu. Press  on the ‘Printer device’ line, to see the ‘Printer 
configuration’ dialog. 

Printing via PsiWin 
PsiWin allows you to link your Series 3c to a PC. Using the Psion Print application 
supplied with PsiWin, you can print files that you have created on your Series 3c to 
almost any printer that is installed in Windows on your PC, whether it is directly 
connected or networked to your PC. 
In the application that you want to print from: 
1. Select the ‘Print setup’ option from the ‘Special’ menu. 

2. Press  on the ‘Printer model...’ line and select ‘Psion Print’. 

3. Press  to confirm the dialog. (Note: you may wish to set up your page layout 
first, as described below.) 

Your Series 3c is now ready to print using Psion Print. See your PsiWin User Guide for 
more details about printing using Psion Print. 

Printing to a parallel printer 
The Parallel Printer Link connects directly to a parallel printer. The leaflet 
accompanying the Parallel Printer Link explains how to connect it to your Series 3c and 
printer. 
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To set up the Series 3c for printing to a parallel printer: 
1. Select the ‘Printer’ option on the ‘Control’ menu in the System screen. 
2. Set the ‘Printer device’ line to ‘Parallel’. 

3. You don’t need to change any other settings. Press . 

Printing using Infrared 
You can print directly from your Series 3c to any Infrared-capable (IrDA) printer. 
To set up the Series 3c: 
1. Select the ‘Printer’ option on the ‘Control’ menu in the System screen. 
2. Set the ‘Printer device’ line to ‘Infrared’. 

3. You don’t need to change any other settings in this dialog. Press . 

 Remember to select the ‘Communications’ option on the ‘Special’ menu in the 
System screen, and set the ‘Use’ line to ‘Psion IR’ before you start to print.  

When you have chosen the printer driver, and selected your page layout (see the rest of 
this chapter) you should remember the following when printing to an Infrared-capable 
printer: 

•  Point the Series 3c at the printer. 

•  Ensure that the Series 3c and printer are no more than one metre apart, if the power 
setting is set to ‘High’, or 30cm apart if the power setting is set to ‘Low’ in the 
Series 3c’s ‘Communications’ dialog. 

Printing to a serial printer 
To print to a serial printer, you need the PC Link cable (available with PsiWin) and a 
Serial Printer Converter to connect to your printer. 
1. Select the ‘Printer’ option on the ‘Control’ menu in the System screen. 
2. Set the ‘Printer device’ line to ‘Serial’. 
Many serial printers will work with the default settings, however you may need to 
change some of the settings. To do this: 

3. Press  on the ‘Serial characteristics...’ line, and change any settings in 
accordance with your printer manual. 

4. Press  on the ‘Serial handshaking...’ dialog and change any settings in 
accordance with your printer manual. 
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Handshaking is the method used to stop and start the flow of information between 
the Series 3c and the printer. Most serial printers use either ‘Xon/Xoff’ 
handshaking, ‘Dsr/Dtr’ handshaking, or both. The Series 3c is initially set to use 
both, and this should work even if your printer is only using one of the two 
methods. If you have problems, you can try setting one or other to ‘Off’. 

5. Press  to confirm the settings. 

Printing to a file 
You can print information to a file on disk, if you wish. 
1. Select the ‘Printer’ option in the System screen. 
2. Set the ‘Printer device’ line to ‘File’.  
3. On the ‘File Name’ and ‘Disk’ lines set the name and location of the “print file” to 

create.  

4. Press  to confirm the settings in the dialog. 

When you next print information, it will be saved in this file, instead of being printed. 

 Be sure to use the correct filename and location. If the file already exists, it will be 
overwritten without warning. 

Choosing the printer driver 

Selecting the printer model 
The Series 3c comes with printer drivers for various printer models. Word, Sheet, 
Agenda, Data, Jotter and the Program editor each have a ‘Print setup’ option. 
1. Select the ‘Print setup’ option on the ‘Special’ menu. 

2. Move the highlight to the ‘Printer model’ line, and press . 

3. On the ‘Select printer’ line, select the printer driver to use for the current file. 
If you have one of the printer models (or a compatible model) for which a printer driver 
is supplied, you can print using any of the fonts and sizes which the printer driver 
supports.  

 Most printers can emulate more standard models, such as Epsons or the IBM 
Proprinter; you may need to set a DIP switch, or use the printer’s control panel, to 
make your printer do this. Check your printer’s manual if in doubt. 

4. If you cannot find a suitable printer driver, select ‘General’. This allows you to 
print plain text to almost any printer which can accept plain text. 
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 If you can’t find a suitable printer driver for an IrDA Infrared compatible printer, 
choose a model that is compatible to the one you are using, or configure your 
printer to emulate one of the standard models. For example, an IR-capable HP 
LaserJet 5P would use the HP LaserJet IIP setting; the Citizen PN60 can be 
configured to support the IBM Proprinter or Epson LQ models. You can, of 
course, use the 'General' setting. 

Other printer drivers may be available from Psion, or from other sources. 

 

You cannot enter printer codes by hand in the files you print. All of the font and 
layout settings are handled automatically by the applications and the printer 
drivers. 

The ‘General’ printer driver 
•  If no other drivers are suitable for your printer, select the ‘General’ printer driver 

in ‘Print setup’.  

•  The Series 3c then has no special knowledge of your printer, but assumes that the 
printer font will be monospaced (not proportional), at 10 CPI (characters per inch), 
and with a height of 12 points, which is 6 LPI (lines per inch).  

•  Many printers use a font with these settings when you first turn them on; check 
with your printer manual if in doubt. 

•  If your printer does not start with a font that uses these settings, you should set 
them, where possible, from the front panel of switches on the printer. 

•  You can, if you wish, leave your printer set to some other font size. If it has a 
different width or is proportional, the left and right margins (word-wrapping) may 
not be handled correctly. If it is set to a different height, page breaks may not be at 
the correct places. 

 

When the ‘General’ printer driver is installed, Word will print spaces to implement 
layout features, such as centred text and tab positions. 

Changing the printer driver 
If you change your printer driver with the ‘Printer setup’ option to one which supports 
fewer fonts, then when you print with this driver, only the supported fonts will be used. 
In Word, font settings are not changed when you change your printer driver (unless you 
change them yourself, with ‘Style gallery’ for example). When you change back to the 
original printer driver, you can print the document properly. Similarly, Sheet print styles 
are not changed when you change your printer driver. 
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Choosing the font 

Except in Word and Sheet, which have their own advanced font control, you can set the 
‘Default font’, i.e. the font to use for the printout.  

1. In the ‘Print setup’ dialog, press  on the ‘Printer model’ line. 

2. Move to the ‘Default font’ line and press . 

3. The fonts available depend on the printer driver you choose. You can set any 
combination of bold, underline and italic for the ‘Default font’. 

You cannot set the ‘Default font’ line when in Word - each style or emphasis can be set 
individually to any of the available fonts. For example: 
1. Select the ‘Style Gallery’ option on the ‘Styles’ menu. 

2. Press the  or  to select the style to set. 

3. Move the highlight to the ‘Font’ line, and press . 

4. Select the font settings. (Note: ‘Print position’ cannot be changed in this case.) 
Important: if you use the ‘General’ printer driver, you can still set font attributes - 
bold, underline, italic, and sometimes superscript and subscript - in the ‘Default font’ in 
an Agenda or Data, in styles in a Word document, and in ‘Font styles’ in a worksheet. 
However, they will not appear on any printout - only normal text will be used. 

Font sizes 
Font sizes are specified in points. There are 72 points in an inch. Font sizes allow for a 
gap between lines of text. (In Word, you would usually set the line spacing to be the 
same as the font size for single-spaced text, or to twice the font size for double-spaced 
text.) 

Character sets 

•  The Series 3c uses the IBM Code Page 850 character set. Some printers use this 
character set; others use extended versions of the ASCII character set. The Code 
Page 850 character set is included in the ‘Appendix’. Most printer manuals also 
include the printer’s character set(s). 

•  Code Page 850 and ASCII use the same characters for the decimal codes from 32 
to 127. This includes the letters A-Z in upper and lower case, the digits 0-9 and 
most commonly used symbols. Some characters in the range 128 to 255 - foreign 
language characters, and various symbols - are different. 

•  If you use the ‘General’ printer driver, and you try to print characters with codes 
between 128 and 255, some may not print out correctly on a printer which does not 
use the Code Page 850 character set. 



 327

•  If you have one of the printer models supported by the Series 3c, and you use its 
printer driver, a suitable character set will be used. If there are differences between 
the character sets, the Series 3c will translate characters to the same (or nearest) 
character on the printer. However, if the printer supports more than one character 
set, you may need to set a DIP switch, or use its front panel, to set it to use the 
correct character set. 

Setting the page layout 

Word, Sheet, Agenda and Data allow you to design the layout of information on the 
printed page. 

•  Select the ‘Print Setup’ option on the ‘Special’ menu in each of these applications. 

•  Press  on the ‘Page size’, ‘Margins’, ‘Header’, ‘Footer’ and ‘Paging control’ 
lines to choose your settings. 

Setting the ‘Page size’  
•  On the ‘Page size’ line, set the size of the paper you are using. Press  to see 

which page sizes are supported. Choose ‘Custom’ if your paper size is not listed; 
you can then type the width and height of the paper. 

 The title of the ‘Page size’ dialog reminds you of the current “units” setting - 
inches or centimetres. To change this: either press  on the ‘Printer device’ line 
of the ‘Print setup’ dialog, or use the ‘Printer’ option in the System screen. 

•  On the ‘Orientation’ line, select ‘Portrait’ or ‘Landscape’. With portrait 
orientation, the length is greater than the width; with landscape, the width is 
greater than the length.  
Some printer drivers (especially for laser printers) send a code to the printer to 
instruct it to print in landscape orientation. In other cases, you may be able to use 
the control panel on the printer to set it to print like this, or simply feed the paper 
in sideways. However, some printers will not print in landscape orientation at all.  

Setting the ‘Margins’ 
The ‘Margins’ dialog allows you to set the margins to use on the paper. Information will 
only be printed on the area inside the margins. 

•  If you try to set any individual margin to a value that is too large for the size of the 
paper, a message will inform you of this. 

•  If you set a combination of margins which is too great for the size of the paper you 
are using, an ‘Invalid margins’ message will be displayed. 

 Few printers can print right to the edge of the paper, so you should not normally 
set very small margins. 
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Setting the ‘Headers’ and ‘Footers’ 
Headers and footers are printed in the top and bottom margins of each page. For 
example, you might use a header to print the title for the document at the top of every 
page, and a footer to print the page number at the bottom of every page. 
1. On the ‘Text’ line, type the text that you want to print as the header or footer on 

every page. You can also use any of the following codes in the ‘Text’ line to insert 
particular pieces of information in the header or footer: 

Code Inserts 
%F the name of the document file 
%D the current date 
%T the current time 
%P the current page number (1, 2, 3...) 
%% a single % character 

 When setting up headers and footers in the Word and Sheet applications, you can 
also use %M, to insert the last page number.  
For example, if you use Page %P of %M as the footer, then a three-page printout 
would have Page 1 of 3, Page 2 of 3 and Page 3 of 3 as the footers on the three 
pages.  

 The %M code cannot be used in headers and footers when printing from Data or 
Agenda because these applications do not paginate (count their pages) before they 
print. 

2. On the ‘Alignment’ line, you can change the position of the header or footer on the 
page. 

•  ‘Left’/’Right’: positions the text at the left/right margin. 

•  ‘Centred’: centres the text between the two margins. 

•  ‘Two column’: is used for text that is in two parts, separated by a . The first 
part is printed on the left, and the second on the right. 

•  ‘Three column’: is used for text in three parts, each separated by a . The first 
part is printed on the left, the second in the centre, and the third on the right. 

3. The ‘On first page’ line lets you turn off the header and/or footer on the first page - 
for example, for a title page in a Word document. 

4. The ‘Font’ line lets you set the font for the header or footer. 
5. For a header, the ‘Vertical offset’ is the distance from the bottom of the header 

text to the bottom edge of the top margin.  
For a footer it is the distance from the bottom of the footer text to the top edge of 
the bottom margin (which therefore includes the height of the text).  
The larger the vertical offset, the closer the header/footer will be to the edge of the 
page. 
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Setting the ‘Paging control’ 
This controls how page numbers appear (if you use them in headers or footers), and 
offers “widows and orphans” control of page ends. 

•  On the ‘Number for first page’ line, specify which number you wish to appear on 
the first page of the document, when you use %P in a header or footer. 

•  On the ‘Page number style’ line you can choose the style of page numbers inserted 
by %P: 1,2,3 or i, ii, iii, or I, II, III (the last two use Roman numerals). 

•  The ‘Allow widows/orphans’ line is mainly for Word documents, which are based 
around paragraphs. The terms widows and orphans describe the first or last line of 
a paragraph being printed on a different page to the rest of the paragraph. This 
looks a little strange, so ‘Allow widows/orphans’ is initially set to ‘No’. Set it to 
‘Yes’, if you want to allow widows and orphans to occur on your printed pages. 

 

In Word, if a style has ‘Keep together’ set (in the ‘Spacing’ dialog), paragraphs 
using this style cannot be split over a page end at all, and widows and orphans 
cannot occur in them. 

Printing from Word 

Spacing and positioning paragraphs 
To set the spacing and positioning of a paragraph (or highlighted paragraphs), select the 
‘Spacing’ option on the ‘Format’ menu. 
To change all paragraphs which use a particular style, use the ‘Style gallery’ option on 
the ‘Styles’ menu, and press  on the ‘Spacing’ line. 

•  ‘Line spacing’ is the height required for each line of text. It takes effect when you 
print, but is not reflected in the screen display. 

 Vertical spacing, like font sizes, is specified in points. One point is 1/72, so: 
 Lines per inch Equivalent line spacing (in points) 
 6  12 
 8  9 
 9  8 

 Important: The line spacing should always be at least as big as the font size for 
this style, otherwise lines could overlap when you print. (The font size already 
allows for a small gap between lines of printed text.) For example, for a 12 point 
font size of single-spaced text you would typically set a 12, 13 or 14 point line 
spacing; for double-spaced text, you would typically set it to 24 points. 

•  ‘Space above’ and ‘Space below’ can be used to set extra vertical gaps above and 
below this paragraph for printing. Initially, ‘Space above’ for Body Text is set to 
zero, while ‘Space below’ is set to the same value as the line spacing. This has the 
effect of printing a blank line after each paragraph. 
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 If you prefer, you could set ‘Space below’ to 0, and enter blank lines between 
paragraphs (by pressing  twice). You can then see the gaps between 
paragraphs on the screen. However, you will have no fine control over inter-
paragraph spacing, and blank lines may get printed at the tops of pages. 

Controlling page breaks 
The other three settings in the ‘Spacing’ dialog are for controlling page breaks: 

•  ‘Keep together’: if set to ‘Yes’ a paragraph will never be split across two pages. If 
there is not enough room for it at the bottom of a page, a new page will be started. 
You might set this to ‘Yes’ for a paragraph consisting of a number of lines that end 
with  - a table, for instance. 

•  ‘Keep with next’: if set to ‘Yes’, a paragraph of this style must be printed on the 
same page as the paragraph which follows it. For example, you might use this 
setting for heading styles, so that your headings don’t end up being printed “alone” 
at the bottom of a page. 

•  ‘Start new page’: if set to ‘Yes’, a paragraph of this style will always appear at the 
top of a new page. Use this setting to force the start of a new page. 

Displaying page breaks 
The ‘Paginate’ option on the ‘Search’ menu works out where each page will end if the 
current document is printed, and displays a dotted line across the screen at each 
position. This takes all of your current settings into account - font sizes, margins, line 
spacing, styles which force a new page, and so on. ‘Paginate’ displays a message telling 
you the number of pages needed to print your document. 

 

 

If a page break occurs within a paragraph, and the document wraps at the screen 
edge, the position of the page break can only be shown approximately. 

Page break positions are not updated automatically. Any time you wish to see where 
they would occur in the printed document, select the ‘Paginate’ option. 
The ‘Jump to page’ option on the ‘Search’ menu will also paginate the document, if 
necessary, before asking for the page to go to. 
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Previewing line ends and page ends 
Before you print a document, you can see on the screen how line ends and page ends 
will appear: 
1. Select the ‘Paginate’ option, to show where each page will end. 
2. Select the ‘Use printer layout’ option on the ‘Word’ menu to make text appear as it 

will be printed. 
New lines are now started only where they will start on the printout, and all page breaks 
are shown at exactly the correct place. If you’ve used Tabs to align columns of 
information, they are accurately shown, so that you can check the alignment of the 
information. 

 

Printer layout does not accurately show the position of centred or right-aligned 
text. 

When selected, the ‘Use printer layout’ option changes to ‘Use screen layout’; select 
this option to return to normal word-wrapping at the screen edge. 

 

For further information about previewing, see ‘Print preview’ later in this chapter. 

The ‘Print’ option 
When the document is laid out as you wish it to be printed, select the ‘Print’ option on 
the ‘Special’ menu. A ‘Print’ dialog is shown, like this: 

 

If you set the ‘Whole document’ line to ‘No’, you can set a page range to be printed. 
You can also set the number of copies to print. 

When you press  to complete the dialog, the printing begins. You can carry on 
using your Series 3c for other things while the printing is in progress. 
Do not unplug the lead connecting your Series 3c to the printer or PC, open either 
of the SSD doors or turn your Series 3c off while printing. 
If you see a message such as ‘Device does not exist’, check that you have used the 
‘Print setup’ option to set the destination of the print, and check that the relevant cable 
is firmly plugged in. 
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Preferred settings 
•  You can give new files your preferred ‘Print setup’ settings automatically, by 

creating a default template. (See the ‘Word’ chapter for more details.) 

•  If you create a new document with the ‘New file’ option in Word and specify the 
name of a template file to use, then the new document will inherit the ‘Print setup’ 
settings from the template file. 

•  Whenever a document is saved, its current ‘Print setup’ settings are saved as part 
of the file. 

Printing an outline 
You can display an outline or document summary on the screen by using the ‘Outline’ 
option on the ‘♦ ’ menu. When an outline is shown, selecting the ‘Print’ option will 
print the outline, not the whole document. 
If Word is currently showing an outline, the title of the ‘Print’ dialog changes to remind 
you that the outline version will be printed. 

Printing Tabs 
Instead of printing tabs as ‘tab’ characters (character 9 in the ASCII / Code Page 850 
character sets), Word tells the printer to move by the correct amount, according to the 
Tab positions for a given style. For the ‘General’ printer driver, Word uses spaces to set 
the positions. 

Printing from the Agenda 
Use the ‘Print setup’ option on the Agenda’s ‘Special’ menu, as described earlier, to set 
the font to use and to control the layout of the printed page. 

 

If you frequently print from your Agenda, you may wish to include today’s date 
(i.e. the letters %D) in the header. You can then distinguish the most up-to-date 
copy. 

The ‘Print’ option 
The ‘Print’ option on the ‘Special’ menu lets you print part or all of an agenda. In the 
Anniversary and To-do views ‘Print’ only prints anniversary and to-do entries. In other 
views all entry types are printed. You can also use ‘Find’ to list more selective groups 
of entries, and then print them. 
The printed entries have a similar appearance to the List view: 

•  Each entry starts on a new line and word-wraps to the width of the paper.  

•  Timed entries have their times neatly aligned.  

•  Most special symbols, such as the memo symbol, are not printed.  
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•  Crossed out entries will only be printed as crossed out if your printer driver 
supports this. Crossed out entries are marked with a “–” on the printout. 

You can choose to print a range of entries from today forwards, until today, for this 
month, last month, this year and last year, or between specific dates. 
Do not unplug the lead connecting your Series 3c to the printer or PC, open either 
of the SSD doors or turn your Series 3c off while printing. 

Printing from the Day, Week, Year, List and Busy views 

 

It is a good idea to use ‘Print preview’ first, as the Agenda may produce very long 
printouts if you have repeating entries. 

To print all or part of your Agenda from these views: 
1. Select the ‘Print’ option on the ‘Special’ menu. 
2. Select the ‘Range of entries’ that you want to print, or type your own ‘Start date’ 

and ‘End date’. You can also set ‘Entry types’ to exclude certain types of entry 
from the printout. 

3. Set the ‘Repeat entries’ line. If you choose ‘Show next only’, repeating entries will 
be printed once; ‘As normal’ means they are printed as many times as they are 
shown in the view. (The ‘Repeat entry’ dialog lets you set this for each entry.) 

 

If you choose ‘As normal’, note that repeating entries or anniversaries could be 
printed many times, producing a very long printout. Remember that you can always 
stop a print in progress by pressing . 

4. Set the ‘Crossed out entries’ line to ‘No’ if you wish to exclude crossed out entries 
from the printout. 

5. Press  to complete the dialog. 

To print a more specific list of entries, print from the ‘Find’ screen, as described later in 
this chapter. 

Printing a list of anniversaries 
To print a list of anniversary entries within a specified date range: 
1. Move to the Anniversary view and select the ‘Print’ option. 
2. Set the ‘Range to print’. You can choose from ‘This year’ and ‘By date’. If you set 

‘By date’, set the ‘Start month’, ‘Start year’, ‘End month’ and ‘End year’ lines. 
3. Set the ‘Include crossed out entries’ line to ‘No’ if you want to exclude crossed out 

entries from the printed list. 

4. Press  and the selected entries will be printed. 
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Printing a list of to-dos 
To print a list of all the to-do entries in all your to-do lists, or all the entries from a 
single list: 
1. Move to the To-do view and select the ‘Print’ option. 
2. Set the ‘Which lists’ line to ‘All lists’, ‘One list’, or ‘Selection’. If you set ‘One 

list’, select the list to print on the ‘List name’ line. If you set ‘Selection’, you can 
set each individual list to ‘Yes’ or ‘No’, and print all the lists you want at the same 
time. 

3. Set the ‘Include crossed out entries’ line to ‘No’ if you want to exclude crossed out 
entries from the printed list. (This is independent of whether they are shown on 
screen.) 

4. Press  to complete the dialog. 

If you chose to print ‘All lists’ they are printed in the order in which they appear in the 
To-do view. You can set this with the ‘To-do list settings’ option. 

Information not printed 
•  Display features such as duration and overlap bars, slot times, slot lines and so on 

are not printed. 

•  Most special Series 3c symbols, e.g. the memo symbol, are not printed as they are 
not supported by most printers. 

•  Memos are not printed. However, they can be printed separately. 

Printing memos 
Memos are not printed when you print an Agenda. However, while editing a memo you 
can use the Memo editor’s ‘Print’ option to print it.  
Note: there is one set of ‘Print setup’ settings for all the memos in each Agenda file, so 
use the ‘Print setup’ option while editing any memo. 

Printing from the ‘Find’ screen 
You can use ‘Find’ to search for a set of entries that you want to print. For example, if 
you have marked all your job interviews with the letters ‘intv’ in the entry text, you can 
use ‘Find’ and then ‘Print’ to print them all. 
When you choose to print from the ‘Find’ dialog, no ‘Print’ dialog is displayed; the 
Series 3c always prints the same list of entries shown on the ‘Find’ screen. 

 

If you want to exclude crossed out entries from the printed list, you must exclude 
them in the ‘Find’ dialog itself. 
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Printing from Data 
In Data, use the ‘Print setup’ option on the ‘Special’ menu, as described earlier in this 
chapter, to set the font to use and to control the layout of the printed page. 

The ‘Print option 
You must print from the ‘Find’ view. You cannot print from the ‘Edit’, ‘Add’ or ‘List’ 
views. 
Use the ‘Print’ option on the ‘Special’ menu to print the current database. 

•  The ‘New page for each entry’ line allows you to print each entry on a separate 
page. 

•  The ‘Entries’ line setting controls which entries are printed: 
Matching: only those entries which match the current search clue are printed. 
All: all of the entries in the current database are printed. 
Current: only the currently displayed entry is printed. (This setting is not available 
if ‘Not found’ is currently displayed on the ‘Find’ screen.) 

•  If labels are currently shown on the screen, then they are printed alongside each 
entry. You can use the ‘Show labels’/ ‘Hide labels’ option on the ‘Special’ menu 
to set this. 

•  Data does not show blank lines in an entry. If you wish, however, you can print 
them, by setting ‘Show blank lines’ in this dialog to ‘Yes’. 

•  If you set the ‘Keep entries together’ line to ‘Yes’, each entry will always be 
printed on one page, and will never split across two pages. If there is not enough 
room for it at the bottom of a page, it will be printed on a new page. This is the 
same sort of effect as the ‘Keep together’ setting in Word. 

 

Each line or group of lines corresponding to each label will act as a separate 
paragraph, as far as the ‘Allow widows/orphans’ print setting is concerned. 

The telephone symbol (�) is a special Series 3c character, and its character code would 
be interpreted differently by printers. For this reason, the printer driver translates it to 
some other suitable character or characters - usually a # symbol. 
Do not unplug the lead connecting your Series 3c to the printer or PC, open either 
of the SSD doors or turn your Series 3c off while printing. 
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Printing from Sheet 
In the Sheet application, use the ‘Print setup’ option on the ‘Special’ menu, as 
described earlier in this chapter, to control the layout of the printed page. 

To print the whole worksheet 
To print the whole worksheet, without changing the margins, fonts etc., select the 
‘Print’ option on the ‘Special’ menu.  

 Sheet works out where any page breaks will be, given your current printer settings. 
Page breaks may be caused by the length or width of the worksheet - if the 
worksheet is too wide to fit on a page, it will be printed in strips, with as many 
columns in each strip as will fit. 

The ‘Print’ dialog is displayed.  

•  To print the whole worksheet, just press .  

•  Select which pages to print on the ‘Pages’ line. 

•  Set the ‘Print formulae as’ line to specify what should be printed for cells which 
contain formulae. Set it to ‘Formulae’ to print the formulae themselves (just as if 
the cells had ‘Show formulae’ as their format). 

Do not unplug the lead connecting your Series 3c to the printer or PC, open either 
of the SSD doors or turn your Series 3c off while printing. 

To print a highlighted range 
Highlight a range before you select ‘Print’, then set the top line of the ‘Print’ dialog to 
‘Highlighted range’ instead of the ‘Worksheet’. 
If the highlight covers a large range, you can again set which pages to print. 

Information not printed 
The following are not printed: 

•  Grid lines. 

•  Row/column headers (A B C... and 1 2 3...). 

•  The contents of cells with ‘Hidden’ display format. 

Page breaks 
To see where the page breaks occur, select the ‘Jump to page’ option on the ‘Search’ 
menu.  

•  The ‘Printing range’ line lets you choose between the whole worksheet, and any 
print ranges (explained later).  

•  Type a page number on the ‘Jump to page line’ (the ‘Pages available’ line shows 
the range).  
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•  Press , and the page you chose is highlighted, with the cell pointer in its top 
left cell. 

“Vertical” printing 
When printing wide worksheets on separate sheets of paper, you may prefer to print in 
‘landscape’ orientation, where the sheet is “turned” through 90 degrees. This may allow 
you to use fewer pages when printing.  

•  Select ‘Print setup’, press  on the ‘Page size’ line, and set ‘Orientation’ at the 
bottom of this dialog to ‘Landscape’. 

Some of the built-in printer drivers (e.g. for laser printers) may tell the printer 
automatically to print in landscape orientation. On other printers - wide-carriage dot 
matrix printers, for example - you may be able to feed the sheets in manually. 

Advanced worksheet printing 

You can define any number of print ranges. When you finally come to print, choose 
which of these ranges to use. 
To define a print range: 
1. Highlight the range to use, then select the ‘Set print range’ option on the ‘Range’ 

menu. 
2. Edit the suggested range, if necessary. You can also type in the name of a named 

range. 

3. Press  to define the print range. 

Unlike named ranges, you do not give each print range a separate name. A print range is 
referred to just by the range reference (or named range) you enter when defining it. 

Changing or deleting print ranges 
•  Select the ‘Edit print range’ option on the ‘Range’ menu. Use  to select the 

print range you want to change from the ‘Existing ranges’. Move the highlight to 
the ‘Range’ line, and type the new range to use. Then press . 

•  To delete a print range, use the ‘Delete print range’ option on the ‘Range’ menu. 

Applying font styles 
•  There are four font styles which you can apply to cells (this is similar to applying 

styles in Word).  

•  These font styles are reflected on the screen, and are used when you print 
information from Sheet. 

•  Initially, the four font styles are set to use the same font and size, with different 
combinations of bold and italic settings. 
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•  You can change these fonts, though, to be any size and style supported by the 
printer driver for your chosen ‘Printer model’. The names of the font styles change 
to reflect the settings you give them. 

•  Font (1) is special in that it applies to all cells which have not had a font style 
applied to them. 

To change one of the font styles: 
1. Select the ‘Change styles’ option on the ‘View’ menu.  
2. Select the font style to change from the ‘Printing style’ line of the dialog.  
3. Then change the ‘Font’, ‘Size’ and emphases for this font style, as required. 

 The fonts available to you are set by your choice of ‘Printer model’ in the ‘Print 
setup’ option. 

To set a range to use a particular font style: 
1. Highlight the range, then use the ‘Format’ option on the ‘View’ menu.  
2. Choose the font style to use for this range on the ‘Font’ line. 
The screen display will reflect the style of the font - bold, underline, and so on. (Note: 
some printer models may not print the style of the font - in particular, the ‘General’ 
printer driver.) 

 Be careful if you apply a font style to a range. As this uses the ‘Format’ dialog, you 
will also set the display format for all numbers in the range. 

Pagination and ‘Jump to Page’ 
•  If you use the ‘Jump to page’ option when you have set print ranges, it first 

paginates all of them. You can then set the first line of the dialog to the print range 
required, and the second line to the page number in that print range. 

•  Pagination does not take account of different font styles. When ‘Jump to page’ 
paginates it assumes the settings of font styles (1) throughout. If, for example, you 
were to use double-height characters in one of the four font styles, any rows which 
use it may need a blank row above them, to stop them overwriting previous rows. 

•  There is no simple way to force page breaks. Change your print ranges if you wish 
to print different areas of the worksheet on different pages. 
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Print preview 
If you wish, you can check that your printout is going to be the way you want before 
you print it.  

•  Select the ‘Print preview’ option on the ‘Special’ menu, in the Agenda, Data, 
Jotter, Sheet or Word applications. 

‘Print preview’ paginates, if necessary, then asks for the same “what to print” 
information as the ‘Print’ option. It begins to work out and display how each printed 
page will look - it may take a little time to do this. (Lines which use small font sizes 
may be shown run together, i.e. all in one block.) 

If you press the  key, you will see a new menu of ‘Print preview’ options: 

•  ‘Print’ prints the file, as it appears in ‘Print preview’. You cannot print while ‘Print 
preview’ is still calculating the layout of the pages; for a long file, you may wish to 
press  to abandon the ‘Print preview’, and use the ‘Print’ option from the 
main menu. 

 

Word allows you to print more than one copy at a time; although ‘Print preview’ 
only shows the one copy, it will still print them all. 

•  ‘Show margins’ displays the current margins, as set in ‘Print setup’, as grey lines 
on the pages in Print Preview. As well as the left, right, top and bottom margins, it 
displays the ‘Vertical offset’ positions of the headers and footers. 

•  ‘Pages to display’ lets you show from one to four pages on the screen at a time. It 
also has a ‘Facing pages’ setting; if your final document is to be bound, use this 
setting to see each pair of left and right pages together. 

•  ‘Jump to page’ lets you see the preview for any page calculated so far. 

 You can press  or select ‘Exit preview’ to leave ‘Print preview’, at any time.  

When the calculations are finished, ‘Print preview’ displays the final number of pages 
in the top left-hand corner.  

•    move from page to page.  

•  Pg Up and Pg Dn move to the previous/next set of screens. 

•  Home and End move to the first/last screen.  
(You don’t have to wait until ‘Print preview’ has finished calculating before you move 
between the pages.)  
Each application initially takes its settings for ‘Margins’ and ‘Pages to display’ from 
those set on the ‘Print preview’ line of the ‘Printer’ dialog in the System screen. 
Thereafter each individual application remembers its own last-used settings, for as long 
as it has an open file. 

 

‘Print preview’ needs 3-4K of free memory to get started, and takes up around 400 
bytes per previewed page. 
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Other printing information 

Cancelling printing 
You can cancel any printing in progress. Return to the application which is printing, if 
you have left it, then press the  key. 

Settings for new files 
When you create a new file, whether an Agenda, Data, Word or Sheet file, the new file 
inherits the ‘Printer setup’ settings from any file you were using - that is, from the 
previously open file which exits when you create your new file. 
If there was no open file, the settings most recently set in any application will be 
inherited. 

 

If you use a template when creating a new Word document, the printer settings are 
inherited from the template. 

Printing from the Text editor and the Program editor 
You can print plain text files when using Word as a text editor, and OPL programs from 
the Program editor, as you would print a document from Word. The same ‘Print setup’ 
and ‘Print’ options are available in the Program editor. 

As in Agenda and Data, press  on the ‘Printer model’ line of the ‘Print setup’ 
dialog, and set the default font for the printer to use. 

Printing from an OPL program 
OPL has a command, LPRINT, for printing information. Refer to an OPL programming 
manual for more details on printing from OPL. 
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Infrared 

You can transfer any information - highlighted text or a complete 
file - straight to another Series 3c. 

This chapter shows you how to: 

••••  switch ‘Infrared’ communications on and off.  

••••  select the information to send - from a single entry in your 
database, to a large Word processor file. 

You can also use Infrared to print directly to printers which 
support Infrared - see the ‘Printing’ chapter for more details. 
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Transferring information using Infrared 
The Series 3c has Infrared built-in, allowing you to copy whole files or just individual 
names and addresses, details of meetings, notes etc. to another Series 3c. You just turn 
Infrared on, select the information to copy and send it across. 

 You can also use Infrared to send information from a Series 3c to a Psion Siena, or 
vice versa. Refer to the Siena User Guide if you need further instructions. 

On the Series 3c, the Infrared “window” is on the outer casing, to the left of the main 
battery door. When you open the Series 3c, the Infrared window moves around so that it 
faces away from the machine. When you transfer information, hold the Series 3c (or rest 
it on a flat surface) and align the Infrared windows on each Psion. 

Turning Infrared on 

•  Select the ‘Communications’ option on the ‘Special’ menu in the System screen 
and set the ‘Use’ line to ‘Psion IR’. 

 Infrared has two power settings - high and low. High power allows data transfer 
over a distance of up to a metre, and low power up to 30cm. You should normally 
use the high power setting. You might like to switch to low power when you are 
sending information between two Series 3cs that are very close to each other, and 
wish to save power. 

Selecting information to transfer 

•  To transfer an entire entry from Data, just find the entry in the Find view as 
normal. To copy part of an entry, highlight the part you want to copy. 

•  To transfer an Agenda entry, move the cursor onto it. 

•  To transfer text from other applications, highlight the text.  

•  To transfer a file from the System screen, highlight its name on the System screen. 

•  To transfer a file from the File selector, highlight its name. 

•  To transfer a file from the Files application, highlight its name in the Files view.  

 Infrared always sends the highlighted file. Files you have “tagged” in the File 
selector or in the Files application are not selected to be sent by Infrared - only the 
highlighted filename is sent. 
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Transferring information 

1. Either: 

•  open the appropriate application on the Series 3c that you wish to send the 
information to, and select the information to transfer, or 

•  if you are transferring a whole file, move to the System screen on both Psions.  
 See ‘About transferred information’ later for information about the effects of 

sending information to the same, or to a different application. 
2. Point the two Psions at each other. Important: The two Psions should be no 

more than 1 metre away from each other for Infrared to work (or 30cm if you 
have set Infrared to use the low power setting). 

3. On the receiving Psion, press the Infrared keypress (  on the Series 3c), 
and then  to receive: 

 

4. Press  on the Series 3c that you are sending from, and then  to send. 

 You cannot switch to other applications on either Psion while the Infrared dialogs 
are displayed; if you want to stop the transfer of data to use another application, 
press . 

If the data transfer fails 
You will see a message that will indicate why the information transfer failed. Follow the 
advice given in the dialog, and try again. See the ‘Troubleshooting’ chapter for more 
information about solving problems with transferring information by Infrared. 

When the information transfer is completed 
The Infrared screens will disappear and you will be returned to your previous screen. 

To cancel the transfer 
•  Press  on either Psion while the Infrared dialog is on screen. 
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About transferred information 
The information on the Series 3c that you send from is not affected by the data 
transfer. 

Agenda information 
•  When you send an entry from your Agenda to the Agenda application on the 

receiving Series 3c, all the entry details are transferred (including alarms and 
memos). 

•  When you transfer an entry from a To-do list to a Series 3c that does not have a 
To-do list with the same name, the to-do entry will be placed on the first To-do list. 

•  When you send an Agenda entry to a different application on the receiving 
Series 3c, only the entry text is transferred. 

•  If you send an entry which has an entry code, the entry code letter will be 
transferred with the entry. Note that the ‘Description’ for each entry code is not 
transferred, and that the entry code letter may already exist for other categories of 
entries on the receiving Series 3c. If the same entry code letter is used for different 
categories of entries on the two Series 3cs, simply change the entry code letter on 
the receiving Series 3c after the entry has been transferred. 

Data information 
When you send a Data entry to the List or Find view in Data on the receiving Series 3c, 
a new entry is automatically created; just press  to save it. If you send it to the Edit 
or Add view in Data, or to any other application, the text is inserted at the cursor 
position. 

Jotter information 
•  To send a complete note, highlight the note in the List view. 

•  To send part of a note, move to the Edit view and highlight the text to send. 

Sheet information 
•  When you send cells from Sheet to the Sheet application on the receiving machine, 

formulae for calculations are transferred (relative and absolute cell references are 
preserved and behave normally). 

•  When you send cells from Sheet to a different application, the results of any 
formulae, and not the formulae themselves, are copied. 

Soundmaster information 
•  You cannot select part of a sound in Soundmaster to send by Infrared. If you want 

to send Soundmaster information by Infrared, highlight the filename in the System 
screen, File selector or Files application and send the complete file. 
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Word information 
•  When you send a complete file from Word to the receiving Series 3c, all the style 

and emphasis details are transferred as well. 

•  When you send highlighted text to the Word application on the receiving Series 3c, 
styles or emphases in the copied section are also transferred. Only the styles or 
emphases in use in the highlighted text are copied - other styles in use in other 
parts of the document are not transferred. 

•  When you send highlighted text to a different application on the receiving 
Series 3c, only the text is transferred. 

•  If you send highlighted text which contains styles or emphases to a Word 
document with matching style names, the styles are not updated. If you want to 
change the styles in use, use the ‘Style gallery’ menu option to change them. 

•  Template files do not remain “attached” to a document, and are not transferred if 
you send documents that were opened using them. To transfer a template file, 
locate it using the File selector or Files application (template files have the 
extension .wrt, and are usually stored in the \WRT directory) and highlight it to 
send as usual. 

Sending files 
•  When you send a file, the file is sent to a directory of the same name as the one it 

came from on the sending Series 3c. If a directory of that name doesn't exist on the 
receiving Series 3c, it will be created automatically as part of the file transfer 
process. 

 Any application files you transfer (e.g. Agenda files, Data files etc.) will only 
appear on the System screen on the receiving Series 3c if they are sent from the 
default directory for that application. If they appear to “disappear” from the System 
screen, you can locate them with the File selector or the Files application and move 
or copy them to the correct directory. See ‘Filenames not appearing in the System 
screen’ in the ‘Troubleshooting’ chapter for more details.    

•  If you send a Word or Sheet file which is password-protected, the password is 
transferred as well - you will still need the password to open the file on the 
Series 3c you send it to. 
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Troubleshooting 

This chapter should help you if you have any problems using your 
Series 3c, including: 

••••  things to try if your Series 3c does not seem to work as you 
expect it to. 

••••  how to solve problems with files, memory and SSDs. 

••••  how to solve problems you experience while printing, or 
transferring information using Infrared. 

••••  how to exit an application which appears to have stopped 
working. 

••••  how to, as a last resort, reset your Series 3c. 
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General problems 

If the Series 3c doesn’t seem to turn on 

•  Check the screen contrast with  and . 

•  Check the main batteries. If you continue using the Series 3c when the main 
batteries are low it will eventually turn off and refuse to turn on again. You must 
then change the batteries before you can use it again. 

If the Series 3c won’t “auto switch off” 

•  Check the ‘Auto switch off’ option on the ‘Control’ menu in the System screen. 

 If you use OPL, note that a running OPL program can prevent automatic turn off if 
it neither pauses, nor waits for a keypress. 

Screen too dark, or insufficient contrast 

•  Change the screen contrast with  and . 

Batteries need replacing 

Battery warnings appear when your batteries need replacing. See ‘Changing the 
batteries’ in the ‘Getting started’ chapter for details. If the warnings continue to appear 
after you have replaced the batteries: 

•  Remove the new batteries and replace them ten seconds later. 

•  Check the contacts to the main batteries - make sure they are clean, dry and making 
good contact with the batteries. 

 When you replace “flat” batteries with rechargeable Nickel Cadmium batteries, you 
may see the ‘Replace’ warning for a few seconds after you have inserted the NiCd 
batteries. This is normal, and will go away on its own. 

Flat batteries and “Auto switch off” 
If you disable the ‘Auto switch off’ feature, the Series 3c will only turn off when 
you press , the OFF keypress. 

You should not in general disable ‘Auto switch off’ while using battery power - if you 
were to leave the Series 3c on by mistake even once, or if an alarm turned the Series 3c 
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on while you were absent, it would stay on until the batteries failed. The Series 3c 
would then turn off, and you would not be able to use it again until you change the 
batteries. 

Beeping sounds 

The Series 3c will beep when: 

•  You try to type in more characters than the Series 3c allows in a particular place - 
for example, when entering a long Agenda entry.  

•  You type the name of a setting on a dialog line (in order to select it), or the name 
of a city or country in the World application, and the Series 3c is unable to match 
the letters that you type against a setting, file or country. 

•  You select a menu option for a task which is not possible at that time, for example, 
if you select ‘Exit application’ in the System screen when the highlight is on the 
name of an application which is not running. A message may also be displayed to 
tell you why your chosen action is not possible. 

 You can change the volume of these beeps by selecting the ‘Sound’ option on the 
‘Control’ menu in the System screen. 

Problems with alarms 

If your alarms..... 
...sound like beeps - your batteries are too low to play the sound you have chosen for 
your alarm. 
...don’t ring - there are a number of possible causes: 
1. You may have turned the sound off permanently with the ‘Sound’ option on the 

System screen’s ‘Control’ menu. Use it again to turn the sound back on. 
2. The Agenda did not inform Time to ring an alarm. This can happen when: 

•  There are a large number of entries in the Agenda file. 

•  You create a new Agenda entry and switch your Series 3c off immediately 
afterwards. 

•  You exit an Agenda file that contains a number of entries with alarms. 
 This is because open Agenda files inform the Time application about their next 

alarm only. (It is the Time application which actually rings the alarm.) It takes a 
certain amount of time for the Agenda to calculate when the next alarm should go 
off and inform the Time application. If you switch your Series 3c off before the 
calculation is complete, the Time application will not have been informed to sound 
the alarm. When an Agenda alarm rings, the open Agenda file then informs Time 
of the next alarm it contains, and so on. So if you exit an Agenda file, the Time 
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application will still ring the Agenda file’s next alarm, but will not be able to 
ring any others from that file until you open it again. 

 The Series 3c can only have 24 “processes” - open files and applications, for 
example - at any one time. When you reach this limit, the Series 3c will not be able 
to play a sound file as an alarm, and will only beep instead. (If you are at this limit 
and you try ‘Test sound’ in the ‘Set alarm’ dialog to play a sound file, you will see 
a ‘Too many processes’ message.) 

Problems with menus 

You cannot use the  key to display a menu in the following situations: 

•  While a dialog is being shown on the screen. 

•  While you are using Help on the screen. 

•  While you are setting a city’s position in World. 

•  While full screen messages, such as alarms and disk error messages, are displayed. 

Press  or  as appropriate to remove the dialog, or complete the task, then 
press  to display the menu. 

Cut/Copy/Paste, and Delete/Undelete 

If you’ve used commands like these in other personal computer software, note that the 
Series 3c combines the ‘delete’ and ‘cut’ ideas: 

•  When you copy highlighted information with the ‘Copy...’ menu options (such as 
‘Copy text’), a copy of the information is made on a separate area, called the 
“clipboard”. Any information previously stored on the clipboard is lost. 

 You can insert (“paste”) the information on the clipboard, as many times as you 
like, with the ‘Insert’ menu options. (This is usually called ‘Insert text’; in the 
Spreadsheet it is called ‘Paste’.) 

•  When you delete highlighted information with the  key, it is deleted from 
the document, but is also put on the clipboard. (This also happens if you delete 
part of a line with  or . If you just delete a 
single character with the  key, however, the clipboard is not affected.) 

•  If you delete information by mistake, you can use the ‘Insert’ option to put it back 
(“undelete” it). 

•  To delete highlighted information without replacing the clipboard, press 
. (You cannot do this in the Sheet application, though.) 
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Each open application has its own clipboard. You can copy information to a file of the 
same kind by copying it, then using the ‘Open file’ option to open the second file. The 
clipboard still contains what you copied, so you can insert it in the second file. 
To copy information to a file of a different type, use the ‘Bring’ options. 
There is no highlighting in the Agenda; just move to the entry you want to cut or copy. 

Problems with SSDs 

•  Do not remove an SSD while information is being written to it, such as when using 
a ‘Save as’, ‘Open file’ or ‘Copy file’ option and choosing a file on the SSD drive. 

•  If you do remove an SSD while it is being written to, a message is shown asking 
you to replace it. If the disk’s “volume” name is backup, for example, the 
message will be ‘Please replace volume "backup"’. 

 You must either reinsert the disk and select ‘Retry’, or just select ‘Fail’. You 
cannot use the Series 3c until you do so (although any alarms that you’ve set will 
still ring). 

Important: If a file was being saved or written to in any way, and you select ‘Fail’, the 
file will almost certainly be corrupted and become unusable. You should delete the file. 
A ‘Media is corrupt’ message means that the Series 3c cannot read the structure of a 
disk. You may see this message when trying to access an unformatted SSD. If the SSD 
is formatted, remove it, then re-insert it and try again. If you still can’t get the Series 3c 
to access it, there may be a hardware problem with the SSD. Contact Psion Technical 
Support for further information. 

Memory problems 

Checking internal memory 
Memory is measured in K (Kilobytes) - 1K can hold just over a thousand characters. 
If you want to keep an eye on the amount of internal memory which is still free, press 
the  key in the System screen: 
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You can then take early action to prevent the internal memory filling up, to avoid it 
happening at an inconvenient time. 
The ‘Memory info’ option from the ‘Info’ menu in the System screen also shows you 
the amount of internal memory used and the amount free. If you press the  and  
keys, more details are given of what is using up the memory - the internal disk, each 
open Word processor file, and so on. 

 

Applications use up memory to run, and you can exit any open applications to recover 
memory. For example, Calc uses a few K of internal memory. If you exit Calc, by 
moving the highlight onto it and pressing , you can recover this memory. Of 
course, to use Calc in the future, you would need a few K of memory to be free. Time 
also uses a few K of memory, but you cannot exit it. 

If the Series 3c seems slow 

•  If your Series 3c is running slowly, you should first check which applications are 
using up memory with the ‘Memory info’ option, and close any unnecessarily open 
files. 

•  If this does not cure the problem, it may be because you have removed an 
application from the System screen when it was still running, for example if you 
remove Data when you have Data files that are still open. If you have done this, the 
application files will not be displayed as using memory in the ‘Memory info’ 
dialog.  

 To view open files for applications that you have removed from the System screen, 
use the ‘Install standard’ option to install the ‘RunImg’ application. 

 

Any open application files will then appear on the System screen 
underneath the RunImg icon. 

You can move to any of the open files in this list and use the  key to close 
them as normal to free some memory. Note that the  just exits the files - it 
does not delete them. 
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‘Memory full’, ‘No system memory’ or ‘Disk full’ 

If you’ve almost filled up the internal memory with information on the internal disk, 
you may find yourself unable to enter more information. A ‘Memory full’, ‘No system 
memory’ or ‘Disk full’ message will be shown.  

•  The Sheet, Word, Soundmaster and the Program editor applications need enough 
free memory to make a separate copy of the file to work with, as they do not use 
the file directly.  

•  Internal memory is also used to keep each file or application open. The name of 
each open file is shown in bold in the System screen. (You can open more than one 
file of the same type by using  in the System screen.) 

•  Translating large OPL programs requires a certain amount of free memory. 
Many of the things you do on the Series 3c also need just a little free memory in order 
to work - displaying dialogs, menus, Help information, or the File Selector. These can 
also fail with a message like ‘Memory full’. 
Don’t worry if you fill up memory - your information is still safe. Here are some 
ways to free more memory: 

•  Press the System button, move to a bold name at the top of a list, and press 
. This exits an open file. You can exit Calc in the same way. You might 

exit Calc and World for a while, or any Word files or programs that you are 
editing. (You can use the System screen’s ‘Exit all applications’ option to exit 
them all, if you wish.) 

•  Use the Agenda’s ‘Compress’ option on any Agenda files on the internal disk. 
Then use Data’s ‘Compress’ option on any Data files on the internal disk. This will 
reclaim any space taken up by deleted or edited information. 

•  Delete any unwanted files on the internal disk. 

•  Copy files to an SSD, then delete them from the internal disk. 

•  Sometimes you can free a certain amount of memory (temporarily) by moving to an 
open Sheet, Data, Agenda or Word file, and using the ‘Copy text’ option on as 
small an amount of information as possible. This may reduce the size of any 
information saved on the clipboard. 

 If you edit a large file, then open a small file, Word or the Program editor may 
under some circumstances still take up more internal memory than necessary for 
the new file. Exit the file, then open it again. 

Sheet and Word can sometimes produce these messages when their files approach their 
maximum size. See the ‘Sheet’ and ‘Word’ chapters for more details. 
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Problems with files 

Filenames not appearing in the System screen 

If you copy, move or rename a file, you may find that the file does not appear under the 
icon in the System screen.  
There are two possible reasons: 

•  The files are not stored in the correct directory for their icon. Locate the file(s) 
using the File selector and copy them to the correct directory (see below). 

•  The files have the wrong file extension. Locate them using the File selector and 
rename them to give them the correct file extension (see below). 

The Series 3c stores files for the different applications in the following directories: 
 Directory File extension 
Agenda \AGN .AGN 
Data \DAT .DBF 
Sheet \SPR .SPR 
World \WLD .WLD 
Word \WRD .WRD 
Word templates \WDR .WRT 
Sheet \SPR .SPR 
Jotter \JOT .JOT 
Soundmaster \WVE .WVE 
Printer drivers \WDR .WDR 
Program editor \OPL .OPL 
RunOPL \OPO .OPO 
Applications \APP or \IMG .APP, .OPA, .IMG 
other OPL files \OPD .ODB, .PIC 
System screen lists/groups \APP .ALS, .GRP 

Three dots (...) in file lists 

A file list can end with three dots (...) to signify that some files could not be shown. 
Several things can cause this: 

•  It is possible to have more files for one icon than the System screen can handle. 
They will not be shown in the file list unless you delete some of the other files. Try 
creating a new list for this icon, and moving some of the files to this new list. See 
the ‘System screen’ chapter for more about file lists. 

•  Internal memory may have become filled by the generation of the file lists, causing 
one or more lists to be incomplete. You need to free some internal memory, as 
described earlier. 
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•  An SSD door was opened while the lists were being updated. 
To find out which of these reasons of these caused ‘...’ to be shown, try to move the 
highlight onto the ‘...’ itself. A message will be shown, explaining the reason for the 
incomplete list. 

 ‘File or device in use’ 

You will see a ‘File or device in use’ message if you try to copy, rename or delete a 
file shown in bold in the System screen’s file lists. Exit it, by moving the highlight to 
it and pressing , then try again. Note that pressing  just exits the file - 
it does not delete it. 

•  If an opened file is busy for some reason, e.g. if a dialog is displayed, you cannot 
exit it. 

•  You cannot open a file if that file is already open (or otherwise in use). For 
example, you might have two agendas called Agenda and Business, and use 

 on the System screen to open both files at the same time. If, while 
looking at Business, you use the ‘Open file’ option and try to open Agenda, a 
‘File or device in use’ message is shown, as it is already open. 

•  The same situation may occur if you use the File selector to open a different type 
of file. For example, if you try to open an OPL program file in the Word 
application, this will fail if the file is already opened under the Program editor. 

•  You may also encounter this message if you have the Series 3c linked to a PC and 
the link fails while copying a file - you will see the message if you then try to 
access the file. Select the ‘Communications’ option on the ‘Special’ menu in the 
System screen, and set the ‘Use’ line to ‘Psion IR’ or ‘None’, then try again. 

The built-in applications 

Deleting the first entry in a database 
When you have just found an entry, you can always delete it with . The main 
area of the ‘Find’ screen, where the entry is shown, has a highlighted border. If, 
however, you have just moved to the ‘Find’ screen, the first entry is shown. The one-
line box at the bottom is highlighted, ready for you to type a search clue. The  
key will now delete characters you type, as when editing any kind of text on the 
Series 3c. 
If you want to delete the first entry, use the ‘Delete entry’ option on the ‘Edit’ menu. 

Alternatively, press , and the main area of the screen will have the highlighted 
border. The  key can then be used to delete the entry. 
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Losing entries in the Agenda 
If a repeating entry has a fixed end date, and is set to show ‘Next only’, the entry will 
vanish after its last occurrence. To make the entry reappear, temporarily set the date on 
the Series 3c back to a date before the last occurrence. 
If a ‘Merge in’ fails (through lack of disk space, for example), it is possible for the 
Agenda to lose track of the number of to-do lists in the file. Create “new” lists, and any 
missing lists will reappear. 

Trig functions in Calc 
Functions such as ‘Sin’ and ‘Cos’ can work with either degrees or radians. (360 degrees 
equals 2*PI radians.) A ‘Use radians’/’Use degrees’ option on the ‘Special’ menu lets 
you swap between the two. You can also use the ‘Format’ option on the same menu. 

World times 
The biggest problem with calculating world times is “daylight saving”, or summer 
times, where clocks are put forward, usually for the summer months. The dates that 
clocks are set to change vary from country to country, and sometimes even within a 
country; some countries do not use summer times at all. 
The chapter on World describes summer times in detail. Countries around the world 
tend to fall into three separate zones, each with their own behaviour for summer times, 
and you can set summer times on and off at the appropriate time for these three zones.  
However, if you’re not concerned by some World times occasionally being wrong by an 
hour, think of World as two hemispheres - Northern/European combined, and Southern. 
When clocks go forward in your Home city, set your hemisphere ‘On’, and the other 
‘Off’. When clocks go back again, set your hemisphere ‘Off’, and the other ‘On’. 

‘Module does not exist’ in Calc 
If you load an OPL module in Calc, it must be available for all future calculations. If 
you delete it, or remove the SSD which contains it, a ‘Module does not exist’ message 
will be shown on every future calculation. There are two ways to solve the problem: 

•  Reinsert or recreate the translated OPL module. 

•  Exit then reopen Calc. 

‘Disconnected’ in the Files application 
If you have connected your Series 3c to a PC using PsiWin, and the link fails, e.g. if the 
link cable is removed, a ‘Disconnected’ message is displayed whenever you press  
to move to the Tree view. 

•  If you want to continue using PsiWin, replace the Link cable or re-connect using 
the ‘Link to Psion’ menu option. The ‘Disconnected’ message will disappear in the 
Files application. 

•  Alternatively, if you do not want to re-connect to the PC but do want to remove the 
‘Disconnected’ message, select the ‘Communications’ option in the System screen, 
and set the ‘Use’ line to ‘None’. 
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Password-protected files 
If you have given a password to a Word or Sheet file, and then forgotten it, that file is 
no longer available to you. You will be unable to access the password-protected file, 
until you remember the password. 
If it is the only Word or Sheet file (perhaps still called ‘Word’ or ‘Sheet’), you need to 
create a new file, and use that instead. Position the highlight under the Word or Sheet 
icon in the System screen, and use the ‘New file’ option on the ‘File’ menu. Enter a 
different name for the new file. 

Printing 

•  Paragraphs not printed correctly. Check that the indent spacing for the style in 
use is appropriate for the size of your page margins. 

•  Text has the wrong emphases. Either they are wrong in the document, in which 
case you need to replace them, or you may have used the ‘General’ printer driver, 
in which case you will need to change the printer driver the Series 3c is set up to 
use. See ‘Choosing the printer driver’ in the ‘Printing’ chapter for more details. 

•  Blank lines appear between each line of text. You should check that: 
1. You don’t have line breaks between lines in your paragraph. Paragraphs will not 

word-wrap if you press  at the end of each line in the paragraph. 

2. The line spacing is appropriate for the font size of the text. Use the ‘Spacing’ 
option. Reduce the size of the ‘Space below’ and ‘Space above’ settings (to 0, if 
every line is double-spaced), and set the ‘Alter’ line to ‘All using this style (BT)’. 

•  Some characters do not get printed correctly. If you use the ‘General’ printer 
driver for a printer that does not use the Code Page 850 character set, and you try 
to print characters between 128 and 255, some may not print out correctly. 

•  Trouble printing the “£” symbol. Check your printer manual, and see if you can 
set the printer to use a character set which has the “£” symbol as character 156 
(hexadecimal 9C). 
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Problems with Infrared communications 

If the Infrared transfer fails you will see a message that will indicate why the 
information transfer failed. Follow the advice given in the dialog, and try again. 

•  If you have transferred a file and cannot find it on the receiving Psion, it may be 
that the file has been sent to a directory whose files are not shown on the System 
screen. You will need to use the File selector to locate the file, and then either copy 
the file to another directory whose files are shown on the System screen, or use the 
File selector to “browse” directories for the file from the ‘Open file’ dialog. See 
‘Filenames not appearing in the System screen’ for more details. 

•  Information highlighted to send is not received. This may occur if you are 
sending from one application to a different one, e.g. from Word to Agenda, as the 
information which can be inserted into a single Agenda entry is limited. 

 If you want all the highlighted information to be sent, either: 
1. Create a new entry in Agenda, then use ‘Edit memo’ to start a memo for the entry. 

Repeat the Infrared transfer; all the highlighted information can be included in the 
memo.  

2. Send the information to another application, perhaps Jotter. Then use ‘Bring’ to 
copy some of the information into to your Agenda. 

Resetting the Series 3c 
You should never need to reset your Series 3c. Even if an add-on application were to 
stop working, the Series 3c is designed in such a way that it could not interfere with 
other applications, such as Data, Word, and so on.  

Killing a running application 
If you find that you cannot exit an application normally, you will need to “kill” the 
application. You can kill any application (except Time). 

 When you kill an application you will lose all the unsaved information in the file 
that was open. You should therefore only kill applications in an emergency. 

To do so: 

•  Move to the System screen, move the highlight onto the application that you wish 
to kill and select the ‘Kill application’ option on the ‘Apps’ menu. 

•  If you cannot move to the System screen, you will need to press  
 to kill the application that is currently displayed on screen 

(the foreground process). 
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Soft reset - preserving your data 
If, for any reason, your Series 3c should “lock-up”, you can always perform a 
“soft reset”; a soft reset should restart your Series 3c while preserving most of your 
data. 
It is worth trying a soft reset if: 

•  the keys on your Series 3c do not appear to respond, or 

•  your Series 3c does appear to switch on and you are sure the batteries are good 
(especially if the contrast still works but the screen is otherwise blank). 

If you do need to reset: 

•  gently press something like an unfolded paper clip into the reset hole (above the 
 key).  

When you turn the Series 3c on again it will beep, show the start-up screen again, and 
then the System screen. After a soft reset: 

•  Any changes you had made to open Sheet or Word files (or OPL programs) would 
be lost. 

•  Your other files on the internal disk will almost always be safe. 

•  If you had other applications installed (other than the built-in applications), the 
icons will have disappeared from the System screen. Use ‘Install’ from the ‘Apps’ 
menu in the System screen to re-install the application icons. 

•  Any additional file lists or application groups you had set up in the System screen 
will be lost, and you will need to set them up again. See the ‘System screen’ 
chapter for more information about groups and lists. 

•  Any alarms that you had set in the Time application are lost.  

Hard reset - losing all of your data 
It is possible (though unlikely) that an application failure causes the reset to lose the 
information on the internal disk. It could even prevent the reset from working at all. If 
this happens, you will have to perform a “hard reset”. To do this: 

•  Hold down the right-hand  key, and gently press a suitable object into the 
reset hole, as before. Press  to turn on, still holding down the right  
key.  

This will reset the Series 3c completely, and all information in internal memory, 
including the internal disk, will be lost. 

 You may not need to press  to switch on when resetting, as the Series 3c may 
turn itself on. 
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absolute reference  A cell reference that does not change when it is copied to another 
part of the spreadsheet. On the Series 3c, you put a $ symbol before each part of a cell 
reference that you wish to make absolute. 
alignment  The position of text relative to the left and right margins of a page, or the 
position of characters in a cell in Sheet relative to the edges of the cell. 
application  A computer program that is used for a particular job, such as word 
processing.  
archive  To remove Agenda entries from the current file, by copying them to another 
Agenda file, and then deleting the original entries. 
arithmetic mean  The average of a set of numbers. 
attributes  These are given to files to indicate their status: Read only, System, Hidden 
or Archive/Modified. You can change a file’s attributes by highlighting the filename in 
the System screen and selecting the ‘File attributes’ option on the ‘File’ menu. 
automatic switch off time  The amount of time the Series 3c can remain switched on 
when not in use, before it automatically switches itself off. 
backup  A copy of files which is kept in case of loss or damage to the original files. It is 
wise to make backup copies of important files on a regular basis. 
bring  The menu option that allows you to copy text from one application to another on 
the Series 3c. To use it, simply select the information you want to copy in its originating 
application, then, without exiting the application, move to the location where you wish 
to copy the text, then select the destination application’s ‘Bring’ option. 
browse  To look through the directories for a file. You can display the File selector 
from the File: Name line in any dialog and use it to browse the Series 3c’s directories. 
busy time  Time that is taken up by appointments in your Agenda. To mark time as 
“busy”, enter a timed day entry to cover the period. 
Buttonbar  The area containing the application buttons, between the keyboard and the 
screen. 
cell reference  The reference for a cell is the letter of its column and the number of its 
row, e.g. the top left cell in the worksheet is called A1. You can use cell references in 
formulae for calculations, to insert the contents of the cell at the reference in the 
calculation. 
character set  The set of characters (letters, numbers and symbols) that you can type 
and print. 
circular reference  Where you have a formula in a spreadsheet that directly, or 
indirectly refers to itself. 
clipboard  This is where copied or deleted text is placed. The text on the clipboard 
remains intact until you copy or delete something else onto it. You can insert the 
contents of the clipboard back into your document using an ‘Insert’ option. 
compress  To reduce the amount of space taken up on the Series 3c’s internal disk by 
Agenda and Data files, by reclaiming the space used by deleted and modified entries. 
Files for the other built-in applications do not need to be compressed. 
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cursor  The symbol on the screen that shows your current position. The cursor is 
usually represented by a vertical line wherever you can type, e.g. in Word, and by a 
square on dialog lines and in the Agenda. 
dated to-do entry  A to-do entry for which you have entered a due date, i.e. that you 
wish to complete by a certain date. 
daylight saving setting  The practice of setting the clocks forward by an hour during 
the summer months. This is also known as the summer time setting. 
default  The default for any action is the standard setting, i.e. what happens normally 
unless you specify otherwise. The default settings in most applications can be changed 
using the ‘Set preferences’ option on the application’s ‘Special’ menu. 
dialog  A window that appears to request or supply information. Dialogs appear when 
you have selected a menu option, such as the ‘Open file’ option, that requires you to 
supply information before the action can be completed. 
DIP switch  A switch on a printer that allows you to change its settings, for example to 
change to a different character set. 
directory  Part of the structure in which files are stored on the Series 3c. Directories 
divide up the Internal disk into smaller sections which can contain files or further 
subdirectories. 
drive  A drive (or “disk drive”) is an electro-mechanical device which reads and writes 
information on computer disks. 
emphasis  A style of type that is used to distinguish a piece of text from the text around 
it. Commonly used emphases include bold, italic and underline. 
emulate  To behave as and be able to use the same settings as another printer. 
entry  An item in the Agenda, or a page for a name and address in Data. 
entry code  A code that you can attach to entries in the Agenda to mark them as 
belonging to a particular group of entries. You can use any letter/character as an entry 
code, and you can also give a description to a code to make it easier to remember what 
the code means. 
entry number  Marks the position of a Data entry in the file. The entry number is 
displayed in the bottom right-hand corner of the screen in the Find view, along with the 
total number of entries in the Data file. 
export  To transfer Agenda entries to a time management application, e.g. Schedule+, 
on a personal computer. 
file  A collection of information that is given a filename and is saved on a disk. 
file conversion  The process by which the format of the Series 3c file types is changed 
so that they can be used with equivalent applications on another computer. E.g., 
Series 3c Word files must be converted to a personal computer word-processing 
application such as WordPerfect or Microsoft Word before they can be opened on a 
personal computer. Files from other computers must also be converted to a Psion file 
format before they can be opened on the Series 3c. Files from other Psion computers, 
the Series 3 and Series 3a, for example, can be used in equivalent applications on the 
Series 3c without the need for any conversion (the Series 3c uses the same Psion file 
formats as other Psion computers). 
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file format  The way in which information is stored in a computer file. Series 3c file 
formats and other computer file formats are not usually compatible (with the exception 
of a few Psion-specific applications that can use Series 3c files on a personal computer). 
To use a Series 3c file on another computer, the file must be converted to a suitable 
format. For personal computers running Microsoft Windows, PsiWin makes file 
conversion straightforward. 
file list  The list of files underneath an application icon on the System screen. 
file specification  Indicates the location in which a file is stored on a computer disk. A 
file specification consists of the name of the disk on which the file is stored, followed 
by the path to the file, then the filename and filename extension. 
filename  The name given to a file. A filename must be no more than 8 characters and is 
followed by a dot (.) and a three letter extension - for example, MYLETTER.WRD.  

filename extension  In the MS-DOS and Series 3c filing systems, every file is given a 
three letter extension to indicate the application that created it (.WRD for Word 
documents), or its type (.TXT for text files). The extension is written after a full stop 
following the filename, like this: FILENAME.EXT. 

font  The name given to a particular typeface. 
forced line break  A way of starting a new line without starting a new paragraph. 
formatting disks  This involves writing special information onto a disk which is used 
by the Series 3c to help it store and retrieve files. This process also deletes all the files 
on the disk, so you shouldn’t format a disk unless you have backup copies of the files it 
contains, or you’re sure you don’t want the files. 
group  A selection of applications or icons which is listed under a single icon in the 
System screen. 
handshaking  This is the method the Series 3c uses to start and stop the flow of 
information to a printer. Most serial printers can use XON/XOFF handshaking or 
DSR/DTR or both. The Series 3c is initially set to use both and should successfully 
print even if your printer uses only one of these methods. If you have problems printing, 
try setting one or other of the two to Off. 
hard reset  The type of reset that clears all the information from the Series 3c’s Internal 
memory, deletes all the files on the Internal disk, and returns all the applications to the 
state they were in when you first used the Series 3c, i.e. removes all the preferences you 
have set up. You should only perform this type of reset in emergencies. 
highlight  Where the text appears in white on black, instead of black on white. You use 
a highlight to select things, e.g. menu options, or to mark text (or cells in Sheet) that 
you wish to work on. 
hot-key  A shortcut keypress that provides you with a quicker way of selecting menu 
options. You will see the hot-key for a menu option beside its name on the menu; it 
consists of a symbol that represents the Psion key and a letter. To select an option using 
its hot-key, hold down the Psion key and press the letter for the hot-key at the same 
time.  
icon  A picture representing an application. 
Internal disk  The Series 3c’s main file storage location. 
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keyword  A command in the OPL programming language. 
killing an application  This exits the application without saving changes to the file that 
was open in the application; there is some risk of corrupting the file. You should only 
kill applications if you cannot exit them normally. 
label  On a disk, the label is the name given to the disk. You may label Solid State 
Disks using the ‘Name disk’ option on the ‘Disk’ menu in the System screen. 
line spacing  Line spacing settings determine how much space appears between the 
lines of text in your printout. 
memo  A note that you can attach to an Agenda entry. 
Menubar  The horizontal bar near the top of an application screen. The Menubar 
contains the names of all the menus of options for the application. You display the 
Menubar by pressing the Menu key. 
menu  A list of options for the things that you can do in an application. Menu option 
names appear in the Menubar near the top of the window. 
module  A unit of code in the OPL programming language. Modules are also known as 
procedures. 
MS-DOS  Acronym for the Microsoft Disk Operating System. 
OPL  This is the programming language that is built into the Series 3c; you can use it to 
write your own programs and functions for the Series 3c. 
Open entry  An Agenda entry that you would like to be exported when you transfer 
your Agenda to a personal computer. 
operator  A mathematical command, e.g. + is the operator to add numbers. 
option  A command for performing an action in an application.  
overwrite  To delete a file by replacing it with another file of the same name. The 
information in the original file is lost. 
owner information  The information you enter about yourself using the ‘Set owner’ 
option.  
parallel  A type of communication used by computers and printers. 
password-protect  To protect the Series 3c or an individual Word or Sheet file from 
prying eyes, by setting a password. 
paste  Insert an entry or piece of text that you have cut or copied. 
path  Specifies the location of a file or directory. Paths are written in the order 
drive\directory\filename, e.g. LOC::M:\WRD\FRED.WRD. 

precedence (of operators)  Calculations which use more than one operator produce 
different results according to the order of the calculation. E.g. 7+3x4 gives 40 if you 
work out the addition first, or 19 if you work out the multiplication first. Calculators 
normally use what is known as operator precedence to ensure that calculations always 
give the same result: they assign each operator a certain rank (or precedence), and then 
calculate those operators with the highest rank first. Calc’s Desk view does not use 
operator precedence when working out calculations (calculations are simply worked out 
from left to right), whereas the Advanced view does.  
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preferences  Your preferred settings for the way an application looks or works. You 
can change them using the ‘Set preferences’ option on the ‘Special’ menu in most 
applications. 
print range  The selection of cells that you wish to print from Sheet. 
printer configuration  The settings that determine how the Series 3c communicates 
with a printer. 
printer driver  A software file that makes the Series 3c send information in the 
appropriate way for a particular printer. 
printer model  The name of a printer. 
Private entry  An Agenda entry that you do not want to be exported when you transfer 
your Agenda to a personal computer. 
procedure  A unit of code in the OPL programming language. Procedures are also 
known as modules. 
procedure template  The template for the Program editor that provides you with the 
keywords that you need at the start and end of a procedure. 

Psion key  The key marked  in the bottom left corner of the keyboard. It is used in 
combination with other keys to produce special keypresses or functions. 
range reference  A reference that relates to a number of adjacent cells in a spreadsheet. 
read only  Files which are marked read only cannot be written to or changed. However, 
if you copy the file and rename it you may then write to it. Making a directory read only 
does not affect the files within the directory. 
relative reference  A cell reference in a formula that automatically changes to reflect its 
new position when you copy it to another part of a spreadsheet. 
Restricted entry  An Agenda entry that you do not wish to automatically export when 
you transfer your Agenda to a personal computer. 
root directory  The top level directory on a computer disk in which all the other 
directories are stored.  
RS232  The standard which defines the serial port. 
search clue  The text or numbers that you would like Data to look for in each entry to 
find the entry(ies) you require. 
select  To mark an item, e.g. a menu option, so that a subsequent action can be 
performed on it. You usually select an item by highlighting it. 
serial  A method of communication used by computers and printers. 
serial port  A connection or socket that can be used to connect the Series 3c to a device 
such as a printer or personal computer. 
shortcode  The two-letter code that you use to apply a style or emphasis in Word. 
snooze  To stop an alarm, wait for five minutes and then sound the alarm again. 
soft hyphen  This marks a place at which hyphenation for word-wrap can occur if 
necessary. A soft hyphen only appears on a printout if it causes word-wrap to occur. 
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soft reset  The type of reset that clears all the information from the Series 3c’s Internal 
memory, e.g. changes you have just made to open Word or Sheet files, without deleting 
all your files on the Internal disk. You should only perform a soft reset in emergencies 
Solid State Disk  See SSD. 
sort  To rearrange the order of the entries in a Data file. 
SSD  The acronym for Solid State Disk, the Psion equivalent of a PC floppy disk. SSDs 
store files and can be inserted into and removed from the two SSD drives, marked A 
and B. An SSD inserted in an SSD drive appears as Disk A or B in dialogs where you 
can select a disk, e.g. when choosing the disk on which to backup files. 
start year  The setting for an Anniversary entry in the Agenda that you use to record 
the year that a person was born, or the year in which the event for which you celebrate 
an anniversary took place. 
Status window  A window which displays the current time and date, the name of the 
current application or file, and other optional information, such as a battery indicator, 
Caps Lock indicator etc.  
style  A style is a collection of formats which is applied to a complete paragraph. Styles 
can use particular alignment, tab and indent settings, line spacing and fonts. 
subdirectory  A directory within another directory. (Subdirectories can also contain 
other subdirectories.) 
substitute fonts  To replace a font that you used in a document, but which is not 
provided in the printer driver that you have chosen to use, with an equivalent one that is 
provided by the printer driver. 
summer time setting  The practice of setting the clocks forward an hour during the 
summer months. 
system password  The password which protects the Series 3c itself. When you set a 
system password, the Series 3c will not turn on until the password is entered. 
System screen  The control panel for the Series 3c from which you can access all its 
applications and files. This is also where you can change the settings that apply to more 
than one application. 
tab stop  A pre-set position on the page to which you can move text by pressing the Tab 
key. You can set up a number of different Tab stops across the page. 
tab type  The setting that determines how text will be aligned in relation to a tab stop, 
i.e. whether it goes to the right of the tab stop, to the left, or is centred on the tab stop 
position. 
tag  To mark a file as being part of a group of files on which you wish to work. 
templates  You can use templates as the basis for new documents.  
text file  A file format that can be used by many different computer applications. Text is 
saved without any formatting or layout that has been applied to it. 
tidy  To remove unwanted entries from an Agenda file. You can either archive the 
unwanted entries, or simply delete them. 
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till roll  The display that appears above the calculation area in Calc’s Desk view to 
show your previous calculations. 
timed day entry  An Agenda entry for which you have entered a start time and 
duration. The entry appears as busy time in the Busy view. 
Tips  A series of tips about how to get the most from your Series 3c. You can set them 
to appear once a day, every time you turn the Series 3c on or you can turn them off. 
translate  The process by which an OPL program is compiled so that it can be run on a 
Series 3c. 
typeface  The name given to a set of letters, numbers etc. that are all of the same design. 
The typeface used for most of the text in this manual is called Times New Roman. 
undated to-do entry  A to-do entry for which you have not entered a due date, i.e. that 
you do not wish to complete by a certain date. 
uninstalling an icon  Removing an icon to tidy up your System screen. 
untimed day entry  An Agenda entry for which you have not entered a start time and 
duration. The entry will not appear in the Busy view. 
views  The different screens in the Series 3c’s applications. 
worksheet  The name used for a file in Sheet. 
wrap  To change where lines of text break to make them fit on the screen. 
X-axis  The horizontal axis on a graph. 
Y-axis  The vertical axis on a graph. 
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Appendix 

This Appendix contains details of: 

••••  the Series 3c character set. 

••••  the Series 3c specification. 
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Character set (IBM Code Page 850)  
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The Series 3c contains many fonts, but all have the same basic character set. This is the 
IBM Code Page 850 character set (shown opposite). 

•  Characters with decimal codes from 32 to 127 are the same as ASCII characters. 
Those from 0 to 32 are special control codes. 

•  These are the characters available on the Series 3c. For each character, first the 
decimal, then the hexadecimal code is given.  

•  32 is the space character.  

Entering characters at the keyboard 
Any of the characters in the character set can be entered directly from the keyboard: 
1. Look up the decimal code of the character you want in the preceding table. 

2. Hold down the  key and type the 3-digit code, then release the  key. 

Make sure you add preceding zeros if necessary to make a code three digits long - for 
example, use  096 to enter a left single quote, `. 

Accented characters 
The  key turns the number keys 2 to 6 into accent keys. 

 umlaut/diaeresis "   

 grave  `    

 acute  ´ 

 tilde  ~   

 circumflex ^ 

The letters , , , , , ,  (upper or lower case) can be accented, as 
appropriate. 

To get the accent, hold down the  key while you press the accent's number. Then 
press the letter to be accented. It will appear on the screen with an accent. 
Examples: 

  then  gives à 

  then  gives ü 

  then  gives ñ 

 To get the letters in upper case, either have Caps Lock on or hold down a  
key while you enter the letter. 
Example: 

  then   gives Ñ 
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Other characters 
Press  then the letter shown below to get the following accented characters 
or symbols: . 

  å  Å 

 ç  Ç 

 ð  Ð 

 æ  Æ 

 ø  Ø 

 Þ  þ 

 ß   ¿ 

 «   » 

 ¡   £ 

All of these characters are part of the character set given earlier. 
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Specification 
Dimensions: 
Size: 165mm x 85mm x 22mm (6.5" x 3.3" x 0.95"). 
Weight: 275g including batteries. 

Screen: 
480 x 160 pixel high contrast LCD graphics screen. Up to 80 characters by 25 lines. 
High contrast, retardation film LCD. 

Internal memory: 
ROM: 2Mbyte containing multi-tasking, windowing operating system, Microsoft 
MS-DOS Flash Filing System, and software applications. 
RAM: 1M or 2M. 

Solid State Disks: 
Size: 63mm x 43mm x 6mm / 2.5" x 1.75" x 0.2". 
MS-DOS format for compatibility with desktop computers. 
Flash SSDs require no battery backup; capacity from 128K up to several megabytes. 
RAM SSDs have their own Lithium battery; capacity from 128K. 
2 SSD drives. 

Processor: 
16 bit NEC V30H (80C86 compatible), 7.68 MHz. 

Sound: 
Loudspeaker for DTMF auto-dialling and digital sound playback. 
Microphone for digital sound recording. 

Power: 
2 x AA size Alkaline batteries, giving approximately 80 hrs use (without expansions); 
2-4 months of typical usage. 
Standard Lithium (CR 1620) backup battery protects RAM while main batteries are 
changed. 

Optional External AC adaptor (10V±10% (9V-11V), 250mA).  
Approved models: 1602-0001-02 (UK); 1602-0002-02 (Europe); 1602-0014-01 (US) 

Keyboard: 
58 key, QWERTY layout, computer-style keyboard. 
9 touch-sensitive buttons for application selection. 
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Operating temperature: 
0 - 50°C when running from internal batteries.  
0 - 40°C when running from AC (mains) adaptor. 

Communications options: 
•  IrDA SIR optical link supports infrared communications. 

•  RS232 serial link (with Link cable) provides interface to other computers, modems 
and serial printers. 

•  XMODEM, YMODEM and ZMODEM protocols, give compatibility with most 
computer communications software. 

•  Full script language allows automated log-on to electronic mail and other systems, 
and control of modems. 

•  Optional Parallel Printer Link provides interface for parallel printers. 

•  Optional PsiWin software (with Link cable) provides windows based file 
management, file conversion, and TrueType™ printing for a linked PC running 
Microsoft Windows. 

•  Additional software supplied with PsiWin provides a simple interface for 
exchanging information with IBM PC compatibles and the Apple Macintosh, 
giving direct remote file access. 
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Index 

Symbols 
# character, in Sheet, 199, 213 
� symbol, 75, 86, 93 
$ character 

currency symbol, 256 
in Sheet, 208 

&, in Sheet, 203 
*, in Sheet, 199, 232 
*, in World, 106 
+ symbol, in Sheet, 203 
... 

after option names, 15 
in the System screen, 260, 354 
on dialog lines, 16 

<, in Sheet, 231 
<=, in Sheet, 231 
<>, in Sheet, 231 
=, in Sheet, 202 
>, in Sheet, 231 
>=, in Sheet, 231 
>>, in Agenda, 44 
?, in Sheet, 232 
\, in Sheet, 222 
~ , in Sheet, 232 
£ character 

currency symbol, 256 
¥ character, in Sheet, 215 
24 hour clock, 12, 105, 132 

A 
abbreviations, in Spell, 171 
ABS function, in Sheet, 236 
absolute references, in Sheet, 208, 232, 362 
accented characters 

entering, 371, 372 
in Sheet, 218 
in Spell, 173 

ACOS function 
in Calc, 115 
in Sheet, 235 

acronyms, in Spell, 171 
Add city option, in World, 130 
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Add view, in Data, 74 
adding 

alarms, in Agenda, 56 
anniversaries, in Agenda, 35 
appointments, in Agenda, 31 
birthdays, in Agenda, 35 
cities, to World, 129, 130, 131 
countries, to World, 130 
data, in Sheet, 209 
duplicate icons, 264 
entries, in Data, 75 
entry codes, in Agenda, 62 
extra lines, in Data, 75 
labels, in Data, 86 
lists of things to do, 38 
new applications, 261 
notes, in Jotter, 98 
numbers, in Calc, 122 
numbers, in Sheet, 202 
text strings, in Sheet, 203 
titles, in Sheet, 199 

addresses, 19, 74 
adjectives, in Spell, 175 
Adjust for alarm option, 194 
adverbs, in Spell, 175 
Agenda 

adding entries, 31, 35, 38 
alarms, 47, 56, 57, 58 
anniversaries, 35 
appointments, 50 
backup files, 68 
BC dates, 36 
bell symbols, 57 
birthdays, 35 
bold text, 48 
Busy view, 54 
busy/free time, 54 
calendars, 34 
clipboard, 47 
completed to-dos, 42 
copying entries, 47 
creating a new file, 68 
crossed out entries, 53, 66 
crossing out entries, 47 
date range, 36 
Day view, 50 
deleting entries, 47, 66 
duration of entries, 32 
entry codes, 36, 60, 62, 63 
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exiting files, 57 
finding entries, 53 
hidden entries, 45 
how views look, 50, 51, 52, 55, 65 
icon, 9 
Infrared, 344 
inserting entries, 47 
italic text, 48 
List view, 52 
losing entries, 356 
memos, 58, 59, 60 
merging two Agenda files, 67 
moving to today, 35 
overlapping entries, 32 
overnight entries, 31 
printing, 327, 332 
reclaiming disk space, 67 
reminders, 56 
repeating entries, 35, 43, 44, 53 
saving files, 68 
slot compression, 49 
text size, 49 
time separator, 49 
time slots, 49, 50 
to-do lists, 38, 40, 41, 66 
To-do view, 72 
underlined text, 48 
Week view, 51 
workday alarms, 57 
workday repeats, 44 
Year view, 63 

alarms 
adjusting sound files, 194 
disabling, 110 
in Agenda, 56, 109 
in Time, 107 
repeats in Soundmaster, 194 
responding to, 108, 109 
setting, 107, 108 
soft reset, 359 
Soundmaster files, 194 
sounds, 107 
troubleshooting, 349 
turning alarm sounds on/off, 255 
viewing next, 109 
WAV files, 189 
workday alarms, 57, 105, 107 

alignment 
about, 362 



 378

in Sheet, 213 
in Word, 144 

alphabetical order 
in Data, 84 
in Sheet, 211 

ALS files, 275 
am-pm clock, 12, 132 
anagrams, solving, 176 
analog clocks, 13 
AND operator, in Sheet, 203, 232 
anniversaries, in Agenda, 35 
Anniversary view, in Agenda, 35 
annuity investments, 239, 240 
applications, 18 

about, 15, 362 
add-on applications, 261 
appearance, 18 
Buttonbar buttons, 14, 262 
closing, 259 
groups, 267 
installing, 261 
killing an application, 358 
moving between, 14 
opening, 259 
preferences, 18 
removing, 262 
views, 23 

appointments, in Agenda, 19, 31 
APR, in Sheet, 237 
archive files, 362 
arithmetic mean, 362 
arrow keys, 23 
arrows, in dialogs, 16 
ASIN function 

in Calc, 115 
in Sheet, 235 

associating files, using Files, 292 
AT function, in Sheet, 245 
ATAN function 

in Calc, 115 
in Sheet, 235 

ATAN2 function, in Sheet, 235 
auto recalculation, in Sheet, 204 
Auto switch off option, 253 



 379

averages, calculating 
in Calc, 122 
in Sheet, 246 

AVG function, in Sheet, 246 
axes on graphs, in Sheet, 222, 224 
Axis option, in Sheet, 224 

B 
background drawing, 220 
backing up. See backups 
Backspace key, 23 
backup battery, 373. See batteries 
Backup files option, 316 
backups, 22, 316 

about, 362 
files, 316, 319 
importance, 312 
on a PC, 320 
on SSDs, 316 
Sheet files, 216 

Bad number message, 116 
bar graph, 219, 220, 227. See also graphs 
Bargraph display format, in Sheet, 214 
batteries, 373 

backup, 4, 26, 373 
changing, 25, 26 
checking, 27 
fitting, 4, 5 
in Ram SSDs, 272 
life, 25 
low, 25 
main, 4, 26, 373 
playing sound, 188 
rechargeable, 5, 25 
saving Agenda entries, 69 
saving power, 204 
troubleshooting, 348 
types, 4 
usage monitor, 28 

Batteries too low for digital audio message, 188 
Battery info option, 27 
Battery too low message, 69 
Battery too low to write to Flash message, 69 
beeping, 255 
birthdays, 35 
blank lines, in Data, 75 
bold text 
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in Agenda, 48 
in Sheet, 215 
in Word, 142 

brackets, in calculations, 114 
Bring from list option, in Calc, 114 
Bring options 

about, 362 
copying notes from Jotter, 101 
in Agenda, 46, 48 
in Data, 82, 83, 84 
in Sheet, 210 
in Spell, 176 
in Word, 138 
tabs in Word, 210 

British Summer Time. See summer times 
bulleted lists, in Word, 151 
busy time, in Agenda, 362 
Buttonbar, 6, 9, 14, 362 

assigning a button, 262 
Jotter button, 99 

buttons in dialogs, 16 

C 
Calc 

Advanced view, 112 
changing the sign of a number, 112 
changing views, 112 
clearing calculations, 113 
clearing the memory, 117 
constant expressions, 113 
decimal places, 120 
Desk view, 112 
Fixed number format, 121 
functions, 122 
General number format, 121 
hexadecimal numbers, 121 
icon, 9 
long integers, 123 
memories, 117 
Module does not exist message, 123 
operators in Advanced view, 114 
OPL procedures, 123 
parameters to OPL, 123 
percentages, 119 
powers, 115 
recalling the number in memory, 117 
renaming memories, 119 
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Scientific number format, 121 
squaring numbers, 112, 115 
storing a number in memory, 117 
Too big for fixed format message, 121 
unloading OPL modules, 123 
using more than one memory, 118 
very large/small numbers, 116 

calculations 
in Calc, 112 
in Sheet, 196, 200, 202 
what if? type, 196, 204, 233, 234 

calendars 
in Agenda, 34 
in dialogs, 17 

cancelling, 18 
actions, 23 
changes, in Soundmaster, 190 
Infrared, 343 
printing, 340 

capital letters, 24 
care of Series 3c, 22 
Case and accents setting, in Spell, 173 
case sensitivity, in Sheet, 211, 231 
cash flow calculations, 238 
categorising Agenda entries, 60 
cell attribute functions, in Sheet, 248 
cell pointer, in Sheet, 197, 204, 216, 248 
cell references, in Sheet, 197, 202, 203, 208, 362, 366 
centimetres, 147 
Change entry date option, in Agenda, 47 
Change entry details option, in Agenda, 46 
Change memories option, in Calc, 119 
Change sign option, in Calc, 112 
Change styles option, in Sheet, 214 
changing 

alarms, 108 
date, 105 
display, in Sheet, 200 
entries, in Agenda, 46 
entries, in Data, 76, 81 
fonts, in Sheet, 223 
information, in World, 131 
labels, in Data, 86 
margins, in Word, 327 
owner information, 312 
paragraph spacing, in Word, 329 
passwords, 314, 315 
range names, in Sheet, 201 
screen display in World, 132 
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text, in Sheet, 214 
time, 105 
titles, in Sheet, 199 
views in applications, 23 

CHAR function, in Sheet, 245 
character set, 362, 370, 371 
CHOOSE function, in Sheet, 236 
chronological order, in Data, 84 
circular references, in Sheet, 205 
cleaning the Series 3c, 22 
Clear option, in Sheet, 205 
clearing 

alarms, 109 
cells, in Sheet, 205 
formatting, in Sheet, 205 
previous calculations, in Calc, 114 

clocks, 13 
CODE function, in Sheet, 245 
Collapse outline option, 160 
COLS function, in Sheet, 248 
column titles, in Sheet, 199 
Column widths option, in Sheet, 213 
columns 

in Data, 76, 87 
in Sheet, 197, 208, 213 

comment lines, in Program, 299 
Comms 

Baud rate, 309 
installation, 309 
Terminal emulation screen, 309 

Communications option, 258, 342 
Compare directories option, 293 
comparison operators, in Sheet, 231 
compiling programs, in Program, 299 
Compress file option 

in Agenda, 47, 67 
in Data, 89 
in Jotter, 102 

compressing files, 362 
concatenating strings, in Sheet, 203 
conjunctions, in Spell, 175 
contrast, 7, 348 
Convert to SPR format dialog, 218 
converting 

formulae to values, in Sheet, 206 
converting currency, 119, 298 
converting files, 363 
copies of files, 312 
Copy text option 
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in Data, 82, 83 
in Jotter, 101 
in Word, 138 

copying 
Agenda entries, 46, 47, 342 
between applications, 210, 362 
between Series 3cs, 342 
between spreadsheets, 207, 210 
criterion ranges, in Sheet, 231 
Data entries, 342 
database ranges, in Sheet, 231 
disks, 281 
Data entries, 83 
files, 319 
files, by Infrared, 342 
files, in the System screen, 276 
formulae, in Sheet, 202, 207, 209 
in Files, 290 
in Sheet, 200, 207, 209, 210 
in Word, 138 
Infrared, 342 
notes, from Jotter, 101 
Sheet files, 216 
spreadsheets to other Psions, 217 
styles and emphases, in Word, 155 
text, by Infrared, 342 

correcting spelling. See Spell 
COS function 

in Calc, 115 
in Sheet, 235 

COUNT function, in Sheet, 246 
Count option, in Word, 139 
counting pages, 328, 330 
counting words, in Word, 139 
Create new group option, 268 
Create new list option, 264 
Create PIC file option, in Sheet, 226 
creating 

directories, in Files, 293 
directories, in the System screen, 278 
emphases, in Word, 149 
graphs, 224 
labels in Data, 88 
new files, in Agenda, 68 
new files, in Data, 88 
new files, in Word, 161 
new files, in World, 131 
spreadsheets, 196 
styles, in Word, 152 
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templates, in Word, 157 
criterion range, in Sheet, 229 
Crossing out, in Agenda, 42, 47 
crossword puzzles, solving, 176 
CTERM function, in Sheet, 238 
currency, 256 

converting, 119, 298 
Currency format, in Sheet, 214, 215 
currency symbol, in Sheet, 215 
negative amounts, 255 
Yen character, 215 

Current country only option, in World, 127 
cursor, 363 
cutting. See deleting 

D 
D$C files, 180 
daily alarms, 107 
Data 

adding entries, 75 
copying entries, 83 
creating a new file, 88 
deleting entries, 82 
deleting first entry, 355 
editing entries, 81 
entering a tab character, 75 
finding entries, 76, 79 
icon, 9 
Infrared, 344 
labels, 74, 96 
merging two files together, 89 
printing, 327, 335 
sorting entries, 84 
viewing entries, 76 

Data find option, in Sheet, 230 
database statistical functions, 247 
databases, in spreadsheets. See Sheet 
date 

changing the format, 105 
setting the date, 104, 126 

Date format, in Sheet, 214 
DATE function, in Sheet, 242 
dated To-do entry, 363 
dates, in dialogs, 17 
DATEVALUE function, in Sheet, 243 
DAVG function, in Sheet, 247 
DAY function 
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in Calc, 122 
in Sheet, 243 

day numbers, in Sheet, 218 
Day view, in Agenda, 30 
daylight saving, 106, 128, 363 
DCOUNT function, in Sheet, 247 
DDB function, in Sheet, 241 
decimal places, 214 

in Calc, 120, 121 
decimal point, 215 
decimal separator 

in Calc, 122 
in the System screen, 256 

Default country, 91 
Default disk option, 273 
default number format, in Sheet, 214 
default settings, about, 363 
default template, in Word, 158 
degrees/radians 

converting, 235 
in Calc, 115, 356 

Delete alarm option, in Time, 108 
Delete cells option, in Sheet, 208 
Delete entry option, in Data, 82 
Delete graph option, in Sheet, 225 
deleting 

Agenda entries, 47, 66 
alarms, 108 
cells, in Sheet, 205, 208 
cities, in World, 132 
columns, in Sheet, 208 
countries, in World, 132 
database records, in Sheet, 230 
directories, in Files, 291 
entries in Data, 355 
entries, in Data, 82 
entry codes, in Agenda, 63 
files, in Files, 291 
files, in the System screen, 275 
graphs, 225 
icons, 262 
memos, in Agenda, 60 
notes, in Jotter, 101 
on dialog lines, 12, 23 
range names, in Sheet, 201 
rows, in Sheet, 208 
Sheet files, 216 
sounds, in Soundmaster, 192 
styles and emphases, in Word, 154 
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text, 23 
text, in Word, 137 
to-do lists, in Agenda, 40 

depreciation calculations, 241 
dial codes. See also dialling 

in World, 126 
dial keypress, 92 
Dialling option, in System screen, 91 
dialling phone numbers 

free-form dialling, 95 
from Agenda, 92, 93 
from Data, 90, 92 
further digits, 92 
in the USA, 95 
problems, 95 
setting up, 91 
when abroad, 93 

dialogs 
... on lines, 16 
about, 363 
displaying, 16 
entering dates, 17 
entering numbers, 17 
removing, 23 
saving settings, 16 
unavailable lines, 17 
with buttons, 16 

diamond key, 23 
and memory information, 351 
in Agenda, 33, 53 
in Data, 85 
in Sheet, 219 
in the System screen, 254, 351 

dictionaries, in Spell, 179 
DIF file format, 218 
digital clocks, 13 
directories 

about, 363 
comparing, in Files, 293 
creating a new directory, 278 
creating, in Files, 293 
default, 275 

Disable/Enable alarm option, in Time, 110 
disabling 

alarms, 110 
system password, 314 
undo feature, in Sheet, 206 

Disconnected message, 356 
disk drive, 363 
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Disk full error message, 217 
Disk full message, 162, 353 
Disk info option, 269, 272 
disks 

copying, 281 
default disk, 273 
formatting, in Files, 293 
information, in Files, 288 
LOC:: disk, 280 
M: disk, 279 
naming disks, 273 
REM:: disk, 280 
volume names, 293, 351 

displaying 
calendars, 34 
graphs, 221, 225 
memory bar, 254 
negative values for currency, 255 
Status window, 12, 254 

distance for Infrared, 343 
DMAX function, in Sheet, 247 
DMIN function, in Sheet, 247 
document dictionaries, 180 
documents, managing, 72 
drive, 363 
drivers 

General printer driver, 325 
printers, 324 

DSTD function, in Sheet, 247 
DSUM function, in Sheet, 248 
DVAR function, in Sheet, 248 



 388

E 
E. message, in Calc, 113 
echoes, in Soundmaster, 193 
Edit alarm option, in Time, 108 
Edit entry option, 81 
Edit labels option, in Data, 86 
Edit memo option, in Agenda, 58, 59 
Edit range option, in Sheet, 201 
editing 

cells, in Sheet, 205, 206 
entries, in Agenda, 46 
entries, in Data, 81 
information, in World, 131 
keys to use, 24 
OPL programs, in Program, 297, 300 
preventing, in Sheet, 206 
range names, in Sheet, 201 
strings, in Sheet, 244 
text, in Data, 81 
text, in Word, 136 
titles, in Sheet, 199 

emphases, in Word, 148 
Emphasis gallery option, in Word, 148, 150 
Emphasis housekeeping option, in Word, 149 
emulation, 363 
End key, 24 
ENDP: keyword, in Program, 297 
entering 

accented characters, 371 
anniversaries, in Agenda, 35 
appointments, in Agenda, 19, 50 
birthdays, in Agenda, 35 
data, in Sheet, 198 
information, 19 
names and addresses, 20, 74 
notes, in Agenda, 58 
numbers to dial, 93, 94, 95 
owner information, 312 

entry codes, in Agenda, 60, 62, 363 
entry numbers, in Data, 77, 363 
ERR function, in Sheet, 250 
error beeps, 255 
error functions, in Sheet, 250 
error messages 

Bad number, 116 
Batteries too low to write to Flash, 69 
Battery too low, 69 
beeping, 349 
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Disconnected, 356 
Disk full, 162, 217, 353 
File deleted: cannot exit until file is saved, 162 
File or device in use, 355 
Illegal character, 210 
Invalid margins, 327 
Label too long, 87 
Maximum number of characters reached, 163 
Media is corrupt, 351 
Memory full, 353 
Mismatched (or), 210 
Module does not exist, 123, 356 
No system memory, 163, 270, 353 
Overflow, 116, 163 
Please replace volume, 351 
Sound is disabled, 255 
Syntax error, 114, 210 
Too big for fixed format, 121 
Too complex, 210 
Too many processes, 350 
Type mismatch, 210 
Underflow, 116 

Esc key, 18 
Evaluate 

format for results, 255 
in Agenda, 46 
in Data, 82 

EXACT function, in Sheet, 244 
Examine repeat option, in Agenda, 45 
exchange rates, 119 

writing a program in OPL, 298 
Exit all applications option, 259 
Exit, lose changes option 

in Sheet, 216 
EXP function,in Sheet, 236 
Expand outline option, 160 
exponential numbers 

in Calc, 116 
in Sheet, 214 

exporting files, 218, 363 
Extract option, in Sheet, 230 
Extract unique records only?, 230 

F 
F in calculation line (Desk view), 120 
Fade in/Fade out option, in Soundmaster, 190 
FALSE function, in Sheet, 237 
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fields, in Sheet, 228 
File associations, 292 
file attributes, 280, 286, 313, 362 
file conversion, 363 
File deleted: cannot exit until file is saved message, 162 
file extensions, 274, 364 

displaying in Files, 286 
file lists, 18 

about, 364 
in the System screen, 264, 265 

File or device in use message, 309, 355 
File selector 

displaying, 277 
finding files, 277 
tagging files, 278 

file size 
displaying in Files, 286 

file specification, 364 
filenames, 18, 364 

in bold, 14 
files, 18 

about, 363 
ALS files, 275 
and file extensions, 274 
ASCII files, 164 
attributes, 362 
conversion of, 363 
D$C files, 180 
dictionary files, 180 
DIF file format, 218 
exporting, 218 
file attributes, 286 
file lists, in the System screen, 260 
Files application, 285 
formats, 364 
groups and lists, 359 
GRP files, 275 
in Data, 88 
in Word, 161, 163, 164 
in World, 131 
listing, 264 
moving between lists, 265 
OPD files, 300 
opening more than one file, 260 
OPL files, 298 
OPO files, 300 
passwords, 315 
pathnames, 279 
plain text files, 164 
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printing to a file, 324 
read-only files, 286 
root directory, 274 
RTF files, 166 
Series 3/3a Agenda files, 69 
Sheet files, 216, 217 
SPR file format, 218 
troubleshooting, 355 
where files are stored, 275 
WKS/WK1 file format, 218 
WRT files, 157, 158 

Files application 
associating files, 292 
comparing directories, 293 
copying, 290 
creating directories, 293 
deleting, 291 
directories, 287 
Disconnected message, 356 
displaying file information, 286 
file attributes, 286 
formatting disks, 293 
hidden files, 286 
icon, 9 
memory information, 288 
modified files, 286 
moving, 290 
naming disks, 293 
renaming, 290 
sorting files in File list view, 286 
system files, 286 
tagging files and directories, 289 
untagging files and directories, 290 
utilities, 294 
wildcards, 286 

filters, in Soundmaster, 193 
Find again option 

in Agenda, 54 
in Sheet, 212 
in Word, 140 

Find by label option, in Data, 80 
Find file option, 291 
FIND function, in Sheet, 244 
Find option 

in Sheet, 212 
in Word, 140 

finding 
Agenda entries, 44, 53 
alarms, 53 
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cities & countries, in World, 127 
crossed out entries, in Agenda, 53 
database records, in Sheet, 229, 231 
entries, in Data, 76, 77 
files, in Files, 291 
in Sheet, 200, 212 
notes, in Jotter, 100 
repeat entries, in Agenda, 44, 53 

Fixed number format 
in Calc, 120, 121 
in Sheet, 214 

Flash SSDs, 271, 373 
Sheet files, 216 
Soundmaster, 186 
Word files, 162 

fonts, 364 
about, 368 
in the System screen, 257 
in Word, 145 
on graphs, 223 
printing, 326 

forced line breaks, in Word, 135, 139 
foreign characters, 371, 372 
Format disk option, 271 
Format option 

in Calc, 121 
in Sheet, 214, 220, 225 

Formats option, in Time, 105, 132 
formatting 

disks, 293, 364 
in Sheet, 205, 209, 213 
in Word, 148 
text on graphs, 223 

formulae 
converting to values, in Sheet, 206 
copying, in Sheet, 207, 209 
in Sheet, 198, 202, 203, 204, 214 

Function argument error, 210 
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functions 
in Calc, 122 
in OPL, 122, 297 
in Sheet, 203, 232, 235 

FV function, in Sheet, 240 

G 
games. See Patience 
General number format 

in Calc, 121 
in Sheet, 214 

General printer driver, 325 
global dictionary, in Spell, 180 
Glossary, 362 
graphs 

3D graphs, 220 
background drawing, 220 
colour of bars, 227 
compatibility with Lotus 1-2-3, 219 
creating, 224 
deleting, 225 
displaying, 220, 221 
fonts for text, 223 
grid lines, 221 
labels, 221, 223 
legends, 222 
menu options, 220 
named ranges, 221 
number formats, 224 
printing, 226 
ranges, 220 
renaming, 225 
saving, 221 
saving as PIC files, 226 
titles, 221, 222 
types, 220, 225 
viewing, 225 
X labels, 222 

grid lines 
in Data, 77 
in Jotter, 100 
in Sheet, 215 
on graphs, 221, 223 

grouping Agenda entries, 60 
groups and lists, 359 
groups, in the System screen, 267 
GRP files, 275 
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H 
handshaking, 364 
hanging indents, in Word, 145 
hard hyphens, in Word, 135 
hard reset, 314, 364 
headings, in Word, 151 
Help, displaying, 10 
hexadecimal numbers, 121 
hidden characters, in Word, 139 
Hidden display format, in Sheet, 214 
hidden files, 286 
Hide grid option 

in Data, 77 
in Jotter, 100 

Hide labels option, in Data, 87 
hiding 

cells, in Sheet, 215 
time slots/lines, in Agenda, 50 

Highlight all text option 
in Agenda, 60 
in Word, 137 

highlighting, 24, 364 
in Sheet, 200 
in Word, 136 
in World, 126 
paragraphs, 24 
text, 24 
words, 24 

History option, in Spell, 174 
HLOOKUP function, in Sheet, 249 
home city, 11, 126, 128 
Home city option, in Time, 11, 104 
Home key, 24 
hot-keys, 15, 364 
HOUR function 

in Calc, 122 
in Sheet, 243 

I 
icons 

displaying in Files, 286 
duplicate icons, 264 
in System screen, 364 
installing, 261 
rearranging, 263 
removing, 262 
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identical records, in Sheet, 230 
Illegal character message, 199, 205, 210 
inches, 147 
INDEX function, in Sheet, 248 
information 

keeping it safe, 21 
storing, 21 

Infrared, 374 
copying Agenda entries, 48 
distance, 343 
in Word, 138 
printing, 323 
security, 313 
sending files, 345 
troubleshooting, 358 
turning on, 258 

Inherited setting, in Word, 149, 152 
Insert cells option, in Sheet, 208 
Insert entry option, in Agenda, 47 
Insert text option, in Jotter, 101 
inserting 

Agenda entries, 46, 47 
appointments, 50 
cells, in Sheet, 208 
columns, in Sheet, 208 
comments in OPL programs, 299 
entry codes, in Agenda, 62 
extra lines, in Data, 75 
page breaks, in Word, 135, 330 
rows, in Sheet, 208 
silence in sound files, 190 
text, in Word, 137 

Install option, 180 
installing 

applications, 261 
Comms application, 309 
Script, 310 

INT function, in Sheet, 236 
interest rates, in Sheet, 237 
Internal disk, 21, 364 
intransitive verbs, in Spell, 175 
Invalid margins, 327 
IRR function, in Sheet, 239 
ISERR function, in Sheet, 250 
ISNA function, in Sheet, 250 
ISNUMBER function, in Sheet, 246 
ISSTRING function, in Sheet, 246 
italic text 

in Agenda, 48 
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in Sheet, 215 
in Word, 142 

IV8192, in Sheet, 198 

J 
Jotter 

bringing from Jotter, 101 
Buttonbar button, 98 
compressing files, 102 
copying to other applications, 101 
deleting notes, 101 
finding notes, 100 
icon, 9 
Infrared, 344 
listing notes alphabetically, 100 
listing notes by date, 100 
starting in Add view, 99 
starting with a blank note, 99 

jumping to 
cells, in Sheet, 198, 200 
circular references in Sheet, 205 
entries, in Data, 79 
pages, in Word, 142 
ranges, in Sheet, 201 

K 
K in calculation line, in Calc, 113 
Keep backup files, in Sheet, 216 
keyboard, 23 

clicks, 255 
key pictures, 3 
special functions, 6 
yellow markings, 6 

keys 
action keys, 23 
arrows, 23, 24 
Caps Lock, 24 
Control key, 24 
Delete key, 23, 24 
Dial keypress, 92 
diamond (♦ ) key, 23 
editing, 24 
End key, 24 
Enter key, 23, 24 
Esc key, 23 
Help key, 23 



 397

Home key, 24 
Infrared keys, 23 
movement, 24 
PgDn, 24 
PgUp, 24 
Psion key, 6, 15, 24, 366 
Shift key, 24 

keywords, in Program editor, 365 
Kill application option, System screen, 358 

L 
Label too long message, 87 
labels 

in Data, 74, 86, 88, 96 
on disks, 365 
on graphs, 221, 223 

latitude, 130 
LEFT function, in Sheet, 245 
legends, on graphs in Sheet, 222 
LENGTH function, in Sheet, 245 
letter size on screen, 7 
line graphs, 220, 225. See also graphs 
line spacing, 365 
lines 

in Sheet, 215 
on graphs, 221 

Link cable, 258 
List view, in Agenda, 52 
list, of calculations, in Calc, 114 
listing 

entries, in Data, 76 
notes, in Jotter, 100 

lists. See Agenda, to-dos 
lists (for files), in the System screen, 264 
LN function, in Sheet, 236 
Load OPL option, in Calc, 123 
loan payments, 241 
LOG function 

in Calc, 116 
in Sheet, 236 

logical functions, in Sheet, 237 
logs 

in Calc, 116 
in Sheet, 236 

long integers, in Calc, 123 
longitude, 130 
Look up (Thesaurus), 171 
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Lookup functions, in Sheet, 249 
Lotus 1-2-3, 217, 218 

compatibility with Sheet, 218 
differences to Sheet, 196, 250 

loudspeaker, 188 
low battery indicator, 25 
LOWER function, in Sheet, 245 
lump sum investments, 238 

M 
M in option, in Calc, 117 
main batteries. See batteries 
mains adapter, 4, 373 
Make directory option, 278, 293 
manual recalculation, in Sheet, 204, 205 
margins, printing, 327 
mathematical operators, 202 

in Sheet, 203 
MAX function 

in Calc, 122 
in Sheet, 246 

Maximum number of characters reached message, 163 
MEAN function, 

in Calc, 122 
Media is corrupt message, 351 
memories, in Calc, 117 
memory 

and Sheet, 196, 213, 214 
checking the amount free, 351 
displaying, in Files, 288 
information, in the System screen, 254 
troubleshooting, 353 

Memory full message, 353 
Memory info option, 269, 352 
memos in Agenda, 365 
Menu key, 15, 23 
menu options, 15 
menubar, 15, 365 
menus, 15, 365 

troubleshooting, 350 
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Merge in option 
in Agenda, 67 
in Data, 89 
in Word, 163 

microphone, 186 
MID function, in Sheet, 245 
midnight, 12 
MIN function 

in Calc, 122 
in Sheet, 246 

MINUTE function 
in Calc, 122 
in Sheet, 243 

Mismatched (or) message, in Sheet, 210 
missing letters, finding, 176 
mixing two sound files, 191 
modified files, 286 
Module does not exist message, 123, 356 
modules, 365 
modulus calculations, 123 
MONTH function 

in Calc, 122 
MONTH function, in Sheet, 243 
movement keys, 24 

in Sheet, 198, 200 
moving 

Agenda entries, 47 
directories, in Files, 290 
files, in Files, 290 

MS-DOS, 365 

N 
N function, in Sheet, 248 
NA function, in Sheet, 250 
Name disk option, 293 
names 

in Data, 19 
ranges of cells, in Sheet, 198, 201, 221 

names and places, in Spell, 171 
negative values (for currency), 255 
net present value, 239 
New alarm option, in Time, 107 
New entry option, in Agenda, 36, 39 
New file option 

in Agenda, 68 
in Data, 88 
in Jotter, 102 
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in Program, 300 
in Sheet, 216 
in System screen, 216 
in Word, 136, 156 
in World, 131 

New graph option, in Sheet, 224 
New list option, in Calc, 114 
NiCd (Nicad) batteries, 5 
No more found message, in Data, 79 
No system memory message, 163, 196, 270, 353 
No words found message, in Spell, 172 
non-breaking spaces, in Word, 135, 139 
Normal emphasis, in Word, 142 
Not found message, in Data, 79 
NOT operator, in Sheet, 203 
Not saved, continue anyway? message, 217 
notes 

in Agenda, 58 
in Jotter, 98 

nouns, in Spell, 175 
NOW function, in Sheet, 244 
NPV function, in Sheet, 239 
number formats 

in Calc, 120 
in graphs, 224 
in Sheet, 214, 215 

Number formats option, 256 
number of entries, in Data, 75 
number separators, 215 
numbers 

calculations, in Sheet, 202 
formats in Sheet, 214 
in Sheet, 198, 199 

numerical order, in Sheet, 211 

O 
Off key, 7 
ON/Esc key, 7, 23 
Online... message, in Comms, 309 
OPD files, 300 
Open entry, in Agenda, 365 
Open file option 

in Sheet, 206, 218 
open files, 14 
opening 

more than one file of the same type, 260 
Sheet files, 216 
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operators, 365 
in Calc, 112, 114 
in Sheet, 202, 203 

OPL. See also Program editor 
about, 365 
automatic switch off, 304 
cacheing - improving speed, 302 
combining modules, 304 
compatibility with Series 3 OPL, 303 
displaying text in programs, 301 
editing, 166 
ENDP: keyword, 297 
functions, in Calc, 123 
indentation, 298 
naming procedures, 297 
printing, 340 
PROC: keyword, 297 
procedures, 297 
REM keyword, 299 
speed cacheing, 302 
sprites, 302 
upper/lower case in keywords, 298 
using DYLs, 302 
using procedures in Calc, 123 

OPO files, 300 
options, 15, 365 

selecting, 15 
OR operator, in Sheet, 203, 232 
Overflow message, 116, 163 
Override protection option, in Sheet, 207 
overwrite, 365 
overwriting cells, in Sheet, 205 
owner information, 22, 253, 312 

P 
page breaks, in Word, 135, 330 
page layout, printing, 327 
page numbers, in Word, 329 
page size, printing, 327 
pagination, 328, 330 
paragraph spacing, in Word, 329 
parallel communication, 365 
passwords, 22, 253 

about, 313, 314 
and Infrared, 345 
choosing, 313 
files, 315 
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forgetting, 357 
in Agenda memos, 59, 315 
in Sheet, 218, 315 
in Word, 315 
on files, 315 
system password, 313, 314 

Paste option, in Sheet, 207 
Paste special option, in Sheet, 209 
paths for files, 365 
Patience 

bonus points and gambling, 184 
High Scores table, 184 
icon, 9 
rules of the game, 183 
scoring, 183 
sound effects, 182 
starting a new game, 184 
two players, 184 
undoing a move, 183 

PC backups, 320 
Percent format, in Sheet, 214 
percentages 

in Calc, 119 
in Sheet, 203, 237 

phone numbers 
dialling, 74 
entering in Data, 75, 93 
international, 94 

phone symbol, 75, 86, 93 
phonetic spelling, in Spell, 174 
PI 

in Calc, 115 
in Sheet, 235 

PIC files, in Sheet, 219, 226, 227 
pie charts, 220, 225, 227. See also graphs 
playing sounds, 188, 191 
Please replace volume message, 351 
PMT function, in Sheet, 241 
Position to-do entry option, 41 
powers, in Calc, 115 
precedence 

about, 365 
in Calc, 112, 114 
in Sheet, 203 

preferences, 18, 366 
prepositions, in Spell, 175 
previous calculations, in Calc, 114 
Print option, 331, 332, 335 
Print preview option, 339 
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print range, 366 
Print setup option, 324, 327, 335 
printer configuration, 366 
printer drivers, 324, 366 
printer model, 366 
printing, 322 

cancelling, 340 
emulation, 363 
from Agenda, 332 
from Data, 335 
from Sheet, 336 
from Word, 160, 329 
graphs from Sheet, 226 
headers and footers, 327 
Infrared, 323 
margins, 327 
outlines, in Word, 332 
page size, 327 
parallel printers, 322 
previewing, 339 
PsiWin, 322 
selecting the printer, 324 
serial printers, 323 
to a file, 324 
to a PC, 322 

Private entry, in Agenda, 366 
PROC: keyword, in Program, 297 
procedure template, in Program, 366 
Program editor. See also OPL 

calling procedures, 297 
combining modules, 304 
comment lines in procedures, 299 
compatibility mode, 303 
compiling programs, 299 
creating programs, 296, 300 
editing programs, 297, 300 
ENDP: keyword, 297 
errors in translation, 299 
filename extensions, 298 
files and directories, 300 
functions, 297 
icon, 9 
indentation, 298 
naming procedures, 297 
normal mode, 303 
OPD files, 300 
OPL files, 298 
OPL modules, 297 
OPO files, 300 
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PROC: keyword, 297 
procedures, starting and ending, 297 
running programs, 299 
running Series 3 OPL programs, 303 
stopping programs, 300 
testing programs, 299 
translating programs, 299 
translating programs for the Series 3, 299 
upper/lower case, 298 

programming your Series 3c 
in OPL, 296 

PROPER function, in Sheet, 245 
proper nouns, in Spell, 171 
protecting cells, in Sheet, 206 
protection indicator, in Sheet, 207 
Protection option, in Sheet, 206 
PsiData, 20 
Psion key, 6, 7 
Psion Print, 322 
PsiWin, 20, 320 

file conversion, 218, 363 
file conversions, 164 
printing, 322 

PV function, in Sheet, 240 

R 
radians/degrees 

converting, 235 
in Calc, 115, 356 

Ram SSDs, 271, 373 
RAND function, in Sheet, 236 
range functions, in Sheet, 248 
range names, in Sheet, 201, 207 
range painting, in Sheet, 204 
range references, in Sheet, 202, 203, 366 
Range setting, in Soundmaster, 189 
ranges of cells 

in Sheet, 211 
ranges of cells, in Sheet, 198, 200 
RATE function, in Sheet, 238 
read-only files, 280, 286, 313, 362 

about, 366 
Recalc option, in Sheet, 205 
recalculating, in Sheet, 204, 234 
rechargeable batteries, 5, 25 
reciprocals, in Calc, 112, 115 
recording sounds, 187 
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references to cells, in Sheet, 203, 362, 366 
Reinstate entry option, 47 
relative references, in Sheet, 207, 211, 366 
REM, OPL keyword, 299 
reminders. See Agenda, to-dos 
removing 

cells, in Sheet, 208 
columns, in Sheet, 208 
directories, 279 
entry codes, in Agenda, 63 
file lists, 266 
formatting, in Sheet, 205 
highlighting, in Sheet, 200 
memos, in Agenda, 60 
protection on cells, in Sheet, 207 
rows, in Sheet, 208 

Rename graph option, in Sheet, 225 
renaming 

directories, in Files, 290 
files, in Files, 290 
files, in the System screen, 276 
graphs, 225 
memories, in Calc, 119 

REPEAT function, in Sheet, 245 
repeating entries, in Agenda, 44 
repeating text, in Sheet, 213 
Replace backup battery message, 26 
REPLACE function, in Sheet, 245 
Replace main batteries message, 25 
Replace option, in Word, 141 
resetting the Series 3c, 314, 358 

hard reset, 359 
killing an application, 358 
soft reset, 359 

Restore files option, 318 
restoring, 316 

all files, 318 
backups, 318 
files, 318, 319 

Restricted entry, in Agenda, 366 
results of calculations 

in Calc, 112, 114 
in Sheet, 202 

reversing sounds, in Soundmaster, 191 
Revert option 

in Sheet, 206 
in Soundmaster, 190 
in Word, 157, 162 

RIGHT function, in Sheet, 245 
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roman numerals, in Spell, 171 
root directory, 274, 366 
ROUND function, in Sheet, 236 
row titles, in Sheet, 199 
ROWS function, in Sheet, 248 
rows, in Sheet, 197, 208 
RS232, 366 
Run utility option, 294 
RunImg icon, 352 
running programs, in Program, 299 
run-on words, in Spell, 174 
RunOPL icon, 299 

S 
S function, in Sheet, 248 
S3 Translate option, in Program, 299 
Save as option 

in Agenda, 68 
in Sheet, 218 

Save as template option, in Word, 157 
saving, 18 

dialog settings, 16 
graphs, 221 
in Data, 75, 90 
in Sheet, 206, 216 
numbers, in Calc, 117 
sound files, 189, 194 

Scatter graphs, 220, 226. See also graphs 
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Scientific number format 
in Calc, 116 
in Sheet, 214 

scoring, in Patience, 183 
screen 

cleaning, 7 
contrast, 7 

Script, installation, 310 
scrolling the screen 

in Sheet, 197 
search clues, in Data, 366 
search criterion in Sheet, 229 
Search option in Agenda, 44 
searching 

databases, in Sheet, 229, 231 
for text, using Files, 291 
in Agenda, 53 
in Data, 78, 79, 80 
in Sheet, 212 
in Word, 140 
repeat entries, in Agenda, 44 

SECOND function 
in Calc, 122 
in Sheet, 243 

security 
backups, 312 
Infrared, 313 
owner information, 253 
passwords, 253 
read-only files, 280 
write-protecting SSDs, 272 

Select disk option, 285, 288 
selecting 

about, 366 
cells, in Sheet, 200 
columns, in Sheet, 200 
directories, in Files, 289 
files, in Files, 289 
files, using the File selector, 278 
options, 24 
paragraphs in Word, 143 
part of a sound file, 188 
ranges of cells, in Sheet, 200 
rows, in Sheet, 200 
text, 24 
text, in Word, 136 

sensitivity analysis, 233, 234 
serial communication, 366 
serial port, 366 
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Series 3/3a 
Agenda files, 69 

Series 3c 
character set, 326 
Infrared, 342 
loudspeaker, 188 
memory, 353 
microphone, 186 
OPL programming, 301 
programming, 296 
resetting, 358 
running Series 3 OPL programs, 303 
specification, 373 

Set alarm for entry option, in Agenda, 56, 57 
Set outline level option, in Word, 160 
Set owner option, 253, 312 
Set preference options, 18 
Set ranges option, in Sheet, 220 
Set repeats option, in Soundmaster, 194 
Set style for entry option, in Agenda, 48 
Set up ♦  list option 

in Agenda, 53 
in Data, 85 
in Jotter, 101 

Set up file list option, 286 
setting 

alarms, 107 
date, 12, 104 
home city, 11, 104, 126 
owner information, 312 
passwords, 315 
start of the week, 106 
summer times, 106, 129 
system password, 314 
time, 12, 104 
workdays, 105 

Sheet 
backup files, 216 
bottom right cell, 198 
cell references, 197 
compatibility with Lotus 1-2-3, 218 
copying to other applications, 210 
creating files, 196, 198 
database ranges, 228 
databases, 227, 228, 229, 230 
description, 196 
diamond key, 219 
differences to Lotus 1-2-3, 196, 250 
display, 213 
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error messages, 210 
extent, 200 
file formats, 218 
files, 196, 216 
formulae, 202, 204 
graphs. See graphs 
icon, 9 
Infrared, 344 
Jump to option, 201 
lines on grid, 215 
location of files, 216 
Lotus 1-2-3, 217 
memory requirements, 196 
numbers allowed, 199 
optimising, 204 
printing, 226, 327, 336 
protecting cells, 207 
protection indicator, 207 
range painting, 204 
recalculation indicator, 204 
relative references, 211 
running, 197 
scrolling screen, 197 
searching databases, 229 
sorting database records, 229 
titles, 199 
Titles on/off option, 199 
working area, 200 

shortcodes, in Word, 366 
Show formulae, in Sheet, 214 
Show grid option, 77 
Show labels option, in Data, 87 
Show option, in Sheet, 215 
significant digits, in Calc, 121 
silence, inserting in sound files, 190 
silencing alarms, 109 
SIN function 

in Calc, 115 
in Sheet, 235 

size, text on screen, 7 
SLN function, in Sheet, 241 
snoozing alarms, 109, 366 
soft hyphens, in Word, 135, 139 
soft reset, 367 
Solid State Disks, 21 
Sort key size, in Data, 85 
sort keys, in Sheet, 211 
Sort list option, 286 
sorting, 367 
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database records, in Sheet, 229 
entries, in Data, 77, 84 
file lists, in Files, 286 
in Sheet, 211 
notes, in Jotter, 100 
on opening a database, 85 
to-do entries, 41 

Sound is disabled message, 255 
Soundmaster 

and alarm sounds, 194 
cancelling changes, 190 
deleting part of a sound, 192 
echoes, 193 
filters, 193 
icon, 9 
Infrared, 344 
inserting silence, 190 
loudspeaker, 188 
microphone, 186 
mixing files, 191 
playing sounds, 191 
recording sounds, 187 
reversing sounds, 191 
selecting part of a sound file, 188 
Sound is disabled message, 255 
speed, 192 
voice messages, 194 
WAV files, 189 
Workfiles, 189 

sounds. See also alarms. See also Soundmaster 
controlling, 254 

SP! files, from Sheet, 216, 217 
specification, 373 
Spell 

abbreviations and acronyms, 171 
correcting spelling, 172 
dictionaries, 179, 180 
entering words, 171 
finding missing letters, 176 
history list, 174 
icon, 9 
memory requirements, 170 
names and places, 171 
No words found message, 172 
numbers and symbols, 178 
parts of speech, 175 
phonetic spelling, 174 
proper nouns, 171 
repeated words, 179 
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solving anagrams, 176 
solving crossword clues, 176 
Thesaurus, 175 
uppercase words, 178 
US and UK spellings, 170 
Word or phrase too long message, 176 

spell-checking. See Spell 
SPR directory, 227 
SPR file format, 217, 218 
spreadsheets. See Sheet 
square root function 

in Calc, 115 
in Sheet, 236 

SSDs, 21, 270, 373 
about, 367 
batteries, 272 
copying, 281 
default disk, 273 
Flash, 316 
formatting, 271, 293, 364 
naming disks, 273 
Ram, 316 
Soundmaster, 186 
troubleshooting, 351 
volume names, 351 
write-protecting, 272 

stack-bar graphs, 220, 225. See also graphs 
standard deviation, 122, 246 
Standard template, in Word, 158 
Start at current entry option, in Data, 79 
start year, in Agenda, 367 
statistical functions, in Sheet, 246 
Status window 

clock type, 13 
displaying, 12, 254 
indicators, 13, 25 

STD function 
difference to VAR, 247 
in Calc, 122 
in Sheet, 247 

STRING function, in Sheet, 246 
strings, in Sheet, 203, 244 
style bar, in Word, 150 
Style gallery option, in Word, 151, 153 
Style housekeeping option, in Word, 154 
styles 

in Sheet, 214 
in Word, 148 

subdirectories, 367 
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subscript text, in Word, 142 
substituting fonts, 367 
SUM function 

in Calc, 122 
in Sheet, 246 

summer times, 106, 128, 367 
changing to, 106 

sums 
in Calc, 112 
in Sheet, 196, 200, 202 
what if? type, 204, 233, 234 

sunrise time, 126 
sunset time, 126 
superscript text, in Word, 142 
switching 

views in applications, 23 
switching on and off, 7 

automatic switch off, 253, 362 
Jotter button, 99 
troubleshooting, 348, 359 

SYD function, in Sheet, 241 
synonyms, in Spell, 175 
Syntax error message, 114, 210 
system files, 286 
system password, 314 
System screen, 8, 14 

about, 367 
application groups, 267 
applications, 8 
displaying, 252 
file lists, 259, 264, 275 
font, 257 
groups, 275 
icons, 8, 262, 263, 264 
memory information, 254, 351 
moving to, 9 
Status window, 254 
text size, 256 

T 
tab characters 

in Data, 75 
in Sheet, 210 
in Word, 139, 210 
printing, 332 

Tab key 
in dialogs, 16 



 413

in Sheet, 198 
tab stops 

about, 367 
tab types, 367 
Table 1 option, in Sheet, 234 
Table 2 option, in Sheet, 234 
Table options, in Sheet, 233, 234 
tables 

in Sheet, 196, 211, 233, 234 
in Word, 147 

tagging files 
about, 367 
using Files, 289 
using the File selector, 278 

TAN function 
in Calc, 115 
in Sheet, 235 

tax calculations, 119, 120 
templates, in Word, 156, 345, 367 
TERM function, in Sheet, 240 
text 

deleting, 23 
in Agenda, 49 
in Sheet, 198 
in Word, 136 
on graphs, 221, 223 
size, 7, 49 
styles in Sheet, 214 

text editor, 165 
printing, 340 

text files, 90, 367 
text wrapping 

about, 7 
in Data, 86 

Thesaurus, 175 
in Word, 139 

things to do. See Agenda, to-dos 
thousands separator, 215, 256 
Tidy/extract option, in Agenda, 66 
tidying Agenda files, 367 
till roll, in Calc, 368 
Time 

24 hour clock, 12 
Agenda alarms, 58 
alarms. See also alarms 
am-pm clock, 12 
clock type, 13 
displaying the time, 105 
icon, 9 
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setting the current time, 12 
setting the date, 104 
setting the time, 104, 126 
summer time, 106 
time format, 105 
time zones, 106 

Time and date option, in Time, 12, 104 
Time format, in Sheet, 214 
TIME function, in Sheet, 243 
time functions 

in Calc, 122 
in Sheet, 243 

time slots, in Agenda, 50 
timed day entry, 368 
TIMEVALUE function, in Sheet, 243 
Tips 

controlling when Tips appear, 257 
finding a Tip, 257 
the Tips screen, 8 

titles 
editing in Sheet, 199 
on graphs, 221, 222, 227 
on tables, in Sheet, 199, 212 

To-do list settings option, 40, 41 
Too big for fixed format message, 121 
Too complex message, 210 
Too many processes message, 350 
transitive verbs, in Spell, 175 
Translate option, in Program, 299 
translating OPL programs, 299, 368 
Triad number format, in Sheet, 214 
trigonometry 

in Calc, 115 
in Sheet, 235 

TRIM function, in Sheet, 245 
TRUE function, in Sheet, 237 
turning on and off, 7 

automatic switch off, 253, 362 
troubleshooting, 348, 359 

Type mismatch message, 210 
typeface. See fonts 

U 
undated To-do entry, 368 
Underflow message, 116 
underlined text 

in Agenda, 48 
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in Word, 142 
undoing changes 

disabling undo, in Sheet, 206 
in Patience, 183 
in Sheet, 206, 207 
in Soundmaster, 190 

Units of measurement option, 147 
Untag files/directories option, 290 
untimed day entry, 368 
Update city option, in World, 131 
Update country option, in World, 131 
Update lists setting, 260 
updating 

entries, in Data, 76, 81 
information, in World, 131 
labels, in Data, 86 

UPPER function, in Sheet, 245 
US and UK spelling, 170 
Usage monitor option, 28 
Use graph option, in Sheet, 225 
Use printer layout option, in Word, 146 
Use screen layout option, in Word, 146 
utilities, in Files, 294 

V 
VALUE function, in Sheet, 246 
VAR function (variance) 

difference to STD, 247 
in Calc, 122 
in Sheet, 247 

variance, 246 
verbs, in Spell, 175 
vibrato, in Soundmaster, 192 
View all repeats option, in Agenda, 44, 45 
View legends option, in Sheet, 222 
View next alarms option, 58, 109 
viewing 

entries, in Data, 77 
graphs, 225 

views, 23, 368 
VLOOKUP function, in Sheet, 250 
voice messages, in Soundmaster, 194 
volume names, for disks, 293, 351 
voxcode, in Soundmaster, 192 
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W 
Week view, in Agenda, 51 
weekly alarms, 107 
what if? calculations, 196, 202, 204 
Which symbols option, in Agenda, 61 
wildcards 

in Files, 286 
in Sheet, 212, 232 

WKS/WK1 file format, 218 
Word 

adding up columns, 147 
alignment and justification, 144 
applying emphases, 148 
applying styles, 151, 153 
bold text, 142 
BT Body Text style, 151 
bulleted lists, 151 
centred text, 144 
clipboard, 137 
copying styles and emphases, 155 
copying text, 138 
counting words, 139 
cursor, 136 
default templates, 158 
deleting styles and emphases, 154 
deleting text, 137 
document dictionaries, 180 
emphases, 148 
files, 161, 162, 163, 164 
finding text, 140 
fonts, 144, 145, 166 
forced line breaks, 135 
hanging indents, 145 
hard hyphens, 135 
headers and footers, 328 
hidden characters, 139 
highlighting text, 136 
icon, 9 
indenting a paragraph, 146 
Infrared, 138, 345 
Inherited setting, 149, 152 
italic text, 142 
joining paragraphs, 137 
margins, 327 
Maximum number of characters reached message, 163 
measurement units, 147 
merging documents, 163 
moving text, 139 
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new files, 158, 161 
non-breaking spaces, 135 
Normal view, 159 
Outline view, 159 
Overflow message, 163 
page breaks, 135, 330 
page numbers, 329 
paragraph spacing, 329 
paragraphs, 143 
printing, 160, 327 
replacing text, 141 
RTF (Rich Text Format), 166 
short codes for styles/emphases, 142 
soft hyphens, 135 
spell-checking, 139, 177 
Standard template, 158 
style bar, 150 
styles, 148, 152, 367 
subscript text, 142, 149 
summary outlines, 159 
superscript text, 142, 149 
tab positions, 146 
tables, 147 
templates, 156, 166 
text editor, 165 
text files, 164, 165 
Thesaurus, 139, 179 
underlined text, 142 
wrapping text, 134 
ZA, ZB... styles, 153 

word count, in Word, 139 
Word or phrase too long message, in Spell, 176 
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workdays 
alarms, 105, 107 
alarms, in Agenda, 57 
repeat entries, in Agenda, 44 
setting, 105 

Workfile, in Soundmaster, 189 
worksheet file, 196 
World 

accuracy of information, 126 
creating new files, 131 
finding cities & countries, 127 
icon, 9 
screen display, 132 

wrapping text, 368 
about, 7 
in Data, 86 
in Word, 134 

write-protecting SSDs, 272 
writing 

documents, in Word, 133 
letters, in Word, 167 
notes, in Agenda, 58 
notes, in Jotter, 98 
OPL programs, in Program, 297 

X 
X labels, on graphs, 222 
X-axis, 368 
XMODEM protocol, 309 
X-rays, 312 
Xword, 171 
XY/Scatter graphs, 220, 224, 226. See also graphs 

Y 
Y-axis, 368 
YEAR function 

in Calc, 122 
in Sheet, 243 

Year view, in Agenda, 63 
Yen character, 215 
YMODEM protocol, 309 
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Z 
ZA,ZB... styles, in Word, 153 
zero values, in Sheet, 215 
ZMODEM protocol, 309 
Zoom in/out option 

in Agenda, 49 
in Data, 86 
in Sheet, 223 
in the System screen, 7, 256 
in Word, 135 
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